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Welcome
DPOJET is a jitter, noise, timing, and eye analysis tool for Tektronix Performance Digital Oscilloscopes (DPO5000/B, MSO5000/B,
DPO7000C, DPO70000C/D/DX, DSA70000C/D, MSO70000/C/DX, DPO72304SX, DPO73304SX, DPO75002SX, DPO75902SX, and
DPO77002SX series). DPOJET enables you to achieve new levels of productivity, efficiency, and measurement reliability on complex
clock, digital, and serial data signals. DPOJET revolutionized jitter analysis by adding noise analysis.

Some of the features of DPOJET are:

• Advanced Jitter, Noise and Timing Analysis for clocks and data signals, with up to 99 simultaneous measurements on 12 analog and
16 digital sources.

• Jitter Guide/Serial Data wizard for easy configuration of popular measurement sets.
• One Touch Jitter wizard for quick jitter summaries.
• Accurate jitter decomposition and TJ (BER) estimation using industry-accepted methods.
• Isolate jitter and noise due to crosstalk, and make random and deterministic estimations in the presence of crosstalk.
• Comprehensive measurement statistics.
• Random Jitter (RJ) Lock value for analysis.
• BER analysis of serial data rates.
• BUJ analysis of both clock and data signals.
• Flexible measurement/statistic logging and export capabilities.
• Sophisticated plots for graphical analysis such as Histograms, Time Trends, Eye Diagrams, Spectrums, Bathtub Plots, BER Eye

Contour, Composite Jitter Histogram, Composite Noise Histogram, Noise Bathtub, BER eye, Correlated Eye, PDF Eye and Real-Time
Eye® diagrams with transition and non-transition bit separation.

• Tektronix patented Programmable PLL software clock recovery.
• Standards-specific support for clock recovery and jitter separation methods.
• Capture and storage of worst-case waveforms for subsequent analysis.
• Thorough remote programmability using oscilloscope-like syntax.
• Optical measurements are added under optical standard tab: Average Optical Power, Extinction Ratio, Optical Modulation Amplitude,

Optical High, Optical Low, Eye Crossing Level, Eye Crossing Time, Eye Crossing Percent, Mask Hit Ratio, Mask Margin, RIN,
RINxOMA, and TDEC.

• Characterizing and compensating oscilloscope vertical noise from the measured result.
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Introduction to the application
Related documentation
Tektronix manuals are available at: www.tektronix.com/manuals and www.tektronix.com/software. Use the following table to determine the
document that you need: 

Table 1: List of reference documents

For information on: Refer to:

• Operating the Oscilloscope Oscilloscope user manual.

Oscilloscope user online help.

• Software warranty

• List of available applications

• Compatible oscilloscopes

• Relevant software and firmware version numbers

• Applying a new option key label

• Installing an application

• Enabling an application

• Downloading updates from the Tektronix Web site

Optional Applications Software on Windows-Based Oscilloscopes
Installation Manual, which is provided on the Optional Applications
Software on Windows-Based Oscilloscopes CD-ROM, in the
Documents directory.

Conventions
Online Help uses the following conventions:

• When steps require sequence of selections using the application interface, the “>” delimiter marks each transition between a menu and
an option. For example, Analyze > Wizard > One Touch Jitter.

• The terms “DPOJET application” and “application” refer to DPOJET. 

• The term “oscilloscope” refers to any product on which this application runs.

• The term “DUT” is an abbreviation for Device Under Test. 

• The term “select” is a generic term that applies to the methods of choosing an option: with a mouse or with the touch screen.
• User interface screen graphics are taken from a DPO7000 series oscilloscope.

You can find a PDF (portable document format) file for this document in the Documents directory on the Optional Applications Software on
Windows-Based Oscilloscopes DVD. The DVD booklet only contains information on installing the application from the DVD and on how to
apply a new label. You can also find the PDF and the Online Help at Start > All Programs > TekApplications > DPOJET.

Introduction to the application

34

http://www.tektronix.com/manuals
http://www.tektronix.com/software


Table 2: Icon descriptions

Icon Meaning

This icon identifies important information.

This icon identifies conditions or practices that could result in loss of data.

This icon identifies additional information that will help you use the application more efficiently.

Technical support
Tektronix welcomes your comments about products and services. Contact Tektronix through mail, telephone, or the Web site. Click
Contacting Tektronix for more information.

Tektronix also welcomes your feedback. Click Customer feedback for suggestions for providing feedback to Tektronix.

Customer feedback
Tektronix values your feedback on our products. To help us serve you better, please send us your suggestions, ideas, or other comments
you may have regarding the application or oscilloscope.

Direct your feedback via email to

techsupport@tektronix.com

Or FAX at (503) 627-5695, and include the following information:

General Information
• Oscilloscope model number (for example, DPO/MSO5000, DPO7000, DSA/DPO/MSO70000 series) and hardware options, if any.
• Software version number.
• Probes used.

Application-specific Information
• Description of the problem such that technical support can duplicate the problem.

• If possible, save the oscilloscope and application setup files as .set and associated .xml files.

• If possible, save the waveform on which you are performing the measurement as a .wfm file.

Once you have gathered this information, contact technical support by phone or through e-mail. In the subject field, please indicate
“DPOJET Problem” and attach the .set, .xml and .wfm files to your e-mail. If there is any query related to the actual measurement
results, then you can generate a .mht report and send it.

The following items are important, but optional:

• Your name
• Your company
• Your mailing address

Introduction to the application
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• Your phone number
• Your FAX number

Enter your suggestion. Please be as specific as possible.

Please indicate if you would like to be contacted by Tektronix regarding your suggestion or comments.

To include screen shots of the oscilloscope waveform and DPOJET user interface, from your oscilloscope menu bar, click File > Save As >
Screen Capture. To include screenshots of the DPOJET plots, select the floppy-disk icon from the plots toolbar. In either case, enter a file
name in the Save As dialog box, select an image file format (For example:.bmp or .png or .jpeg), choose a save location and select Save.
You can then attach the file(s) to your e-mail (depending on the capabilities of your e-mail editor).
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Getting started
Product description
DPOJET is a jitter, noise, timing, and eye diagram analysis tool for Tektronix Performance Digital Oscilloscopes (DPO5000/B, MSO5000/B,
DPO7000C, DPO70000C/D/DX, DSA70000C/D, MSO70000/C/DX, DPO72304SX, DPO73304SX, DPO75002SX, DPO75902SX, and
DPO77002SX series). DPOJET enables you to achieve new levels of productivity, efficiency, and measurement reliability on complex
clock, digital, and serial data signals. DPOJET answers the challenge with a jitter and noise breakdown extended to properly classify the
bounded uncorrelated disturbers in their own category, increasing the accuracy of the jitter/noise result.

The application provides the following features: 

• One Touch Jitter Summary.
• Measurement Setup Wizard.
• Isolate jitter and noise due to crosstalk, and make random and deterministic estimations in the presence of crosstalk.
• Qualify the waveform measurement within a selected result range by General.
• Limit the waveform (data) analysis by Gating, applying a Qualifier or configuring population limits.
• High pass and low pass measurement filters.
• Random Jitter (RJ) Lock value for analysis.
• Auto-detection of signal type (clock or data), bit rate, and pattern length.
• Different architectures for clock recovery to establish a reference clock, the edges of which can be used as a basis for timing

comparisons.
• RJ-DJ and RN-DN decomposition on repeating and arbitrary data patterns.
• BER analysis of serial data rates.
• BUJ analysis of both clock and data signals.
• Eye diagrams with transition and non-transition bits separation.
• Show results as numeric and graphical displays.
• Different types of two-dimensional display plots for easier analysis of results.
• Automatic reference level autoset for eye diagrams, jitter, noise and timing measurements.
• Preferences shortcut to set up options available at the Select panel.

Jitter Analysis Jitter Analysis is the measurement of Time Interval Error (TIE), advanced RJ-DJ decomposition, and other
clock to data edge relationships.

Noise Analysis Noise Analysis is the set of measurements (RN, NN, DDN, ..) that are analogous to Jitter component
measurements (RJ, PJ, DDJ, ..).

Timing Analysis Timing analysis is the measurement of period, setup, hold, skew, and other edge-to-edge data timing
relationships.

Eye Diagram Analysis Eye diagram analysis is the plotting and measurement of eye diagrams and masks.
• Oscilloscope vertical noise compensation from measurement result.

DPOJET option levels
The DPOJET application offers three different levels of features, depending on how it is configured. The configurations are determined by
the following order codes:

• DJE – Jitter and Eye Diagram Analysis Tools - Essentials
• DJA – Jitter and Eye Diagram Analysis Tools - Advanced
• DJAN – Noise Analysis Tools - Requires DJA

Getting started
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Note: The application name “Jitter and Eye Diagram Analysis Tools” is the same for DJE, DJA. The application name for DJAN
is "Noise Analysis Tools" and it requires DJA enabled. However, Help > About DPOJET indicates the configured option level.
Save/Recall is compatible between the option levels. If a setup file saved in DJA is recalled in DJE, only the capabilities available
in DJE will be recalled. If a setup file saved in DJAN is recalled in DJA or DJE, only the capabilities available in DJA or DJE will be
recalled.

Jitter and Eye Diagram Analysis Tools - Essentials
Use Essentials for basic timing and jitter analysis. Essentials offers:

• Period, Frequency and Time Interval Error analysis.
• Timing parametrics such as rise/fall times, pulse width and duty cycle.
• Many graphical tools such as histograms, time trends, and spectrums.
• Configurable HTML report generation.
• Logging features for recording individual measurements, statistics, or worst-case waveforms.
• Comprehensive remote control using oscilloscope-like GPIB syntax.
• A wizard interface to ease common setup tasks.

Note: Summary View and Overall Test Result are not available for DJE.

Jitter and Eye Diagram Analysis Tools-Advanced
The Advanced configuration offers all the features of Essentials, and adds the following:

• Jitter separation (RJ-DJ analysis).
• Eye measurements.
• Amplitude measurements.
• Measurement filters.
• Eye diagrams, bathtub plots or Mask Hits waveform plots.
• Pass/Fail limits capability.
• RJ Lock value

Note: Option DJA is required for PCI Express Gen1/Gen2/Gen3 measurements and for DDRA measurements.

Noise Analysis Tools - Requires DJA
The Noise Analysis Tools configuration offers all the features of Advanced and adds the following:

• Jitter separation RJ(h), RJ(v), PJ(h), PJ(v).
• Noise measurements RN, RN(v), RN(h), DN, DDN, DDN(1), DDN(0), PN, PN(v), PN(h), NPN, TN@BER, Unit Amplitude.
• Plots related to composite Jitter+Noise analysis, such as BER Eye, Correlated Eye and PDF Eye.
• Noise measurement plots such as BER Eye contour, Noise Bathtub, Composite Noise Histogram.

Compatibility
For information on oscilloscope compatibility, refer to the Optional Application Software on Microsoft Windows Based Oscilloscopes
Installation Manual, Tektronix part number 077-0067-XX. The manual is available as a PDF file. 
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Requirements and restrictions
DPOJET requires Matlab MCR (Matlab Compiler Runtime) 8.0 for 64-bit oscilloscopes. DPOJET requires .Net framework v4 or higher for
64-bit oscilloscopes. 

Supported probes
The application supports the following probes:

• TAP1500
• TAP2500
• TAP3500
• P5100
• P6015
• P6101A
• P6139A
• P6241
• P6243
• P6245
• P6249
• P6150
• P6158
• P7240
• P7260
• P7330
• P7340A
• P7350
• P7350SMA
• P7360A
• P7380A
• P7380SMA
• P7313A
• P7313SMA
• All P75XX, P76XX and P77XX probes

Installing the application
Refer to the Optional Applications Software on Windows-Based Oscilloscopes Installation Manual for the following information:

• Software warranty.
• List of available applications, compatible oscilloscopes, and relevant software and firmware version numbers.
• Applying a new option installation key label.
• Installing an application.
• Enabling an application.
• Downloading updates from the Tektronix Web site.
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You can find a PDF (portable document format) file for this document in the Documents directory on the Optional Applications Software on
Windows-Based Oscilloscopes DVD. The DVD booklet contains information on how to install the application from the DVD and on how to
apply a new option installation key label.

About DPOJET
Click Help > About DPOJET to view application details such as the release software version number, application name, and copyright.

Figure 1: About DPOJET

Note: The version displayed above is indicative only, the version number displayed will vary depending upon the exact version of
the application installed.
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Operating basics
About basic operations

Starting the application
On the oscilloscope menu bar, click Analyze > Jitter and Eye Analysis (DPOJET) > Select to open the application.

Application interface menu controls
Table 3: Application menu controls descriptions

Item Description

Tab Shortcut to a menu in the menu bar or a category of menu options; most tabs are short
cuts.

Area Visual frame with a set of related options.

Option button Button that defines a particular command or task.

Field A box to type in text, or to enter a value with the Keypad or a Multipurpose knob.

Check Boxes Use to select or clear preferences.

Scroll bar Vertical or horizontal bar at the side or bottom of a display area that can be used for moving
around in that area.

Browse Displays a window where to look through a list of directories and files.

Command button Button that initiates an immediate action such as Run command button  in the
control panel.

Virtual Keypad icon 
Click to use on-screen keypad to enter alphanumeric values.

MP knob references (a or b) Identifiers that show which Multi Purpose Knob (MPK) may be used as an alternate
means to control a parameter; turn the knob on the oscilloscope front panel to adjust
the corresponding parameter Also, the value can be entered directly on the MPK display
component.

Virtual keypad

Select the  icon and use the virtual keypad to enter alphanumeric values, such as reference voltage levels.
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Figure 2: Virtual keypad

Tips on DPOJET user interface
The following tips help you with the application user interface:

• Use the Serial Data/Jitter Guide to rapidly set up and initiate sets of commonly used measurements. After running the Serial Data/Jitter
Guide, you can modify the configuration parameters to meet specific needs.

• Select a measurement to create a measurement and add it to the current measurement table. New measurements initially use the

same source as the earlier measurement, or the most recently used source. Click  to change the measurement source or adjust
other source parameters such as the reference levels.

• Select any measurement multiple times to create multiple copies. This may be useful if you wish to run the same measurement with
different configuration options.

• Use the Single button  to obtain a single set of measurements from a single new waveform acquisition. Pushing the button
again before processing has completed will interrupt the processing cycle.

• Use the Run button  to continuously acquire and accumulate measurements. Push the button again to interrupt the current
acquisition.

• Use the Recalc button  to perform measurements on the waveform currently displayed on the oscilloscope, that is without
performing a new acquisition. This is useful if you wish to modify a configuration parameter and re-run the measurements on the
current waveform.

Basic oscilloscope functions

Application directories
The installation directory for DPOJET is C:\Program Files\TekApplications\DPOJET. During installation, the
application sets up directories for various functions such as to save setup files. The file name extension is used to identify the file
type.
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Table 4: Application directories

Default directory Used for

C:\%USERPROFILE%
\Tektronix\TekApplications\DPOJET\Images 1

Exported plot files.

C:\Users\Public\Tektronix\TekApplications
\DPOJET\Limits

Pass/fail limits files.

C:\Users\Public\Tektronix\TekApplications
\DPOJET\Patterns

Bit patterns.

C:\%USERPROFILE%
\Tektronix\TekApplications\DPOJET\Logs 1

Log files. Consists of three subfolders:

• Statistics for statistics log files (.csv)

• Measurements for measurement log files (.csv) and

• Waveforms for worst case waveforms (.wfm)

C:\Users\Public\Tektronix\TekApplications
\DPOJET\Masks

Mask files for various serial data standards. For Example - PCIE,
FBDIMM, SATA.

C:\%USERPROFILE%
\Tektronix\TekApplications\DPOJET\Reports
1

Report files (.mht , .pdf).

C:\%USERPROFILE%
\Tektronix\TekApplications\DPOJET\Data 1

Error log file, DPOJETErrors.log.

C:\Users\Public\Tektronix\TekApplications
\DPOJET\Examples

Various tutorial and support files.

C:\Users\Public\Tektronix\TekApplications
\DPOJET\Filters

BTFilter.

C:\Users\Public\Tektronix\TekApplications
\SDLA\taps

FFETaps.

File name extensions
Table 5: File name extensions

File Extension Description

.csv Ascii file containing Comma Separated Values. This file format may be read by any ascii text editor
(such as Notepad) or may be imported into spreadsheets such as Excel.

Table continued…

1 %USERPROFILE% represents your user location.
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File Extension Description

.xml Ascii file containing measurement setup information, limits or other data in Extensible Markup
Language.

.set Binary file containing oscilloscope setup information in a proprietary format.

.mht An HTML archive file, compatible with common Windows applications; and contain the full report,
including text and graphics.

.msk A user mask file.

.wfm Binary file containing an oscilloscope waveform record in a recallable, proprietary format.

.flt Filter file containing sample rate and filter co-efficient information in a proprietary format.

.pdf A portable document format compatible with common PDF opening applications such as Adobe
Acrobat Reader, Foxit PDF Reader etc. Contains full report including text and graphics.

Application menu shortcuts
The DPOJET application provides shortcuts for navigating the user interface. Use Alt+ A for the Analyze menu and Alt+A+J for Jitter and
Eye Analysis (DPOJET). Use Alt+A+E for PCI Express and Alt+A+U for USB 3.0 Essentials.

Note: is common for all submenus except the Help menu.

Table 6: Application shortcuts

Menu Items SubMenu Shortcut

Wizard One Touch Jitter Alt +A+J+J

Serial Data/Jitter Wizard Alt +A+J+W

Select Alt +A+J+S

Configure Alt +A+J+C

Results Alt +A+J+R

Plots Alt +A+J+P

Reports Alt +A+J+O

Export Data Snapshot Alt +A+J+E+D

Measurement Summary Alt +A+J+E+S

Table continued…

Operating basics

44



Menu Items SubMenu Shortcut

Data Logging Alt +A+J+L

Preferences Alt +A+J+F

Limits Alt +A+J+I

Global Configuration Alt +A+J+G

Measurement Summary Alt +A+J+M

Deskew Alt +A+J+K

Help

About DPOJET Alt +H+J

Help on Jitter and Eye Analysis Alt +H+T

Help on PCI Express MOI Alt+H+M

Help on USB 3.0 MOI Alt+H+U

 

Returning to the application
When you access oscilloscope functions, the DPOJET control windows may be replaced by the oscilloscope control windows or by the
oscilloscope graticule. Access oscilloscope functions in the following ways:

• From the menu bar on the oscilloscope, choose Analyze > Jitter and Eye Analysis (DPOJET) > Select.

• Alternatively, switch between recently used control panels using the forward or backward arrows  on the right corner of the control
panel.

Warning log notifiers

Warning Log Notifiers display error messages or warnings. Warnings ( ) or Error ( ) messages are also shown in the results tab.
You can click View Log to view the error log information in a text editor. Click OK to discard the displayed error message. 
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Figure 3: Warning log notifiers(Error)

You can set the duration for which the warning notification should appear on the screen in the Preferences dialog box or click OK to
discard the warning information.

Figure 4: Warning log notifiers(Warning)

Note: The error or warning log is saved as DPOJETErrors.log in subfolder, where %USERPROFILE% represents your user
location.

Saving and recalling setups

Saving a setup
The DPOJET application state is automatically saved with the oscilloscope state. To save the oscilloscope settings and application state,
follow these steps:

1. Click File > Save As > Setup.
2. In the file browser, select the directory to save the setup file.
3. Select or enter a file name. The application appends *_DPOJET.xml to store DPOJET setup, and *.set to store oscilloscope

settings.
4. Click Save.

Note: After the oscilloscope application is started, DPOJET needs to be launched at least once before any saved DPOJET
configuration can be recalled.

Recalling a saved setup
To recall the default application setup and oscilloscope settings, do the following steps:

1. Click File > Recall.
2. Select the directory in the file browser to recall the setup file.
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3. Select a .set file and click Recall.

Note: Only .set files can be selected for recall; any corresponding _DPOJET.xml file in the same directory will be recalled as well,
if DPOJET has been launched at least once since the oscilloscope application was started. If DPOJET has not been launched at
least once, the oscilloscope settings will be recalled but the DPOJET configuration will be ignored.

Recalling the default setup
To recall the default application and oscilloscope settings, click File > Recall Default Setup.

Operating basics

DPOJET Jitter, Noise and Eye Diagram Analysis Solution Application Help 47



Jitter, Noise and Eye Diagram Analysis
About Jitter, Noise and Eye-diagram analysis
This section describes the DPOJET measurement and their analysis for real-time oscilloscopes. Using Navigation panel and Control panel
DPOJET measurements are selected and analysed.

Control panel
The Control panel appears on the right of the application window. Using this panel, you can start or stop the sequence of processes for the
application and the oscilloscope to acquire information from the waveform. The controls are Clear, Recalc, Single and Run. The following
table describes each of these controls:

Figure 5: Control panel

Table 7: Control panel selections

Item Description

Clear Clears the current result display and resets any statistical results and autoset ref levels.

Recalc Runs the selected measurements on the current acquisition.

Single Initiates a new acquisition and runs the selected measurements.

Run Initiates a new acquisition and runs the selected measurements repeatedly until Stop is
clicked. Used only for live sources.

Show Plots Displays the plot summary window when clicked. This button appears in the control panel
only when a plot is selected.

DDR Analysis Shortcut to access the DDRA application from DPOJET. Appears in the control panel only
when DDRA is opened using Analyze > DDR Analysis.

The control panel with Show Plots is as shown:
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Figure 6: Control panel (Show Plots)

Navigation panel
The Navigation panel appears on the left of the application window. It consists of the following tabs: Select, Configure, Results, Plots and
Reports.

Table 8: Navigation panel functions

Tab Description

Select Displays the various measurements available for selection. By default, this tab is
highlighted. You can click any measurement categorized with Period/Freq, Jitter, Time,
Eye and Amplitude tabs.

Configure Displays the configuration for the selected measurement.

Results Displays the result for the selected measurement.

Plots Displays the result as a two-dimensional plot for additional measurement analysis. You can
select and configure plots for selected measurements.

Reports Displays the configuration for generating reports in .mht or .pdf format. Allows to view the
results, plots, and details.
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Figure 7: Navigation panel

Setting up DPOJET to take measurements

Setting up the application for analysis
In general, setting up the application for analysis consists of these steps:

1. Selecting one or more measurements
2. Configuring parameters for the selected measurements
3. Configuring any global parameters
4. Adding plots to visual measurement results

Steps 2-4 are optional, and step 4 can be done either before or after measurement results have been calculated. In addition to this manual
process, several wizard interfaces (One Touch Jitter, Serial Data/Jitter Guide) are available that can streamline the process.

Selecting measurements is accomplished by first selecting a measurement category (Period and Frequency, Jitter and Noise, Time, Eye,
Amplitude, or Standard-Specific Measurements) and then choosing specific measurements. A measurement may be selected multiple
times, for example to run on different waveform sources or to run on the same waveform source with different parameters.

Refer to the following sections for more details on various measurements:

Table of measurements-Period/Freq on page 53

Table of measurements-Jitter on page 54

Table of measurements-Noise on page 56

Table of measurements-Time on page 58

Table of measurements-Eye on page 59

Table of measurements-Amplitude on page 60

Table of measurements-Standard on page 61

Related topics

Selecting a measurement
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Deskew for accurate measurement

Deskew for accurate measurement
To ensure accurate results for two-channel measurements and differential signals acquired on two channels, it is important to first deskew
the probes and oscilloscope channels before you take measurements of your DUT.

The application includes an automated deskew utility that you can use to deskew any pair of oscilloscope channels.

Note: To produce the best deskew results, you should connect the probes to the fastest slew rate signals from your DUT.

Connecting to a device under test (DUT)
You can use any compatible probes or cable interface to connect between your DUT and oscilloscope.

WARNING: To avoid electric shock, remove power from the DUT before connecting the probes. Do not touch exposed conductors
except with the properly rated probe tips. Refer to the probe manual for proper use. Failure to do so may cause injury or death.

Refer to the General Safety Summary in your oscilloscope manual.

Deskewing on Oscilloscopes with bandwidth extension
Some Tektronix oscilloscopes feature software-based bandwidth extension. The bandwidth extension may be enabled on a per-channel
basis.

Enabling or disabling bandwidth extension on any channel affects the skew on that channel. Thus, you should deskew probes and
channels after you make such configuration changes. Bandwidth Extension provides improved timing accuracy, phase matching, and
amplitude accuracy. It also will provide noise reduction. Bandwidth extension should be used at all times.

Steps to deskew probes and channels
To deskew probes and oscilloscope channels, follow these steps:

1. Refer to Connecting to a Device Under Test before starting the procedure.
2. Connect both probes to the fastest signal in your DUT.

Set up the oscilloscope as follows:

1. Use the Horizontal Scale knob to set the oscilloscope to an acquisition rate so that there is at least two, preferably five, samples per
edge or more samples on the deskew edge.

2. Use the Vertical Scale and Position knobs to adjust the signals to fill the display without missing any part of the signals.
3. Set the Record Length so that there are more than 100 edges in the acquisition.
4. Launch the DPOJET application.
5. Click Analyze > Jitter and Eye Analysis (DPOJET) > Deskew.

Jitter, Noise and Eye Diagram Analysis

DPOJET Jitter, Noise and Eye Diagram Analysis Solution Application Help 51



Figure 8: Deskew setup

6. Set the Reference channel source to Ch1. The source waveform is the reference point used to deskew the remaining channels.
7. Set the Channel to be Deskewed source as Ch2.
8. To start the process, click Perform Deskew.
9. Repeat steps 7 and 8 for other Ch waveforms.
10. Select Summary to view the deskew values.

Figure 9: Deskew summary channel source and deskew values

Selecting a measurement
To take a measurement, click Analyze > Jitter and Eye Analysis (DPOJET) > Select. 

You can select measurements listed under the following categories:

• Period/Freq: Click here to view the measurements grouped under Period/Freq.
• Jitter: Click here to view the measurements grouped under Jitter.
• Noise: Click here to view the measurements grouped under Noise.
• Time: Click here to view the measurements grouped under Time.
• Eye: Click here to view the measurements grouped under Eye.
• Amplitude: Click here to view the measurements grouped under Amplitude.
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• Standard: Click here to view the measurements grouped under Standard.

Note: Noise measurements are accessible only when DJAN - Noise Analysis Tools is enabled.

• When the Analysis Method is Jitter Only, Jitter tab is displayed and only jitter measurements are accessible under Select panel. Click
Analyze > Jitter and Eye Analysis (DPOJET) > Preferences > Jitter Decomp to select the analysis method as Jitter Only.

Figure 10: Jitter Only measurements are enabled

• When the Analysis Method is Jitter + Noise, Jitter tab will be displayed as Jitter/Noise with measurements under Select panel. You can
also see two radio button for selecting Jitter or Noise measurements. By default Jitter measurements are selected. Click Analyze >
Jitter and Eye Analysis (DPOJET) > Preferences > Jitter Decomp to select the analysis method as Jitter + Noise.

Figure 11: Jitter/Noise measurements are enabled

Note: Preferences-Jitter decomp on page 156 allows you to enable or disable Noise measurements.

The application provides you different methods to set up the application:

• Wizard

The Serial Data/Jitter Guide allows you to set up, configure, and run the selected set of measurements without requiring any
knowledge of the control menus. However, it does not provide access to many of the advanced features.

• Measurement Setup sequence

The Measurement Setup Sequence buttons in the left navigation panel shows the logical order you would follow to set up the
application if you do not use the Wizard.

Alternatively, click Analyze > [application name] to personalize DPOJET for a specific standard. For example, to take a PCI Express
measurement, click Analyze > PCI Express and for USB 3.0 Essentials measurement, click Analyze > USB 3.0 Essentials.

Related topics
DPOJET option levels on page 37

Table of measurements-Period/Freq
Definitions of the period and frequency-related measurements are given in the following table:
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Table 9: Period/Frequency measurements definitions

Measurement Description

Period For clock signals, the elapsed time between consecutive crossings of the mid reference voltage level in
the direction specified; one measurement is recorded per crossing pair. For data signals, the elapsed
time between consecutive crossings of the mid reference voltage in opposite directions divided by the
estimated number of unit intervals for that pair of crossings; one measurement is recorded per unit
interval so N consecutive bits of the same polarity result in N identical period measurements.

Frequency The inverse of the period for each cycle or unit interval.

CC–Period The cycle-to-cycle period; the difference in period measurements from one cycle to the next, that is the
first difference of the Period measurement.

N–Period The duration of N periods.

Pos Width Amount of time the waveform remains above the mid reference voltage level.

Neg Width Amount of time the waveform remains below the mid reference voltage level.

+Duty Cycle The ratio of positive width to period, expressed in %.

–Duty Cycle The ratio of negative width to period, expressed in %.

+CC–Duty The difference between two consecutive positive widths.

–CC–Duty The difference between two consecutive negative widths.

Data Rate This measurement calculates the inverse of the mean duration of all cycles defined by the consecutive
starting and stopping edges if the signal is clock and mean duration of the unit intervals, if the signal is
data.

Table of measurements-Jitter
By default, the application enables analysis of all jitter components except non-periodic jitter (NPJ). This is because NPJ (a form of
bounded uncorrelated jitter (BUJ) that isn’t periodic) is less frequently encountered and its analysis typically requires longer waveforms,
multiple waveforms, or both. The default processing mode is called Spectral Only. To enable analysis of NPJ, you must set the processing
mode to Spectral + BUJ. This is done either from the Preferences-Jitter Decomp panel or from the Jitter map.

Definitions of the jitter-related measurements are given in the following table.

Note: All jitter measurements except TIE are statistical measurements that require sufficient record length so that all deterministic
effects can be observed and the random jitter can be modeled.
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Table 10: Jitter measurements definitions

Measurement Description

TIE Time interval error is the difference in time between an edge in the source waveform and the
corresponding edge in a reference clock or explicitly by another source signal. The reference clock is
determined by a clock recovery process.

RJ Random jitter is the statistics for all timing errors not exhibiting deterministic behavior, based on the
assumption that they follow a Gaussian distribution. If the Jitter separation model is set to Spectral
+ BUJ, the Gaussian assumption is further validated and jitter appearing to be non-Gaussian is
excluded. Random jitter is characterized by its standard deviation.

RJ–δδ Dual-dirac random jitter is random jitter as defined above, but calculated based on a simplified
assumption that the histogram of all deterministic jitter can modeled as a pair of equal-magnitude dirac
functions (impulses known as delta-functions).

DJ Deterministic jitter is the statistics for all timing errors that follow deterministic behavior. Deterministic
jitter is characterized by its peak-to-peak value.

DJ–δδ Dual-dirac random jitter is random jitter as defined above, but calculated on the same simplified model
as described under RJ–δδ.

PJ Periodic jitter is the statistics for that portion of the deterministic jitter which is periodic, but for which
the period is not correlated with any data in the waveform.

DDJ Data-dependent jitter is the statistics for that portion of the deterministic jitter directly correlated with
the data pattern in the waveform.

DCD Duty cycle distortion is the statistics for that portion of the deterministic jitter directly correlated with
signal polarity, that is the difference in the mean timing error on positive edges versus that on negative
edges.

TJ@BER Total jitter at a specified bit error rate (BER). This combines the random and deterministic effects, and
predicts a peak-to-peak jitter that will only be exceeded with a probability equal to the BER.

Jitter Summary This is not an individual measurement but a convenience function. Pressing this button automatically
adds a set of eleven jitter-related measurements with a single action. The measurements are: TIE, RJ,
RJ–δδ, DJ, DJ–δδ, PJ, SRJ, DDJ, DCD, TJ@BER, and Width@BER.

Phase Noise The RMS magnitude for all integrated timing jitter falling between two specified frequency limits. This
measurement is only applicable for clock signals.

NPJ 2 Non-Period Jitter is the statistics for that portion of the non-deterministic jitter that has a bounded
distribution. It is characterized by its dual-dirac amplitude (that is, the amount by which its presence
causes an additional separation of the two Gaussian distributions in the dual-dirac model).

J2 Total jitter at a bit error rate (BER) value of 2.5E-3. This statistical value predicts a peak-to-peak jitter
that will only be exceeded with a probability equal to the BER.

Table continued…

2 The NPJ measurement is only available when the Jitter Separation Model is set to Spectral + BUJ under DPOJET Preferences Setup.
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Measurement Description

J9 Total jitter at a bit error rate (BER) value of 2.5E-10. This statistical value predicts a peak-to-peak jitter
that will only be exceeded with a probability equal to the BER.

F/N The peak-to-peak amplitude of periodic jitter occurring at a rate that divides the data rate by an integer.
(When a deterministic jitter component could be interpreted either as F/N or DDJ, it is treated as DDJ
by convention.)

SRJ Sub-rate jitter is jitter at rates that integrally divide the data rate. SRJ typically results when a data
stream has been created by multiplexing multiple lower-rate streams. SRJ is a subcomponent of PJ,
and can be further isolated into F/N components.

RJ(h) RJ(h) is that component of measured RJ which is due to direct phase modulation.

RJ(v) RJ(v) is that component of measured RJ which is due to vertical waveform fluctuations, appearing as
phase fluctuations due to AM-to-PM conversion on the waveform rising or falling edges.

PJ(h) PJ(h) is that component of measured PJ which is due to direct phase modulation.

PJ(v) PJ(v) is that component of measured PJ which is due to vertical waveform fluctuations, appearing as
phase fluctuations due to AM-to-PM conversion on the waveform rising or falling edges.

PJrms Periodic Jitter RMS (PJrms) is the root mean square amplitude for that portion of the deterministic jitter
which is periodic but for which the period is not correlated with any data pattern in the waveform. A
single PJrms value is determined for each acquisition, by means of RJ-DJ separation analysis.

SJ@Freq SJ@Freq is a Sinusoidal Jitter measurement which reports the peak to peak amplitude of energy
within the narrow spectral band specified by the user. A single SJ@Freq value is determined for each
acquisition, by means of TIE spectral analysis.

PkPkClkRJ PkPkClkRJ is the random component value of the histogram data.

PkPkClkDJ PkPkClkDJ is the deterministic component value of the histogram data.

PkPkClkTJ PkPkClkTJ is equal to RJ*2*Q@BER+DJ.

Related topics

Breakdown of jitter (Jitter map)

Preferences jitter decomp

Table of measurements-Noise
When DPOJET application is first launched, the noise analysis is disabled and no noise measurements appear for selection. To enable
noise measurements, click Preferences > Jitter Decomp and select the Analysis Method as Jitter + Noise. This option will not appear
unless your scope has the optional Jitter + Noise package (DJAN).

The application doesn't attempt to detect non-periodic Bounded Uncorrelated Noise (NPN). This is because NPN is less frequently
encountered and its analysis typically requires longer waveforms, multiple waveforms, or both. The default processing mode is called
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Spectral Only. To enable analysis of NPN, you must set the processing mode to Spectral + BUJ. This is done either from the Preferences
jitter decomp panel or from the Noise map. The following table describes the measurements under Noise.

Table 11: Noise measurements definitions

Measurement Description

RN Random noise (RN) is the RMS magnitude of all non-deterministic Gaussian-distributed vertical
deviations from the nominal bit amplitude at the specified UI offset of each bit interval.

RN(v) RN(v) is that component of measured RN which is due to direct amplitude modulation.

RN(h) RN(h) is that component of measured RN which is due to phase modulation, appearing as noise
fluctuations due to PM-to-AM conversion near the center of the unit interval.

DN Deterministic noise (DN) is the peak-to-peak amplitude for all amplitude variations from nominal bit
amplitudes that exhibit deterministic (non-random) behavior.

DDN Data dependent noise (DDN) is the total vertical eye closure due to bit pattern-correlated vertical
variations, at the center of the eye. It is the sum of the positive peak DDN(0) relative to the nominal low
level, and the negative peak DDN(1) relative to the nominal high level.

DDN(0) Data dependent noise 0 (DDN0) is the peak-to-peak amplitude for all bit pattern-correlated vertical
variations of low bits from the nominal low level, at the specified UI offset.

DDN(1) Data dependent noise 1 (DDN1) is the peak-to-peak amplitude for all bit pattern-correlated vertical
variations of high bits from the nominal high level, at the specified UI offset.

PN Periodic noise (PN) is the peak-to-peak amplitude for that portion of the deterministic noise which is
periodic, but for which the period is not correlated with any data pattern in the waveform.

PN(v) PN(v) is that component of measured PN which is due to direct amplitude modulation.

PN(h) PN(h) is that component of measured PN which is due to phase modulation, appearing as noise
fluctuations due to PM-to-AM conversion near the center of the unit interval.

NPN 3 Non-Periodic noise (NPN) is the dual-dirac magnitude of that portion of the bounded uncorrelated
noise that is not periodic. Bounded uncorrelated noise (BUN) is the collection of amplitude variations
that is not correlated to data pattern but which is bounded in vertical amplitude (i.e. does not grow
larger as the observation interval is increased). BUN is composed of PN plus NPN.

TN@BER Total noise at a specified bit error rate (BER). This extrapolated value statistically predicts a peak-to-
peak vertical eye closure (at the specified horizontal bit offset) that will only be exceeded with a
probability equal to the BER. It is typically not equal to the actual vertical eye closure for a given
observation interval.

Unit Amplitude Unit Amplitude is the difference between nominal high and low values, and it is used to normalize all
the other noise measurements if the units are switched from absolute to normalized. The nominal high
level is the mean value of the distribution that represents DDN(1), and the nominal low level is the
mean value of the distribution that represents DDN(0).

Table continued…

3 The NPN measurement is only available when the Jitter Separation Model is set to Spectral + BUJ under DPOJET Preferences Setup.
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Measurement Description

Noise Summary This is not an individual measurement but a convenience function. Pressing this button automatically
adds a set of nine noise-related measurements with a single action. The measurements are: RN, DN,
PN, DDN, DDN0, DDN1, TN@BER and NPN3.

Related topics

Breakdown of noise (Noise map)

Preferences jitter decomp

Table of measurements-Time
Definitions of the time-related measurements are given in the following table:

Table 12: Time measurements definitions

Measurement Description

Rise Time Elapsed time between the Low reference level crossing and the High reference level crossing on the
rising edge of the waveform

Fall Time Elapsed time between the High reference level crossing and the Low reference level crossing on the
falling edge of the waveform

High Time Amount of time the waveform remains above the high reference voltage level

Low Time Amount of time the waveform remains below the low reference voltage level

Setup 4 Elapsed time between the designated edge of a data waveform and that of a clock waveform, based
on the respective mid reference level crossings

Hold 4 Elapsed time between the designated edge of a clock waveform and that of a data waveform, based
on the respective mid reference level crossings

Rise Slew Rate Rate of change of voltage between the two chosen reference level crossings on the rising edges of the
waveform

Fall Slew Rate Rate of change of voltage between the two chosen reference level crossings on the falling edges of the
waveform

Skew 4 Time difference between two similar edges on two waveforms assuming that every edge in one
waveform has a corresponding edge (either the same or opposite polarity) in the other waveform; edge
locations are determined by the mid reference voltage level.

Gated Skew Time difference between two corresponding edges on two gates on two/single waveform. Edge
locations are determined by the mid reference voltage level.

Table continued…

4 Two Source Measurements.
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Measurement Description

SSC Profile SSC Profile is not intended to serve as a measurement. It is a vehicle for showing the SSC modulation
profile versus time, using a time trend plot.

SSC Mod Rate SSC Mod Rate computes the SSC modulating frequency.

SSC Freq Dev SSC frequency deviation in ppm (parts per million), measured at each inflection point in the modulation
profile

SSC Freq Dev Min The minimum frequency shift as a function of time

SSC Freq Dev Max The maximum frequency shift as a function of time

Time Outside Level. Time Outside Level Ring Back is defined as the time interval of overshoot or undershoot.

tCMD-CMD 5 tCMD-CMD is a timing measurement and it measures the elapsed time between two logic states on a
specified digital bus.

Table of measurements-Eye
Definitions of the eye-related measurements are given in the following table:

Table 13: Eye measurements definitions

Measurement Description

Autofit Mask Hits The number of unit intervals for which mask violations occurred. A mask violation occurs when, during
a unit interval, the waveform passes through a segment of the defined mask. Autofit mask hits are
separately tailed for Segment 1 (upper), Segment 2 (Center) and Segment 3 (lower) and the total for
all three segments is also reported. Autofit Mask Hits reports mask hits in terms of Pixel (not UI) and
only the Segment 2 (Middle) is considered as criteria for mask hits calculation and it will move the
mask a location where the minimum or zero hits are happening.

Height The measured clear vertical eye opening at the center of the unit interval. Height = High(min) –
Low(max)

Height@BER The eye height at a specified Bit Error Rate

Width Measured clear horizontal eye opening at the middle reference level.

Width = UI(mean) – TIE(max) – TIE(min)

Table continued…

5 This measurement is available only on 64-bit MSO instruments.
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Measurement Description

Width@BER The horizontal eye opening projected to correspond to a specified Bit Error Rate. This number is
obtained by measuring the jitter on the waveform, performing RJ-DJ separation analysis, creating
a bathtub curve, and reporting the bathtub width at the appropriate error rate. This eye width may
not match the observed eye width because it is a statistical measure. The measurement requires a
sufficient record length so that all deterministic effects can be observed and the random jitter can be
modeled.

Width(BER) = UI(mean) – TJ(BER)

Mask Hits The number of unit intervals for which mask violations occurred. A mask violation occurs when, during
a unit interval, the waveform passes through a segment of the defined mask. Mask hits are separately
tallied for Segment 1 (upper), Segment 2 (center-of-eye mask) and Segment 3 (lower), and the total
for all three segments is also reported. Thus, as many as three hits can be added to the total count
for each unit interval. The population for this measurement gives the total number of unit intervals
observed.

Eye High The voltage at a selected horizontal position across the unit interval, for all High bits in the waveform.

Eye Low The voltage at the selected horizontal position across the unit interval, for all Low bits in the waveform.

Q-Factor Quality Factor is the ratio of vertical eye opening to rms vertical noise.

DFE EW This measurement is used to calculate the Eye Width of input waveform in a non-parametric manner
from the rendered eye diagram. The rendered plot is processed to come up with the optimal eye width
value. The measurement also comes with dedicated configuration panel tab “DFE”.

The DFE tab allows you to adjust the configuration parameters such as DFE tap value, measurement
point as a % of peak to peak of the signal, and the resolution of the measurement.

DFE EH This measurement is used to calculate the Eye Height of input waveform in a non-parametric manner
from the rendered eye diagram. The rendered plot is processed to come up with the optimal eye height
value. The measurement also comes with dedicated configuration panel tab “DFE”

This DFE tab allows you to adjust the configuration parameters such as DFE tap value, measurement
point as a % of UI of the signal, and the resolution of the measurement.

DFE Eye Diagram This measurement is used to render the Eye Diagram representation of input waveform with or without
a mask file specified.

By default, this measurement is executed without any mask, but the configuration panel also gives you
the option to specify a particular mask file.

V-Widest Open Eye This measurement measures the voltage at the widest eye opening in the search range from 40% to
60% of the eye amplitude.

Table of measurements-Amplitude
Definitions of the amplitude-related measurements are given in the following table:
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Table 14: Amplitude measurements definitions

Measurement Description

AC RMS The true Root Mean Square voltage, minus any DC component, of the waveform data points that are
above the Mean signal level.

High The High Amplitude measurement calculates the nominal amplitude of a “1” bit, in one of two ways
depending on the selected Method. Note that the Mean method results in one measurement value for
each “1” bit of the selected type, whereas the Mode method results in a single measurement value for
the entire waveform record.

Low The Low Amplitude measurement calculates the nominal amplitude of a “0” bit, in one of two ways
depending on the selected Method. Note that the Mean method results in one measurement value for
each “0” bit of the selected type, whereas the Mode method results in a single measurement value for
the entire waveform record.

High–Low Difference between High and Low amplitude measurements that bound each selected transition. This
value is always expressed as a positive number, regardless of whether the transition is rising or falling.

DC Common Mode 4

Common-mode voltage for the two sources. .

AC Common Mode4 The common mode voltage between two single-ended signals. AC is defined as all the frequency
components above the cutoff frequency (30 kHz).

T/nT-Ratio Ratio of the transition eye-voltage to the nearest subsequent non-transition eye voltage, expressed in
decibels.

V–Diff –Xovr 4 Voltage level at the crossover voltage of a differential signal pair.

Overshoot Difference between the positive-going peak amplitude and the reference voltage level, for each
waveform event that exceeds the reference level.

Undershoot Difference between the negative-going peak amplitude and the reference voltage level (expressed as a
positive number), for each waveform event that exceeds the reference level.

Cycle Pk-Pk Difference between the maximum and minimum voltage for each cycle, where a cycle is defined as
a positive half-cycle followed by a negative half-cycle or a negative half-cycle followed by a positive
half-cycle. Half-cycles are determined by the mid reference level crossings.

Cycle Min Defined as the peak negative voltage for each negative half-cycle, where half-cycles are determined by
the mid reference level crossings.

Cycle Max Defined as the peak positive voltage for each positive half-cycle, where half-cycles are determined by
the mid reference level crossings.

Table of measurements-Standard
Standard-specific measurements in the this category may include timing, jitter, amplitude or eye measurements. Generally, they are
measurements that have been modified to support a specific standard or otherwise deviate from the generic measurements. Use the
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Standard drop-down list to view the DDR, PCI Express, USB and Optical measurements. Use the Test point selection when available, to
select the setup file specific to the standard. Their measurement definitions are given in the following table:

Table 15: Standard-specific measurements definitions

Measurement Description

PCI Express

PCIe T-Tx-Diff-PP Defined as the change in voltage level across a transition in the waveform. It is the peak-to-peak
differential voltage swing.

PCIe T-TX Defined as the measured clear horizontal eye opening at the middle reference level.

PCIe T-Tx-Fall Defined as the time difference between the VRefLo(20%) reference level crossing and the
VRefHi(80%) reference level crossing on the falling edge of the waveform.

PCIe Tmin-Pulse Defined as the single pulse width measured from one transition center to the next.

PCIe DeEmph Defined as the ratio of the transition eye-voltage to the nearest subsequent non-transition eye voltage,
expressed in decibels.

PCIe T-Tx-Rise Defined as the time difference between the VRefHi(80%) reference level crossing and the
VRefLo(20%) reference level crossing on the rising edge of the waveform.

PCIe UI For clock signals, the elapsed time between consecutive crossings of the mid reference voltage level in
the direction specified; one measurement is recorded per crossing pair. For data signals, the elapsed
time between consecutive crossings of the mid reference voltage in opposite directions divided by the
estimated number of unit intervals for that pair of crossings; one measurement is recorded per unit
interval so N consecutive bits of the same polarity result in N identical period measurements.

PCIe Med-Mx-Jitter Defined as the maximum time between the jitter median and the maximum deviation from the median.

PCIe T-RF-Mismch Defined as the mismatch between Rise time (TRise) and Fall time (TFall).

PCIe MAX-MIN Ratio 6 Defined as the voltage range ratio over which a particular receiver must operate for consecutive UI.

PCIe SSC FREQ DEV Defined as the SSC frequency deviation in ppm (parts per million).

PCIe SSC PROFILE Shows the modulation profile of the SSC.

PCIe AC Common Mode 7 The common mode voltage between two single-ended signals. AC is defined as all the frequency
components above the cutoff frequency (30 kHz).

T-TX-DDJ Defined as the time delta between the PDF’s mean for each zero crossing point and the corresponding
recovered clock edge.

Table continued…

6 Custom name for PCIe MAX-MIN Ratio is PCIe VRX-MAX-MIN Ratio.
7 Two Source Measurements.
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Measurement Description

T-TX-UTJ Referenced to a recovered data clock generated by means of a CDR tracking function. Uncorrelated
total jitter may be derived after removing the DDJ component from each PDF and combining the PDFs
for all edges in the pattern.

T-TX-UDJDD Defined as uncorrelated jitter at the zero crossing point and the corresponding recovered clock edge.

T-TX-UPW-TJ Defined as an edge-to-edge phenomenon on consecutive edges.

T-TX-UPW-DJDD Defined as uncorrelated PWJ at the zero crossing.

V-TX-NO-EQ Defined by setting c-1 and c+1 to zero and measuring the p-p voltage on the 64-ones/64-zeroes
segment of the compliance pattern.

V-TX- EIEOS Defined by setting c+1 coefficient value of –0.33 and a c-1 coefficient of 0.0 and measuring the p-p
voltage on the 8-ones/8-zeroes segment of the compliance pattern, where the pattern is repeated for a
total of 128 UI.

ps21TX Measured by comparing the 64-zeroes/64- ones p-p voltage (V111) against a 1010 pattern (V101).

V-TX-BOOST When c-1 and c+1 are non-zero, measure the PP voltage on the 64-ones/64-zeroes segment of the
compliance pattern and with immediate single transition bit voltage.

USB 3.0 Essentials

USB VTx-Diff-PP Defined as the change in voltage level across a transition in the waveform. It is the peak-to-peak
differential voltage swing.

USB TCdr-Slew-Max 8 This measurement finds the peak-to-peak period jitter. Period jitter can be obtained by taking the first
difference of the filtered phase jitter.

USB Tmin-Pulse-Tj Defined as the single pulse width measured from one transition center to the next including all jitter
sources.

USB Tmin-Pulse-Dj Defined as the minimum pulse width with only deterministic jitter components.

USB SSC MOD RATE Defined as the SSC modulation rate in terms of Hz.

USB SSC FREQ DEV MAX Defined as the maximum frequency shift as a function of time.

USB SSC FREQ DEV MIN Defined as the minimum frequency shift as a function of time.

USB SSC PROFILE Shows the modulation profile of the SSC.

Table continued…

8 To run a slew rate measurement, you need a waveform with minimum record length of 5 MB.
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Measurement Description

USB UI For clock signals, defined as he elapsed time between consecutive crossings of the mid reference
voltage level in the direction specified; one measurement is recorded per crossing pair. For data
signals, defined as the elapsed time between consecutive crossings of the mid reference voltage in
opposite directions divided by the estimated number of unit intervals for that pair of crossings; one
measurement is recorded per unit interval so that N consecutive bits of the same polarity result in N
identical period measurements.

USB AC Common Mode 9 The common mode voltage between two single-ended signals. AC is defined as all the frequency
components above the cutoff frequency (30 kHz).

Optical

AOP (Average optical power) The true average component of an optical signal, in Watts.

ER (Extinction ratio) The ratio of average power levels of the logic 1 level (High) to the logic 0 level (Low) of an optical
signal. All level determinations are made within the Eye Aperture.

The Eye Aperture is adjustable and defaults to 20% of the signal bit time.

OMA (Optical modulation
amplitude) 

The difference between the average power levels of the logic 1 level (High) to the logic 0 level (Low) of
an optical signal. All level determinations are made within the Eye Aperture.

The Eye Aperture is adjustable and defaults to 20% of the signal bit time.

Optical High The Optical High measurement calculates the nominal amplitude of a “1” bit, in one of two ways
depending on the selected Method. Note that the Mean method results in one measurement value for
each “1” bit of the selected type, whereas the Mode method results in a single measurement value for
the entire waveform record.

Optical Low The Optical Low measurement calculates the nominal amplitude of a “0” bit, in one of two ways
depending on the selected Method. Note that the Mean method results in one measurement value for
each “0” bit of the selected type, whereas the Mode method results in a single measurement value for
the entire waveform record.

Eye Crossing Level The Eye Crossing Level measurement lists the voltage/watts level where the rising and falling edges of
the eye waveform intersect (PCross 1 and PCross2). The measurement algorithm searches for the eye
waveform with narrowest crossing width.

Eye Crossing Time The Eye Crossing Time measurement is the time of a single eye crossing waveform in seconds
(TCross1).

Eye Crossing Percent Eye Crossing Percent measurement is an eye crossing point expressed as a percentage of the eye
waveform height.

Mask Hit Ratio A Mask Hit Ratio is the ratio of number of UI that have a mask hit and total number of UI observed.
Mask Hit Ratio = (# of UI that have a mask hit) / (total # of
UI observed)

Table continued…

9 Two Source Measurements
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Measurement Description

Mask Margin The concept of margin allows for more information to be shared than merely Pass/Fail decision. We
assume the position of level values and unit interval boundary as 100% and original mask location as
0%. Hence a 20% mask margin implies that the mask violations does not occur even after scaling the
original mask by this amount.

RIN RIN (Relative Intensity Noise) is the ratio of the laser intensity's noise to the laser's power.

RINxOMA RINxOMA is the Relative Intensity Noise on Optical Modulation amplitude. Optical modulation
amplitude is the difference between the high level and the low level, each level measured in a
particular part of the waveform.

TDEC Transmitter Dispersion and Eye Closure (TDEC) is a parameter used to characterize the quality
of an optical transmitter. It is measured by the vertical eye closure based on histogram data
from eye diagrams captured for a waveform using an optical to electrical converter. Within the
oscilloscope, filtering is implemented to limit the bandwidth which is defined by a reference receiver.
The equalization of the filtered and captured waveform is performed using SDLA and this TDEC
measurement is to be applied post equalization.

Test point selection in the standard tab
Test Point Selection is available only for PCI Express, USB, and MIPI standards. You can either use the Test Point “Setup” button or File >
Recall option to select the setup file for the selected standard.

The Test Point shows “None Selected” if no test point is specified. Click Setup to navigate to the directory, which contains the setup files
specific to the standard.

The setup file with oscilloscope settings and test measurements replaces any selected measurements and oscilloscope settings before
specifying the test point. A warning message is displayed as shown:

Figure 12: Test point selection in the standard tab

Once the test point is selected, the measurements associated with the test point are displayed in the measurement table and the
configuration specific to the standard is recalled. However, you can still add the measurements specific to the standard. At any time, you
can save the setup file to recall. The Test Point field displays only the Test point name. A tool tip displays the entire file name as shown:
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Figure 13: Test point selection in the standard tab (Measurements)

When you select PCI Express from the Standards list, a hint saying “This standard contains Gen1 and Gen2 measurements” as shown:

Figure 14: Test point selection in the standard tab (Measurements with show plots)

Configuring measurements

About configuring a measurement
You can configure the measurements listed under the following categories:

• Period/Freq
• Jitter/Noise
• Time
• Eye
• Amplitude
• Standard

Note: Configuration for respective measurements are displayed only when measurement is selected.

Note: When noise measurements are enabled, Jitter tab is displayed as Jitter/Noise.

Related topics

Correlation of measurement to configuration on page 271

About global on page 68

General on page 67

About filters on page 72

About clock recovery on page 78
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Bit config on page 91

BER on page 99

RJ-DJ on page 100

RN-DN on page 103

Configuring bus states on page 106

Custom gating on page 108

Edges on page 109

Spread spectrum clocking (SSC) on page 123

Margin on page 123

DFE on page 124

Optical on page 126

General
Configuration tab allows you to customize the measurement name and qualify the measurement within a selected result range. The
General tab appears same for all the measurements but is not common. The values are different for different measurements. You can
set the custom name per measurement here. Use the virtual keyboard to enter the measurement name of your choice. Measurements
selected in DDRA are the custom names for the measurements defined in DPOJET. A tool tip displays the custom name and the
DPOJET-based measurement name (in brackets) on moving the mouse over the row in the measurement table, results, data snapshot,
and measurement configuration summary.

Note: Custom measurement names revert to their DPOJET-based measurement names on being cleared in the General
configuration screen.

Figure 15: General configuration

Table 16: General options

Item Description

Off Disables the application from using the specified measurement limits.

On Enables the application to use the specified measurement limits.

Max or Min value Specify the maximum and minimum range of valid measurement values measurements. The default
values for the Measurement Range Limits options vary by measurement.

Custom Measurement Name Option to modify the measurement name. Allows adding a user-specified name to any measurement.
This is useful for aligning DPOJET measurements with a user measurement list or standard.
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Note: If a max value smaller than the min value is entered, it is accepted and the min value is also silently reduced to the same
value. Likewise, if a min value larger than the max is entered, both are set to that value.

Global

About global
This configuration tab is common for all measurements. You can limit the waveform data analysis by Gating, by applying a Qualifier, or
by setting the measurement population limits. Access the Global configuration directly from the oscilloscope menu under Analyze > Jitter
and Eye Analysis (DPOJET) > Global Configuration. 

• Gating on page 68
• Qualify on page 69
• Population on page 71

Figure 16: Global Configuration

Gating
Gating allows you to focus the analysis on a specific area of the waveform bounded by a gated region, which is a way to filter unnecessary
information.

You can set up a gated region in one of the following ways:

• Zoom

• Cursors

Figure 17: Global-Gating

Table 17: Global-Gating options

Item Description

Off No gating occurs; application takes measurements over the entire waveform.

Table continued…
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Item Description

Zoom Zooms the specified region of the source waveform to take measurements within the selected area.
The region of waveform within the zoom is analyzed.

Cursors Gates the waveform with Vertical cursors. The region of waveform within the cursors is analyzed.

Qualify
Qualifiers allows you to limit the application to more narrowly defined conditions before taking measurements. All sources for the
measurements and Qualify input must have the same Horizontal Sample Rate, Record Length, and Position to ensure that measurements
function properly. For measurements which require clock recovery such as TIE or eye measurements, only the first qualified region will be
measured even if multiple qualified regions are present. For all other measurements, the entire waveform is processed.

Figure 18: Global-Qualify

Table 18: Global-Qualify options

Item Description

Off Disables the application from using the defined conditions while taking measurements.

On Enables the application to use the defined conditions while taking measurements.

Configure Displays the Configuring qualify with logic on page 70 dialog box.
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Configuring qualify with logic
Table 19: Qualify-Configure options

Source  Ch1-Ch4, Ref1-Ref4, Math1-Math4 Search0-Search8

Configuration
Panel

 

Configure
options

Item Description

Source 10 Selects a waveform to qualify the signal or clock
source used for the measurement. The input
source waveforms or files are Ch1-Ch4, Ref1-
Ref4, and Math1-Math4.

Selects a waveform to qualify the signal or clock
source used for the measurement. The input
source waveforms or files are Search0-Search8.
Displays the burst control type selected in DDRA
when you turn on the qualifier. Also indicates that
ASM is turned on.

Mid Shows the vertical reference level of the qualifier
waveform. 11

Hysteresis Shows the amount of hysteresis applied to the
vertical reference level of the qualifier waveform.
Hysteresis prevents small amounts of noise in
a waveform from producing multiple threshold
crossings.

Active

High12 Enables measurements in regions 12 where the
qualifier waveform exceeds the mid reference
level.

Low12 Enables measurements in regions12 where the
qualifier waveform falls below the mid reference
level.

OK Accepts the changes and closes the window.

10 Measurement and Qualify sources must have the same Horizontal Sample Rate, Record Length, and Position to ensure that measurements function properly.
11 The default behavior for all reference levels is to automatically adjust based on the signal amplitude after a Clear operation, unless you disable the autoset check box

in the source configuration panel. Whether you use the Qualify with Logic dialog box to adjust the levels or not, be aware that the levels may change if automatic
adjustment is still enabled. For more information, refer to Automatic versus manual reference voltage levels.

12 For measurements that require clock recovery, only the first qualified region will be measured even if multiple qualified regions are present.
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Search behavior in DPOJET
When search is configured, the application analyzes the identified marks on the source waveform. Read and Write bursts are selected
in ASM when search is selected as the qualify source. Each Mark indicates the start and stop of a burst. These marks are used by the
DPOJET measurement when the qualify source is configured to Search. You can configure up to eight searches (Search1 – Search8) in
ASM (Advanced Search and Mark)and Search0 for visual search. The same search number gets reflected in DPOJET. Search is used for
Multiple burst analysis. For more details, refer to your oscilloscope online help.

Population
The Population control allows you to limit the amount of waveform data that is analyzed. This is often done in industry standards to make
sure that there is consistency between measurement techniques. 

Figure 19: Global-Population

Table 20: Global-Population options

Item Description

Off Disables the application from using a Population limit while taking measurements.

On Enables the application to use a Population limit while taking measurements. 13

Configure Displays the Configuring population limit on page 71 dialog box. This allows you to set a limit on a
maximum population to obtain, for selected measurements.

Configuring population limit

Figure 20: Configuring population limit

13 If population limit is turned ON for the Mask Hits measurement, then unselect Enable high-performance eye rendering in Preferences-Measurement on page 154 for
accurate results.
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Table 21: Population-Configure options

Item Description

Population The limit determines the population of measurement observations that will be accumulated. Some
measurements may accumulate observations more quickly than others.

Acquisitions The limit determines the number of acquisition cycles that will be performed.

Each Measurement Each measurement stops accumulating as soon as it reaches the specified limit. Sequencing does not
stop until all measurements have reached the limit, at which time every measurement will have exactly
the limit.

Last Measurement Sequencing continues and all measurements continue accumulating until the last (slowest
accumulating) measurement reaches the limit, at which time they all stop. When sequencing stops, all
measurements except one may have higher population than the limit.

Limit Specifies the number of acquisitions or measurements the application takes before sequencing stops.
Population limit is not applicable for Mask Hits.

OK Accepts the changes and closes the window.

Filters

About filters
This configuration tab allows you to modify the measurement data by applying a High Pass filter to block low frequency band components
or a Low Pass filter to block high frequency band components. For Example, Selecting a 1 MHz high pass filter can reduce the effect of
SSC on results.

For some measurements (Period, Frequency, TIE, +Duty Cycle, –Duty Cycle, +CC Duty, – CC Duty, CC–Period, Positive Width, Negative
Width, N–Period, Rise Time, Fall Time, Low Time, High Time, DC Common Mode, High–Low, High, Low, T/nT Ratio, PCIe T-Tx-Rise,
PCIe T-Tx-Fall, PCIe T-RF-Mismch, PCIe UI, USB UI, PCIe SSC FREQ DEV, USB TCdr-Slew-Max, USB SSC FREQ DEV, USB SSC
MOD RATE and USB SSC PROFILE), the measurements versus time waveform (time trend) that is derived from the original oscilloscope
waveform can be filtered before it is passed to the statistics and plotting subsystems. 

Jitter, Noise and Eye Diagram Analysis

72



Figure 21: Filters (High Pass, Low Pass, SSC)

Band Pass Filtering
You can create a band pass filter by enabling both the High Pass and the Low Pass filters on a measurement. The cut-off frequency for the
Low Pass filter must be greater than or equal to the cut-off frequency for the High Pass filter.

You should be aware that setting the cut-off frequencies close to each other may effectively filter out all of the measurement data, or
all but a small amount of timing noise. This diagram shows the spectrum of the measurement data passed to the statistics and plotting
subsystems when you use both the High Pass and the Low Pass filters.

Figure 22: Band Pass Filtering

High Pass filters attenuate low frequencies, and filter out DC values entirely. When a high pass filter is added to a period or frequency
measurement, the mean value of the filtered measurement goes to zero. This can be seen by creating a Time Trend plot of a
high-pass-filtered period or frequency measurement. Although this is the correct theoretical behavior for the filtered measurement, it is not
very useful if the Results panel reports that the mean period or frequency is zero. For this reason, the mean values that appear in the
results panels for Period and Frequency measurements are the values before the filter.
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Figure 23: Filter

Table 22: Filter options

Item Description

Filter Spec When enabled, blocks the low frequency band and passes only the high frequency band of the
waveform; defined as 1st order, 2nd order, 3rd order Butterworth and No filter, being the default.

Freq (F1) 14 High Pass filter cut-off frequency at which the filter magnitude falls by 3 dB.

Filter Spec When enabled, blocks the high frequency band and passes only the low frequency band of the
waveform; defined as 1st order, 2nd order, 3rd order Butterworth, and No filter, being the default.

Freq (F2)14 Low Pass filter cut-off frequency at which the filter magnitude falls by 3 dB.

Advanced Displays the Advanced filter configuration on page 75 dialog box.

Apply to All Settings of the measurement are applied to all measurements with those settings.

Measurements such as AC Common Mode, PCIe AC Common Mode, and USB AC Common Mode use a high-pass sliding window filter.
This filter is applied to remove low frequency common mode noise. It has a 30 kHz cutoff frequency.

Figure 24: Filter (High Pass Frequency)

Table 23: Filter options

Item Description

High Pass Frequency

Off High pass frequency is set to Off. Default configuration of High pass frequency for measurements is
Off.

Table continued…

14 Includes a 3 dB cut-off frequency.
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Item Description

On High pass frequency is set to On.

Brick wall filter configuration
Measurements such as PCIe DeEmph and PCIe Med-Mx Jitter use the Brick Wall filter. A brick wall filter is applied to the PCIe signal to
remove the low frequency jitter components. The PCI Express application applies the filter as per the PCIe specification. A Brick Wall filter
has a very sharp cut-off frequency. 

Figure 25: Brick wall filter

Advanced filter configuration
The measurement filters are implemented using infinite impulse response (IIR) designs. As with any causal filter, a transient may occur at
the filter’s output in response to the arrival of the input signal. It is usually desirable to exclude this transient from the measurement results.

In the DPOJET application, the filter transient is managed in two ways. First, the input to the filter is gently “ramped up” from zero to its
full value over some ramp time tr. Second, the output of the ramp is “blanked” over some duration tb, so that the remaining effects of any
transient are omitted from measurement results, statistics and plots. The sequence of operations is depicted here:

The ramp function has a raised-cosine profile and is defined in the time domain as:
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You may adjust the ramp time tr by means of the Advanced control panel. If you wish to turn off the ramp function, set the ramp time to 0.

Similarly, you can adjust the blanking duration tb by means of the Advanced control panel. Setting the blanking duration to 0 will allow you
to see the entire filtered measurement, including any transients.

Both, the ramp time tr and the blanking duration tb, are set relative to the reciprocal of the lowest filter frequency Fc. By default, both of
these parameters are set to 1/Fc. Since they are normalized to the filter frequency, they will automatically adjust if you change the filter
cut-off frequency.

The complete set of signal processing options, together with representative waveforms that suggest how the options affect the
measurement vector, are shown here:
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Figure 26: Advanced filter configuration

Table 24: Advanced filter configuration options

Item Description

Ramp Time Duration of the raised-cosine smoothing function applied to the measurement vector before the vector
is filtered.

Blanking Time Duration of the filter’s output that is suppressed. The blanked portion of the output is not included in
the measurement statistics, or in any plots.

OK Accepts changes and closes.

Configuring Filters for SJ@Freq
This configuration tab allows you to select the SJ Frequency and SJ Bandwidth.

Figure 27: Configuring Filters for SJ@Freq

Table 25: Configuring Filters for SJ@FREQ

Item Description

SJ Frequency The frequency at which Sinusoidal Jitter measurement is calculated.

Table continued…
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Item Description

SJ Bandwidth Narrow band around which Sinusoidal Jitter measurement is calculated. A high limit of 1 MHz will be
optimal.

Note: The peak to peak amplitude of energy within this spectral band is reported as a Sinusoidal Jitter.

Clock recovery

About clock recovery
Clock recovery refers to the process of establishing a reference clock, the edges of which can be used as a basis for timing comparisons.
The Clock Recovery configuration tab allows you to select one of the following clock recovery methods:

Constant clock - mean on page 79

Constant clock - median on page 80

Constant clock - fixed on page 81

PLL standard BW on page 83

PLL custom BW on page 84

Explicit Clock-Edge on page 86

Explicit Clock-PLL on page 87

Behavioral on page 90

The first five methods derive the reference clock from the same channel upon which the measurement is defined. This is the conventional
method of clock recovery for serial data communications, where no separate clock is available. Explicit Clock-Edge and Explicit Clock-PLL
methods derive the reference clock from a channel other than the one upon which the measurement is defined. 

About constant clock recovery
In Constant Clock Recovery, the clock is assumed to be of the form A*sin (2Π ft +Φ), where the frequency (f) and phase (Φ) are treated as
unknown constants. Once a source waveform has been acquired and the edges extracted, one or both of these constants are determined
using linear regression, so that the recovered clock minimizes the mean squared sum of the Time Interval Error (TIE) for that waveform.

If Constant Clock - Mean is selected as the clock recovery method, both the frequency and the phase are chosen to minimize the mean
squared error.

If Constant Clock - Fixed is selected as the clock recovery method, the precise frequency specified is used but the phase is chosen so that
the median error between the recovered and measured edges is zero.

If Constant Clock - Median is selected as the clock recovery method, the phase is chosen so that the median error between the recovered
and measured edges is zero. 
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Figure 28: Constant clock recovery

Constant clock - mean
This method provides the following options that control how the clock recovery is performed:

• Auto Calc First Acq
• Auto Calc Every Acq

Selecting Autocalc First Acq will allow the clock-recovery algorithm to choose a new best-fit clock frequency and phase only on the first
acquisition. Subsequent acquisitions will choose a best fit on clock phase but retain the clock frequency found on the first acquisition.

Selecting Autocalc Every Acq will allow the clock-recovery algorithm to choose a new best-fit clock frequency and phase for each new
oscilloscope acquisition.

Clearing the measurement results by choosing Clear on the sequencing panel will reset the clock recovery so that both frequency and
phase are optimized on the subsequent acquisition. 

Figure 29: Constant clock - mean

Table 26: Constant clock - mean options

Item Description

Auto Calc First Acq Calculates the best fit of the initial acquisition or the first acquisition after clearing results, and then
uses the value until you clear the results.

Auto Calc Every Acq Calculates the best fit for each acquisition (default).

Apply to All

Table continued…
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Item Description

Apply Applies the current clock recovery configuration to all selected measurement(s), PLL-Standard clock
recovery options that have Clock Recovery as configuration tab.

Advanced Displays the Clock recovery advanced setup on page 81 dialog box.

Constant clock - median
This method provides the following options that control how the clock recovery is performed:

• Auto Calc First Acq
• Auto Calc Every Acq

Selecting Autocalc First Acq will allow the clock-recovery algorithm to choose a new best-fit clock frequency and phase only on the first
acquisition. Subsequent acquisitions will choose a best fit on clock phase but retain the clock frequency found on the first acquisition.

Selecting Autocalc Every Acq will allow the clock-recovery algorithm to choose a new best-fit clock frequency and phase for each new
oscilloscope acquisition.

Clearing the measurement results by choosing Clear on the sequencing panel will reset the clock recovery so that both frequency and
phase are optimized on the subsequent acquisition.

Figure 30: Constant clock - median

Table 27: Constant clock - median options

Item Description

Auto Calc First Acq Calculates the best fit of the initial acquisition or the first acquisition after clearing results, and then
uses the value until you clear the results.

Auto Calc Every Acq Calculates the best fit for each acquisition (default).

Apply to All

Apply Applies the current clock recovery configuration to all selected measurement(s) that have Clock
Recovery as the configuration tab.

Advanced Displays the Clock recovery advanced setup on page 81 dialog box.

 

Jitter, Noise and Eye Diagram Analysis

80



Constant clock - fixed
This method provides a single option that controls how the clock recovery is performed. With Fixed Constant Clock recovery, no attempt
is made to derive information about the actual data rate from the signal under test. Instead, the precise frequency that you specify will be
used. (However, the clock phase will be chosen so that the median difference between the recovered and measured edges is zero.)

Figure 31: Constant clock - fixed

Note: Click to apply the clock recovery configuration to all selected measurement(s) that have Clock Recovery as configuration
tab.

Clock recovery advanced setup
The Advanced Clock Recovery methods can be used when unusually high noise or ambiguous data patterns defeats normal clock
recovery methods. Under most normal operating conditions, these methods are not required nor recommended.

Nominal Data Rate and Known Data Pattern are the two advanced clock recovery methods.

In Nominal Data Rate, you can provide the nominal data rate to the clock recovery algorithm. Normally, the application analyzes your data
and determines the data rate automatically. Setting this parameter to Manual allows you to provide a starting point or hint to the clock
recovery algorithm. This is useful when the data pattern makes data rate detection ambiguous. As an example, a “1 1 0 0 1 1 0 0” pattern
at 8 Gb/s would otherwise be detected as a “1 0 1 0” pattern at 4 Gb/s. Setting the bit rate to 8 Gb/s will cause the proper unit interval and
pattern length to be identified.

In Known Data Pattern, the pattern is specified by using an ASCII text file containing the characters 1 and 0. The file may contain other
characters, spaces and tabs for formatting purposes, but they will be ignored. Several files for commonly used patterns are included with
the application, and you may use these as examples if you wish to create your own pattern files. Click Browse to modify the default
location for pattern files.

Note: The last line of the pattern file must end with a CR/LF. Without the CR/LF, you will receive a too many bits error message.

Figure 32: Clock recovery advanced setup
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Table 28: Advanced clock recovery options

Item Description

Auto Enables automatic detection of the data rate on the first acquisition following a Clear or configuration
change.

Manual Allows you to manually specify the nominal data rate. This is useful when the data pattern makes data
rate detection ambiguous. As an example, a “1 1 0 0 1 1 0 0” pattern at 8 Gb/s would otherwise be
detected as a “1 0 1 0” pattern at 4 Gb/s.

Bit Rate In Manual configuration, allows you to specify the approximate data rate in bits per second (b/s). In
Auto configuration, displays the detected data rate.

Off, On Enables (On) or disables (Off) advanced clock recovery through a known data pattern.

Pattern File Name

Browse Selects a file to use for the data pattern.

OK Accepts changes and closes.

About PLL clock recovery setup
When PLL-based clock recovery is selected, the application simulates the behavior of the hardware Phase Locked Loop clock recovery
circuit. This is a feedback loop in which the Voltage-Controlled Oscillator (VCO) is used to track or follow slow variations in the bit rate
of the input waveform. Such loops are frequently used to recover the clock in communication links that do not transmit the clock as a
separate signal. The PLL parameters in the application may be adjusted to simulate with the behavior of a receiver in such a link, within
certain guidelines.

Note: The effective transfer function of a PLL loop is not equal to the PLL Loop BW setting. The Transfer function depends on the
factors such as damping, transition density and type.

Figure 33: PLL clock recovery setup

Note: PLL response is not instantaneous. This causes some signals to have a ramped trend at the beginning of a waveform as
the PLL locks to the applied signal. To avoid a PLL start-up transient, part of the output is blanked out. This is applicable only
when you select PLL Custom BW, PLL Standard BW or Explicit Clock-PLL as the clock recovery method. PLL blanking is used by
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measurements such as TIE, RJ, RJ-δδ, DJ, DJ-δδ, PJ, TJ@BER, High Voltage, Low Voltage, High-Low, T n/t Ratio, Eye Width,
Eye Height, Width@BER, Height@BER, Rise Time and Fall Time.

About PLL loop BW versus JTF BW
Phase locked loops are characterized according to their bandwidth (BW), and several different bandwidths are commonly used. The
terminology used for these bandwidths is described here, since it varies somewhat across different industries.

• Loop BW (or Closed Loop BW) is the frequency at which the closed-loop gain has fallen to -3 dB (half power) relative to unity-gain. The
closed-loop gain function has the character of a low-pass filter.

• JTF BW (Jitter Transfer Function BW or Error Function BW) is the frequency below which input jitter to a tracking loop is removed. The
JTF BW has a high-pass filter characteristic.

For Type I loops, the Loop BW and the JTF BW are always equal. For Type II loops, these two bandwidths are different, and their ratio
depends on the PLL damping factor. You can choose to specify either bandwidth, and the other is displayed for reference.

PLL standard BW
The PLL control area provides control over the phase-locked loop used for clock recovery. You can choose the loop bandwidth and the
loop order, and if a Type II loop is chosen, you can specify the damping factor.

To set the loop bandwidth automatically, based on a serial standard, select PLL: Standard BW as the clock recovery method. From the
Standard: b/s list box, select the standard that matches your data link. For example, choose “PCI-E: 2.5” to test a 2.5 Gbit/second PCI
Express link. In this case, the PLL bandwidth will be set to 1.5 MHz, which is 1/1667 of the baud rate as specified in PCI Express standard.

You can use the PLL Model list box to choose between Type I and Type II loop. A Type I loop has a transfer function that approaches zero
frequency with a slope of 1/s and a Type II loop approaches zero frequency with a 1/s2 slope (In much of the PLL literature, these terms
are used interchangeably with First-Order and Second-Order loops. For a thorough discussion of loop type versus order, see Frequency
Synthesis by Phase Lock, by William Egan).

Note: Although it is possible to configure a Type II PLL with a bandwidth up to 1/10 of the baud rate, such a loop will have poor
dynamic performance. This is because Type II loops have less phase margin than Type I loops. A preferred alternative to using a
Type II PLL with a bandwidth close to its baud rate is to use a second order high-pass measurement filter to emulate the effects of
the PLL.

Figure 34: PLL standard BW

Table 29: PLL-standard clock recovery options

Item Description

PLL Model Selects between a Type I or Type II phase-locked loop.

Table continued…
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Item Description

Damping Use the keypad to specify the damping ratio of the PLL. It is enabled only for Type II phase-locked
loop.

Loop BW Displays the Closed Loop bandwidth that has been configured based on the current standard.

JTF BW Displays the Jitter Transfer Function bandwidth that has been configured based on the current
standard.

Standard: b/s Implicitly sets the loop bandwidth of the clock recovery PLL, based on selection of the industry
standard and data rate in bits/second.

Apply to All Applies the current clock recovery configuration to all selected measurements that have user-
configurable clock recovery.

Apply Applies the current clock recovery configuration to all selected measurement(s) that have Clock
Recovery as the configuration tab.

Advanced Displays the Clock Recovery Advanced Setup. For more details, refer to the Clock recovery advanced
setup.

Related topics

About PLL loop BW versus JTF BW on page 83

PLL custom BW
The PLL control area provides control over the phase-locked loop used for clock recovery. You can choose the loop bandwidth and the
loop order, and if a Type II loop is chosen, you can specify the damping factor.

To manually control the loop bandwidth, select PLL: Custom BW as the clock recovery method and use the BW control to choose the
–3 dB bandwidth, in Hz.

You can use the PLL Model list box to choose between a Type I and Type II loop. A Type I loop has a transfer function that approaches
zero frequency with a slope of 1/s and a Type II loop approaches zero frequency with a 1/s2 slope. (In much of the PLL literature,
these terms are used interchangeably with First-Order and Second-Order loops. For a thorough discussion of loop type versus order, see
Frequency Synthesis by Phase Lock, by William Egan).

If you choose a Type II loop, you can use the radio buttons to select whether you will directly control the Loop BW (low-pass function) or
the JTF BW (high-pass function). You must also select the Damping Factor for a Type II loop.

Note: Although it is possible to configure a Type II PLL with a bandwidth up to 1/10 of the baud rate, such a loop will have poor
dynamic performance. This is because Type II loops have less phase margin than Type I loops. A preferred alternative to using a
Type II PLL with a high bandwidth is to use a 2 order high-pass measurement filter to emulate the effects of the PLL.
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Figure 35: PLL custom BW

Table 30: PLL-Custom clock recovery options

Item Description

PLL Model Selects between Type I or Type II phase-locked loop.

Damping Use the keypad to specify the damping ratio of the PLL. It is enabled only for Type II phase-locked
loop.

JTF BW Explicitly sets the JTF bandwidth of the clock recovery PLL when the PLL Model is Type II and the JTF
BW radio button is selected.

Loop BW Explicitly sets the Loop bandwidth of the clock recovery PLL when the PLL Model is Type II and the
Loop BW radio button is selected.

Apply to All Applies the current clock recovery configuration to all selected measurements that have user-
configurable clock recovery.

Apply Applies the current clock recovery configuration to all selected measurement(s) that have Clock
Recovery as the configuration tab.

Advanced Displays the Clock Recovery Advanced Setup. For more details, refer to the Clock recovery advanced
setup.

Related Topics

About PLL loop BW versus JTF BW on page 83

Jitter, Noise and Eye Diagram Analysis

DPOJET Jitter, Noise and Eye Diagram Analysis Solution Application Help 85



About explicit clock recovery
In Explicit Clock Recovery, the reference clock is not derived from the measurement’s target source at all, but is instead taken from a
separately-identified source. Since the source used for the measurement now differs from the source used to derive the reference clock,
selecting this type of clock recovery converts the measurement from a single-source measurement to a dual-source measurement. The
reference clock source is always shown on the right when the two sources appear in a measurement table. Changing the clock-recovery
method back to a non-explicit clock method will change the measurement back to a single-source measurement.

Explicit Clock-Edge
Select Explicit Clock-Edge method if you want to use the edges found in the selected clock source (possibly multiplied up by an integral
number). If the Clock Multiplier is set to 1 (the default), only these edges will be used. If the Clock Multiplier is set to a number N other
than 1, linear interpolation will be used between each pair of actual edges to create N-1 additional reference edges. The interpolated edge
times, combined with the actual edges, give a total of N reference edge times per actual edge.

Figure 36: Explicit Clock-Edge

Table 31: Explicit-Clock edge options

Item Description

Clock Source Select Ch1 to Ch4, Ref1 to Ref4, or Math1 to Math4 as reference source for clock recovery.

Clock Edge Specify whether the rising, falling or both edges of selected source should be considered.

Clock Multiplier Specify the number of edges to be used.

Apply to All

Apply Applies the current clock recovery configuration to all selected measurement(s) that have Clock
Recovery as the configuration tab.

Advanced Displays the Advanced explicit clock-edge dialog wherein you can adjust the timing relation between
reference clock source and data source.

Advanced explicit Clock-Edge
To compare the reference clock times to the edge times from the data source, some assumptions must be made about how they align.
The default assumption is that each data source edge is associated with the reference clock edge to which it is nearest in time. This
assumption may not be optimum, for example if the probes for the reference clock and data signal have different cable lengths.

To change the way the reference clock edges and data edges are associated, you can control the Nominal clock Offset Relative to Data. 

Jitter, Noise and Eye Diagram Analysis

86



Figure 37: Advanced explicit Clock-Edge

Table 32: Advanced explicit-Clock edge options

Item Description

Auto Automatically calculates the clock data skew and shifts the reference clock edges before the
application associates each data edge with the closest clock edge.

Manual Specify a time delay (positive or negative) to shift the reference clock edge before the application
associates each data edge with the closet data edge.

Recalculate

When required Recalculates the nominal clock offset value whenever a new measurement is added or results are
cleared or there are any measurement configuration changes.

Every acquisition Recalculates the nominal clock offset value for every acquisition.

Related topics

Effect of nominal clock offset on eye diagrams on page 90

Explicit Clock-PLL
Select Explicit Clock-PLL as the clock recovery method if you want to feed the edges from the selected clock source through a PLL rather
than using them directly. The actual edges from the clock source will be used to drive a software PLL model, and the edge times coming
out of the PLL will be used as the reference edges for the target measurement. If the Clock Multiplier is set to a number N other than 1, the
output of the PLL will have N edges per actual edge.
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Figure 38: Explicit Clock-PLL

Table 33: Explicit Clock-PLL options

Item Description

Clock Source Select Ch1 to Ch4, Ref1 to Ref4 or Math1 to Math4 as reference source for clock recovery.

Clock Edge Specify whether the rising, falling or both edges of selected source should be considered.

Clock Multiplier Specify the number of edges to be used.

Apply to All

Apply Applies the current clock recovery configuration to all selected measurement(s) that have Clock
Recovery as configuration tab.

Advanced Displays the Advanced explicit clock-PLL dialog wherein you can adjust the timing relation between
reference clock source and data source.

Advanced explicit Clock-PLL
In the Advanced Explicit Clock- PLL, you can specify the PLL type, bandwidth, damping factor and nominal clock offset relative to data.
Damping numeric input is enabled only for Type II phase-locked loop.

Nominal Clock Offset Relative to Data
To compare the reference clock times to the edge times from the data source, some assumptions must be made about how they align.
The default assumption is that each data source edge is associated with the reference clock edge to which it is nearest in time. This
assumption may not be optimum, for example if the probes for the reference clock and data signal have different cable lengths.

To change the way the reference clock edges and data edges are associated, you can control the Nominal clock Offset Relative to Data.
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Figure 39: Nominal Clock Offset Relative to Data

Table 34: Advanced Explicit-Clock PLL options

Item Description

PLL Settings for Explicit Clock

JTF BW Explicitly sets the JTF bandwidth of the clock recovery PLL when the PLL Model is Type II and the JTF
BW radio button is selected.

Loop BW Explicitly sets the Loop bandwidth of the clock recovery PLL when the PLL Model is Type II and the
Loop BW radio button is selected.

PLL Model Selects between Type I or Type II phase-locked loop.

Damping Use the keypad to specify the damping ratio of the PLL. It is enabled only for Type II phase-locked
loop.

Auto Automatically calculates the clock data skew and shifts the reference clock edges before the
application associates each data edge with the closest clock edge.

Manual Specify a time delay (positive or negative) to shift the reference clock edge before the application
associates each data edge with the closet data edge.

Recalculate

When required Recalculates the nominal clock offset value whenever a new measurement is added or results are
cleared or there are any measurement configuration changes.

Every acquisition Calculates the nominal clock offset value for every acquisition.
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Related topics

Effect of nominal clock offset on eye diagrams on page 90

Effect of nominal clock offset on eye diagrams
Nominal Clock Offset does not affect the eye diagrams directly. Data and clock timing relationship is maintained ignoring the clock offset
value. The clock offset still affects the eye diagram shape indirectly through edge labeling and TIE measurement but not with alignment.

When Explicit Clock Recovery is used, the Nominal Clock Offset does not affect eye diagram alignment. The relative alignment between
data and clock is maintained as acquired. An absolute alignment is controlled by Ref Clock Alignment setting in Eye Diagram plot
configuration panel. To ensure proper alignment between data and clock it is important to properly deskew oscilloscope channels.

Behavioral
Select Behavioral option for technology specific clock recovery method.

PCIe Gen5
PCIe Gen5 specification specifies a specific CDR function to be used for analyzing scope-based waveforms for jitter. This CDR function is
shown below for 32 GT/s waveforms:
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Bit config

Bit config for eye height measurements
This configuration tab allows you to select which waveform bit types (Transition bits, Non-Transition or All Bits) are included when taking
eye height.

Figure 40: Bit config for eye height

Table 35: Bit config for eye height

Item Description

Bit Type

All Bits Eye analysis includes both transition and non-transition bits.

Transition Eye analysis only on transition bits.

Non-Transition Eye analysis only on non-transition bits.

Bit config for eye high eye low and Q-Factor measurements
This configuration tab allows you to select which waveform bit types (Transition bits, Non-Transition or All Bits) are included when taking
eye height. This configuration tab also allows you to set the percent of unit interval where the measurement is taken.

Figure 41: Bit config for eye high, low, and Q-Factor

Table 36: Bit config for eye high, low, and Q-Factor

Item Description

Bit Type

Table continued…
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Item Description

All Bits Eye analysis includes both transition and non-transition bits.

Transition Eye analysis only on transition bits.

Non-Transition Eye analysis only on non-transition bits.

Measure at X% of the Unit
Interval

Sets the horizontal position where the measurement is taken, as a percentage of the Unit Interval.

Bit config for Height@BER measurements - Jitter Only
This configuration tab is displayed for the Height@BER measurement when the analysis method selected is Jitter Only (Preferences >
Jitter Decomp > Analysis Method) .

Figure 42: Bit config for Height@BER

Table 37: Bit config for Height@BER

Item Description

Bit Type

All Bits Eye analysis includes both transition and non-transition bits.

Transition Eye analysis only on transition bits.

Non-Transition Eye analysis only on non-transition bits.

Measurement Range (UI %)

Start Start % value of UI

End End % value of UI

# of Bins The resolution by the number of bins into which Span is divided.

Bit config for Height@BER measurements - Jitter + Noise
This configuration tab is displayed for the Height@BER measurement when the analysis method selected is Jitter + Noise (Preferences >
Jitter Decomp > Analysis Method).
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Figure 43: Bit config for Height@BER

Table 38: Bit config for Height@BER

Item Description

Signal Type

Clock Clock Forces the signal to be interpreted as a Clock. Measurements will take place on the edges
specified by the Clock Edge control.

Data Data Forces the signal to be interpreted as a Data. Both rising and falling edges are used.

Auto Allows the application to automatically detect whether the signal is clock or data. If the signal is a clock,
the Clock Edge control will determine which edges are used; otherwise the Clock Edge control will
have no effect.

Vertical Position

Measure at X% of the Unit
Interval

Sets the horizontal position where the measurement is taken, as a percentage of the Unit Interval.

Bit config for TN@BER measurement
This configuration tab is displayed for the TN@BER measurement.

Figure 44: Bit config for TN@BER

Table 39: Bit config for TN@BER

Item Description

Signal Type

Clock Clock Forces the signal to be interpreted as a Clock. Measurements will take place on the edges
specified by the Clock Edge control.

Table continued…
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Item Description

Data Data Forces the signal to be interpreted as a Data. Both rising and falling edges are used.

Auto Allows the application to automatically detect whether the signal is clock or data. If the signal is a clock,
the Clock Edge control will determine which edges are used; otherwise the Clock Edge control will
have no effect.

Vertical Position

Measure at X% of the Unit
Interval

Sets the horizontal position where the measurement is taken, as a percentage of the Unit Interval.

Bit config for mask hits measurements
This configuration tab allows you to select the waveform bit type (All Bits, Transition, or Non-Transition) and the mask to be used for Mask
hits measurements.

Figure 45: Bit config for mask hits

Table 40: Bit config for mask hits

Item Description

Bit Type

All Bits Eye analysis includes both transition and non-transition bits.

Transition Eye analysis only on transition bits.

Non-Transition Eye analysis only on non-transition bits.

Mask

Browse Allows selection of the mask file. (If none of the supplied mask files meets your need, you may create a
custom mask file with a text editor by using one of the existing mask specification files as a template.)

Table continued…
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Item Description

Mask There are two types of mask coordinates:

• Absolute: Select to define the mask in terms of absolute values. The units defining the polygon X
and Y values are in the waveforms horizontal and vertical coordinates.

• Relative: Select to define the mask in terms of normalized values. The horizontal axis is
normalized to the Unit Interval and the vertical axis is normalized to Nominal1 and Nominal0.
Normalized levels of 0 and 1 represent logic zero and one respectively. These are defined by the
means of the lower and upper halves of the central 0.2 UI of the eye.

Relative Mask Math:

Nominal1 = <Vertical Value of 1>

Nominal0 = <Vertical Value of 0>

UI = <Time Interval of Symbols>

UICenter = <Time at Center of UI>

hRelativeStart = 0.5

vValue(y) = (y*(Nominal1 – Nominal0)) + Nominal0

hValue(x) = (x – hRelativeStart-0.5)*UI + UICenter

Bit config for autofit mask hits measurement
This configuration tab allows you to select the waveform bit type (All Bits, Transition, or Non-Transition) and the mask to be used for Autofit
Mask hits measurements and Advance options.

Figure 46: Bit config for autofit mask hits measurement

Table 41: Bit config for autofit mask hits measurement

Bit config for mask hits Description

Bit Type

All Bits Eye analysis includes both transition and non-transition bits.

Table continued…
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Bit config for mask hits Description

Transition Eye analysis only on transition bits.

Non-Transition Eye analysis only on non-transition bits.

Mask

Browse Allows selection of the mask file. (If none of the supplied mask files meets your need, you may create a
custom mask file with a text editor by using one of the existing mask specification files as a template.)

Mask • Absolute: Select to define the mask in terms of absolute values. The units defining the polygon X
and Y values are in waveforms horizontal and vertical coordinates.

• Relative: Select to define the mask in terms of normalized values. The horizontal axis is normalized
to the Unit Interval and the vertical axis is normalized to Nominal1 and Nominal0. Normalized
levels of 0 and 1 represent logic zero and one respectively.

Advance Displays the Mask Offset dialog box.

Autofit configuration: When Autofit is clicked, If “Autofit” configuration is selected, the backend
algorithm automatically identifies the best location where the pixel hits are either minimum or zero in an
eye diagram. The “Horizontal Mask Offset” value will get updated in Autofit text box.

Manual configuration: If Manual configuration is selected, the positive offset value will move the
mask to the right side and negative offset value will move the mask to left side of eye diagram. We
should add a short line of text at the bottom of the Horizontal section: “A positive value moves the
mask to the right”. There will be no mask movement for this particular configuration (Manual = 0
seconds).

Bit config for mask hits ratio measurement
This configuration tab allows you to select the waveform bit type (All Bits, Transition, or Non-Transition) and the mask to be used for Mask
hits measurements.
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Figure 47: Bit config for mask hits ratio measurement

Table 42: Bit config for mask hits ratio measurement

Item Description

Bit Type

All Bits Eye analysis includes both transition and non-transition bits.

Transition Eye analysis only on transition bits.

Non-Transition Eye analysis only on non-transition bits.

Mask

Browse Allows selection of the mask file. (If none of the supplied mask files meets your need, you may create a
custom mask file with a text editor by using one of the existing mask specification files as a template.)

Bit config for mask margin measurement
This configuration tab allows you to select the waveform bit type (All Bits, Transition, or Non-Transition) and the mask to be used for Mask
hits measurements.

Figure 48: Bit config for mask margin measurement

Table 43: Bit config for mask margin measurement

Item Description

Bit Type

All Bits Eye analysis includes both transition and non-transition bits.

Table continued…
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Item Description

Transition Eye analysis only on transition bits.

Non-Transition Eye analysis only on non-transition bits.

Mask

Browse Allows selection of the mask file. (If none of the supplied mask files meets your need, you may create a
custom mask file with a text editor by using one of the existing mask specification files as a template.)

Bit config for amplitude measurements
This configuration tab is present only for High, Low and High–Low measurements. You can select the waveform bit type (All Bits,
Transition, Non-Transition) and method.

Figure 49: Bit config for amplitude measurements

Table 44: Bit config for amplitude measurements

Item Description

Bit Type

All Bits Eye analysis includes both transition and non-transition bits.

Transition Eye analysis only on transition bits.

Non-Transition Eye analysis only on non-transition bits.

Measure the Center X% of the
Bit

Determines what percentage (1 to 100) of a unit interval, centered in the middle of the bit, shall be
included in each measurement. The waveform points selected by the percentage form a distribution
(vertical histogram) from which a single value is extracted, based on the Method control.

Table continued…
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Item Description

Method Determines whether the Mean value or the Median of the selected distribution is used for the
measurement value for each unit interval.

Bit config for PCI express measurements
This configuration tab allows you to select which waveform bit types (Transition, Non-Transition or All Bits) are included when taking PCI
Express measurements, PCIe T-Tx-Rise and PCIe T-Tx-Fall.

Figure 50: Bit config for PCI express measurements

Table 45: Bit config for PCI express measurements

Item Description

Bit Type

All Bits Analysis includes both transition and non-transition bits.

Transition Analysis only on transition bits.

Non-Transition Analysis only on non-transition bits.

BER
The BER configure panel is available for T-TX-UTJ, T-TX-UDJDD, T-TX-UPW-TJ, T-TX-UPW-DJDD, PkPkClkTJ measurements.

Figure 51: BER configure panel
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Table 46: BER configure

Item Description

Target BER

BER= 1E-? Sets the Bit Error Rate exponent, thereby setting the statistical level at which Total Jitter and Eye
Opening are reported.

Apply To All

Apply Applies the Target BER value to both Jitter Target BER and Target BER for all the measurements that
have the BER as the configuration tab.

RJ-DJ

About RJ-DJ
This configuration tab allows you to select an appropriate decomposition method for jitter analysis. The RJ-DJ decomposition analysis
divides the timing jitter into various categories and uses the results to predict the total jitter at a selected bit error rate (BER).

The DPOJET application offers two methods of RJ-DJ analysis: 

• A method based on spectral analysis that is appropriate for cyclically repeating data patterns.
• A method that works for arbitrary data sequences.

This tab allows you to configure the decomposition method based on the data pattern. By default, the decomposition method is selected
automatically based on the detected bit pattern. This is the recommended configuration.

Figure 52: RJ-DJ

Table 47: RJ-DJ analysis of repeating options

Item Description

Pattern Detection/Control

Auto [Preferred] Causes the data pattern to be detected automatically on the first acquisition following a “Clear” or
configuration change. Based on this detection, the Pattern Type and associated controls are then
configured optimally for the given record length.

Manual Allows (and requires) that the Pattern Type and associated controls be set manually.

Table continued…
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Item Description

Pattern Type

Pattern Type - Repeating If the data signal is repeating pattern of N bits, then Repeating pattern type should be selected. 15

Pattern Type - Arbitrary If the data signal is non-repeating pattern, or is unknown then Arbitrary pattern type should be
selected.

Pattern Length (Present only when the Pattern Type is Repeating.) When Pattern Detection is Auto, this field shows
the detected pattern length. When Pattern Detection is Manual, this control must be set to match the
actual pattern length. If the manually-set pattern length is inconsistent with the detected pattern length,
processing will continue but a warning will be logged.

Window Length (Only present when the Pattern Type is Arbitrary.) Determines the number of unit intervals over which
pattern correlation effects are analyzed. The window should be set to a large enough value that the
impulse response of the serial data transmitter and channel have settled.

Target BER

BER= 1E-? Sets the Bit Error Rate exponent, thereby setting the statistical level at which Total Jitter, Total Noise
and Eye Opening are reported.

Note: Target BER configuration is available only for TJ@BER, Width@BER, Height@BER,
BER mask test and PDF mask test measurements.

Apply To All

Apply Applies all settings on this configuration tab to all other measurements that have an RJ-DJ tab.

Noise Compensation Note: Noise Compensation is available only in Jitter+Noise decomposition method for
TJ@BER, RJ, RJ - dual dirac and Width@BER measurements.

Auto Scope RN(rms) will be automatically fetched from Scope Noise Characterization application database,
based on the provided Reference ID and oscilloscope configurations. This value is interpolated to
match the current scale, position and offset.

Fetching of oscilloscope noise happens when user run the measurement.

Manual Causes the Scope RN(rms) to be directly taken as input from the user manually. The reference ID is
not needed to be entered in this case.

Scope RN(rms) Sets the oscilloscope vertical noise in terms of RMS.

Ref ID This reference ID has to match the reference ID which is used to perform noise characterization
in Scope Noise Characterization application. This will be only applicable for auto mode of noise
compensation.

Related topics

RJ-DJ analysis of arbitrary pattern on page 102

15 A minimum of 50 repeats of the pattern must be present.
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RJ-DJ analysis of repeating patterns on page 102

RJ-DJ analysis of repeating patterns
This method of RJ-DJ analysis uses a Fourier transform of the time-interval error signal to identify and separate jitter components. It is
described in the Fibre Channel - Methodologies for Jitter and Signal Quality Specification (MJSQ) and has wide industry acceptance.

This method requires that the data signal be composed of a pattern of N bits that are repeated over and over. A minimum of 50 repeats of
the pattern must be present. If you select Manual configuration, you must enter the pattern length (N), although it is not necessary to know
the specific bits that make up the pattern. If you use the default “Auto” configuration, this method will be selected if possible and configured
based on the detected bit pattern.

Figure 53: RJ-DJ analysis of repeating pattern

RJ-DJ analysis of arbitrary pattern
When the data pattern is not repeating, or is unknown, a second method of RJ-DJ analysis may be used. (It may also be used if the pattern
is repeating, and correlates well with the Spectral method in this case.) This method assumes that the Inter Symbol Interference (ISI) from
a given edge only affects a relatively small number of subsequent bits. For example, in a band-limited link where a string of ones follows a
string of zeros, the signal may require three or four bit periods to fully settle to the “high” state.

In this method, an analysis window with a width of K+1 bits is slid along the waveform. For each position of the window, the time interval
error of the rightmost bit in the window is stored, along with the K-bit pattern that preceded it. After the window has been slid across all
positions, it is possible to calculate the component of the jitter that is correlated with each observed K-bit pattern, by averaging together all
the observed errors associated with that specific pattern.

In the configuration menu for the arbitrary-pattern method, the Window Length field allows you to select how many bits are included in the
sliding window. The window should include enough bits to allow the impulse response of the system under test to settle, usually 5 to 10
bits. The disadvantage of increasing the window length is that it uses more memory and requires additional processing time and greater
measurement population to form an answer. If the measurement population is not sufficient at the end of a processing cycle to calculate an
answer, the results table displays <Min# of UI.

Prior versions of DPOJET allowed direct control of the minimum number of observations required for each data pattern, before a result
would be produced. This minimum is now set internally to 10. DPOJET always uses all available observations; this control only set the
minimum allowable.

The arbitrary pattern approach for measuring jitter may not be appropriate if there are very-long-duration memory effects in your data link.
An example would be if there are impedance mismatch reflections that arrive long enough after the initial edge to fall outside the analysis
window.
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Figure 54: RJ-DJ analysis of arbitrary pattern

RN-DN

About RN-DN
This configuration tab allows you to select an appropriate decomposition method for noise analysis. The RN-DN decomposition analysis
divides the noise into various categories and uses the results to predict the total jitter at a selected bit error rate (BER).

The DPOJET application offers two methods of RN-DN analysis: 

• A method based on spectral analysis that is appropriate for cyclically repeating data patterns.
• A method that works for arbitrary data sequences.

This tab allows you to configure the decomposition method based on the data pattern. By default, the decomposition method is selected
automatically based on the detected bit pattern. This is the recommended configuration.

Figure 55: RN-DN

Table 48: RN-DN analysis of repeating options

Item Description

Pattern Detection/Control

Auto Automatically detects the data pattern on the first acquisition when Clear is selected or a change in
configuration. Based on this detection, the Pattern Type and associated controls are then configured
optimally for the given record length.

Auto is the recommended selection.

Manual Allows you to manually configure the Pattern Type and associated controls.

Pattern Type

Pattern Type - Repeating If the data signal is repeating pattern of N bits, then select Repeating pattern type.

Table continued…
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Item Description

Pattern Type - Arbitrary If the data signal is non-repeating pattern, or is unknown then select Arbitrary pattern type.

Pattern Length When Pattern Detection is Auto, this field shows the detected pattern length. When Pattern Detection
is Manual, this control must be set to match the actual pattern length. If the manually-set pattern length
is inconsistent with the detected pattern length, processing will continue but a warning will be logged.

Present only when the Pattern Type is Repeating.

Window Length Determines the number of unit intervals over which pattern correlation effects are analyzed. The
window should be set to a large enough value that the impulse response of the serial data transmitter
and channel have settled.

Present only when the Pattern Type is Arbitrary.

Target BER

BER= 1E-? Sets the Bit Error Rate exponent, thereby setting the statistical level at which Total Jitter, Total Noise
and Eye Opening are reported.

Note: Target BER configuration is available only for TN@BER measurement.

Apply To All

Apply Applies settings on this configuration tab to all other measurements that have an RN-DN tab.

Noise Compensation Note: Noise Compensation is available only in Jitter+Noise decomposition method for
TN@BER, RN, RN(V), and Height@BER measurements.

Auto Scope RN(rms) will be automatically fetched from Scope Noise Characterization application database,
based on the provided Reference ID and oscilloscope configurations. This value is interpolated to
match the current scale, position and offset.

Fetching of oscilloscope noise happens when user runs the measurement.

Manual Causes the Scope RN(rms) to be directly taken as input from the user manualy. The reference ID is
not needed to be entered in this case.

Scope RN(rms) Sets the oscilloscope vertical noise in terms of RMS.
Ref ID This reference ID has to match the reference ID which is used to perfrom noise characterization in

Scope Noise Characterization application.

Related topics

RN-DN analysis for arbitrary pattern on page 105

RN-DN analysis for repeating pattern on page 104

RN-DN analysis for repeating pattern
This method of RN-DN analysis uses a Fourier transform of the noise signal to identify and separate noise components.
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This method requires that the data signal be composed of a pattern of N bits that are repeated over and over. A minimum of 50 repeats of
the pattern must be present. If you select Manual configuration, you must enter the pattern length (N), although it is not necessary to know
the specific bits that make up the pattern. If you use the default “Auto” configuration, this method will be selected if possible and configured
based on the detected bit pattern.

Figure 56: RN-DN analysis for repeating pattern

RN-DN analysis for arbitrary pattern
When the data pattern is not repeating, or is unknown, a second method of RN-DN analysis may be used. (It may also be used if the
pattern is repeating, and correlates well with the Spectral method in this case.) This method assumes that the Inter Symbol Interference
(ISI) from a given edge only affects a relatively small number of subsequent bits. For example, in a band-limited link where a string of ones
follows a string of zeros, the signal may require three or four bit periods to fully settle to the “high” state.

In this method, an analysis window with a width of K+1 bits is slid along the waveform. For each position of the window, the time interval
error of the rightmost bit in the window is stored, along with the K-bit pattern that preceded it. After the window has been slid across all
positions, it is possible to calculate the component of the jitter that is correlated with each observed K-bit pattern, by averaging together all
the observed errors associated with that specific pattern.

In the configuration menu for the arbitrary-pattern method, the Window Length field allows you to select how many bits are included in the
sliding window. The window should include enough bits to allow the impulse response of the system under test to settle, usually 5 to 10
bits. The disadvantage of increasing the window length is that it uses more memory and requires additional processing time and greater
measurement population to form an answer. If the measurement population is not sufficient at the end of a processing cycle to calculate an
answer, the results table displays <Min# of UI.

Prior versions of DPOJET allowed direct control of the minimum number of observations required for each data pattern, before a result
would be produced. This minimum is now set internally to 10. DPOJET always uses all available observations; this control only set the
minimum allowable.

The arbitrary pattern approach for measuring jitter may not be appropriate if there are very-long-duration memory effects in your data link.
An example would be if there are impedance mismatch reflections that arrive long enough after the initial edge to fall outside the analysis
window.

Figure 57: RN-DN analysis for arbitrary pattern
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Bus state

Configuring bus states
The following topic applies only to MSO series oscilloscopes, since it depends on the ability to define a digital bus using the oscilloscope
logic channels.

Use this configuration tab to select the bus states, clock source, edge and polarity used in measurements that require a bus source. The
configuration changes based on the selected measurement. Measurement tCMD-CMD requires two different bus states to calculate the
time between them. Select the bus states using a bus symbol file or a bus pattern setup. Select between the options using the radio
buttons.

If a symbol file is not loaded, Enter pattern is selected. If a symbol file is loaded, Use symbol file is selected. The symbol file loads
commands into the drop down lists. The Bus State user interface stays in sync with the Bus Setup window of the oscilloscope. Any change
in Bus state configuration tab will reflect in Bus setup window and vice versa.

When a symbol file is loaded, the From Symbol and To Symbol drop downs are displayed, with the commands loaded from the symbol file.
You can select the required Measure at bus states. Changing Measure at to Clock Edge lets you set the clock source and polarity. Clock
Edge considers the time at which commands are registered, that is, at the Rising or Falling edge of the clock, depending on the Clock
Polarity configuration.

Figure 58: Configuring bus states

Measurements like tCKSRE require one waveform source and one bus state. Select the waveform source from the Clock Source drop
down or the Source Configuration window. Your selected source is the first choice in the Clock Source drop down. Select the bus state
using the Symbol drop down.

Figure 59: Configuring bus states (tCKSRE)

The tBurst-CMD measurement is a single-source measurement by default. The Measure at selection does not have a Clock Edge
selection, only Start and Stop.
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Figure 60: Configuring bus states (tBurst-CMD measurement)

Select Enter pattern to directly enter the required symbol bit patterns.

Figure 61: Configuring bus states (Required symbol bit pattern)

Table 49: Bus state options

Item Description

Use symbol file Use the bus state in the symbol file.

Enter pattern Specify a bus state pattern.

Symbol File Browse for the symbol file to use.

Symbol The bus state symbol to use in measurements.

Measure at Specify where to take the measurement.

Clock Edge Settings

Clock Source Specify the clock source for the measurement.

Clock Polarity Specify the clock polarity for the measurement.

Between bus states

From Symbol Specify where the measurement is take from.

To Symbol The symbol file specifies where to measurement to.

Table continued…

Jitter, Noise and Eye Diagram Analysis

DPOJET Jitter, Noise and Eye Diagram Analysis Solution Application Help 107



Item Description

Measure at The symbol file specifies where to take the measurement.

Start - Considers Start time of the command. Stop - Considers Stop time of the command.Clock Edge -
Considers the time at which Commands are registered, that is, at the Rising edge of the clock.

Custom gating

Configuration for custom gating
This configuration tab is displayed for Gated skew measurements.

Table 50: Configuration for custom gating

Item Description

Region

Source1 Lists the gates which are enabled and associated with Source 1

Source2 Lists the gates which are enabled and associated with Source 2

From Edge

Rise Uses only the rising edges of the signal

Fall Uses only the falling edges of the signal

Both Uses both the rising and falling edges of the signal

To Edge

Rise Uses only the rising edges of the signal

Fall Uses only the falling edges of the signal

Both Uses both the rising and falling edges of the signal

Measurement Edge

First Uses only the first configured edge of the signal

All Uses all the configured edges of the signal
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Edges

Configuring edges
This configuration tab allows you to select waveform edge(s) the application should use to take measurement. Depending on the particular
measurement, the tab will offer access to other options and constraints that help guide the analysis. The application is able to automatically
detect whether a signal is clock or data, and will do so by default. This can be overridden by configuring the signal type as Clock or Data.

The configuration options for Edges change based on whether the analysis method selected is Jitter Only or Jitter + Noise (Preferences >
Jitter Decomp > Analysis Method).

Configuring edges - Jitter only
The following configuration options apply to most measurements when the analysis method selected is Jitter Only. See the subsequent
sections for Edge tabs corresponding to particular measurements.

Figure 62: Configuring edges - Jitter only

Table 51: Configuring edges - Jitter only

Item Description

Signal Type

Clock Forces the signal type to be interpreted as a Clock. Measurements will take place on the edges
specified by the Clock Edge control.

Data Forces the signal to be interpreted as a Data. Both rising and falling edges are used.

Auto Allows the application to automatically detect whether the signal is clock or data. If the signal is a clock,
the Clock Edge control will determine which edges are used; otherwise the Clock Edge control will
have no effect.

Clock Edge

Rise Uses only the rising edges of the signal.

Fall Uses only the falling edges of the signal.

Both Uses both the rising and falling edges of the signal.
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Configuring edges - Jitter + Noise
The following configuration options apply to most Jitter measurements when the analysis method selected is Jitter + Noise. The rise edge
and fall edge configuration is disabled for Width@BER and all Jitter measurements except TIE. For TIE measurement, the Clock Edge
configuration are enabled. See the subsequent sections for Edge tabs corresponding to particular measurements. 

Figure 63: Configuring edges - Jitter + Noise

Table 52: Configuring edges - Jitter + Noise

Item Description

Signal Type

Clock Forces the signal type to be interpreted as a Clock. Measurements will take place on the edges
specified by the Clock Edge control.

Data Forces the signal to be interpreted as a Data. Both rising and falling edges are used.

Auto Allows the application to automatically detect whether the signal is clock or data. If the signal is a clock,
the Clock Edge control will determine which edges are used; otherwise the Clock Edge control will
have no effect.

Clock Edge

Rise Disabled (greyed out)

Fall Disabled (greyed out)

Both Uses both the rising and falling edges of the signal (default).

The following configuration options apply to most Noise measurements when the analysis method selected is Jitter + Noise. See the
subsequent sections for Edge tabs corresponding to particular measurements.

Figure 64: Configuring edges - Jitter + Noise
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Table 53: Configuring edges - Jitter + Noise

Item Description

Signal Type

Clock Forces the signal type to be interpreted as a Clock. Measurements will take place on the edges
specified by the Clock Edge control.

Data Forces the signal to be interpreted as a Data. Both rising and falling edges are used.

Auto Allows the application to automatically detect whether the signal is clock or data. If the signal is a clock,
the Clock Edge control will determine which edges are used; otherwise the Clock Edge control will
have no effect.

Configuring edges for skew measurements
This configuration tab is displayed for Skew measurements.

Figure 65: Configuring edges for skew measurements

Table 54: Configuring edges for skew measurements

Item Description

From Edge

Rise Uses only the rising edges of the signal.

Fall Uses only the falling edges of the signal.

Both Uses both the rising and falling edges of the signal.

To Edge

Same as From Each measurement is defined by a pair of like edges (Rise to Rise or Fall to Fall).

Opposite as From Each measurement is defined by a pair of opposing edges (Rise to Fall or Fall to Rise).

Configuring edges for differential CrossOver voltage measurements
This configuration tab is displayed for Differential CrossOver Voltage measurements.
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Figure 66: Configuring edges for differential CrossOver voltage measurements

Table 55: Configuring edges for differential CrossOver voltage measurements

Item Description

Rise Uses only the rising edges of the signal.

Fall Uses only the falling edges of the signal.

Both Uses Both the rising and falling edges of the signal.

Configuring edges for phase noise measurements
This configuration tab is displayed for Phase Noise measurements. Phase noise measurements are undefined for data signals, so the
signal is assumed to be a clock.

The Noise Integration Limits determine the portion of the phase noise spectrum that is integrated to produce a single measurement per
waveform acquisition.

Figure 67: Configuring edges for phase noise measurements

Table 56: Configuring edges for phase noise measurements

Item Description

Active Edge

Rise Uses only the rising edges of the signal.

Fall Uses only the falling edges of the signal.

Both Uses both the rising and falling edges of the signal.

Noise Integration Limits

Table continued…
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Item Description

Upper Frequency Sets the upper end of the noise integration frequency range.

Lower Frequency Sets the lower end of the noise integration frequency range.

Configuring edges for N-Period measurements
This configuration tab is displayed for N–Period measurements.

Figure 68: Configuring edges for N-Period measurements

Table 57: Configuring edges for N-Period measurements

Item Description

Signal Type

Clock Forces the signal to be interpreted as a Clock. Measurements will take place on the edges specified by
the Clock Edge control.

Data Forces the signal to be interpreted as a Data. Both rising and falling edges are used.

Auto Allows the application to automatically detect whether the signal is clock or data. If the signal is a clock,
the Clock Edge control will determine which edges are used; otherwise the Clock Edge control will
have no effect.

Clock Edge

Rise Uses only the rising edges of the signal.

Fall Uses only the falling edges of the signal.

Both Uses both the rising and falling edges of the signal.

N= Specifies number of cycles or unit interval in each N-period group.

Edge Increment Specifies the temporal displacement in edges between consecutive measurements.

Configuring edges for setup/hold
This configuration tab is displayed for two source measurements: Setup and Hold. 
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Figure 69: Configuring edges for setup/hold

Table 58: Configuring edges for setup/hold

Item Description

Clock Edge (Source1)

Rise Uses only the rising edges of the signal.

Fall Uses only the falling edges of the signal.

Both Uses both the rising and falling edges of the signal.

Clock Edge (Source2)

Rise Uses only the rising edges of the signal.

Fall Uses only the falling edges of the signal.

Both Uses both the rising and falling edges of the signal.

Configuring edges for CC-Period/Duty cycle measurements
This configuration tab is displayed for the CC–Period, +Duty Cycle and –Duty Cycle measurements. These measurements are only defined
for clock signals, and each measurement value is evaluated over one full clock cycle. 

Figure 70: Configuring edges for CC-Period/Duty cycle measurements

Table 59: Configuring edges for CC-Period/Duty cycle measurements

Item Description

Clock Edge

Rise Measurements are only initiated on the Rising edges of the clock signal.

Table continued…
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Item Description

Fall Measurements are only initiated on the Falling edges of the clock signal.

Both Measurements are initiated on both the Rising and falling edges of the clock signal.

Configuring edges for DCD measurement
This configuration tab is displayed for DCD measurement.

Figure 71: Configuring edges for DCD measurement

Table 60: Configuring edges for DCD measurement

Item Description

Signal Type

Clock Forces the signal type to Clock. Edges are selectable.

Data Forces the signal type to Data. Both rising and falling edges are used.

Auto Automatically detects whether the signal is clock or data.

Configuring edges for Overshoot/Undershoot measurements
This configuration is displayed for both Overshoot and Undershoot measurements. The algorithm calculates the maximum peak amplitude
above/below the specified edge configuration Ref levels on page 147 for Overshoot/Undershoot measurements.

An Overshoot event is defined by a rising crossing followed by a falling crossing of the reference level. Undershoot is defined by a falling
crossing followed by a rising crossing of the reference level.

The difference between the peak amplitude and the reference level voltage is shown in the measurement results, expressed as a positive
value in all cases. The results are stored zero for the cycles which do not have Overshoot/Undershoot. 
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Figure 72: Configuring edges for Overshoot/Undershoot measurements

Configuring edges for rise/fall slew rate
This configuration is displayed for rise slew rate measurement: 

Figure 73: Configuring edges for rise slew rate

Table 61: Configuration options for rise slew rate

Item Description

From Level

Mid Uses the source configuration mid reference voltage level for the Rise slew rate.

Low Uses the source configuration low reference voltage level for the Rise slew rate. Default is low.

To Level

High Uses the source configuration high reference voltage level for the Rise slew rate. Default is high.

Mid Uses the source configuration mid reference voltage level for the Rise slew rate.

Slew Rate Technique

Nominal Method Determines the slew rate between From -> Low level to To -> High level.

DDR Method Determines the slew rate between low to high reference level. If the actual signal is earlier than the
nominal slew rate line, then the slew rate is calculated using the tangent method From->Low level to
To->High to the sample, which occurred earlier.

This configuration is displayed for fall slew rate measurement: 
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Figure 74: Configuration options for fall slew rate

Table 62: Configuration options for fall slew rate

Item Description

From Level

High Uses the source configuration high reference voltage level for the Fall slew rate. Default is high

Mid Uses the source configuration mid reference voltage level for the Fall slew rate.

To Level

Mid Uses the source configuration mid reference voltage level for the Fall slew rate.

Low Uses the source configuration low reference voltage level for the Fall slew rate. Default is low.

Slew Rate Technique

Nominal Method Defines the slew rate between From -> Low level to To -> High level.

DDR Method Determines the slew rate between high to low reference level. If the actual signal is earlier than the
nominal slew rate line, then the slew rate is calculated using the tangent method From->High level to
To->Low to the sample, which occurred earlier.

Related topics

High, mid and low reference voltage levels on page 147

Configuring edges for time outside level
This configuration is displayed for the Time Outside Level measurement: 

Figure 75: Configuring edges for time outside level
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Table 63: Configuring edges for time outside level

Item Description

Level

High Time Outside Level measurement is computed only in overshoot using High Ref Level.

High Ref Voltage Displays or allows you to define the high reference voltage level.

Low Time Outside Level measurement is computed only in undershoot using Low Ref Level.

Low Ref Voltage Displays or allows you to define the low reference voltage level.

Both Time Outside Level measurement is computed in both overshoot and undershoot using High and Low
Ref Levels.

Related topics

High, mid and low reference voltage levels on page 147

Configuring edges for F/N measurements - Jitter Only
This configuration tab is displayed for F/N measurements.

Figure 76: Configuring edges for F/N measurements - Jitter Only

Table 64: Configuring edges for F/N measurements - Jitter Only

Item Description

Signal Type

Clock Forces the signal to be interpreted as a Clock. Measurements will take place on the edges specified by
the Clock Edge control.

Data Forces the signal to be interpreted as a Data. Both rising and falling edges are used.

Auto Allows the application to automatically detect whether the signal is clock or data. If the signal is a clock,
the Clock Edge control will determine which edges are used; otherwise the Clock Edge control will
have no effect.

Clock Edge
Table continued…
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Item Description

Rise Uses only the rising edges of the signal.

Fall Uses only the falling edges of the signal.

Both Uses both the rising and falling edges of the signal.

Subrate Divisor

N Specifies the subrate divisor value 2 , 4, 8 which is used to compute F/2, F/4, F/8 jitter measurement.

Configuring edges for F/N measurements - Jitter + Noise
This configuration tab is displayed for F/N measurements when the analysis method selected is Jitter + Noise.

Figure 77: Configuring edges for F/N measurements - Jitter + Noise

Table 65: Configuring edges for F/N measurements - Jitter + Noise

Item Description

Signal Type

Clock Forces the signal to be interpreted as a Clock. Measurements will take place on the edges specified by
the Clock Edge control.

Data Forces the signal to be interpreted as a Data. Both rising and falling edges are used.

Auto Allows the application to automatically detect whether the signal is clock or data. If the signal is a clock,
the Clock Edge control will determine which edges are used; otherwise the Clock Edge control will
have no effect.

Clock Edge

Rise Disabled (greyed out)

Fall Disabled (greyed out)

Both Uses both the rising and falling edges of the signal.

Subrate Divisor
Table continued…
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Item Description

N Specifies the subrate divisor value 2 , 4, 8 which is used to compute F/2, F/4, F/8 jitter measurement.

Configuring edges for DDR tCH(avg) and DDR tCL(avg)
This configuration tab is displayed for both DDR tCH(avg) and DDR tCL(avg). Set the window size for clock measurements. The
measurement analysis is done on a sliding window of size 200 cycles with a step increment of 1 cycle. You can set window size up to 1M,
with at least 200. 

Figure 78: Configuring edges for DDR tCH(avg) and DDR tCL(avg)

Configuring edges for DDR tERR(m-n)
This configuration tab is displayed for DDR tERR(m-n) measurement. 

Figure 79: Configuring edges for DDR tERR(m-n)

Table 66: Configuring edges for DDR tERR(m-n)

Item Description

Clock Edge

Rise Measurements are only initiated on the Rising edges of the clock signal.

Fall Measurements are only initiated on the Falling edges of the clock signal.

Minimum Specify the minimum number of periods required to calculate error across multiple consecutive cycles
from tCK(avg).

Maximum Specify the maximum number of periods required to calculate error across multiple consecutive cycles
from tCK(avg).

Table continued…
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Item Description

Window Size Measurement analysis is done on a window of size 200 cycles with a step increment of 1 cycle. As per
the standard, the default window size is 200. You can set window size up to 1M.

Configuring edges for DDR tERR(n)
This configuration tab is displayed for DDR tERR(n) measurement.

Figure 80: Configuring edges for DDR tERR(n)

Table 67: Configuring edges for DDR tERR(n)

Item Description

Clock Edge

Rise Measurements are initiated only on the Rising edges of the clock signal.

Fall Measurements are initiated only on the Falling edges of the clock signal.

Number of Periods Timing error (tERR) requires number of periods (n(per)) to calculate error across multiple consecutive
cycles from tCK(avg). You can configure n(per) up to 50, with a resolution of 1.

Window Size Measurement analysis is done on a window of size 200 cycles with a step increment of 1 cycle. As per
the standard, the default window size is 200. You can set window size up to 1M.

Configuring edges for DDR tHZDQ and DDR tLZDQ
This configuration tab is displayed for both DDR tHZDQ and DDR tLZDQ. 

Figure 81: Configuring edges for DDR tHZDQ and DDR tLZDQ
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Configuring edges for DDRtJIT(per) DDRtCK(avg) and DDRtJIT(duty)
This configuration tab is displayed for DDRtJIt(per), DDRtCK(avg) and DDRtJIT(duty). 

Figure 82: Configuring edges for DDRtJIT(per) DDRtCK(avg) and DDRtJIT(duty)

Table 68: Configuring edges for DDRtJIT(per) DDRtCK(avg) and DDRtJIT(duty)

Item Description

Clock Edge

Rise Measurements are only initiated on the Rising edges of the clock signal.

Fall Measurements are only initiated on the Falling edges of the clock signal.

Window Size Measurement analysis is done on a window of size 200 cycles with a step increment of 1 cycle. As per
the standard, the default window size is 200. You can set window size up to 1M.

Configuring edges for DDR VIH.DQ(AC), VIH.DQ(DC), VIL.DQ(AC), and VIL.DQ(DC)
This configuration tab is displayed for DDR VIH.DQ(AC), VIH.DQ(DC), VIL.DQ(AC), and VIL.DQ(DC). 

Figure 83: Configuring edges for DDR VIH.DQ(AC), VIH.DQ(DC), VIL.DQ(AC), and VIL.DQ(DC)

Table 69: Configuring edges for DDR VIH.DQ(AC), VIH.DQ(DC), VIL.DQ(AC), and VIL.DQ(DC)

Item Description

Data Edge

Rise Measurements are only initiated on the Rising edges of the clock signal.

Fall Measurements are only initiated on the Falling edges of the clock signal.

Table continued…
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Item Description

Base Value (Setup)

SSC

Spread spectrum clocking (SSC)
This configuration tab allows you to set the nominal frequency of the Spread spectrum clocking (SSC). 

Figure 84: Spread spectrum clock

Table 70: Spread spectrum clock

Item Description

Nominal frequency

Auto Allows the application to determine the frequency.

Manual You enter the nominal frequency of the spread spectrum clock.

Margin
This configuration tab is displayed for the Mask Margin configuration.

Figure 85: Margin config for mask margin
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Table 71: Margin config for mask margin

Item Description

Hit Ratio Allows the user to set a threshold mask hit ratio value and the mask margin computation proceeds till it
reaches the defined hit ratio or 100%

Hit Count Allows the user to set a threshold mask hit count value and the mask margin computation proceeds till
it reaches the defined hit count or 100%.

Resolution Allows the user to set a resolution to be used in the mask margin computation. Higher resolution gives
coarser results and smaller resolution gives finer results.

DFE
This configuration tab is displayed for DFE EH, DFE EW, and DFE Eye Diagram measurements.

Configuring for DFE EH
This configuration tab is displayed for DFE eye height measurement.

Figure 86: DFE configuration for DFE EH

Table 72: DFE configuration for DFE EH

Item Description
Tap Value Enter the explicit DFE tap value. Default value is 0V.
SDLA Displays the DFE tap value for SDLA output file. Default path is

C:\Users\Public\Tektronix\TekApplications\SDLA\FinalEQR
esults.txt

Delay Compensation Select the delay compensation mode.
Delay Enter the delay value. This is enabled when the delay compensation mode is manual.
Absolute Time Level Sets the window around the V% to search for the maximum width. Default value is 0 s.
Measure at X% of the UI Sets the horizontal position where the measurement is taken, as a percentage of the Unit

Interval. Default value is 50%.
Resolution Sets the window around the X% to search for the maximum width/height. Default value is

5%.
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Configuring for DFE EW
This configuration tab is displayed for DFE eye width measurement.

Figure 87: DFE configuration for DFE EW

Table 73: DFE configuration for DFE EW

Item Description
Tap Value Enter the explicit DFE tap value. Default value is 0V.
SDLA Displays the DFE tap value for SDLA output file. Default path is

C:\Users\Public\Tektronix\TekApplications\SDLA\FinalEQR
esults.txt

Delay Compensation Select the delay compensation mode.
Delay Enter the delay value. This is enabled when the delay compensation mode is manual.
Absolute Voltage Level Sets the window around the V% to search for the maximum width. Default value is 0V.
Measure at V% of the PkPk Sets the reference voltage in the vertical scale to measure the eye width. Default value is

50%.
Resolution Sets the window around the X% to search for the maximum width/height. Default value is

5%.

Configuring DFE Eye Diagram
This configuration tab is displayed for DFE Eye Diagram measurement.

Figure 88: DFE configuration for DFE Eye Diagram

Table 74: DFE configuration for DFE Eye Diagram

Item Description
Tap Value Enter the explicit DFE tap value. Default value is 0V
Table continued…
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Item Description
SDLA Displays the DFE tap value for SDLA output file. Default path is

C:\Users\Public\Tektronix\TekApplications\SDLA\FinalEQR
esults.txt

Delay Compensation Select the delay compensation mode.
Delay Enter the delay value. This is enabled when the delay compensation mode is manual.

Optical

The Optical configuration tab is displayed for RIN, RINxOMA, and TDEC measurements.

Configuring for RIN

This configuration tab is displayed for RIN measurement.

Figure 89: Optical Configuring for RIN

Table 75: Optical Configuring for RIN

Item Description

Continuous Sets the type of waveform used as continuous
Modulated Sets the type of waveform used as modulated
Bandwidth Sets the optical bandwidth
Scope RN(rms) Sets the vertical scope noise

Configuring for RINxOMA

This configuration tab is displayed for RINxOMA measurement.
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Figure 90: Optical Configuring for RINxOMA

Table 76: Optical Configuring for RINxOMA

Item Description

Bandwidth Sets the optical bandwidth
Scope RN(rms) Sets the vertical scope noise

Configuring for TDEC

This configuration tab is displayed for TDEC measurement.

Figure 91: Optical Configuring for TDEC

Table 77: Optical Configuring for TDEC

Item Description

FFE Taps Browse button selects the FFE file in “.tap” file format obtained by receiver equalizer tap optimization.

The default path for FFE Taps is "C:\Users\Public\Tektronix\TekApplications\SDLA\taps"

BT Filter Browse button selects the 4th order Bessel Thomson Filter file in “.flt” file format

The default path for BT Filter is "C:\Users\Public\Tektronix\TekApplications\DPOJET\Filters"

Target BER Sets the Target BER
Table continued…
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Item Description

Scope RN(rms) Sets the vertical scope noise

General configuration (DPOJET)

One touch jitter
One Touch Jitter is a process for automatically performing complex jitter analysis with a single menu selection. The process selects a
waveform source, sets the horizontal and vertical scales, chooses measurements, generates statistical results and creates plot summary
(Histogram, Spectrum, Bathtub and Eye Diagram). To run this process, select Analyze > Jitter and Eye Analysis (DPOJET) > One
Touch Jitter.

By default, the DPOJET application chooses an appropriate source for the jitter measurements from the available active source(s)
(amplitude >50 mV) before generating the jitter summary. 

Figure 92: One touch jitter

Note: If the source amplitude is not greater than 50 mV, the application displays a message “Signal amplitude is extremely low for
the selected source”.

The following logic is used if none or many sources are active:

• None of the sources are active
• Only one source is active
• Two sources are active
• Three sources are active
• Four or more sources are active

Case 1: None of the sources are active
If none of the sources are active, you are prompted to select any one of the Ch, Ref or Math sources. The selected source is validated
to have amplitude >50 mV. When the amplitude of the selected source is >50 mV, then autoset is performed to increase vertical and
horizontal resolution of the signal. The selected source is assigned for all single source jitter measurements. The results and plots are
generated for a single sequence.

Case 2: Only one source is active
The application checks if the active source has amplitude >50 mV. The selected source is assigned for all single jitter measurements. The
results and plots are generated for a single sequence.
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Case 3: Two sources are active
The application checks whether the active sources are a differential pair. If so, it creates a Math waveform by taking the difference of the
two (Example: Math1=Ref1–Ref2). The lowest numbered Math waveform is considered as the source for all single jitter measurements.
The results and plots are generated for a single sequence.

If the active sources are not a differential pair, the application checks if one of the source is a clock with a period that divides the other
sources. An explicit clock recovery method derives the clock from the clock source. The application creates explicit-clock measurements
TIE, Height, TJ@BER, RJ–δδ, DJ–δδ and Width@BER for the source. The results and plots are generated for a single sequence.

If one of the active sources is not a clock, the application selects a single source from the active sources using the following priority:

• 1st- Lowest numbered Math
• 2nd- Lowest numbered Channel
• 3rd- Lowest numbered Ref

The results and plots are generated for a single sequence.

Case 4: Three sources are active
The application checks whether one of the active sources is a Math, which is defined as difference of two sources (Example: Math1=Ref1–
Ref2 ). The application selects the Math waveform as the source for all single source jitter measurements. The results and plots are
generated for a single sequence.

If one of the active sources is not a Math, the application selects a single source from the active sources using the following priority:

• 1st-Lowest numbered Math
• 2nd-Lowest numbered Channel
• 3rd-Lowest numbered Ref

The application creates single source jitter measurements. The results and plots are generated for a single sequence.

Case 5: Four or more sources are active
If four or more sources are active, the application selects a single source from the active sources using the following priority:

• 1st-Lowest numbered Math
• 2nd-Lowest numbered Channel
• 3rd-Lowest numbered Ref

The application creates single source jitter measurements for the selected source. The results and plots are generated for a single
sequence. The following figure shows the summary plot after One Touch Jitter is performed.
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Figure 93: Plot after One Touch Jitter is performed

Serial Data/Jitter guide

About serial Data/Jitter guide
The Serial Data/Jitter Guide allows you to set up, configure and run a measurement without intimate knowledge about the control menus.

Select Analyze > Jitter and Eye Analysis (DPOJET) > Serial Data/Jitter Wizard to launch the Serial Data/ Jitter Wizard.

The Serial Data/ Jitter Wizard includes the following steps:

Select measurement on page 130

About configuring measurement on page 131

Select sources on page 133

Configure autoset options on page 135

Select plots on page 135

Note: You can exit the Serial Data/Jitter Wizard without affecting any settings in the DPOJET application by clicking anytime
before clicking the button.

Select measurement
In this step, you can select any of the listed measurements:
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Figure 94: Select measurement

• Period and Frequency
• Skew
• Time Interval Error (TIE)
• Jitter Summary includes Total Jitter (TJ@BER), RJ, DJ, PJ, DDJ, TIE, and DCD measurements and plots
• Eye summary includes Height, Height@BER, Width, Width@BER, and Unit Interval measurements and plots

By default, the Period and Frequency measurement is selected. Click Next to accept the measurement and proceed to Configure

Measurement. The transition to next step is represented by  on the left along with selections or default values.

About configuring measurement
By default, the configuration parameters are displayed for Period and Frequency, TIE and Eye measurements. The Configure
Measurement option is available only for Skew and Jitter Summary. The selection in the previous step is displayed on the left.

Configure skew measurement

Configure jitter summary measurement

Configure measurement-Skew
If you select Skew in the previous step, you can configure edges by selecting the From and To edges and set the measurement limits.

Click Next to select the measurement sources.
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Figure 95: Configure measurement-Skew

Related topics

Configuring edges for skew measurements on page 111

Configure measurement-Jitter summary
If you select Jitter Summary measurement in the previous step, the bit rate and pattern length will automatically be determined by
DPOJET, thus the Configure Measurement section is not required.

Note: The measurements that you select also determine the plot types.

Click Next to select the measurement sources.
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Figure 96: Configure measurement-Jitter summary

Related topics

RN-DN analysis parameters on page 238

About RJ-DJ on page 100

Select sources
In this step, you can select the measurement source(s). The source selection depends on the measurement type. By default, Source1
is displayed automatically for all the measurements depending on the waveform last used. If Ch1/Ref1/Math1 is displayed for Source1,
Source2 is Ch2/Ref2/Math2 else Ch1/Math1/Ref1 will be selected as Source2. 
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Figure 97: Select sources (Measurement source)

The Source2 option is displayed only for two source measurements such as Skew.

Figure 98: Select sources (Two source measurements)

Click Next to configure autoset.
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Configure autoset options
In this step, you can choose to automatically adjust the oscilloscope settings or the reference levels before the measurement. The default
of Yes is recommended. By selecting No, you will retain the current oscilloscope settings and/or ref levels.

Click Next to select plots.

Figure 99: Configure autoset

Select plots
In this step, you can select the plots that you want to display. The measurements that you selected earlier also determine which plot types
will be available in this step. The following table lists the available plots for measurements:

Table 78: Measurements and available plots

Measurement Plots

Period and Frequency Period Trend, Period Spectrum, Period Histogram.

Skew Skew Trend, Skew Spectrum.

TIE TIE Trend, TIE Spectrum, TIE Histogram.

Jitter Summary TIE Trend, TIE Spectrum, TIE Histogram, and Bathtub Curve.

Eye summary Eye Diagram (Transition Bit), Eye Diagram (Non Transition Bit) Unit Interval Histogram, and Eye
Width@BER.

In this example, the selections shown are for a Period and Frequency measurement.
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Figure 100: Period and Frequency measurement

Click Finish to start the acquisition sequence using the selected settings. The Serial Data/Jitter Guide window closes and the results
screen is displayed.

Figure 101: Results

Note: None of the user specified settings are retained if you click before clicking .

Configuring for SSC (Spread Spectrum Clocking). Spread spectrum clocking involves modulating the clock frequency of a device
and high-speed serial signals in a controlled manner. The purpose of using SSC modulation is to spread the spectral energy to mitigate
interference due to unintentional RF radiation. The typical modulating frequency is 33.3 kHz.
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The Serial Data wizard will configure DPOJET appropriately to see an open eye diagram for a signal with SSC, by using PLL clock
recovery to track the modulation. If your goal is to analyze the SSC modulation profile versus time, a different configuration is required. You
can use the SSC-related measurements (SSC Profile, SSC Mod Rate, SSC Freq Dev, etc) to configure DPOJET appropriately for those
purposes. 

Source configuration

Custom source name
Any oscilloscope source (Channel, Math, or Reference) can have a custom label which is created or changed using the main oscilloscope
interface:

• Channels: Vertical > Label
• Maths: Math > Setup
• References: File > Reference Waveform Controls

If a source has been assigned a custom label, both the native name and custom name are shown on the Source Config panel. When
sources with custom labels appear in the measurement lists (for example, on the Select or Config panels of DPOJET), only the custom
label is shown. To see the native name, move the mouse over the row in the measurement table; a tool tip displays the native name. In
these cases, the custom label is shown, followed by the native name in parenthesis, for example DQS (Ch1).

The custom source names (DQ and DQS) appear in the following screens:

Figure 102: Measurement table

Figure 103: Source configuration
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Figure 104: Results

Figure 105: Plots

Figure 106: Data snapshot
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Figure 107: Data logging

Figure 108: Measurement summary
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Figure 109: Export results to Ref

Sources setup
The application takes measurements from waveforms specified as input sources. You can select an oscilloscope channel input (live), a
reference or a math waveform as the source and also view Labels of the selected waveforms. Some measurements require a Bus as a
source.

You can configure sources using any of the following options:

• Click  icon in the table which lists the selected measurements.
• Double-click anywhere on a row in the table that lists the selected measurements.

The source selections depend on the selected measurement.

Note: Setup, Hold, V–DIff–Xovr, DC Common Mode and Skew are two source measurements. The Source2 option is displayed
only for two source measurements.

When more than one single source measurement is selected, Apply to all single source measurements option
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Figure 110: Source measurements (Period1)

is enabled in the source configuration screen.

When more than one two source measurement is selected, Apply to all two source measurements option is enabled in the source
configuration screen.

Figure 111: Source measurements (Setup1)

Note: Although any DPOJET measurement can be assigned a custom name (Example: tDQSH), the custom name is not
displayed in the DPOJET source configuration screen. Instead, the default name for the corresponding measurement is displayed.

Related topics

Source autoset

Ref levels

Bus as a source
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Source autoset
The Source Autoset allows you to automatically adjust the oscilloscope's vertical and/or horizontal settings for live sources (Ch1-Ch4) to
improve measurement accuracy.

The Vertical Scale option automatically checks the peak-to-peak level of live sources. The vertical scale and offset of all signals with a
peak-to-peak value less than six divisions are adjusted so the peak-to-peak will be eight divisions. If the maximum or minimum value of a
signal is “clipped”, the vertical scale and offset are adjusted so that the peak-to-peak value will be eight divisions.

The Horizontal Resolution option checks the Rise Time/Resolution and Fall Time/Resolution of all live channels. The instrument horizontal
resolution is set to the largest value that does not cause the samples-per-edge of the fastest edge to fall below five samples per edge. The
option sets the acquisition sampling mode to Real Time for signals with very high edge speeds. Horizontal Autoset, by default, tries to set
the record length corresponding to 10000 UI for any given waveform at highest possible sample rate.

To automatically define both the vertical and horizontal settings for all channel sources, select the Vert and Horiz button. The Vert and
Horiz option also applies an oscilloscope autoset on each channel before performing the vertical scale and horizontal resolution autoset.

Follow these steps to automatically define the vertical or horizontal settings for active sources: 

1. Ensure that any channel waveform that you want to autoset is visible on the oscilloscope.
2. Select one of the following options:

• Vert & Horiz to autoset both vertical and horizontal setting.
• Vert Scale button to autoset oscilloscope vertical settings only.
• Horiz Res to autoset oscilloscope horizontal settings only.

3. Select Undo to return the oscilloscope to its state before autoset.

Figure 112: Autoset configuration options

Table 79: Autoset configuration options

Item Description

Vertical Scale If a channel waveform is clipped or does not exceed six vertical divisions, adjust the scale so that the
waveform occupies about eight divisions.

Table continued…
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Item Description

Horiz Res Sets the horizontal resolution so that the number of samples on the fastest transition (edge) exceeds a
specified target.

Vert & Horiz Performs a sequence: Oscilloscope Autoset, Vertical scale and Horizontal resolution.

Undo Returns to the settings present before an Autoset was performed; disabled after measurements are
taken until you perform another source autoset.

Ref Levels Setup Click Ref Levels Setup in the Source Configuration screen to hide/unhide the Ref Levels Setup.

 

Bus as a source
On MSO model oscilloscopes only, some measurements (tCMD-CMD, GDDR5 tCKSRE, GDDR5 tCKSRX, and GDDR5 tBurst-CMD )
require a bus as a source. Set up the bus using the Bus Setup window of TekScope, and set up the source using the Source
Configurations window of DPOJET. If you try to select a measurement that requires a bus, but no bus is configured, a pop up asks you to
set up a bus.

Figure 113: Bus setup

Clicking Bus Setup displays the Bus Setup window where you can configure a bus.

Figure 114: configuration of bus

You can select sources using the Source configuration window. The selected bus is displayed and you can apply both the bus and analog
source settings to all similar measurements. If the measurement requires one bus source and one clock source, the following Source
Configuration window is displayed.
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Figure 115: Source Configuration

If the measurement has only one bus source, and Source Autoset and Ref Level Autoset are not required, then the following Source
Configuration window is displayed.

Figure 116: Source Configuration

Related topic

Sources setup

Digital as a source
DPOJET supports the following measurement on Digital channels. Digital source measurements are available only on
MSO5000/70000 series of instruments running with 64-bit Windows 7 OS.
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Table 80: Digital channels

Period/Frequency measurements Time measurements

Period Skew

Positive Width Setup

Negative Width Hold

Frequency

+Duty Cycle

-Duty Cycle

CC-Period

+CC-Duty

-CC-Duty

Digital source selection
You can select any of the Digital channels (D0 – D15) from the digital tab as shown below.

Figure 117: Digital channels

Left and Right arrows will display the previous and next set of digital channels as shown below:
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Table 81: Digital channels

Figure 118: Digital channels

Digital sources do not have Source Autoset available. Also, digital sources are not used for performing Ref Level Autoset.

Configurations and features
All the configurations and the features that are supported for analog sources are supported for digital sources as well.

Figure 119: Source Configurations
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Related topic

Sources setup

Ref levels
Timing measurements are based on state transition times. By definition, edges occur when a waveform crosses specified reference
voltage levels. Reference voltage levels must be set so that the application can identify state transitions on a waveform. By default, the
application automatically chooses reference voltage levels when necessary.

Figure 120: Ref levels

The DPOJET application uses three basic reference levels: High, Mid and Low. In addition, a hysteresis value defines a voltage band
that prevents a noisy waveform from producing spurious edges. The reference levels and hysteresis are independently set for each
source waveform, and are specified separately for rising versus falling transitions. There are two ways to set the reference voltage levels:
Automatic and Manual.

High, mid and low reference voltage levels
The application uses three reference voltage levels: High, Mid, and Low:

• For most measurements, the application only uses the Mid reference voltage level. The Mid reference level defines when the waveform
state transition occurs at a given threshold.

• For Rise Time and Fall Time measurements, the High and Low reference voltage levels define when the waveform is fully high or fully
low.
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Rising Versus Falling Thresholds
You can specify thresholds for each of the reference voltage levels: High, Mid, and Low. The application uses the thresholds to determine
the following events:

• A Low/Mid/High rising event, which occurs when the waveform passes through the corresponding Rise threshold in the positive
direction.

• A Low/Mid/High falling event, which occurs when the waveform passes through the corresponding Fall threshold in the negative
direction.

For a given logical reference level (such as Low, Mid, or High), rising and falling events alternate as time progresses.

Note: In many cases, the rising and falling thresholds for a given reference voltage level are set to the same value. In those
cases, a hysteresis value helps prevent spurious edges produced by small amounts of noise in a waveform.

Using the hysteresis option
The hysteresis option can prevent small amounts of noise in a waveform from producing multiple threshold crossings. You can use a
hysteresis when the rising and falling thresholds for a given reference voltage level are set to the same value.

The reference voltage level ± the hysteresis value defines a voltage range that must be fully crossed by the waveform for an edge event to
occur. If the decision threshold is crossed more than once before the waveform exits the hysteresis band, the mean value of the first and
last crossing are used as the edge event time.

For example, if the waveform rises through the Threshold – Hysteresis, then rises through the Threshold, then falls through the Threshold,
then rises through both the Threshold and the Threshold + Hysteresis, a single edge event occurs at the mean value of the two rising
crossings.

Example of hysteresis on a noisy waveform

Automatic versus manual reference voltage levels
Each measurement source can be configured to automatically choose voltage reference levels (default), or to use specific absolute
reference voltages.  In the automatic configuration, levels are chosen according to percentages of the overall signal amplitude.

In the Ref Levels Setup panel, a table at the left edge contains all of the current active measurement sources. If a source is configured
for Percentages, appropriate reference levels will be chosen, when necessary (typically when you press the Single or Run button). Select
Autoset at the right edge of the Source Configuration menu to force autoset to occur and to learn which absolute voltage will be used.
For each level, the absolute voltage will be shown directly under the corresponding control. If Autoset has not been selected recently, the
values will be shown as TBD; the last-used voltages will be displayed for reference.

Normally, the reference levels used for rising and falling edges are identical for a given threshold (High, Mid or Low). Some special cases
demand different thresholds for rising edges than for falling edges. In those cases, select the Advanced check box to allow separate
configuration based on polarity. The Advanced view also allows you to adjust the Hysteresis value or choose the Base-Top method.

For more details, refer to Understanding when ref level autoset will occur and Understanding how ref level autoset chooses voltages.
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Table 82: Configure sources ref levels autoset configuration

Item Description

Autoset 16 Calculates and displays the reference voltage levels for all sources where the autoset option is set
according to the Autoset Ref Level Setup.

Base top method Specifies the Base-Top method to be used for all reference voltage levels when autoset occurs.

Understanding when ref level autoset will occur
When Autoset is enabled for a given source, the individual reference levels are displayed but you may not manually adjust them. Instead,
the reference levels are automatically recalculated whenever one of the following events occur:

• A measurement sequence is initiated for the first time after a source has become active.
• A measurement sequence is initiated for the first time after all results have been cleared.
• The Autoset button at the right edge of the panel is pressed.

The Autoset button is provided as a convenience, but it is never required. Autoset will always be run (if enabled) before an uninitialized
source is used for a measurement.

Understanding how ref level autoset chooses voltages
Once triggered, the Reference Level Autoset function uses the following logic to determine actual voltage levels.

For each applicable source, the Top (high logic level) and Base (low logic level) are first determined. Then, the High, Mid and Low levels
are calculated as percentages of the Top-Base difference. For example, if the Top and Base are 2.8 volts and 0.4 volts respectively and the
High percentage level is 90%, this threshold would be calculated as:

HighThres= Base+ High Percent (Top-Base)= 0.4+0.9 (2.8–0.4)= 2.56

Manually adjusting the reference voltage levels
Whether or not you use the application to automatically calculate the initial reference voltage levels, you may need to manually change the
values. To set the reference levels manually, follow these steps:

1. Click  icon in the table which lists the selected measurements to view the source configuration screen.
2. Select the desired source from the Source list.

Note: You cannot select inactive sources.

1. Select the Absolute button.
2. Select the reference levels or hysteresis options and manually adjust the values. The values will not change when you select Autoset

or take measurements.

Note: A source will become inactive if all measurements on that source are removed. If a new measurement is then added on that
source, the source once again becomes active, and defaults to the Percentage method. If you clear all measurement on a source
that was set to Absolute, you must reselect the Absolute method and levels (if desired) when the source is again added.

Click Percentage to set the reference levels in percentages.

16 If you do not perform Autoset using the Autoset button, the application updates the reference levels (if required) when you select Single or Run to take
measurements.
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Figure 121: Reference levels in percentages

Click Absolute to set the reference levels manually to specific voltages.

Figure 122: Reference levels manually

Click Percentage to set the reference levels in percentages with advanced not checked.

Figure 123: Reference levels in percentages (Advanced not checked)

Click Absolute to set the reference levels manually to specific voltages with advanced not checked.
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Figure 124: Reference levels manually (Advanced not checked)

Table 83: Configure sources ref levels configuration

Item Description

Autoset 17 Calculates and displays the reference voltage levels for all sources where the autoset option is set
according to the Autoset Ref Level Setup.

Base top method Specifies the Base-Top method to be used for all reference voltage levels when autoset occurs.

Advanced Allows you to set the Rise and Fall reference levels independently.

Absolute Allows manually setting the reference levels.

Percentage Allows setting the reference levels as a percentage.

20% – 80% Sets the low threshold level to 20%, the mid threshold level to 50%, and the high threshold level to
80%.

10% – 90% Sets the low threshold level to 10%, the mid threshold level to 50%, and the high threshold level to
90%.

Ref Levels Setup (one level per source) 18 

Rise High Sets the high threshold level for the rising edge of the source.

Rise Mid Sets the middle threshold level for the rising edge of the source.

Rise Low Sets the low threshold level for the rising edge of the source.

Fall High Sets the high threshold level for the falling edge of the source.

Fall Mid Sets the middle threshold level for the falling edge of the source.

Fall Low Sets the low threshold level for the falling edge of the source.

Table continued…

17 If you do not update ref levels by clicking Autoset, the application updates the reference levels (if required) when you select the Single or Run to take measurements.
18 Default settings are 90% (High), 50% (Mid), 10% (Low), and 3% (Hysteresis).
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Item Description

Hysteresis Sets the threshold margin to the reference level which the voltage must cross to be recognized as
changing; the margin is the relative reference level plus or minus hysteresis; use to filter out spurious
events.

Close Accepts the changes and closes the window.

Base top method
Click Base top method in the Ref Level Setup screen to select a method used for calculating Top and Base of the waveform.

When the reference levels are set to Autoset, which is the default, the following steps are used during an autoset:

• Base and Top of the waveform are calculated
• High, Mid and Low reference voltages are determined as percentages of the (Top - Base) difference

There are four methods to calculate the Base and Top of the waveform:

• Min - Max
• Low - High Histogram (Full Waveform)
• Low - High Histogram (Center of Eye)
• Auto

Table 84: Autoset ref level configuration

Item Description

Min-Max Uses the minimum and maximum values in the waveform to determine the base and top amplitude.
Useful on a waveform with low noise and free from excessive overshoot.

Low-High Histogram (Full
Waveform) 19

Uses a histogram approach to determine the base top amplitude. Creates a histogram of the
amplitudes of the entire waveform; the histogram should have a peak at the nominal high level,
and another peak at the nominal low level.

Low-High Histogram (Center of
Eye)

Uses a histogram approach to determine the base top amplitude. Creates a histogram of the
amplitudes in the center of each bit (unit interval) while ignoring the waveform during bit transitions.
The histogram should have a peak at the nominal high level and another peak at the nominal low level.

Auto Automatically determines the best Base Top method to use.

OK Accepts the changes and closes the window.

Min - Max
The figure shows a typical data waveform with a vertical histogram turned on. If base-top method Min-Max is selected, the voltages
indicated by the red lines is used for the base and top since these are the absolute min and max points in the entire waveform. If there isn't
too much overshoot in a waveform this is a good base top method.

19 The base and top are based on the base oscilloscope's High and Low measurements.
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Figure 125: Min - Max

Low - High Histogram (Full Waveform)
If base-top method Low - High Histogram (Full Waveform) is selected, the oscilloscope performs two histogram measurements: one on the
top half of the waveform and another on the lower half of the waveform. The upper and lower blue lines in the figure show the modes of the
upper and lower histogram, respectively. The mode of a histogram is the value that appears most frequently; visually, it is the peak of the
histogram. It does a good job of picking out the high and low logic levels to which the waveform settles.

Low - High Histogram (Center of Eye)
If base-top method Low - High Histogram (Center of Eye) is selected, the waveform is assumed to be a serial data signal and DPOJET
performs clock recovery on the waveform. Then, the point at the center of each unit interval is taken. These samples are sorted into low
bits and high bits. One histogram is formed on the low samples, and another on the high samples. The Base and Top are the modes of
these histograms. This is similar to the Histogram Mode method Low - High Histogram (Full Waveform), except it is less influenced by the
shape of the waveform during transitions between bits.

Auto
Base-top method Auto is the default. In Auto, method Low - High Histogram (Full Waveform) is tried first. But sometimes that method gives
ambiguous results because there's no clear point to choose on the histogram. If that occurs, DPOJET switches to method Min-Max.

Preferences setup

About preferences setup
The application provides Preferences Setup, where you can set options that apply globally within DPOJET. These options remain
unchanged until you reset them. Click Analyze > Jitter and Eye Analysis (DPOJET) > Preferences to view the Preferences screen.
Optionally, click the preferences shortcut that is available in the select panel of DPOJET and its modules such as DDR, PCIE, and USB. To
use the application more efficiently, you can set the options in the following tabs:

Preferences-General

Preferences-Jitter decomp on page 156

Preferences-Measurement

Preferences-Path defaults on page 158
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Preferences-General
Click Analyze > Jitter and Eye Analysis (DPOJET) > Preferences > General to view the following:

Figure 126: Preferences Setup-General

Table 85: Preferences-General options

Item Description

View Log Displays the error/warning log file in a Notepad window when the button is pushed.

Clear Log Clears the error/warning log file when the button is pushed.

Horizontal Display Units Select the horizontal display units for Time measurement results as Seconds (default) or Unit Intervals.
Unit Intervals are calculated for time measurements which has Clock recovery only.

Vertical Display Units Select the vertical display units for Noise measurement results as Volts (default) or Unit Amplitude.

Default Image Type Selects the default image format (JPEG, PNG or BMP) that will be used by the functions that save
images.

Notifier Duration Determines how long the warning notifier will remain on the screen before disappearing. (The notifier
may also be dismissed manually).

Cancel Discards all changes and closes the Preferences window.

OK Accepts all changes and closes Preferences window.

Related topics

Preferences-Measurement

Preferences-Path defaults

Preferences-Jitter Decomp

Preferences-Measurement
Click Analyze > Jitter and Eye Analysis (DPOJET) > Preferences > Measurement to view the following:
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Figure 127: Preferences Setup-Measurement

The Measurement tab allows you to limit Rise and Fall measurements to transition bits only, or allow these measurements for all bits. Here,
the transition bits refer to edge transitions for which the preceding transition was only one unit interval away. This may be important for
signals with pre-emphasis, since the transition following a string of two or more like bits has an intentionally low swing that you may not
want to measure.

Use this tab to enable or disable high-performance eye rendering. This provides a trade-off between greater fidelity or greater rendering
speed. You can also select the waveform interpolation type.

Table 86: Preferences-Measurement options

Item Description

Limit Rise/Fall measurements to
transition bits only

When selected, determines whether Rise Time and Fall Time measurements are performed on all bits
or only on transition bits.

Enable high-performance eye
rendering

Determines whether eye diagrams are optimized for speed or fidelity. When disabled, all unit intervals
(UI) in the waveform(s) are included in the rendered eye. This gives the highest fidelity eye rendering,
but can take a considerable amount of time for long records. When this option is enabled, a statistically
representative subset of the UI is rendered, so that eye diagrams for long waveforms can be displayed
in a shorter time. The rules for high-performance rendering are as follows:

• If the waveform contains 15,000 or fewer UI, all the UIs in the waveform are rendered.

• If the waveform includes more than 15,000 UI, it is subdivided into segments of 2000 UI each.
The entire waveform is scanned to find the specific UI, that are the worst-case violators for six
different points around the eye. For each of these worst case violators, the entire segment of 2000
UI in which it lies is rendered. Depending on whether multiple worst-case violators lie in the same
segment or not, as few as 2000 UI but typically from 8000 to 12,000 UI will be rendered in the final
eye.

UIs: Current number of UIs used to render eye diagram: Total number of UIs in the current acquisition

Total: Total number of UIs used to render the eye diagram (when doing multiple acquisitions): Total
number of UIs in the total population (when doing multiple acquisitions.

If high performance rendering is off: UIs X = UIs Y Population X = Population Y

If high performance rendering is on: UIs X < UIs Y Population X < Population Y

Halt free-run on a limit failure for
any measurement

If any of the selected measurement fails a limit test in free run, sequencing is stopped.

Table continued…
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Item Description

Automatic Transition Density
Compensation for PLLs

• When selected, the loop feedback time constants are adjusted to make the actual transfer function
more closely match a mathematical filter polynomial.

• When deselected, the clock recovery algorithm is configured for an assumed 50% transition
density. By default, it is deselected.

Waveform Interpolation Type Select the type of interpolation that is used between sample points, to determine the exact time when a
waveform crosses a reference voltage level. Linear interpolation is faster but introduces distortion that
raises the jitter noise floor slightly. Sin(x)/x Interpolation, also known as Sinc Interpolation, approaches
theoretically perfect waveform reconstruction but is computationally expensive.

Note: For Eye-High, Eye-Low, and Eye-Height measurements, Sin(x)/x interpolation is
always used for eye measurements independent of the chosen interpolation type.

Cancel Discards the changes and closes the window.

OK Accepts the changes and closes the window.

PLL-based clock recovery is implemented using a software model of a hardware PLL circuit, sequentially processing waveform transitions
and adjusting the clock period in a feedback loop. This approach means that the transition density of the input signal has subtle effects
on the effective bandwidth and damping factor of the feedback loop, just as it does with actual hardware PLLs. The influence of transition
density is only relevant for data signals, since clock signals (or data signals with a two bit pattern) have 100% transition density.

Related topics

Preferences-General

Preferences-Jitter Decomp

Preferences-Path defaults

Preferences-Jitter decomp
Click Analyze > Jitter and Eye Analysis (DPOJET) > Preferences > Jitter Decomp to view the following:

Figure 128: Analysis Method - Jitter Only
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Figure 129: Analysis Method - Jitter + Noise

The Jitter Decomp tab allows you to select the Dual Dirac model and the Jitter Separation model, and to select the minimum number of
unit intervals required for BUJ analysis.

Table 87: Preferences-Jitter Decomp options

Item Description

Analysis Method Select the analysis method as:

• Jitter Only
• Jitter + Noise

Dual Dirac Model Determines which parameter-extraction method is used when RJ-DJ separation is done under the
Dual-Dirac model. This affects results for the RJ–δδ and DJ–δδ measurements only. When Fibre
Channel is selected, RJ and DJ parameters are extracted according to guidelines given in ANSI/
INCITS Technical Report TR-35-2004 “Methodologies for Jitter and Signal Quality Specification”. RJ
and DJ values are selected that cause an exact match between the bathtub curves from the dual-dirac
and the full analytical models at two prescribed BER levels. When PCI/FB-DIMM is selected, RJ
and DJ parameters are determined using the methodology defined in the PCI Express Gen 2 and
Fully-Buffered DIMM specifications. In this technique, the bathtub curves are plotted on a Q-scale that
linearizes the tails of the bathtub, and the RJ and DJ values are derived from where the asymptotes to
the curves intersect the BER=0 line.

Lock RJ Value Selecting the Lock RJ Value calculates the measurements at the specified random jitter value. The
checkbox is unchecked by default. Selecting the checkbox displays a text box where you can enter the
RJ value. The default value is 1ps.

Lock RJ Value cannot be configured when Jitter Separation Model is Spectral + BUJ.

Note: This configuration is available only for Analysis Method - Jitter Only.

Table continued…
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Item Description

Jitter Separation Model Selects the type of jitter separation, Spectral Only or Spectral + BUJ. Spectral Only identifies almost
all categories of jitter, including Bounded Uncorrelated Jitter (BUJ) that is periodic (PJ). However, it
cannot separate bounded random jitter from Gaussian random jitter. Spectral+ BUJ includes additional
processing to identify bounded random jitter (also called Non-Periodic Jitter or NPJ). NPJ is typically
caused by crosstalk from a signal on a different clock domain, and generally requires a higher
population of measurements for proper detection.

Minimum # of UI for BUJ
Analysis

Determines the number of unit intervals (UI) that must be processed before jitter separation is
performed. This item is only used for Spectral + BUJ processing, and is not shown if the Jitter
Separation Model is Spectral Only. A higher number of UI will allow the separation algorithm to detect
lower levels of NPJ, but will typically require longer record length, more acquisitions, or both. A lower
number of UI will allow processing to occur on smaller populations of UI, but may only identify stronger
forms of NPJ. Also, note that the number of UI processed for BUJ analysis is only 17% to 33% of the
total UI acquired in each waveform.

Cancel Discards the changes and closes the window.

OK Accepts the changes and closes the window.

Related topics

Preferences-General

Preferences-Measurement

Preferences-Path defaults

Preferences-Path defaults
Click Analyze > Jitter and Eye Analysis (DPOJET) > Preferences > Path Defaults to view the following:

Figure 130: Preferences-Path defaults

The Path Defaults allows you to set the path for images, reports and log files. Click Browse to modify the default directory path.
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Table 88: Preferences-Path defaults options

Item Description

Default image export directory Selects the directory to which images will be saved, unless overridden at the time of the export.

Default logging export directory Selects the directory to which logs will be saved, unless overridden at the time of the export.

Default report export directory Selects the directory to which reports will be saved, unless overridden at the time of the export.

Cancel Discards the changes and closes the window.

OK Accepts the changes and closes the window.

Related topics

Preferences-General

Preferences-Measurement

Preferences-Jitter Decomp

Export data and measurement

Export data snapshot-Statistics
You can save a snapshot of the current statistics in .csv format. The default location is C:\%USERPROFILE%
\Tektronix\TekApplications\DPOJET\Logs\Statistics, where %USERPROFILE% represents your user
location.

Click Analyze > Jitter and Eye Analysis (DPOJET) > Export > Data Snapshot > Statistics to view the following:

Figure 131: Export data snapshot-Statistics
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Table 89: Data snapshot- Statistics options

Item Description

Select Target Measurements Displays the measurement list. Click a row to select the measurement. By default, all measurements
are selected.

Select All Selects all the measurements in the list for saving statistics.

Clear All Deselects all the measurements from the list.

Save Statistics

Save Saves the current statistics of selected target measurements to a log file.

File Name

Browse Allows you to choose the name and location where the .csv file will be saved. The
default name is YYMMDD_HHMMSS_Stats.csv. The default directory is C:\%USERPROFILE%
\Tektronix\TekApplications\DPOJET\Logs, where %USERPROFILE% represents
your user location.

Close Accepts the changes and closes the window.

Note: The default location for saving log files can be changed in the Preferences dialog box.

Related topics
Export data snapshot-Measurement

Export data snapshot-Measurement
You can save a snapshot of the data points in .csv format. The default location is C:\%USERPROFILE%
\Tektronix\TekApplications\DPOJET\Logs\Measurements, where %USERPROFILE% represents your user
location.

Click Analyze > Jitter and Eye Analysis (DPOJET) > Export > Data Snapshot > Measurement to view the following:
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Figure 132: Export data snapshot-Measurement

Table 90: Data snapshot- Measurement options

Item Description

Select Target Measurements Displays the measurement list. Click a row to select the measurement. By default, all measurements
are selected.

Select All Selects all the measurements in the list for saving statistics.

Clear All Deselects all the measurements from the list.

Save Measurements

Save Saves the data points for current acquisition of selected target measurements in a log file.

Folder

Browse Allows you to choose the location where the .csv files
will be saved. The default directory is C:\%USERPROFILE%
\Tektronix\TekApplications\DPOJET\Logs\Measurements, where
%USERPROFILE% represents your user location.

File Names

View Displays View log file names dialog box which lists the measurements and their
source(s) with corresponding log file name in YYMMDD_HHMMSS_<Measurement Name>-
<SourceName>.csv format. 

Close Accepts the changes and closes the window.
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The View Log File Names dialog box lists the measurements and their source(s) with corresponding log file name in
YYMMDD_HHMMSS_<Measurement Name>-<SourceName>.csv format. Click Close to close the dialog box. View log
file names

Figure 133: View Log File Names

Related topics

Export data snapshot

Export measurement summary
Click Analyze > Jitter and Eye Analysis (DPOJET) > Export > Measurement Summary to save the generated report in C:\
%USERPROFILE%\Tektronix\TekApplications\DPOJET\Reports, where %USERPROFILE% represents your user
location. The exported measurement summary contains information only about application setup and configuration.
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Figure 134: Export measurement

Data logging

Data logging-Statistics
The application can continuously log (save to file) the calculated statistics. You can save the statistics to a “comma separated value” (.csv)
file to import into a text editor, a spreadsheet, or an analysis tool.

By default, all measurements are selected. You can select individual measurements by selecting the row in the table on the left.

The steps for logging statistics are: 

1. Click Analyze > Jitter and Eye Analysis (DPOJET) > Data Logging > Statistics to view the Logging Statistics screen.

Figure 135: Data logging-Statistics
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2. Select the measurements that you want to log in the Select Target Measurements table on the left. Click Select All to select all the
measurements for logging or click Clear All to deselect the current measurements list.

3. Click On/Off to enable/disable automatic logging statistics for all selected measurements.
4. Click Browse to select a directory.

The default directory is C:\%USERPROFILE%\Tektronix\TekApplications\DPOJET\Logs\Statistics,
where %USERPROFILE% represents your user location.

Table 91: Log-Statistics options

Item Description

Select Target Measurements Displays the measurement list. Select the check box to select the measurement. By default, all
measurements are selected.

Select All Selects all the measurements in the list.

Clear All Deselects all the measurements in the list.

Off Disables automatic logging for all selected measurements.

On Enables automatic logging for all selected measurements.

Data Log File

Browse Allows you to choose the name and location where the .csv file will be saved. The
default name is YYMMDD_HHMMSS_Stats.csv. The default directory is C:\%USERPROFILE%
\Tektronix\TekApplications\DPOJET\Logs\Statistics, where
%USERPROFILE% represents your user location.

Note: Microsoft Excel has a limitation where you cannot increase the number of rows (65,536) or columns (256) beyond the
maximum row and column limits. Opening log files in or another analysis package is recommended. An error message “File not
loaded completely” is displayed, if you try to open a log file with data exceeding the aforesaid row and column limits.

Related topics

Data logging-Measurement

Data logging-Worst case

Data Logging-Measurement
You can log the actual individual measurement data values as measurement files. 

1. Click Analyze > Jitter and Eye Analysis (DPOJET) > Data Logging > Measurement to view the Logging screen.
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Figure 136: Data Logging-Measurement

2. Select the measurements that you want to log in the Select Target Measurements table on the left. Click Select All to select all the
measurements for logging or click Clear All to deselect the current measurements list.

3. Click On/Off to enable/disable logging for all selected measurements.
4. Click Browse to select a directory.

The default directory is C:\%USERPROFILE%\Tektronix\TekApplications\DPOJET\Logs\Measurements,
where %USERPROFILE% represents your user location.

Table 92: Log-Measurements options

Item Description

Select Target Measurements Displays the measurement list. Select the check box to select the measurement. By default, all
measurements are selected.

Select All Selects all the measurements in the list.

Clear All Deselects all the measurements from the list.

Log Measurements

Off Disables automatic logging for all selected measurements.

On Enables automatic logging for all selected measurements.

Folder

Browse Allows you to choose the name and location where the .csv
file will be saved. The default directory is C:\%USERPROFILE%
\Tektronix\TekApplications\DPOJET\Logs\Measurements, where
%USERPROFILE% represents your user location.

File Names

Table continued…

Jitter, Noise and Eye Diagram Analysis

DPOJET Jitter, Noise and Eye Diagram Analysis Solution Application Help 165



Item Description

View Displays View log file names dialog box which lists the selected
measurements with source(s) and their corresponding log file names in
<MeasurementName>_<SourceName>_YYMMDD_HHMMSS.csv format.

View log file names
The View Log File Names dialog box lists the selected measurements with source(s) and their corresponding log file names in
<MeasurementName>_<SourceName>_YYMMDD_HHMMSS.csv format. A tool tip is displayed as shown on hovering the mouse over the
text. Click Close to close the dialog box.

Figure 137: View log file names

The application displays a hint at the bottom of the screen under the following conditions:

• Qualifier turned on for measurements in Global > Qualify with searches specified.
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Figure 138: View log file names (Global > Qualify)

• Any sources other than search types are specified. Example Math instead of Search1.

Figure 139: View log file names (Math)

Related topics

Data logging-Statistics

Data logging-Worst case
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Data logging-Worst case
1. Click Analyze > Jitter and Eye Analysis (DPOJET) > Data Logging > Worst Case to view the Worst Case Logging screen.

Figure 140: Data logging-Worst case

2. Select the measurements which you want to log in the Select Target Measurements table on the left. Click Select All to select all the
measurements for logging or click Clear All to deselect the current measurements list.

3. Click On/Off to enable/disable worst case logging for all selected measurements.
4. Click Browse to select a directory.

The default directory is C:\%USERPROFILE%\Tektronix\TekApplications\DPOJET\Logs\Waveforms,
where %USERPROFILE% represents your user location.

Table 93: Log-Worst case options

Item Description

Select Target Measurements Displays the measurement list. Select the check box to select the measurement. By default, all
measurements are selected.

Select All Selects all the measurements in the list.

Clear All Deselects all the measurements in the list.

Off Disables the application to save worst case waveforms for all selected measurements.

On Enables the application to save worst case waveforms for all selected measurements.

Folder

Table continued…
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Item Description

Browse Allows you to choose the name and location where
the .csv file will be saved. The default directory is C:\
%USERPROFILE%\Tektronix\TekApplications\DPOJET\Logs\Waveforms,
where %USERPROFILE% represents your user location.

File Names

View Displays View log file names dialog box which lists the
selected measurements with source (labels) and their corresponding log
file names in <MeasurementName>_Min_<Source(label)>.wfm and
<MeasurementName>_Max_<Source(label)>.wfm 20 format.

If the custom measurement name is specified, then the log file name will
be:<CustomName>(<MeasurementName>)_Min_<Source(label)>.wfm and
<CustomName>(<MeasurementName>)_Max_<Source(label)>.wfm

View log file names
The View Log File Names dialog box lists the selected measurements with source(s) and
their corresponding log file names in <MeasurementName>_Min_<Source(label)>.wfm and
<MeasurementName>_Max_<Source(label)>.wfm format. Click Close to close the dialog box.

Figure 141: View log file names

The application displays a hint at the bottom of the screen under the following conditions:

• Qualifier turned on for measurements in Global > Qualify with searches specified.

20 For example, if the selected measurement is Skew1 with Ch1 and Ch2 as sources, then the file names will be Skew1_Min_Ch1(DQS).wfm,
Skew1_Min_Ch2(DQ).wfm, Skew1_Max_Ch1(DQS).wfm, and Skew1_Max_Ch2(DQ).wfm.
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Figure 142: View log file names (Global > Qualify)

• Any sources other than search types are specified. Example Math instead of Search1.

Figure 143: View log file names (Math)

Logging worst case for mask hits measurement
The DPOJET application supports worst case logging for the Mask Hits measurement. Whenever Mask Hits is selected, there are two
waveforms corresponding to maximum and minimum values for each of the segment as shown in the following figure:
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Figure 144: Logging worst case for mask hits measurement

When an additional clock source (Clock Recovery > Explicit Clock Edge) is included for the Mask Hits measurement, there are two
waveforms corresponding to maximum and minimum values for each of the source as shown:

Figure 145: Logging worst case for mask hits measurement (maximum and minimum values)

Note: All waveforms are displayed in the reports when worst case logging is enabled. Worst case waveform logging is now
supported for all search types. For more details on the search types, refer to your oscilloscope online help.

Related topics
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Data logging-Statistics

Data logging-Measurement

Sequencing
Use the Control panel to start or stop the sequence of processes the application and oscilloscope use to acquire information from a
waveform. The application then determines if the algorithm for the selected measurement can be applied to the waveform information.
Sequencing is the steps to acquire waveform information, determine if the information is usable for the measurement, take the
measurement, and display the results (and plots if selected).

When you click Recalc, Single or Run, the corresponding button is changed to Stop and the Progress indicator is displayed. For more
details, refer to the Control panel. 

Figure 146: Sequencing (Progress indicator)

The Progress Indicator displays the sequencer state. Select Stop, if you want to interrupt the sequence before its completion.

For more details on progress bar status messages, refer to Progress bar status messages.

Limits
A Limits file allows you to specify the Pass/Fail threshold for measurements. Each DPOJET-based serial data application typically provides
limits files that include combinations of relevant measurements and statistical characteristics, and an appropriate range of values for each
combination.

The DPOJET application provides an example limits file, called Example_Limits.xml, that is annotated to explain some of the methods of
assigning limits. You can create additional limits files by copying the example and modifying it appropriately. You can specify limits for any
of the result parameters such as Mean, Std Dev, Max, Min, peak-to-peak, population, MaxPosDelta or MinPosDelta. For each of these
result parameters, you can specify Upper Limit (UL), Lower Limit (LL), or Both. The measurement names in the limits file must be entered
as mentioned in

Setting up the application for analysis.

To include Pass/Fail status in the result statistics, you can create a limits file using an XML editor or any other editor in the following format.
If the file is created in any other editor such as notepad, it should be saved in Unicode format.
<?xml version="1.0" encoding="utf-16" ?>
<Main>
<Measurement>
<NAME>Period</NAME>
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<STATS>
<STATS_NAME>Mean</STATS_NAME>
<LIMIT>UL</LIMIT>
<UL>1</UL>
<LL>0</LL>
</STATS>
<STATS>
<STATS_NAME>StdDev</STATS_NAME>
<LIMIT>LL</LIMIT>
<UL>1121</UL>
<LL>0121</LL>
</STATS>
<STATS>
<STATS_NAME>Max</STATS_NAME>
<LIMIT>BOTH</LIMIT>
<UL>1</UL>
<LL>0</LL>
</STATS>
<STATS>
<STATS_NAME>Min</STATS_NAME>
<LIMIT>UL</LIMIT>
<UL>0</UL>
<LL>1</LL>
</STATS>
<STATS>
<STATS_NAME>PeakToPeak</STATS_NAME>
<LIMIT>UL</LIMIT>
<UL>1</UL>
<LL>1</LL>
</STATS>
<STATS>
<STATS_NAME>MaxPosDelta</STATS_NAME>
<LIMIT>UL</LIMIT>
<UL>1121</UL>
<LL>1121</LL>
</STATS>
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<STATS>
<STATS_NAME>MinNegDelta</STATS_NAME>
<LIMIT>UL</LIMIT>
<UL>0</UL>
<LL>0</LL>
</STATS>
<STATS>
<STATS_NAME>Population</STATS_NAME>
<LIMIT>UL</LIMIT>
<UL>0</UL>
<LL>0</LL>
</STATS>
</Measurement>
</Main>

Figure 147: Pass/Fail Limit Setup

Table 94: Limits options

Item Description

Pass/Fail Test

Off/On Enables (On) or Disables (Off) the display of limit information in results. Select On to choose a limits
file for the selected measurement.

Limits File

Browse To select an existing limits file or locate the directory.

Close Accepts the changes and closes the window.

Limits for mask hits
Limits are available for Mask Hits. The applications displays the following in the results panel when limits are turned on (Analyze > Jitter
and Eye Analysis (DPOJET) > Limits):
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Figure 148: Limits for mask hits

If there is a hit in any of the segments, the result is FAIL as shown:

Figure 149: Limits for mask hits (Result)

Measurement summary

Measurement configuration summary-Measurement
Click Analyze > Jitter and Eye Analysis (DPOJET) > Measurement Configuration Summary > Measurement to view measurement,
source and the configuration parameters of each measurement.

Figure 150: Measurement configuration summary-Measurement
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Table 95: Measurement configuration information

Item Description

Measurement Displays the measurement name.

Source Displays the selected source.

Others Displays the other configuration information related to the selected measurement.

OK Closes the window.

Related topics

Measurement summary-Ref levels

Measurement summary-Misc

Measurement summary-Ref levels
Click Analyze > Jitter and Eye Analysis (DPOJET) > Measurement Configuration Summary > Ref Levels to view the ref level tab.
This tab provides information about ref level configuration per source. Displays the reference voltage levels for the high, mid, and low
thresholds for the rising edge and for the falling edge of each active source, and the hysteresis.

Figure 151: Measurement summary-Ref levels

Table 96: Ref level configuration information

Item Description

Source Displays the selected source.

Rise High Displays the high threshold level for the rising edge of the source.

Rise Mid Displays the middle threshold level for the rising edge of the source.

Table continued…
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Item Description

Rise Low Displays the low threshold level for the rising edge of the source.

Hysteresis Displays the threshold margin to the reference level which the voltage must cross to be recognized
as changing; the margin is the relative reference level plus or minus the hysteresis; use to filter out
spurious events.

Fall High Displays the high threshold level for the falling edge of the source.

Fall Mid Displays the middle threshold level for the falling edge of the source.

Fall Low Displays the low threshold level for the falling edge of the source.

OK Closes the window.

Related topics

Measurement configuration summary-Measurement

Measurement summary-Misc

Measurement Summary-Misc
Click Analyze > Jitter and Eye Analysis (DPOJET) > Measurement Configuration Summary > Misc tab to view various configuration
parameters. The Miscellaneous tab shows whether the Gating, Qualify, and Stat Pop Limit functions are enabled; if enabled, it also shows
the source for qualification, the size for population, and various other configuration choices. 

Figure 152: Measurement Summary-Misc

Table 97: Miscellaneous configuration information

Item Description

State Displays On when Gating, Qualify and Population are enabled and Off when they are disabled.

Table continued…
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Item Description

Source Displays the selected source for qualify.

Size Specifies the maximum population that can be obtained for each active measurement.

OK Closes the window.

Related topics

Measurement configuration summary-Measurement

Measurement summary-Ref levels

Results as statistics

Viewing statistical results
The application displays results for the measurements for all acquisitions or for the current acquisition. By default in the detail view, the
limits will not be shown unless the limits are turned on.

Figure 153: Viewing statistical results

Result statistics for most of the measurements show Population in terms of UI or transitions. According to the JEDEC specification,
the analysis for most of the clock measurements is done for a 200-cycle moving window. However, for clock measurements such as
DDRtCL(avg) and DDRtCH(avg), the population is shown as tCK(avg) units. For Data Eye Width, the population number is shown as per
acquisition.

Table 98: Results menu options

Item Description

Displays an error message. You can click  to view the error log information in a text editor.

Displays a warning. You can click  to view the error log information in a text editor.

Description Lists the measurement name and the source.

Mean Lists a statistical mean value for the measurement data.

Table continued…
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Item Description

Std Dev Lists a statistical standard deviation value for the measurement data.

Max Lists a statistical maximum value for the measurement data. Shows Pass if the statistics is within the
specified Upper Limit Equality (ULE).

Min Lists a statistical minimum value for the measurement data. Shows Fail if the statistics has crossed the
specified Lower Limit Equality (LLE).

p-p Lists a statistical peak-to-peak value for the measurement data.

Population 21 Lists the total number of measurement data points used for displaying the statistics.

Max-cc Lists the maximum cycle-to-cycle differences per acquisition.

Min-cc Lists the minimum cycle-to-cycle differences per acquisition.

Options

Click to view Save Current Stats, Export to Ref Waveform, and Display Units-Absolute options.

Save Current Stats... Saves the current statistics as log information.

Export to Ref Waveform Exports time trend data of the selected measurement to the reference memory.

Display Units- Absolute Default display unit is Absolute.

Display Units - dBm Toggle measurement result between Watt and dBm.

Click to view the result details.

Note: For Mask Hits measurement, only Mean, Max, Min and Population values are displayed in the results table. On clicking ,
Hits in Segment 1, Segment 2 and Segment 3 are displayed. For Mask Hits measurements, mean indicates the total number of
hits for all acquisitions.

The results tab with limits turned on is as shown. You can click the zoom icon, available for Max and Min values irrespective of the limits
being turned on/off in the current acquisition. A tool tip displays the message “Click to view the event on the waveform” and appends the
result statistics in full resolution (without any truncation) on hovering the mouse.

Note: The zoom feature is available only for vector measurements.

21 Jitter measurements such as RJ, DJ show population in terms of acquisitions.
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Figure 154: Viewing statistical results (Vector measurement)

Results with Error/Warning Notification

The results tab with error  icon is as shown. Click View Log to view the error log information in a text editor.

Figure 155: Results with Error Notification

The results tab with warning  icon is as shown. You can click View Log to view the error log information in a text editor.

Figure 156: Results with Warning Notification

Overall Test Result
There are two ways to view the statistical results of measurements:

• Summary 
• Details 

Note: Alternatively, you can toggle between Summary and Details using the Expand/Collapse button.

On clicking Single/Run, the Overall Test Result shows Pass/Fail icons depending on the result of the measurement(s).
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Figure 157: Overall Test Result

For example, the Overall test result is fail if any measurement has limit failure. The result statistic which has failed is highlighted in red as
shown:

Figure 158: Overall Test Result (Fail)

Note: When limits are turned off, Summary and Overall Test Result options are not available.

Summary
Displays the summary of the results for all acquisitions. Pass/Fail information is included whereas Max-cc and Min-cc information is
excluded. Click the Expand button for the summary view as shown:

Figure 159: Summary

Details
Displays the detailed results specifying values for High Limit, Low Limit, High Margin, Low Margin, Pass/Fail, and current acquisition. Click
the Expand button for the details view as shown:
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Figure 160: Detailed results

Export results to ref waveform

Using this option, you can export the time trend plot of a measurement to any of the available reference memory, Ref1-Ref4. Click  on
the right corner of the results panel to select the “Export Results to Ref” option.

The Export Results to Ref waveform dialog box appears. It lists all the possible measurements that have time trend result data (that is
measurements for which time trend plot is enabled in the plot panel).

From the list of measurements, results of any one measurement can be exported to any one of the reference memory (Ref1-Ref4) which
is not used as the source of any measurement.

Figure 161: Export results to ref waveform

Before exporting results to a reference memory, the application checks for the following:

• If any of the ref waveforms are already used as source for one of the measurement(s), then you cannot export the results on those ref
destinations. The application prevents exporting by displaying an error message 2003.

• If all the reference waveforms (Ref1-Ref4) are already used as sources for various measurements, the “Export Results to Ref
Waveform” is not displayed. Instead, an error message 2002 is displayed.

• If a ref destination is assigned to a measurement from the list which is not empty (that is, if the ref is already defined and holds any
other recalled waveform), a warning prompts you from overwriting the existing definition of the selected destination ref.

• In case of any error (2002 or 2004) or warning (Overwriting the existing definition) and you select the response as “No”, the destination
ref reverts to its previous value. For example, if the selected measurement is Period-Ref1, and the destination ref assigned to the
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measurement is Ref3, and if you try to change the destination from Ref3 to Ref1, an error message 2003 is displayed. Ref3 is retained
as the destination ref.

• Time trend result export to the reference waveform for a measurement is independent of time trend plot. Time trend result can be
exported to ref without selecting/defining plots in the plots panel.

• If “Export Results to Ref” is selected without any measurement selection, an error message 2005 is displayed.
• If none of the selected measurements have time trend data, an error message 2007 is displayed and “Export Results to Ref” dialog is

not displayed.
• If the selected measurements have no results (results are cleared or measurements are not run to produce results), an error message

2006 is displayed and “Export Results to Ref” dialog box is not displayed.
• If the destination is none for all measurements, the results are not exported to ref on clicking OK. An information/warning 2008 is

displayed.

Bit rate and pattern length detection
Beginning with version 6.1.0, DPOJET performs automatic detection of bit rate and pattern length whenever a new processing cycle occurs
(for example, after a configuration change or a “Clear” operation). The detected values are displayed at the top of the results panel, to
allow quick verification of overall test setup and device configuration.

Figure 162: Bit rate and pattern length detection

• If there are simultaneous measurements on several different sources, the results for the source associated with the first measurement
will be shown initially. The drop-down selector can be used to see the bit rate and pattern length for other sources.

• The reported bit rate can be influenced by the clock recovery settings, and in particular by the Nominal Data Rate (if present) in the
Advanced panel of the clock recovery configuration tab.

• If no repeating pattern is detected, or if jitter measurements are explicitly configured to use arbitrary-pattern analysis, the second line
will say Pattern: Arbitrary.

• By default, the detected pattern length also automatically configures any jitter measurements that require pattern length as a
configuration parameter. These parameters appear on the RJ-DJ tab of the jitter measurements. If a jitter measurement is configured
to use a specific pattern length (instead of using the detected length), the user-specified length will be shown at the top of the results
panel and will be used by the measurement even if it does not appear to match the actual signal. To manually configure the pattern
length, select the configure tab and then the measurement. Select the RJ-DJ tab and select the Manual button.

Related topics

About RJ-DJ

Clock recovery advanced setup
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Result as plots

About plots
The application can display the results as two-dimensional plots for easier analysis. Before or after you take measurements, you can set
up the Select Plots and Plots Configure menus to define up to four plots. The last plot selected is displayed when the application completes
Sequencing.

Note: Plots are not available for DDR tJIT(duty), DDR tJIT(per), DDR tERR(n), DDR tERR(m–n), PCIe Tmin-Pulse, PCIe Med-Mx
Jitter, PCIe Tmin-Pulse-Tj, PCIe Tmin-Pulse-Dj, USB UI,DDR VID(ac), USB SSC FREQ DEV MAX and USB SSC FREQ DEV
MIN, ps21TXand T-TX-DDJ measurements.

If you set up plots after sequencing, the application displays the plot based on the current measurement and result.

Note: When taking measurements in the Run mode, you must stop the sequencing before you can use some plot features.

Figure 163: Plots

Table 99: Plot type definitions

Item Description

Time Trend Represents the measurement values versus the time location.

Data Array Represents the measurement values versus the index number of the measurement array.

Histogram 22 Represents measurements sorted by value as a distribution of measurement values versus the
number of times the value occurred.

Spectrum Represents the frequency content computed using the FFT of the Time Trend of the measurement
data.

Transfer Represents the magnitude ratio of spectrum of time trend data of two measurements from the following
set: Clock Period, Clock Frequency, Clock TIE, Clock PLL TIE, Data Period, Data Frequency, Data
TIE, Data PLL TIE.

Phase Noise 23 Represents the phase noise of a clock signal and is plotted in the frequency domain for only Clock TIE
measurements.

Table continued…

22 Available for all measurements except Mask Hits, DDR tJIT(duty), DDR tJIT(per), DDR tERR(n), DDR tERR(m–n), PCIe Tmin-Pulse, PCIe UI, and PCIe Med-Mx
Jitter.

23 Available only for Phase Noise measurement.
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Item Description

Eye Diagram 24 Represents data for the eye diagram based on the recovered clock as the timing reference; used for
mask testing.

Waveform 25 Represents the acquired waveform. It is available for use with eye diagram mask tests to locate bit
errors in the real-time waveform.

Bathtub 26 Represents the Bit Error Rate versus the unit interval for measurements that include RJ-DJ analysis.

Q-Bathtub 27 Represents Q-Scale value versus the Unit interval for the PCIe 3 Uncorrelated Jitter Measurements.

Q-PulseWidth 28 Represents Q-Scale value versus Time for the PCIe 3 Uncorrelated Pulse Width Jitter Measurements.

Composite Jitter Hist Plots four Histograms (TJ, RJ+BUJ, PJ, DDJDCD) together.

Noise Bathtub 29 This plot shows the extrapolated curves due to noise like the way Bathtub plot shows the extrapolated
curve due to jitter.

BER Eye Contour 30 31 This plot shows the Bit Error Rate contours at standard BER Levels like 1e-6, 1e-9, 1e-12, 1e-15,
1e-18 and Target BER on top of an accumulated eye diagram.

Correlated Eye This plot shows the data dependent eye with all uncorrelated effects removed.

PDF Eye This plot shows the underlying statistical model used to generate the BER contours.

BER Eye This plot shows the probability of a hit vs the location in the eye.

You can select the measurements from the displayed measurement list table on the left. The Plots for the selected measurements are
displayed in Select Plots. The plots which are not applicable for the selected measurement are not available under Select Plots. You can
select up to 4 plots.

Plot usage
This section provides a description of various plots of DPOJET.

Histogram plot usage

A Histogram plot displays the results such that the horizontal axis represents the measurement values and the vertical axis represents
the number of times that each value occurred. Unlike most other plots, a histogram plot can accumulate measurements over multiple
acquisitions, up to a total population size of 2.1 billion.

Histograms are particularly useful in analyzing jitter. A histogram of the Time Interval Error (TIE) represents the basis of jitter analysis using
a histogram approach. In a histogram, Deterministic Jitter (DJ) is bounded so that the horizontal span of the plot will remain relatively

24 Available only for all Eye, TIE and PCIe-T-TXA measurements.
25 Available only for Mask Hits measurement.
26 Available only for TJ@BER and Width@BER measurements.
27 Available only for PCIe TTX-UDJDD and PCIe TTX-UTJ measurements.
28 Available only for PCIe TTX-UPWTJ and PCIe TTX-UPWDJDD measurements.
29 Available only for TN@BER measurement.
30 Available only for Phase Noise measurement.
31 Available only for TN@BER measurement.
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constant. Random Jitter (RJ) is unbounded and amplitude (horizontal span) will continue to grow as more population is acquired. The TIE
histogram provides a good way to quickly and informally assess jitter.

Spectrum plot usage

A Spectrum plot is obtained from the Fourier Transform of measurement data from a Time Trend. This plot is useful in identifying periodic
frequency components that contribute to timing errors, such as phase modulation.

When the signal has a repetitive data pattern, an analysis of the TIE Spectrum of the signal can be used to separate Random Jitter
(RJ) from Deterministic Jitter (DJ) as well as to separate subcomponents such as Periodic Jitter (PJ), ISI and DCD. Spectral components
(spikes ) that do not correlate with the frequencies contained in the data pattern can be a clue that external deterministic noise sources are
coupling into a system.

Data array plot usage

A Data Array plot shows measurement values versus measurement index, where the indexes are always equally spaced along the
horizontal axis. In contrast, the measurement values on a Time Trend plot are not equally spaced along the horizontal time axis.

Time trend plot usage

A Time Trend plot is a waveform trace of a measurement versus time. Each measurement value is placed precisely at the time at
which the measurement took place. Measurements that involve two timing points are placed at the midpoint between those two time. For
example, a Risetime measurement is placed halfway between the low threshold crossing and the high threshold crossing.

A Time Trend plot is useful, for example, in determining if the embedded clock in a serial bit stream is modulated outside the capabilities of
your receiver to recover the clock. If the TIE time trend plot starts to take an unexpected periodic shape, then this could indicate that you
have uncorrelated periodic jitter from crosstalk or from power supply coupling.

Bathtub plot usage

A Bathtub curve is the industry standard way of viewing the statistical Jitter Eye Opening. A Bathtub curve represents eye opening as
a function of the BER (Bit Error Ratio). Most serial standards call for Total Jitter to be measured at a BER of 10-12. The eye opening
represented by the Bathtub Curve is what is left of the unit interval after the total jitter measurement is subtracted.

The Jitter Eye opening and the Total Jitter have the following relationship:

Total Jitter + Jitter Eye Opening = 1 Unit Interval

The Bathtub Curve plot shows the eye opening and total jitter values as functions of the BER level. The plot is obtained from jitter analysis
that performs RJ-DJ separation.
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Figure 164: Bathtub Curve plot

Q-Bathtub plot usage

TTX-UTJ and TTX-UDJDD are two jitter measurements in the PCI Express 3.0 Compliance Specification. The Q-Bathtub plot provides a
graphic visualization of the Q-Scale extrapolation used to arrive at the measurement value. The plot represents the Q-Factor value on the
y-axis over one unit interval on the x-axis and the extrapolation points are clearly indicated.

Q-PulseWidth plot usage

TTX-UPWTJ and TTX-UPWDJDD are two critical jitter measurements in the PCI Express 3.0 Compliance Specification. The Q-PulseWidth
plot provides a graphic visualization of the Q-Scale extrapolation used to arrive at the measurement value. The Q-Factor values lie on the
y-axis, and the x-axis represents a part of one unit interval significant for the measurement.

Phase noise plot usage

A Phase Noise plot shows a frequency domain view of the jitter noise on a waveform normalized in an industry-standard way. The vertical
axis is logarithmic and uses the units of dBc/Hz, which means “decibels (relative to the carrier) per Hertz”. The horizontal axis is logarithmic
with units.

Transfer function plot usage

A Transfer Function plot shows the magnitude ratio of the frequency spectrums of two measurements on logarithmic axes. This can be a
useful way to depict the response of a system to stimuli at various frequencies, or to identify poles and zeros in a system characteristic
equation. Suppose that x(t) is a jitter measurement at the input of a device, and y(t) is a corresponding jitter measurement at the output of
the device. The Transfer Function plot can be used to show the following function, where X(f) is the Fourier Transform of x(t):

The horizontal axis of the Transfer Function plot goes up to the Nyquist frequency of X or Y, whichever is lower. These plots work best if
averaged across multiple acquisitions to reduce the effects of measurement noise.

Waveform plot usage

The waveform plot is only applicable to the Mask Hits measurement. It depicts a copy of the source waveform, with all mask violations
denoted in a highlight color. These are the same violations that appear on the Mask Hits eye diagram, but the waveform plot allows them to
be seen in the context of a continuous-time waveform.
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Eye diagram plot usage

An eye diagram is a plot of the voltage versus time for a serial bit stream, with the time axis “wrapped” so that all unit intervals are
superimposed on top of each other in a time-aligned fashion. Because the resulting plot has many waveforms overlaid, color grading is
used to separate areas with many coincident waveforms from areas that are only rarely crossed.

If there is an area free of waveforms in the center of the diagram, the eye is said to be “open”, and a comparator circuit repetitively
sampling the waveform at this point in the unit interval could unambiguously separate the two logic states. For experienced signal integrity
engineers, the eye diagram allows many common problems to be recognized instantly.

Composite jitter histogram plot usage

Composite Jitter Histogram plots 4 histograms (TJ, PJ, RJ+BUJ, DDJDCD) together. This will be helpful in analyzing 4 components of jitter
together. Configurations for this plot are the same as that of Histogram Plot. This plot is only applicable for Jitter measurements.

BER Eye contour plot usage

This plot shows the Bit Error Rate contours at standard BER Levels like 1e-6, 1e-9, 1e-12, 1e-15, 1e-18 and Target BER on top of an
accumulated eye diagram.

Noise Bathtub plot usage

This plot shows the extrapolated curves due to noise like the way Bathtub plot shows the extrapolated curve due to jitter.

Composite noise histogram plot usage

Composite noise histogram plots 5 histograms (TN, PN, RN+NPN, DDN0, DDN1) together. This will be helpful in analysing 5 components
of noise together.Configurations for this plot are the same as that of Histogram Plot. This plot is only applicable for Noise measurements.

Correlated Eye plot usage

This plot shows the data dependent eye with all uncorrelated effects removed.

PDF Eye plot usage

This plot shows the underlying statistical model used to generate the BER contours.

BER Eye plot usage

This plot shows the probability of a hit vs the location in the eye.

Selecting plots
Before or after you take measurements, you can set up plots for the selected measurements by following these steps:

Figure 165: Selecting plots

1. Click Plots in the Navigation panel to view the Select Plot window. The currently active measurements and source(s) are displayed in
the table on the left (measurement table).

2. Click any of the plot icons that are available for the selected measurement. The corresponding plot type and measurement are then
added to a table on the right (plot table).
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3. Add another plot for the current measurement, or select a different measurement and choose from its plot types. A maximum of four
plots can be selected at any given time.

Table 100: Plot selections

Item Description

Plots Lists only the plots which are available for the selected measurement. Click a plot icon to add the plot
type to the table on the right.

Clear Selected Clears the selected plot from the plot table.

Clear All Clears all plots from the plot table.

Configure Allows you to adjust display options for the selected plot.

 

Configuring plots

About configuring plots
Most plot types (except Data Array and Waveform) have display options that can be adjusted for each instance of the selected plot.

Figure 166: Configuring plots

The steps to configure a plot are:

1. Select a plot instance by clicking on a row from plot table on the right.
2. Click Configure to display a pop-up window with the available configuration options.
3. Adjust the configuration options and click OK to accept the changes and close the window.
4. Click Show Plots in the control panel to view the configured plot.

Note: The Show Plots icon appears in the only when one or more plots are defined.

Related topics

Configuring a time trend on page 191

Configuring a histogram plot on page 192

Configuring a spectrum plot on page 190

Configuring a transfer plot on page 193
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Configuring a phase noise plot on page 194

Configuring an eye diagram for mask hits on page 197

Configuring an eye diagram plot for eye height on page 195

Configuring a noise bathtub plot on page 202

Configuring a composite jitter histogram plot on page 200

Configuring a composite noise histogram plot on page 201

Configure a BER Eye contour plot on page 203

Configure a BER Eye plot on page 204

Configure a Correlated Eye plot on page 205

Configure a PDF Eye plot on page 206

Configuring a bathtub plot
Select a Bathtub plot in the table on the right and click Configure to configure the plot.
Figure 167: Configuring a bathtub plot

Table 101: Configuring a bathtub plot

Item Description

Vertical Scale Select the Vertical Scale as

1. Log for logarithmic scaling of Vertical axis.(default)
2. Linear for linear scaling of Vertical axis.

Minimum displayed BER = 1E-? Sets the lower axis for logarithmic plots to this value (expressed as the negative of a base-10
exponent).

X-Axis Unit Select the X-Axis Unit as Unit Interval or Seconds.

OK Accepts the changes and closes the window.

Configuring a spectrum plot
Select a Spectrum plot in the table on the right to and click Configure to configure the plot. 
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Figure 168: Configuring a spectrum plot

Table 102: Configuring a spectrum plot

Item Description

Log Selects logarithmic scaling for the vertical axis.

Linear Selects linear scaling for the vertical axis.

Base Sets the lower axis limit for logarithmic plots to this value (expressed as a base-10 exponent).
Available only when the vertical scale is log.

Log Selects logarithmic scaling for the horizontal axis.

Linear Selects linear scaling for the horizontal axis.

Mode Selects whether the plot shows only the most recent spectrum, the uniform average of all spectrums
since the last time the results were cleared, or the peak of the envelope of all spectrums since the last
time the results were cleared.

Normal - Shows magnitude values from the most recent acquisition.

Average - Averages the magnitude values at each frequency.

Peak Hold - Keeps the maximum value at each frequency.

OK Accepts the changes and closes the window.

Configuring a time trend
Select a Time Trend plot in the table on the right and click Configure to configure the plot.
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Figure 169: Configuring a time trend

Table 103: Configuring a time trend

Item Description

Vector Connects measurement points with straight lines to form a continuous waveform.

Bar Places a vertical bar at the horizontal position of each measurement with a height (positive or negative)
that represents the value of that measurement; a horizontal baseline represents the mean value of the
Time Trend.

OK Accepts the changes and closes the window.

Configuring a histogram plot
Select a Histogram plot in the table on the right and click Configure to configure the plot.

Figure 170: Configuring a histogram plot

Table 104: Configuring a histogram plot

Item Description

Vertical Scale

Linear Selects linear scaling for the vertical axis.

Table continued…
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Item Description

Log Selects logarithmic scaling for the vertical axis.

Resolution Defines resolution by the number of bins into which Span is divided: 25, 50, 100, 250, 500, 2000, and
Maximum.

Horizontal Scale

Auto Scale Causes the horizontal scale of the histogram to be adjusted automatically based on the accumulated
data points. If subsequently acquired data falls outside the current horizontal scale, histogram bins are
consolidated so that the number of bins is preserved and the horizontal scale allows all data to be
plotted. When checked, disables the “Center” and “Span” numerical inputs.

Center Manually sets the value for the horizontal center of the Histogram, for subsequent plot updates. You
can set values up to 1 as (atto second) using your keyboard.

Span Manually sets the value for the total horizontal range of the Histogram, for subsequent plot updates.
You can set values up to 1 as (atto second) using your keyboard.

Autoset Uses the results of the latest acquisition to determine the logical values for the Center and Span
options (if the population of the measurement is three or more).

OK Accepts the changes and closes the window.

Configuring a transfer plot
Select a Transfer Function plot in the table on the right and click Configure to configure the plot.

Figure 171: Configuring a transfer plot

Table 105: Configuring a transfer plot

Item Description

Definition

Table continued…
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Item Description

Numerator Measurement for which the magnitude spectrum is used as a reference.

Denominator Measurement for which the magnitude spectrum is used to normalize the numerator.

Vertical Scale

Linear Selects linear scaling for the vertical axis.

Log Selects logarithmic scaling for the vertical axis (default).

Horizontal Scale

Linear Selects linear scaling for the vertical axis.

Log Selects logarithmic scaling for the horizontal axis (default).

Mode Selects whether the plot shows only the most recent spectrum, or the uniform average of all spectrums
since the last time the results were cleared (default).

Normal - updates the plot with current values.

Average - averages the magnitude values at each frequency.

OK Accepts the changes and closes the window.

Configuring a phase noise plot
Select a Phase Noise plot in the table on the right and click Configure to configure the plot.

Figure 172: Configuring a phase noise plot
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Table 106: Configuring a phase noise plot

Item Description

Vertical Position

Baseline Sets the lower axis limit for logarithmic plots to this value.

Smoothening Filter Select the Smoothening filter value from the drop-down option. It displays the selected filter values.

OK Accepts the changes and closes the window.

Configuring an eye diagram plot for eye height
Select an Eye Diagram plot (for all eye measurements other than Mask Hits) in the table on the right and click Configure to configure the
plot.

Figure 173: Configuring an eye diagram plot for eye height

Table 107: Configuring an eye diagram plot for eye height

Item Description

Mask

On Enables display and mask testing.

Table continued…
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Item Description

Off Disables display and mask testing.

Browse Select a mask file to import from the
C:\Users\Public\Tektronix\TekApplications\DPOJET\Masks directory.

Horizontal Scale

Auto Scale When checked, causes the horizontal scale to be adjusted automatically.

Resolution Manually sets the horizontal resolution, when Auto Scale is unchecked.

Superimpose Reference Clock
Eye (if available)

When checked, superimposes DQS eye onto the data eye diagram.

Ref Clock Amplitude

Scale to Ref Clock Scales the waveform to the one which is larger among the superimposed eye when the Superimpose
Reference Clock Eye option is checked.

Scale to Data Autoscales to the vertical height of the data signal (DQ as in DDRA) without regard to the reference
clock (DQS) signal amplitude.

Ref Clock Alignment Determines how an eye diagram is positioned on the plot. The position is determined by the eye
reference point, which is the location of overlapping recovered or explicit clock edge locations.
Typically, the eye is located so that waveform edges are approximately at 25% and 75% of the
width of the diagram. This ensures that the eye opening is centered on the plot facilitating cursor
measurements and mask testing.

Auto Determines the alignment property automatically. Eye diagram is aligned automatically. Auto is typically
equivalent to Left.

Center Eye reference point is centered on the plot. Center alignment is appropriate for DDR Write bursts or
other signals with explicit reference clock where the clock and data signals are out of phase.

Left Eye reference point is positioned on the left of the plot so that eye opening is centered. Left alignment
is appropriate for DDR Read bursts and signals with recovered clock or explicit clock where the clock
and data signals are in phase.

User Defined Vertical Range When checked, min and max values entered by you will be taken for y axis of eye diagram

User Defined Horizontal Range When checked, min and max value entered by you will be taken for x axis of eye diagram. If the
entered range is not valid, a warning message gets displayed with the available x range.

Vertical Alignment When checked, aligns the mean of clock waveform to the mean of the data waveform. This is useful
when the mean of data waveform is not matching to the mean of clock waveform.

Interpolation When selected, performs eye rendering for a reduced set of Unit intervals. It also performs
interpolation between samples and gives a finer rendering appearance.

Table continued…
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Item Description

Non-Interpolation When selected, performs eye rendering for the complete set of Unit intervals. This option does not
perform any interpolation and gives a coarser rendering appearance.

Save Eye Diagram Raw Data By clicking Browse button, it saves the raw Eye Diagram 2d histogram data to the specified file path.
The Format is determined through the filename extension.

OK Accepts the changes and closes the window.

Related topics

Effect of nominal clock offset on eye diagrams on page 90

Note: If there is unwanted skew between the data and explicit clock signals, the channels must be properly deskewed. Refer to
your oscilloscope online help on how to deskew the channels.

Configuring an eye diagram for mask hits
An eye diagram plot is activated whenever a mask hits measurement is selected. Click Configure in the plots panel to configure the plot.

Figure 174: Configuring an eye diagram for mask hits
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Table 108: Configuring an eye diagram for mask hits

Item Description

Mask Shows which mask has been selected (for the Mask Hits measurement, the mask selection is
performed as part of measurement configuration rather than plot configuration).

Horizontal Scale

Auto Scale When checked, causes the horizontal scale to be adjusted automatically.

Resolution Manually sets the horizontal resolution, when Auto Scale is unchecked.

Superimpose Reference Clock
Eye (if available)

When checked, superimposes DQS eye onto the data eye diagram.

Ref Clock Alignment Determines how an eye diagram is positioned on the plot. The position is determined by the eye
reference point, which is the location of overlapping recovered or explicit clock edge locations.
Typically, the eye is located so that waveform edges are approximately at 25% and 75% of the
width of the diagram. This ensures that the eye opening is centered on the plot facilitating cursor
measurements and mask testing.

Auto Determines the alignment property automatically. Eye diagram is aligned automatically. Auto is typically
equivalent to Left.

Center Eye reference point is centered on the plot. Center alignment is appropriate for DDR Write bursts or
other signals with explicit reference clock where the clock and data signals are out of phase.

Left Eye reference point is positioned on the left of the plot so that eye opening is centered. Left alignment
is appropriate for DDR Read bursts and signals with recovered clock or explicit clock where the clock
and data signals are in phase.

User Defined Vertical Range When checked, min and max values entered by you will be taken for y axis of eye diagram

User Defined Horizontal Range When checked, min and max value entered by you will be taken for x axis of eye diagram. If the
entered range is not valid, a warning message gets displayed with the available x range.

Vertical Alignment When checked, aligns the mean of clock waveform to the mean of the data waveform. This is useful
when the mean of data waveform is not matching to the mean of clock waveform.

Save Eye Diagram Raw Data By clicking Browse button, it saves the raw Eye Diagram 2d histogram data to the specified file path.
The Format is determined through the filename extension.

Rendering Technique -
Interpolation, Non-Interpolation

Eye diagram can be rendered using Interpolation or Non-Interpolation technique.

OK Accepts the changes and closes the window.

Related topics

Effect of nominal clock offset on eye diagrams on page 90
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Note: If there is unwanted skew between the data and explicit clock signals, the channels must be properly deskewed. Refer to
your oscilloscope online help on how to deskew the channels.

Configuring an eye diagram for DFE measurements
An eye diagram plot is activated whenever a DFE EH, DFE EW, or DFE Eye Diagram measurement is selected. Click Configure in the
plots panel to configure the plot. 

Figure 175: Configuring an eye diagram for DFE measurements

Table 109: Configuring an eye diagram for DFE measurements

Item Description
Mask
On Enables display and mask testing.
Off Disables display and mask testing.
Browse Select a mask file to import from the

C:\Users\Public\Tektronix\TekApplications\DPOJET\Masks directory.
Horizontal Scale
Auto Scale When checked, causes the horizontal scale to be adjusted automatically.
Resolution Manually sets the horizontal resolution, when Auto Scale is unchecked.
Superimpose Reference Clock
Eye (if available)

When checked, superimposes DQS eye onto the data eye diagram.

Ref Clock Amplitude
Scale to Ref Clock Scales the waveform to the one which is larger among the superimposed eye when the Superimpose

Reference Clock Eye option is checked.
Table continued…

Jitter, Noise and Eye Diagram Analysis

DPOJET Jitter, Noise and Eye Diagram Analysis Solution Application Help 199



Item Description
Scale to Data Autoscales to the vertical height of the data signal (DQ as in DDRA) without regard to the reference

clock (DQS) signal amplitude.
Ref Clock Alignment Determines how an eye diagram is positioned on the plot. The position is determined by the eye

reference point, which is the location of overlapping recovered or explicit clock edge locations.
Typically, the eye is located so that waveform edges are approximately at 25% and 75% of the
width of the diagram. This ensures that the eye opening is centered on the plot facilitating cursor
measurements and mask testing.

Auto Determines the alignment property automatically. Eye diagram is aligned automatically. Auto is typically
equivalent to Left.

Center Eye reference point is centered on the plot. Center alignment is appropriate for DDR Write bursts or
other signals with explicit reference clock where the clock and data signals are out of phase.

Left Eye reference point is positioned on the left of the plot so that eye opening is centered. Left alignment
is appropriate for DDR Read bursts and signals with recovered clock or explicit clock where the clock
and data signals are in phase.

User Defined Vertical Range When checked, min and max values entered by you will be taken for y axis of eye diagram
User Defined Horizontal Range When checked, min and max value entered by you will be taken for x axis of eye diagram. If the

entered range is not valid, a warning message gets displayed with the available x range.
Vertical Alignment When checked, aligns the mean of clock waveform to the mean of the data waveform. This is useful

when the mean of data waveform is not matching to the mean of clock waveform.
Interpolation When selected, performs eye rendering for a reduced set of Unit intervals. It also performs

interpolation between samples and gives a finer rendering appearance.
Non-Interpolation When selected, performs eye rendering for the complete set of Unit intervals. This option does not

perform any interpolation and gives a coarser rendering appearance.
Interpolation Factor When selected, performs eye rendering technique for interpolation with the selected factor.

Available values are:

• Auto
• 12.8
• 16

Note: Applicable only for DFE EW, DFE EH and DFE Eye diagram measurements.

Save Eye Diagram Raw Data By clicking Browse button, it saves the raw Eye Diagram 2d histogram data to the specified file path.
The Format is determined through the filename extension.

OK Accepts the changes and closes the window.

Related topics

Effect of nominal clock offset on eye diagrams on page 90

Note: If there is unwanted skew between the data and explicit clock signals, the channels must be properly deskewed. Refer to
your oscilloscope online help on how to deskew the channels.

Configuring a composite jitter histogram plot
Select the Composite Jitter Histogram (CJH) plot from the list on the right and click Configure to configure the plot.
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Figure 176: Configuring a composite jitter histogram plot

Table 110: Composite jitter histogram plot

Item Description

Vertical Scale Select the Vertical Scale as

1. Log for logarithmic scaling of Vertical axis.
2. Linear for linear scaling of Vertical axis (default).

Number of Bins

Resolution Defines resolution by the number of bins into which Span is divided: 25, 50, 100, 250, 500, 2000, or
Maximum.

Jitter Components Selected checkbox values will be plotted

• TJ
• RJ+NPJ
• PJ
• DDJ+DCD

By default , all Jitter components will be checked.

OK Accepts the changes and closes the window

Note: In CJH plot, the RJ+NPJ histogram values and RJ Trend are analytical values when RJ is locked.

Configuring a composite noise histogram plot
Select the Composite Noise Histogram plot from the list on the right and click Configure to configure the plot.

Jitter, Noise and Eye Diagram Analysis

DPOJET Jitter, Noise and Eye Diagram Analysis Solution Application Help 201



Figure 177: Configuring a composite noise histogram plot

Table 111: Composite noise histogram plot

Item Description

Horizontal Scale Select the Horizontal Scale as

1. Log for logarithmic scaling of horizontal axis.
2. Linear for linear scaling of horizontal axis (default).

Number of Bins

Resolution Defines resolution by the number of bins into which Span is divided: 25, 50, 100, 250, 500, 2000, or
Maximum.

Noise Components Selected checkbox values will be plotted

• TN
• RN+NPN
• PN
• DDN(0)
• DDN(1)

By default , all Noise components will be checked.

OK Accepts the changes and closes the window

Configuring a noise bathtub plot
Select a Noise bathtub plot in the table on the right and click Configure to configure the plot. 
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Figure 178: Configuring a noise bathtub plot

Table 112: Configuring a noise bathtub plot

Item Description

Horizontal Scale Select the Horizontal Scale as

1. Log for logarithmic scaling of horizontal axis (default).
2. Linear for linear scaling of horizontal axis.

Minimum displayed BER = 1E-? Sets the lower axis for logarithmic plots to this value (expressed as the negative of a base-10
exponent).

Y-Axis Unit Select the Y-Axis Unit as Unit Amplitude or Volts.

Default - Unit Amplitude

OK Accepts the changes and closes the window.

Configure a BER Eye contour plot
Select a BER Eye contour plot from the list on the right and click Configure to configure the plot. 
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Figure 179: Configure a BER Eye contour plot

Table 113: Configure a BER Eye contour plot

Item Description

Mask

On Enables display and mask testing.

Off Disables display and mask testing.

Browse Select a mask file to import from the
C:\Users\Public\Tektronix\TekApplications\DPOJET\Masks directory.

Contour and Eye rendering

BER contours to display Enables the user to select or de-select BER contours of interest. By default, all the standard BER
contours are selected.

Note: Target BER determines the Target BER value which is configured in RJDJ or RNDN for
the measurements. The default Target BER value is (1E-12).

OK Accepts the changes and closes the window.

Configure a BER Eye plot
Select a BER Eye plot from the list on the right and click Configure to configure the plot. 
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Figure 180: Configure a BER Eye plot

Table 114: Configure a BER Eye plot

Item Description

Contour and Eye rendering

BER contours to display Enables the user to select or de-select BER contours of interest. By default, all the standard BER
contours are selected.

OK Accepts the changes and closes the window.

Configure a Correlated Eye plot
Select a Correlated Eye plot from the list on the right and click Configure to configure the plot. 

Figure 181: Configure a Correlated Eye plot

Table 115: Configure a Correlated Eye plot

Item Description

Contour and Eye rendering

BER contours to display Enables the user to select or de-select BER contours of interest. By default, all the standard BER
contours are un-selected.

Table continued…
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Item Description

OK Accepts the changes and closes the window.

Configure a PDF Eye plot
Select a PDF Eye plot from the list on the right and click Configure to configure the plot. 

Figure 182: Configure a PDF Eye plot

Table 116: Configure a PDF Eye plot

Item Description

Contour and Eye rendering

BER contours to display Enables the user to select or de-select BER contours of interest. By default, all the standard BER
contours are selected.

OK Accepts the changes and closes the window.

Viewing plots

About viewing plots
You can create and configure up to four plots. If you already have measurement results, creating a plot will cause it to be displayed
immediately. If there are no current results, the plot will be created when you sequence the application and results have been calculated.

The Show Plots icon appears in the control panel whenever at least one plot is defined. The Show Plots  icon appears in the
control panel whenever at least one plot is defined. By default, all defined plots windows are grouped in a single window on the upper
half of the display, but the window can be moved, resized, or dragged to a second monitor. The application includes tools to help you
select which plots to view, to size and position the plot windows, to save plot information, to use the zoom function, and to use the cursors
functions.

If your Windows desktop is extended to a second monitor, you can drag the plots window to the second monitor.
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Note: When sequencing is complete, the plot window displays with the last plot selected. The plot window also updates whenever
you reconfigure a plot.

Using a second monitor to view plots
If your oscilloscope setup includes a second monitor that extends the Windows desktop, you can select and drag the title bar of the plot
window to position it in the second monitor. This allows you to simultaneously display a waveform on the oscilloscope, measurement
results, and the plot for easy viewing.

Toolbar functions in plot windows
The Plot Toolbar window includes the following functions:

Figure 183: Plot toolbar functions

Table 117: Plot toolbar functions

Icon Functions

Export Figure.

Print Figure.

Zoom and Pan.

Vertical and Horizontal Cursor controls.

Moving and Resizing Plots.

Plot properties.

Plot Summary Views.

Full view of plots 1 to 4.

Moving and resizing plots
You can move and resize plot windows the same way you would move and resize any window.

You can change the plot size to the whole display of the oscilloscope, or to half the display. When viewing a plot in half the display, you can
position the plot to the top or bottom. The tools also return the plot to the original size. To position a plot quickly on the oscilloscope, select
one of the following tools in the plot window:

•  enlarges the plot to fill the entire display.

•  positions the plot to the top.

•  positions the plot to the bottom.
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•  always keep the plot on top layer.

Using zoom in a plot
Once you have created a plot, you can use the Zoom tools to examine the data at various scales.

Tip: If you prefer to use the zoom functions in a plot window with your finger, you can activate the Touch Screen on the
oscilloscope.

Table 118: Zoom functions in a plot

Item Description

Zoom in (Horizontal and Vertical) – Expands part of the plot; the data appears in more detail.

Zoom out – Contracts part of the plot; the data appears in less detail.

Zoom in (Horizontal only) – Expands the horizontal axis only and retains the vertical axis.

Resets the zoom to 100%.

Changing the scale of data in a plot (Zoom)
To change the scale of the data in a Plot Details window, select one of the following plot zoom tools:

•  zooms in to expand the scale.

•  zooms out to contract the scale.

•  zooms in to expand the horizontal axis only.

•  moves the plot anywhere within the scale.

•  zooms in to restore the entire waveform data.

When you select the  tool, you can use a select-drag-release action to expand part of the waveform (zoom in) by an arbitrary amount
on both axes. After you select (touch with a finger or click with the mouse) and begin dragging, a bounding box shows what part of the
waveform will be expanded upon release.

Select any part of the plot to expand the data by a factor of two (2X) equally on both axes. Double selecting expands the data to the
maximum factor.

To contract an expanded part of the data (zoom out), select anywhere on the data. The view contracts to the values that existed before the
most recent expansion of the data. Selecting multiple times will restore successively earlier views. To expand the scale of the horizontal
axis only by a factor of two (2X), click a part of the waveform. The plot retains the scale of the vertical axis.

Tip: Select  to see the entire available waveform.

Using cursors in a plot
Cursors allow you to view numerical values associated with a plot based on cursor locations. There are two types of cursors:

• Horizontal cursors
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• Vertical cursors

Table 119: Cursor functions in a plot

Item Description

Displays the vertical coordinate where each cursor touches the plot and the difference (Δ) between the
cursors.

Displays the horizontal coordinate where each cursor touches the plot and the difference (Δ) between
the cursors.

Brings the cursors into the visible part of the plot.

Displays the plot properties.

Cursors in a plot
You can use cursors to read the coordinate where each cursor (line) touches the plot and also view the difference (Δ) between the two
cursors. The steps to use cursors in a plot details window are:

1. Select any of the following cursors:

•  to use horizontal cursors.

•  to use vertical cursors.

•  to bring cursors into the visible plot.
2. Select and drag either cursor to move the cursor to the desired part of the plot. The cursor readout changes to reflect the cursor

position.

Note: You can drag cursors only when the Zoom functions are disabled.

Tip: If you prefer to move the cursors in the plot window with your finger, you can activate the touch screen on the oscilloscope.

Exporting plot files

You can export plot image in Plot Toolbar window. Click  to save the contents of the plot window in any of the format as a MATLAB
figure format (.fig), .bmp, .jpg, .png, .emf, .tif, .mat and .csv.

The steps to export a plot file are:

1. Set up the plot window.

2. Select  to save the plot as a figure.
3. Select the directory and enter a file name.
4. Click Save. The application saves the file in C:\%USERPROFILE%

\Tektronix\TekApplications\DPOJET\images, where %USERPROFILE% represents your user location.
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Printing plots
The steps to print a plot are:

1. Verify that the printer is configured.
2. Set up the plot window with zoom, cursors, or grid functions.

3. Click  icon in the plot details/summary window. The Print Preview dialog is displayed.

4. Click  to set up the printing options and print a plot file.

Note: You can customize the print layout using the MATLAB page setup options. The DPOJET online help does not provide
information on MATLAB page setup. For more information, refer to the MATLAB documentation.

Reports
The Reports menu has the following command buttons:

• Save
• Save As
• Append
• View
• Add/Edit comments

Table 120: Reports parameters

Option Parameters Default setting
Auto increment report name if duplicate Set, Clear Set
View report after generating Set, Clear Set
Content to Save
Include pass/fail results summary Set, Clear Set
Include detailed results Set, Clear Set
Include plot images Set, Clear Set
Include setup configuration Set, Clear Set
Include user comments Set, Clear Set
Include complete application configuration Set, Clear Set
Save Waveform file(s) along with report Set, Clear Clear
Report Name Browser C:\%USERPROFILE%

\Tektronix\TekApplications\
DPOJET\Reports, where
%USERPROFILE% represents your user
location.

Report Type Web Archive (*.mht), PDF (*.pdf) PDF (*.pdf)

About reports
You can use the Reports to configure and generate a compliance report to view later or to share with others. You can also access reports
using Analyze > Jitter and Eye Analysis (DPOJET) > Reports. You can select the option which you want to display in the report as
shown in the following table:
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Figure 184: Reports

Note: When only the Mask Hits measurement is selected, the report shows only the Pass/Fail information. If any other
measurement having limits is selected along with the Mask Hits measurement, limit information section is also included in the
generated report.

Table 121: Report generation options

Item Description

Auto increment report name if
duplicate

Select/Clear the option to auto increment the report name if its already
existed. The auto generated report is of YYMMDD_HHMMSS_savedfile.pdf or
YYMMDD_HHMMSS_savedfile.mht format.

View report after generating Select this option to view the report after generation.

Report Name Lists the directory path where the last generated report is stored.

Report Type Saves a report in the selected output format (Web Archive (*.mht), PDF (*.pdf))

Save Saves the changes in the default report directory. Manipulates the report name based on “Auto
increment report name if duplicate” option.

Save As Displays the browser where you specify the directory to save the generated report. You can
also edit the report name in the Save As browser. By default, the generated report is saved in
C:\%USERPROFILE%\Tektronix\TekApplications\DPOJET\Reports, where
%USERPROFILE% represents your user location.

Append Adds the current settings to an existing report.

View Opens the generated report in the default application.

Include pass/fail results summary Select/Clear the option to include/exclude the pass/fail status in the generated report.

Included detailed results Select/Clear the option to include/exclude the measurement result details in the generated report.

Include plot images Select/Clear the option to include/exclude the plot images like measurement plots and oscilloscope
waveform in the generated report.

Saving a report from Internet Explorer does not save plot images.

Include setup configuration Select/Clear the option to include/exclude the setup information like DPOJET version, oscilloscope
version, and status in the generated report.

Table continued…
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Item Description

Include complete application
configuration

Select/Clear the option to include/exclude the complete configuration details in the generated report.

Save waveform file(s) along with
report

Select/Clear the option to include/exclude the oscilloscope waveform details in the generated report.

Include user comments Select the option to include any comments in the generated report. To do so, click the Add/Edit
comments button.

Reports Format
The generated reports are in either in .mht or .pdf format and includes the following configured set of information:

• Comments displays any user comments.
• Setup Configuration such as DPOJET version and oscilloscope version.
• Measurement Configuration such as measurement name, source and other configuration parameters. Click on the measurement name

to view the oscilloscope waveform details.
• Source Reference Levels displays the reference voltage levels for the high, mid, and low thresholds for the rising edge and for the

falling edge of all sources, and the hysteresis.
• Miscellaneous Settings such as Gating, Qualify and Population status.
• Pass/Fail Summary indicating the Pass/Fail status for the selected measurements. Also displays the limits information for

measurements selected along with Mask Hits.
• Measurement Results with statistics.
• Plot Images includes both selected plots and oscilloscope waveforms.
• Reference waveforms stored at includes the location of the waveforms used.

Append Reports
Click the Append button to add the generated report to an existing report of the same format. The application prompts you with a message
“Do you wish to append the current results to xxx.mht”? before the append action.

Figure 185: Append Reports

Whenever user is trying to append to a PDF report which is already opened by another application, following error will appear. Ensure to
close the PDF report before append.
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Note: Time stamp differentiates various appended reports.

Reports compatibility. The application displays a warning when you try to append the report with other reports, generated using previous
versions of DPOJET. Click Yes to overwrite an old report with a newer format.

Figure 186: Reports compatibility

Note: If there is not enough disk space to save the report, the application displays “Cannot save file: There may not be enough
free disk space. Delete one or more files to free disk space, and then try again”.

Printing reports. You need to set the following while printing reports to get the alternate gray and white rows in the table:

• Select Internet Explorer, go to Tools > Internet Options.
• In the Advanced tab, select the option Print Background Color and Images under Printing as shown.
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Figure 187: Print Background Color and Images

Saving waveform files. You can save waveform(s) used for the measurement by checking the option “Save
Waveform file(s) along with report” in the reports screen. The waveforms are stored under C:\%USERPROFILE%
\Tektronix\TekApplications\DPOJET\Reports, where %USERPROFILE% represents your user location.

If one or more waveforms are to be saved, the report name is incremented for every append action by including a number in the
parenthesis as shown:

Note: If the waveform path name is greater than 128 characters, the applications displays a warning even though the waveform is
created with a truncated name (without a .wfm extension).

Add Comments
Check “Include user comments” option to include the comments in the generated report. Click Add comments in the report panel to
include comments in the report. Add Comments changes to Edit Comments in the report panel until all the contents are cleared in the
Comment dialog box.
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Figure 188: Add Comments

Table 122: Comment options

Item Description

Clear Clears the edited contents.

Copy Copies the edited contents.

Paste Pastes the copied contents in the new comments dialog box even after closing the window without
clicking “Ok”.

Cancel Closes the dialog box without saving any added contents.

OK Saves the edited text.
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Tutorial
Introduction to the tutorial
This tutorial teaches how to set up the application, take measurements, and view results as plots or statistics.

Before you begin the tutorial, perform the following tasks:

• Set up the oscilloscope.
• Start the application.
• Recall the tutorial waveform.

Note: The screen captures shown in this section are from a DPO7254 oscilloscope.

Setting up the oscilloscope
The steps to set up the oscilloscope are:

1. Click File > Recall Default Setup in the oscilloscope menu bar to recall the default settings.
2. Press the individual CH1, CH2, CH3, and CH4 buttons as needed to add or remove active waveforms from the display.

Starting the application
Click Analyze > Jitter and Eye Analysis (DPOJET) > Select to open the application.

Waveform files
The application provides the following tutorial waveforms:

• Rt-EyeTutorial.wfm
• ckminus_50gs_18g_20m_pat1.wfm
• ckplus_50gs_18g_20m_pat1.wfm
• dplus_50gs_18g_20m_pat1.wfm
• dminus_50gs_18g_20m_pat1.wfm

The waveform files are found at C:\Users\Public\Tektronix\TekApplications\DPOJET\Examples.

Recalling a waveform file
To recall a waveform file, follow these steps:

1. Click File > Recall in the oscilloscope menu bar to display the Recall dialog box.

Note: If the application is in button mode, select the Recall button to recall the tutorial waveform.

2. Click Waveform icon in the left of the Recall dialog box.
3. Select Ref1, Ref2, Ref3, or Ref4 as the Destination option.
4. Browse to select the waveform. Use the keypad to edit the waveform file name.
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5. Click Recall. The oscilloscope recalls and activates the Reference Waveform control window.
6. Click On to display the waveform.

7. Click  to return to the application. Alternatively, DPOJET can also be accessed from Analyze > Jitter and Eye Analysis
(DPOJET) > Select.

Figure 189: Recalling a waveform file

In the Summary tutorial, the tutorial waveforms are recalled as Math waveforms using the following setup:

• dplus_50gs_18g_20m_pat1.wfm is recalled as Ref1 and dminus_50gs_18g_20m_pat1.wfm as Ref2.

Note: Using Math Setup ( Select Math > Math Setup in the menu bar to view the Math Setup dialog. For more details, refer to
the “Math Equation Editor: Controls in your oscilloscope online help), set .

• ckplus_50gs_18g_20m_pat1.wfm is recalled as Ref3 and ckminus_50gs_18g_20m_pat1.wfm as Ref4.

Note: Using Math Setup, set

Taking a period measurement
In this lesson, you will learn how to take a period measurement and view the results. You can also learn the following tasks:

• Select a measurement and a source
• Configure measurement
• Take measurements
• View results as plots or statistics
• View reports
• Return to the application

Setting up a Period Measurement
Follow these steps to take a period measurement:

1. To set the application to default values, click File > Recall Default Setup. This is not necessary if you have just started the application.
2. To view the DPOJET application, select Analyze > Jitter and Eye Analysis (DPOJET) > Select.
3. Go to Select in the left navigation panel. Click Period in the Measurements area. The application shows the measurement and source

selection on the right of the display. The current measurement selection is displayed as Period1. The subsequent selections will be
Period2, Period3 and so on. In this example, Rt-EyeTutorial.wfm is recalled as Ref1 and is selected as source for Period1. New
measurements initially use the same source as the earlier measurement, or the most recently used source.

Figure 190: Setting up a Period Measurement
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4. Click  or the row which lists the selected measurement to configure the source. Select Ref1 for Period1. For more details, refer to
Source setup.

5. Click Ref Levels Setup. The Configure Reflevel menu appears. For more details, refer to Ref levels.
6. Click Configure in the left navigation panel of the main application window to view the configure tabs. For more details, refer to

Configuring measurements.
7. Click Plots to view the available plots for the selected measurement. Select Time Trend for Period. For more details, refer to

Configuring time trend.
8. Click Single to run the application. When complete, the result statistics is shown in the results tab. The plots are displayed as shown:

Figure 191: Period Measurement plot

Note: You can log result , to a .csv file and to a .wfm file.

Taking a Gated skew measurement
The steps to take a Gated skew measurement are: 

1. To set the application to default values, click File > Recall Default Setup. This is not necessary if you have just started the
application.

2. Go to Measure at the top menu. Click on Gating tab to select Custom Gating.
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Figure 192: custom_gating_selection

3. This opens the Custom Gating window. Custom Gating window allows to configure the gates. Click on any Gate (for eg: Gate 1 in the
below figure) and click On to turn on the gate. You can edit the Left Limit and Right Limit for each of the gates based on their need.
For more details, refer Set up custom gating section under Tekscope Help document.

Figure 193: Custom_gating_window

4. Go to Analyze in the top menu. Click on Jitter and Eye Analysis (DPOJET).
5. Go to Select in the left navigational panel. Click Time tab to select Gated Skew in the Measurements

area. The application shows the measurement and source selection on the right of the display. In
this example, C:\Users\Public\Tektronix\TekApplications\DPOJET\Examples\Waveforms\

Tutorial
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Sine_2M_Ref1.wfm is recalled as Ref1
and C:\Users\Public\Tektronix\TekApplications\DPOJET\Examples\Waveforms\
Sine_2M_Ref2.wfm is recalled as Ref2 and are selected as sources for Gated Skew1.

Figure 194: Gatedskew_Navig_Panel

6. Click  or the row which lists the selected measurement to configure the source. Select Ref1 for Gate1 and Ref2 for Gate 2 as
sources for Gated Skew1. For more details, refer to Source setup

7. Click Ref Levels Setup in the source configuration dialog. The Configure Reflevel menu appears. For more details, refer to Ref
levels.

8. Click Configure in the left navigation panel to view the configure tabs. For more details, refer to Configuring measurements.
9. Click Plots to view the available plots for the selected measurement. Select Time Trend and Histogram for Gated Skew

measurement. For more details, refer to Configure plots.
10. Click Single to run the application. When complete, the result statistics is shown in the results tab. The plots are displayed as

follows:

Figure 195: DPOJET plots

Taking a TIE measurement
For jitter application, use the PLL TIE measurement. The steps to take a TIE measurement are:

1. To set the application to default values, click File > Recall Default Setup. This is not necessary if you have just started the application.
2. Go to Select in the left navigational panel. Click Jitter tab to select TIE in the Measurements area. The application shows the

measurement and source selection on the right of the display. In this example, Rt-EyeTutorial.wfm is recalled as Ref1 and is selected
as source for TIE1.
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Figure 196: TIE measurement

3. Click  or the row which lists the selected measurement to configure the source. Select Ref1 for TIE1. For more details, refer to
Source setup.

4. Click Ref Levels Setup in the source configuration dialog. The Configure Reflevel menu appears. For more details, refer to Ref levels.
5. Click Configure in the left navigation panel to view the configure tabs. For more details, refer to Configuring measurements.

1. Click Plots to view the available plots for the selected measurement. Select Time Trend and Spectrum plots for TIE measurement. For
more details, refer to Configure plots.

2. Click Single to run the application. When complete, the result statistics is shown in the results tab. The plots are displayed as follows:
Figure 197: Plots for TIE measurement

Note: You can log result Statistics, Measurement data points to a .csv file and Worst case waveforms to a .wfm file.

Taking an eye height and width measurement
For signal integrity application, use the Eye Height and Width measurements.

1. Select Analyze > Jitter and Eye Analysis (DPOJET) > Select to run the DPOJET application.
2. Go to Select in the left navigation panel. Click Eye tab to select Height and Width measurement. In this example, Rt-EyeTutorial.wfm is

recalled as Ref1 and is selected as source for Height1 and Width1.

Figure 198: Height and Width measurement
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3. Select Ref1 as source for Height and Width measurements. For more details, refer to Source setup.
4. Click Plots to view the available plots for the selected measurement. Select Eye Diagram for Height measurement.
5. Select Eye diagram Plot type and click Configure to turn on the Mask in the Configure Eye Diagram for Eye Height dialog. For more

details, refer to the Configuring eye diagram plot for eye height.
6. Select Histogram plot for Width measurement.
7. Click Single to run the application. When complete, the result statistics is shown in the results tab.
8. The Plot summary window is displayed as shown in the following figure:

Figure 199: Plot summary window

Note: You can log result Statistics, Measurement data points to a .csv file and Worst case waveforms to a .wfm file.

Summary tutorial
For a summary tutorial, the following example is considered:

Case 1: Period measurement with Low pass filters to show SSC profile:

1. Select Analyze > Jitter and Eye Analysis (DPOJET) > Select to run the DPOJET application. For more details on waveforms
recalled on Math1, Refer Recalling a waveform file.

2. Select Period measurement on Math1.
3. Click Configure. In the Filters configuration tab, select 2nd order low pass filter and specify the cut-off frequency as 33 kHz. (F2=

Fbaud/1667).
4. Go to Plots. Select Time Trend for Period measurement.
5. Click Single to run the application. When complete, the result statistics is shown in the results tab. The Time Trend plot is as shown.

Figure 200: Time Trend plot
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Case 2: A pair of TIE for showing jitter integration caused by SSC and the effect of a high pass filter on SSC spectrum plots:

1. Click Jitter to select TIE measurement.
2. Select Math1 as the source f .

Figure 201: Math1 for TIE1 and TIE2

3. Click Configure. Do the following settings for TIE1 and TIE2 in the Filters configuration tab:

• Select “No Filter” for TIE1.
• Select 2nd order High Pass filter for TIE2. In this example, the F1 cut-off frequency is set to 1 GHz.

4. Go to Plots. Select Time Trend for both TIE1 and TIE2.
5. Select Spectrum plot for both TIE1 and TIE2.
6. Click Single to run the application. When complete, the result statistics is shown in the results tab.
7. A Plot Summary window shows Time Trend plots for TIE1, TIE2 and Spectrum plots for TIE1, TIE2.

Figure 202: Time Trend plots for TIE1, TIE2 and Spectrum plots for TIE1, TIE2

Note: You can log result Statistics, Measurement data points to a .csv file and Worst case waveforms to a .wfm file.

Stopping the tutorial
If you need more than one session to complete the tutorial lessons, you can stop the tutorial and return to it later.

To save the application setup, refer to Saving a setup file. To exit the DPOJET application, click  present at the right corner of the
application.

Returning to the tutorial
To return to the tutorial setup, you can start the application and then recall the saved setup. To recall the application setup, refer to
Recalling a saved setup file.

Tutorial
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Parameters
About parameters
This section describes the DPOJET application parameters and includes the menu default settings. Refer to the user manual for your
oscilloscope for operating details of other controls, such as front-panel buttons.

The parameter tables list the selections or range of values available for each option, the incremental unit of numeric values, and the default
selection or value.

Refer to the GPIB section for a complete list of the GPIB Command Syntax. The topics include a complete list of the GPIB commands
along with the arguments, variables, and variable values that correspond to the DPOJET parameters.

Measurement select parameters
The Measurement Select includes the following measurement categories:

• Period/Freq: Frequency, Period, CC–Period, N–Period, Pos Width, Neg Width, +Duty Cycle, –Duty Cycle, +CC–Duty, –CC–Duty, and
Data Rate.

• Jitter: TIE, RJ, DJ, PJ, DDJ, DCD, RJ–δδ, DJ–δδ, TJ@BER, J2, J9, SRJ, F/N, RJ(h), RJ(v), PJ(h), PJ(v), Jitter Summary, Phase
Noise, SJFreq, PJrms, PkPkClkRJ, PkPkClkDJ, and PkPkClkTJ.

• Noise: RN, RN(v), RN(h), DN, DDN, DDN(1), DDN(0), PN, PN(v), PN(h), NPN, TN@BER, Unit Amplitude, and Noise Summary.
• Time: Rise Time, Fall Time, High Time, Low Time, Setup, Hold, Rise Slew Rate, Fall Slew Rate, Skew, Gated Skew, SSC Profile, SSC

Mod Rate, SSC Freq Dev, SSC Freq Dev Min, SSC Freq Max, and tCMD-CMD.
• Eye: Height, Width, Mask Hits, Autofit Mask Hits, Width@BER, Height@BER, Q-Factor, Eye High, Eye Low, AutoFit Mask Hits, DFE

EyeWidth, DFE_ EyeHeight, DFE_EyeDiagram, and V-Widest Open Eye.
• Ampl: AC RMS, High, Low, DC Common Mode, AC Common Mode, High–Low, T/nT Ratio, Overshoot, Undershoot,  V–Diff –Xovr,

Cycle Min, Cycle Max, Cycle Pk-Pk.
• Standard: Standard-specific measurements are as follows:

• PCI Express: PCIe T-Tx-Diff-PP, PCIe T-TX, PCIe T-Tx-Fall, PCIe Tmin-Pulse, PCIe DeEmph, PCIe T-Tx-Rise, PCIe UI, PCIe
Med-Mx-Jitter, PCIe T-RF-Mismch, PCIe MAX-MIN Ratio (Custom name is PCIe VRX-MAX-MIN Ratio), PCIe SSC FREQ DEV,
PCIe SSC PROFILE, PCIe AC Common Mode.

• USB 3.0 Essentials: USB VTx-Diff-PP, USB TCdr-Slew-Max, USBTmin-Pulse-Tj, USB Tmin-Pulse-Dj, USB SSC MOD RATE, USB
SSC FREQ DEV MAX, USB SSC FREQ DEV MIN, USB SSC PROFILE, USB UI, USB AC Common Mode.

• Optical: AOP, ER, OMA, Optical High, Optical Low, Eye Crossing Level, Eye Crossing Time, Eye Crossing Percent, Mask Hit
Ratio, Mask Margin, RIN, RINxOMA, and TDEC.

You can set the Source option as any of the following waveforms: Ch1, Ch2, Ch3, Ch4, Ref1, Ref2, Ref3, Ref4, Math1, Math2, Math3,
Math4, B1, B2, B3, B4, B5, B6, B7, B8, B9, B10, B11, B12, B13, B14, B15, or B16 (bus source types are applicable for bus measurements
only).

Table 123: Source parameters

Option Parameters Default
Source1 Ch1-Ch4, Math1-Math4, Ref1-Ref4 Ch1
Source1 B1–B16 User should configure
Source2 Ch1-Ch4, Math1-Math4, Ref1-Ref4 Ch2
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Autoset parameters
The Configure Source Autoset includes the following command buttons:

• Vert Scale
• Horiz Res
• Vert & Horiz
• Undo

Ref level menu parameters
The Configure Ref Level menu parameters includes the following command buttons:

• Autoset
• Setup

Table 124: Ref level menu parameters

Option Parameters Default setting

Source Ch1-Ch4, Ref1-Ref4, Math1-Math4

Autoset Set, Clear Set

Rise High –20 V to 20 V 1 V

Rise Mid –20 V to 20 V 0 V

Rise Low –20 V to 20 V –1 V

Fall High –20 V to 20 V 1 V

Fall Mid –20 V to 20 V 0 V

Fall Low –20 V to 20 V –1 V

Hysteresis 0 to 10 V 30 mV

Autoset Ref Levels Parameters
Table 125: Autoset Ref Levels Parameters

Option Parameters Default setting

Base Top Method • Min-Max

• Low-High Histogram (Full Waveform)

• Low- High Histogram (Center of Eye)

• Auto

Auto

Table continued…
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Option Parameters Default setting

Rise High 1 to 99% 90%

Rise Mid 1 to 99% 50%

Rise Low 1 to 99% 10%

Fall High 1 to 99% 90%

Fall Mid 1 to 99% 50%

Fall Low 1 to 99% 10%

Hysteresis 0 to 50% 3%

Preferences parameters
The Analyze > Jitter and Eye Analysis (DPOJET) > Preferences includes the following tabs:

• General
• Measurement
• Jitter Decomp
• Path Defaults

Table 126: Preferences parameters

Option Parameters Default setting

General

Horizontal Display Units Seconds, Unit Intervals Seconds

Vertical Display Units Volts, Unit Amplitude Volts

Default Image Type PNG, JPG, BMP PNG

Notifier Duration 2 to 20 s 5 s

Measurement

Limit Rise/Fall measurements to transition
bits only

Set, Clear Clear

Enable high-performance eye rendering Set, Clear Set

Halt free-run on a limit failure for any
measurement

Set, Clear Clear

Table continued…
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Option Parameters Default setting

Automatic Transition Density Compensation
for PLLs

Set, Clear Clear

Waveform Interpolation Type Linear, Sin(x)/x Linear

Jitter Decomp

Analysis Method Jitter Only, Jitter + Noise Jitter Only

Dual Dirac Model Fibre Channel, PCI/FB-DIMM PCI/FB-DIMM

Loc RJ Value 1fs to 1s 1ps

Jitter Separation Model Spectral Only, Spectral + BUJ Spectral Only

Minimum # of UI for BUJ Analysis 10K to 9M 200k

Path Defaults

Default image export directory Browser C:\%USERPROFILE%
\Tektronix\TekApplications\DPOJET\I
mages 32

Default logging export directory Browser C:\%USERPROFILE%
\Tektronix\TekApplications\DPOJET\L
ogs 32

Default report output directory Browser C:\%USERPROFILE%
\Tektronix\TekApplications\DPOJET\R
eports 32

Deskew parameters
The Analyze > Jitter and Eye Analysis (DPOJET) > Deskew includes the following command buttons:

• Perform Deskew
• Summary

Table 127: Deskew parameters

Option Parameters Default setting

Reference Channel

Source Ch1, Ch2, Ch3, Ch4 Ch1

Table continued…

32 %USERPROFILE% represents your user location.
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Option Parameters Default setting

Mid –20 V to 20 V 0 V

Hysteresis 0 to 10 V 30 mV

Channel to be Deskewed

Source Ch1, Ch2, Ch3, Ch4 Ch2

Mid –20 V to 20 V 0 V

Hysteresis 0 to 10 V 30 mV

Edges Rise, Fall, Both Rise

Deskew Range

Max Value –24.9 ns to 25 ns 1 ns

Min Value –25.0 ns to 24.9 ns –1 ns

Data logging parameters
The application includes the following Log menus:

• Statistics
• Measurement
• Worst Case

Table 128: Data logging parameters

Option Parameters Default

Statistics

Select Target Measurements Set, Clear Set

Log Statistics Off, On Off

Data Log File Browser C:\%USERPROFILE%
\Tektronix\TekApplications\
DPOJET\Logs\Statistics 33

Measurement

Select Target Measurements Set, Clear Set

Table continued…

33 %USERPROFILE% represents your user location.
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Option Parameters Default

Log Measurements Off, On Off

Folder Browser C:\%USERPROFILE%
\Tektronix\TekApplications\
DPOJET\Logs\Measurements 33

Worst Case

Select Target Measurements Set, Clear Set

Log Worst Case Waveforms Off, On Off

Folder Browser C:\%USERPROFILE%
\Tektronix\TekApplications\
DPOJET\Logs\Waveforms 33

Control panel parameters
The Control Panel menu includes the following command buttons:

• Clear
• Recalc
• Single
• Run
• Show Plots

Note: Show Plots appears in the control panel only when one or more plots are selected.

Configure measurement parameters

Bit config parameters
The Eye configure menu has the following parameters:

Table 129: Bit config parameters

Option Parameters Default setting

Bit Type All Bits, Transition, Non-Transition All Bits

Mask 34 Browser C:\Users\Public\Tektronix\T
ekApplications\DPOJET\Masks

Table continued…

34 The Mask selector is available only for Mask Hits measurement.
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Option Parameters Default setting

Measure the Center of the Bit 35 36 1 to 100% For High, Low, High-Low - 1%

For all Optical measurements - 20%

For all other measurements - 50%

Method Mean, Mode Mean

Measurement range (% UI) 37 Start, End, # of Bins 50%, 50%, 1

Mask Hits, Autofit Mask Hits

Table 130: Mask Hits, Autofit Mask Hits parameters

Option Parameters Default setting

Bit Type All Bits, Transition, Non-Transition All Bits

Mask 34 Browser C:\Users\Public\Tektronix\T
ekApplications\DPOJET\Masks

Mask Absolute, Relative Absolute

Measure the Center of the Bit 35 36 1 to 100% For High, Low, High-Low - 1%

For all Optical measurements - 20%

For all other measurements - 50%

Method#unique_245/
unique_245_Connect_42_GUID-61A57A74-
1CFE-4419-9253-1CB570C123BB

Mean, Mode Mean

Measurement range (% UI) 37 Start, End, # of Bins 50%, 50%, 1

BER parameters
The BER configure menu has the following parameters.

Table 131: BER parameters

Option Parameters Default setting

Target BER BER = 1E-? 12

35 Available only for High, Low, and High–Low measurements.
36 Available for OMA, ER, Optical High, Optical Low, Optical Eye Crossing Level, Optical Eye Crossing Time and Optical Eye Crossing Percent.
37 Available only for Height@BER measurement
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Edges parameters
The Edges configure menu depends on the measurement selected.

Period, Freq, TIE, RJ, RD-dd, TJ@BER, DJ, DJ-dd, PJ, J2, J9, SRJ, Width@BER, RJ(h), RJ(v), PJ(h), PJ(h), Data Rate

Table 132: Edges parameters

Option Parameters Default setting

Signal Type Clock, Data, Auto Auto

Clock Edge Rise, Fall, Both Rise

N-Period

Table 133: N-Period parameters

Option Parameters Default setting

Signal Type Clock, Data, Auto Auto

Clock Edge Rise, Fall, Both Rise

N= 1 to 1M 6

Edge Increment 1, 10 K 1

Positive and Negative duty cycle, CC Period

Table 134: Positive and Negative duty cycle, CC Period parameters

Option Parameters Default setting

Clock Edge Rise, Fall, Both Rise

Phase noise

Table 135: Phase noise parameters

Option Parameters Default setting

Active Edge Rise, Fall, Both Rise

Noise Integration Limits

Upper Frequency 0 to 1 T 1 MHz

Lower Frequency 0 to 1 T 0 Hz
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DCD

Table 136: DCD parameters

Option Parameters Default setting

Signal Type Clock, Data, Auto Auto

F/N

Table 137: F/N parameters

Option Parameters Default setting

Signal Type Clock, Data, Auto Auto

Clock Edge Rise, Fall, Both Rise

N= 2, 4, 8 2

Skew

Table 138: Skew parameters

Option Parameters Default setting

From Edge Rise, Fall, Both Both

To Edge Same as From, Opposite as From Same as From

Setup and Hold

Table 139: Setup and Hold parameters

Option Parameters Default setting

Clock Edge (Source 1) Rise, Fall, Both Rise

Data Edge (Source 2) Rise, Fall, Both Both

Rise slew rate
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Table 140: Rise slew rate parameters

Option Parameters Default setting

From Level Mid, Low Low

To Level High, Mid High

Slew Rate Technique Nominal Method, DDR Method Nominal Method

Fall slew rate

Table 141: Fall slew rate parameters

Option Parameters Default setting

From Level High, Mid High

To Level Mid, Low Low

Slew Rate Technique Nominal Method, DDR Method Nominal Method

Time outside level

Table 142: Time outside level parameters

Option Parameters Default setting

Level High, Low, Both High

High Ref Voltage User selectable 0 V

Overshoot/Undershoot

Table 143: Overshoot/Undershoot parameters

Option Parameters Default setting

Ref Voltage –100 V to 100 V 0 V

V-Diff-Xovr

Table 144: V-Diff-Xovr parameters

Option Parameters Default setting

Main Edge Rise, Fall, Both Both
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CrossOver

Table 145: CrossOver parameters

Option Parameters Default setting

Main Edge Rise, Fall, Both Both

Clock recovery parameters
The Clock recovery configure menu depends on the clock recovery method being selected.

PLL Clock recovery method parameters
Table 146: PLL Clock recovery method parameters

Option Parameters Default setting

PLL Standard BW

PLL Model Type I, Type II Type I

Table continued…
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Option Parameters Default setting

Standard: b/s IBA2500: 2.5G, PCI-E: 2.5G, PCI_E_GEN2:
5.0G

FC133: 132.8M, FC266: 265.6M, FC531:
531.2M, FC1063: 1.063G, FC2125:2.125G,

SerATAG1:1.5G, SerATAG2:3.0,
SerATAG3:6.0G

USB 3.0: 5.0G

1394b S400b: 491.5M, 1394b S800b:
983.0M, 1394b S1600b: 1.966G

GB Ethernet: 1.25G

100BaseT:125M

OC1:51.8M, OC3:155M, OC12:622M,
OC48:2.488G,

FC4250:4.25G, FC8500:8.5G

IBA_GEN2: 5.0G

FBD1:3.2G, FBD2: 4.0G, FBD3: 4.8G

XAUI: 3.125G, XAUI_GEN2: 6.25G

SAS15:1.5G (no SSC), SAS3: 3.0G (no
SSC), SAS6: 6.0G (no SSC), SAS12: 12.0G
(no SSC)

SAS15:1.5G (SSC), SAS3: 3.0G (SSC),
SAS6: 6.0G (SSC), SAS12: 12.0G (SSC)

RIO125: 1.25G, RIO250: 2.5G, RIO3125:
3.125G

PCI-E: 2.5G

Damping 38 0.5 to 2 700 m

Loop BW 1 to 2.5 GHz 1.5 MHz

PLL Custom BW

PLL Model Type I, Type II Type I

Loop BW 1 to 2.5 GHz 1.5 MHz

38 Enabled only for Type II PLL models.
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Constant clock recovery method parameters
Table 147: Constant clock recovery method parameters

Option Parameters Default setting

Constant Clock-Mean

Auto Calc First Acq, Every Acq Every Acq

Constant Clock-Median

Auto Calc First Acq, Every Acq Every Acq

Constant Clock-Fixed

Clock Frequency 1 Hz to 25 GHz 2.5 GHz

Explicit clock recovery method parameters
Table 148: Explicit clock recovery method parameters

Option Parameters Default setting

Explicit Clock-Edge/Explicit Clock-PLL

Clock Source Ch1-Ch4, Ref1-Ref4, Math1-Math4 Ch2

Clock Edge Rise, Fall, Both Both

Clock Multiplier 1 to 1 K 1

Advanced clock recovery configuration parameters
Table 149: Advanced clock recovery configuration parameters

Option Parameters Default setting

PLL Custom BW/PLL Standard BW/ Constant Clock-Mean/Constant Clock-Median

Nominal Data Rate Auto, Manual Auto

Bit Rate 0 b/s to 100 Gb/s Auto TBD

Manual 2.5 Gb/s

Known Data Pattern On, Off Off

Table continued…
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Option Parameters Default setting

Pattern Filename Browse C:\Users\Public\Tektronix\T
ekApplications\DPOJET\Patte
rns

Explicit Clock: Edge

Nominal Clock Offset Relative to Data Auto, Manual Manual

Recalculate Every acquisition, When required When required

Explicit Clock:PLL

PLL Method Type I,Type II Type I

Damping 0.5 to 2 700 m

Loop B/W 1 Hz to 2.5 GHz 1.5 MHz

Nominal Clock Offset Relative to Data Auto, Manual (-1s to 1s) Manual

Recalculate When required, Every acquisition When required

SSC parameters
The Spread Spectrum Clock menu has the following parameters:

Table 150: SSC parameters

Option Parameters Default setting

Nominal frequency

Auto Determined by instrument TBD

Manual User selectable 2.5 GHz

RJ-DJ analysis parameters
The RJ-DJ configure menu has the following parameters:

Table 151: RJ-DJ analysis parameters

Option Parameters Default setting

Pattern Detection/Control

Table continued…
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Option Parameters Default setting

Pattern Detection Auto, Manual Auto

Pattern Type Repeating, Arbitrary Auto TBD

Manual Repeating

Pattern Length 39 2 UI to 1M UI 2 UI

Window Length 40 2 to 24 UI for Jitter Only

2 to 17 UI for Jitter + Noise

10 UI

Target BER

BER = 1E-? 41 2 to 18 12

Noise Compensation
Scope RN(rms) 0 to 50 mV 0 V

RN-DN analysis parameters
The RN-DN configure menu has the following parameters:

Table 152: RN-DN analysis parameters

Option Parameters Default setting

Pattern Detection/Control

Pattern Detection Auto, Manual Auto

Pattern Type Repeating, Arbitrary Auto TBD

Manual Repeating

Pattern Length 39 2 UI to 1M UI 2 UI

Window Length 40 2 to 17 UI 10 UI

Target BER

BER = 1E-? 42 2 to 18 12

Noise Compensation
Table continued…

39 Only for Repeating Patterns.
40 Only for Arbitrary Patterns.
41 Only for TIE, TJ@BER, and Width@BER measurements.
42 Only for TN@BER.
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Option Parameters Default setting

Scope RN(rms) 0 to 50mV 0 V

Filters parameters
The Filter configure menu has the following parameters:

Table 153: Filters parameters

Option Parameters Default setting

High Pass (F1)

Filter Spec No Filter, 1st order, 2nd order, 3rd order No Filter

Freq (F1) 10 Hz to 1 THz 1 kHz

Low Pass (F2)

Filter Spec No Filter, 1st order, 2nd order, 3rd order No Filter

Freq (F2) 10 Hz to 1 THz 1 kHz

Table 154: Filter configuration for SJ@Freq

Option Parameters Default setting

SJ Frequency 10 Hz to 1 THz 100 MHz
SJ Bandwidth 10 Hz to 1 THz 500 kHz

Advanced filter configure parameters
The Advanced Filter Configuration includes the following parameters:

Table 155: Advanced filter configure parameters

Option Parameters Default setting

Ramp Time 0/F to 10/F 2/F

Blanking Time 0/F to 10/F 4/F

Bus state
The Bus State configure menu has the following parameters:

Parameters
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Table 156: Bus state options

Option Parameters Default setting

Use symbol file On, Off On

Enter pattern On, Off Off

Symbol MODE_REG, REFRESH, PRECHARGE,
ACTIVATE, WRITE, READ, SRX, DESELECT,
SRE, PDE

PDE

Measure at Clock Edge, Start, Stop Clock Edge

Clock Source Ch1, Ch2, Ch3, Ch4, Math1, Math2, Math3,
Math4, Ref1, Ref2, Ref3, Ref4

Ch2

Clock Polarity Rising, Falling Rising

From Symbol MODE_REG, REFRESH, PRECHARGE,
ACTIVATE, WRITE, READ, SRX, DESELECT,
SRE, PDE

MODE_REG

To Symbol MODE_REG, REFRESH, PRECHARGE,
ACTIVATE, WRITE, READ, SRX, DESELECT,
SRE, PDE

MODE_REG

Clock Edge Settings

To Symbol MODE_REG, REFRESH, PRECHARGE,
ACTIVATE, WRITE, READ, SRX, DESELECT,
SRE, PDE

MODE_REG

Measure at Clock Edge, Start, Stop Clock Edge

General parameters
The General configure menu has the following parameters:

Table 157: General parameters

Option Parameters Default setting

Measurement Range Limits Off, On Off

Maximum and minimum values vary for different measurements. For more details, refer to Measurement range limit values.

Global parameters
The Global configure menu has the following parameters:
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Table 158: Global parameters

Option Parameter Default setting

Gating

Gating Off, Zoom, Cursors Off

Qualify

Qualify Off, On Off

Qualify With Logic

Source Ch1-Ch4, Ref1-Ref4, Math1-Math4,
Search0-Search8, Burst Search

Ch1

Mid –20 V to 20 V O V

Hysteresis 0 to 10 V 30 mV

Active High, Low High

Population

Population Off, On Off

Population Limit

Limits By Population, Acquisitions Acquisitions

Limit 1 to 231 1 K

Stop Condition Each Measurement, Last Measurement Each Measurement

Margin parameters
The margin has the following parameters:

Table 159: Margin parameters

Option Parameters Default setting

Hit Ratio 50 μ to 1.5 m 50 μ

Hit Count 0 to 10 G 0

Resolution 0.1 to 10% 1%

Parameters
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DFE parameters
The DFE eye width, eye height, and eye diagram measurements have the following parameters:

Table 160: DFE parameters

Option Parameters Default setting

Tap Value -10 v to 10 v 0 v

Absolute Voltage Level -1 v to 1 v 0 v

Absolute Time Level -100 ps to 100 ps 0 s

Measure at V% of the PkPk 1% to 100% 50%

Measure at X% of the UI 1% to 100% 50%

Resolution 0% to 100% 5%

Delay Compensation Auto, Manual Manual

Delay -1 s to 1 s 0 s

Optical parameters

The RIN, RINxOMA, and TDEC measurements have the following parameters: 

Table 161: Optical parameters

Option Parameters Default Setting

Scope RN(rms) 0 W to 50 mW 0 W
Bandwidth 0 Hz to 1 THz 14 GHz
Target BER 2 to 18 4.3
Waveform Type Continuous, Modulated Continuous

Plots

Histogram plot parameters
The Histogram plot has Autoset as the command button.
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Table 162: Histogram plot parameters

Option Parameters Default setting

Vertical Scale Log, Linear Linear

Number of Bins

Resolution 25, 50, 100, 250, 500 250

Horizontal Scale

Auto Scale Set, Clear Set

Center –1 ms to 1 Ts 100 ns

Span 1 s to 1 Ts 4 ns

Eye diagram plot parameters
The Eye Diagram plot has the following parameters:

Table 163: Eye diagram plot parameters

Option Parameters Default setting

Mask On, Off Off

Browser C:\Users\Public\Tektronix\T
ekApplications\DPOJET\Masks

Horizontal Scale

Auto Scale Set, Clear Set

Resolution 2.00E–13 to 2.00E–08 1.00E–12

Explicit Clock

Superimpose Reference Clock Eye (if
available)

Set, Clear Clear

Ref Clock Alignment Auto, Centre and Left Auto

Interpolation Interpolation, Non-Interpolation Interpolation

Spectrum plot parameters
The Spectrum plot has the following parameters:

Parameters
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Table 164: Spectrum plot parameters

Option Parameters Default setting

Vertical Scale Log, Linear Log

Base –20 to 15 –15

Horizontal Scale Log, Linear Linear

Mode Normal, Average, Peak Hold Normal

Time trend plot parameters
The Time Trend plot has the following parameters:

Table 165: Time trend plot parameters

Option Parameters Default setting

Mode Vector, Bar Vector

Phase noise plot parameters
The Phase Noise plot has the following parameters:

Table 166: Phase noise plot parameters

Option Parameters Default setting

Vertical Position

Baseline –200 to 0 –170

Smoothening Filter • 1 decade
• 1/10th decade
• 1/100th decade

1 decade

Bathtub plot parameters
The Bathtub plot has the following parameters:
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Table 167: Bathtub plot parameters

Option Parameters Default setting

Vertical Scale Log, Linear Log

Minimum displayed BER= 1E-? 2 to 18 43 14

X-Axis Unit Unit Interval, Seconds Unit Interval

Transfer function plot parameters
The Transfer Function plot has the following parameters:

Table 168: Transfer function plot parameters

Option Parameters Default setting

Vertical Scale Log, Linear Log

Horizontal Scale Log, Linear Log

Mode Normal, Average Average

Composite jitter histogram plot parameters
The Composite Jitter Histogram plot has the following parameters:

Table 169: Composite jitter histogram plot parameters

Option Parameters Default setting

Vertical Scale Log, Linear Linear

Number of Bins

Resolution 25, 50, 100, 250, 500 250

Noise bathtub plot parameters
The noise bathtub plot has the following parameters:

43 Applicable for Log and Linear scale only.

Parameters
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Table 170: Noise bathtub plot parameters

Option Parameters Default setting

Horizontal Scale Log, Linear Log

Minimum displayed BER = 1E-? 2 to 18 44 14

Y-Axis Unit Unit Amplitude, Volts Unit Amplitude

BER Eye contour plot paramters
The BER eye contour plot has the following parameters:

Table 171: Noise bathtub plot parameters

Option Parameters Default setting

Mask On, Off Off

Browser C:\Users\Public\Tektronix\T
ekApplications\DPOJET\Masks

BER contours to display 1E-6, 1E-9, 1E-12, 1E-15, 1E-18, Target
BER (1E-12)

All BER contours to display will be selected.

Composite noise histogram plot parameters
The composite noise histogram plot has the following parameters:

Table 172: Composite noise histogram plot parameters

Option Parameters Default setting

Horizontal Scale Log, Linear Linear

Noise Components TN, RN+NPN, PN, DDN(0), DDN(1) All noise components will be selected

Number of Bins

Resolution 25, 50, 100, 250, 500, 2000, Maximum 250

BER Eye plot parameters
The BER eye plot has the following parameters:

44 Applicable for Log and Linear scale only.
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Table 173: BER Eye plot parameters

Option Parameters Default setting

BER contours to display 1E-6, 1E-9, 1E-12, 1E-15, 1E-18, Target
BER (1E-12)

All BER contours to display will be selected.

Correlated Eye plot parameters
The Correlated eye plot has the following parameters:

Table 174: Correlated Eye plot parameters

Option Parameters Default setting

BER contours to display 1E-6, 1E-9, 1E-12, 1E-15, 1E-18, Target
BER (1E-12)

All BER contours to display will be un-
selected.

PDF Eye plot parameters
The PDF eye plot has the following parameters:

Table 175: PDF Eye plot parameters

Option Parameters Default setting

BER contours to display 1E-6, 1E-9, 1E-12, 1E-15, 1E-18, Target
BER (1E-12)

All BER contours to display will be selected.

Reports
The Reports menu has the following command buttons:

• Save
• Save As
• Append
• View
• Add/Edit comments

Table 176: Reports parameters

Option Parameters Default setting
Auto increment report name if duplicate Set, Clear Set
View report after generating Set, Clear Set
Content to Save
Table continued…

Parameters
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Option Parameters Default setting
Include pass/fail results summary Set, Clear Set
Include detailed results Set, Clear Set
Include plot images Set, Clear Set
Include setup configuration Set, Clear Set
Include user comments Set, Clear Set
Include complete application configuration Set, Clear Set
Save Waveform file(s) along with report Set, Clear Clear
Report Name Browser C:\%USERPROFILE%

\Tektronix\TekApplications\
DPOJET\Reports, where
%USERPROFILE% represents your user
location.

Report Type Web Archive (*.mht), PDF (*.pdf) PDF (*.pdf)
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Reference
Progress bar status messages
Table 177: Progress bar status messages

Function/Measurement module Status/Message Description

Autoset-Source Autoset VertAuto-Chx Vertical autoset for Chx is going on.

Autoset-Source Autoset HorizAuto-Chx Horizontal autoset for Chx is going on.

Autoset-Source Autoset Zooming Horiz Zooming the horizontal scale after horizontal
autoset.

Autoset-Ref Level Autoset RefAuto-Chx Reference level autoset for Chx is going on.

Autoset-Ref Level Autoset RefAuto-Refx Reference level autoset for Refx is going on.

Autoset-Ref Level Autoset RefAuto-Mathx Reference level autoset for Mathx is going
on.

Sequencing Sequencing Refers to the measurement setup-edge
extraction.

Measurement Name Running the measurement specified by
name.

Plots Plotting Plotting is started.

Bathtub Creating Bathtub plot.

Spectrum Creating spectrum plot.

Time Trend Creating time trend plot.

Histogram Creating Histogram plot.

Transfer Func Creating Transfer Function plot.

Eye Mask Hits Creating Eye Diagram plot.

Eye Height Creating Eye Diagram plot.

Data Array Creating Data Array plot.

Phase Noise Creating Phase noise plot.

Edge Extraction Finding Edges Extracting Edges from signal waveform.

Table continued…

Reference
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Function/Measurement module Status/Message Description

Clock Data Recovery Recovery Clk Clock and Data recovery.

Worst case logging Saving WC Wfm Logging the worst case waveform.

Trigger Slow Trigger Waiting for trigger/trigger not available.

Measurements Name Progress Bar Display

AC RMS AC RMS

Amplitude High Low Ampl High–Low

Amplitude HighV Amp High

Amplitude LowV Ampl Low

CMV Common Mode

DCD DCD

DDJ DDJ

DiffXovrV V-Diff-Xovr

DJ DJ

DJδδ DJ–δδ

EdgeExtractor Edge Extractor

EyeHeight Eye Height

EyeHeightBER Eye Height@BER

EyeMaskHits Eye Mask Hits

EyeWidth Eye Width

EyeWidthBER Eye Width@BER

FallTime Fall Time

Frequency Freq

HighTime High Time

Hold Hold

Table continued…
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Function/Measurement module Status/Message Description

LowTime Low Time

NegativeDutyCycle –Duty Cycle

NegativeDutyCycleCycle –CC–Duty

NegativeWidth Neg Width

NPeriod N–Period

PerCycleCycle CC–Period

Period Period

PhaseNoise Phase Noise

PJ PJ

PositiveDutyCycle +Duty Cycle

PositiveDutyCycleCycle +CC–Duty

PositiveWidth Pos Width

RiseTime Rise Time

RJ RJ

RJδδ RJ–δδ

Setup Setup

Skew Skew

TIE TIE

TJ TJ@BER

TNTRatio T/nT Ratio

TJ@BER TJ

NPJ NPJ

RJ(H) RJH

RJ(V) RJV

Table continued…

Reference
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Function/Measurement module Status/Message Description

PJ(H) PJH

PJ(V) PJV

PJrms PJrms

SJ@Freq SJ@Freq

SRJ SRJ

J2_ J2

J9_ J9

F/N F_N

RN RN

RN (v) RNV

RN (h) RNH

DN DN

DDN DDN

DDN0 DDN0

DDN1 DDN1

PN PN

PN (v) PNV

PN (h) PNH

NPN NPN

TN@BER TN

Unit Amplitude UA

Breakdown of jitter (Jitter map)
The breakdown of jitter into components such as RJ, PJ and DDJ is model-based. This means that a suitable mathematical model is
proposed for the overall jitter, consisting of various jitter components. The components are separable from each other based on observable
characteristics, and the rules by which these components combine to form an overall jitter distribution are based on well-understood
mathematical principles.
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The model used by DPOJET is hierarchical, and is represented by a jitter map. To view the jitter breakdown map, follow the steps:

• Click Select > Jitter

• Click the information icon ( ) in the upper right corner of the panel.

Note: If noise measurements are enabled, the Jitter tab is displayed as Jitter/Noise and buttons at the top of the tab allow
selection of Jitter or Noise measurements. Select the jitter button ( ) to display the jitter measurements.

DPOJET displays one of the two different jitter maps depending on the global configuration: 

• Spectral only (default): A simpler map that does not include NPJ and BUJ categories is used when the decomposition method is set to
'Spectral only'. This offers simpler and faster processing and gives accurate results when crosstalk is not present (and often even when
it is present).

• Spectral + BUJ: This decomposition method offers an additional model component (Non-Periodic Jitter or NPJ). This jitter model is
more accurate when certain types of crosstalk are present. The disadvantage of using this map is that more statistics (that is, a
higher population of unit intervals) must be acquired before results can be produced. This may require longer record length, multiple
acquisitions, or both.

By clicking the radio buttons in the upper left corner of the map window, you can switch between the two jitter models and their
corresponding maps. Once a model has been selected, you can add jitter measurements by clicking directly on the buttons embedded in
the map, or dismiss the map and click on the conventional buttons in the main control window.

Figure 203: Jitter map - Spectral Only

Reference
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Figure 204: Jitter map - Spectral + BUJ

Related topics

DPOJET option levels on page 37

Breakdown of noise (Noise map)
The breakdown of noise into components such as RN and DN is model-based. This means that a suitable mathematical model is
proposed for the overall noise measurements, consisting of various components. The components are separable from each other based
on observable characteristics, and the rules by which these components combine to form an overall noise distribution are based on
well-understood mathematical principles.

The model used by DPOJET is hierarchical, and is represented by a noise map. To view the noise breakdown map, follow the steps:

• Click Select > Jitter/Noise and select the noise measurement by radio button. The Preference setup - Jitter Decomp allows you to
enable or disable noise measurements by changing the Analysis Method, if the noise measurement option is available.

• Click the information icon ( ) in the upper right corner of the panel.

Note: If the tab is labeled 'Jitter' and the Jitter and Noise radio buttons are absent, Noise measurements are currently disabled.

DPOJET displays one of the two different jitter maps depending on the global configuration: 

• Spectral only (default): A simpler map that does not include NPN and BUN categories is used when the decomposition method is set to
'Spectral only'. This offers simpler and faster processing and gives accurate results when crosstalk is not present (and often even when
it is present).

• Spectral + BUJ: This decomposition method offers an additional model component (Non-Periodic Noise or NPN). This noise model is
more accurate when certain types of crosstalk are present. The disadvantage of using this method is that more statistics (that is, a
higher population of unit intervals) must be acquired before results can be produced. This may require longer record length, multiple
acquisitions, or both.

By clicking the radio buttons in the upper left corner of the map window, you can switch between the two decomposition models and their
corresponding maps. Once a model has been selected, you can add noise measurements by clicking directly on the buttons embedded in
the map, or dismiss the map and click on the conventional buttons in the main control window.
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Figure 205: Noise map - Spectral Only

Figure 206: Noise map - Spectral + BUJ

Related topics

DPOJET options levels

Separation of Non-Periodic Jitter (NPJ)

Reference
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Error codes
Table 178: Error codes

Code Description

E102 File does not exist

E103 DPOJET is not able to open the help file. In order to use the help file, please reinstall DPOJET.

E104 Mask Hits measurement requires an Eye diagram plot but no more plots can be assigned. Please
remove a plot before adding a Mask Hits measurement.

E105 The maximum number of plots you can select is 4.

E106 No Spectrum plot data is available.

E107 This plot type is not configurable.

E108 The SSC-PROFILE measurement requires an Time Trend plot but no more plots can be assigned.
Please remove a plot before adding a SSC-PROFILE measurement.

E109 The SSC PROFILE measurement requires an Time Trend plot but no more plots can be assigned.
Please remove a plot before adding a SSC PROFILE measurement.

E202 The upper range must be greater than the lower range.

E400 A measurement failed to complete successfully.

W410 Number of edges are not sufficient for a measurement.

E411 In at least one zone, there are too few edges to complete a measurement.

E424 No edges or UI of the required type were found in the waveform. If this is not a clock signal, check the
Vref threshold and record length.

E425 No transitions of the selected Bit Type were found in the waveform.

E426 Result has 0 population since all measurement points fall within the PLL's settling time. Either acquire a
longer waveform, or increase the PLL's bandwidth.

E427 All waveform samples fall within the PLL's settling time. Either acquire a longer waveform, or increase
the PLL's bandwidth.

E500 The record lengths of the source waveforms differ. Please configure for sources with equivalent record
lengths.

E1001 Vertical Autoset Failed: Signal on Source x has extreme offset.

E1002 Vertical Autoset Failed: Amplitude of Source x is too small.

Table continued…
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Code Description

E1003 Vertical Autoset Failed: Amplitude or DC offset of Source x is too high.

E1004 Vertical Autoset Failed: No signal on Source x.

E1005 Vertical Autoset Failed: Signal on Source x exceeds top of scale.

E1006 Vertical Autoset Failed: Signal on Source x exceeds bottom of scale.

E1007 Vertical Autoset Failed: Signal on Source x is clipped on top.

E1008 Vertical Autoset Failed: Signal on Source x is clipped on bottom.

E1009 Vertical Autoset Failed: Measurement error ( ISDB error code = 6 ) on Source x.

E1010 Vertical Autoset Failed: Measurement error ( ISDB error code = 7 ) on Source x.

W1011 A change to Source x vertical settings caused overload disconnect. Original settings are restored and
Source x is reconnected. Ignore oscilloscope message.

E1012 Vertical Autoset Failed: None of the selected measurements use live sources (Ch1-Ch4). Vertical
autoset works for live sources only.

E1013 Vertical Autoset Failed: Invalid signal on Source x.

E1020 Horizontal Autoset Failed: None of the selected measurements use live sources (Ch1-Ch4). Horizontal
autoset works for live sources only.

E1021 Horizontal Autoset Failed: On Source x, cannot determine resolution of rising/falling edges.

E1022 Horizontal Autoset Failed: Horizontal resolution is at the maximum.

E1026 Horizontal Autoset Failed: Source amplitude is too low.

E1027 Horizontal Autoset Failed: Signal is clipped at the top - positive clipping.

E1028 Autoset Failed: Signal is clipped at the bottom - negative clipping.

E1029 Horizontal Autoset Failed: Signal frequency is extremely low.

E1035 Oscilloscope has gone into invalid state. Please restart the system.

E1040 Autoset Failed: None of the live sources (Ch1-Ch4) selected.

E1041 Autoset Failed: Unable to trigger

W1051 Ref Level Autoset: Waveform for the source x is clipped.

W1053 Ref Level Autoset: Source amplitude is extremely low.

Table continued…

Reference
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Code Description

E1054 Ref Level Autoset: Error in setting reference levels.

E1055 Ref Level Autoset Failed: No waveform to measure.

E1056 Ref Level Autoset: Unstable Histogram for waveform on source x.

E1057 Ref Level Autoset: No selected source.

E1058 Ref Level Autoset Failed: Invalid signal on source x.

E1059 Ref Level Autoset Failed: High/Low Method measures High = Low on.

E1060 Ref Level Autoset Failed: Max/Min Method measures Max = Min on.

E1061 Since Digital Filters (DSP) Enabled, Maximum sampling rate has been retained. To enable adaptive use
of lower sampling rate, please choose Analog Only under Vertical->Bandwidth Enhanced.

E1062 The maximum Record Length (RL) in autoset is restricted to 25M, set the RL manually for > 25M.

E1063 The minimum Record Length (RL) in autoset is restricted to 500K, set the RL manually for < 500K.

W1064 Ref Level Autoset: Unable to trigger.

E1065 Ref Level Autoset Failed: Top(Eye High) was calculated as equal or less than Base(Eye Low) for Base
Top method Low-High(eye ctr) on

E1066 Ref Level Autoset Failed: Top(High) was calculated as equal or less than Base(Low) for Base Top
method

E2001 The maximum number of measurements has been reached.

E2002 All the refs are used as sources by the measurements. Export to Ref is not possible.

E2003 Ref ‘x’ is already used as a measurement source.

E2004 Ref ‘x’ is already used as a destination for other measurement.

E2005 No measurement(s) are selected. Export to Ref is not possible.

E2006 No results available to export to ref.

E2007 There are no time trend results for the selected measurement(s).

E2008 No ref destination is selected. Results will not be exported to ref.

E3001 Could not open or create a log file. Please ensure that you have read/write permission to access log
folders and files.

Table continued…
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Code Description

E3002 The specified path is invalid (for example, the specified path is not mapped to a drive).

E3003 The specified path, file name or both exceed the system defined length. For example, on Windows-
based platforms, the path name must be less than 248 characters and file names less than 260
characters.

E3004 The specified path directory is read-only or is not empty.

E3005 Please ensure that the file is currently not in use by other process and/or has not exceeded the file size
limit.

E3006 Invalid filename: Check whether the file name contains a colon (:) in the middle of the string.

E3007 Select at least one measurement from the table before you save.

E3008 There are currently no results to save. Please run a measurement.

E3009 Current statistics is successfully saved at C:\%USERPROFILE%
\Tektronix\TekApplications\DPOJET\Logs\Statistics, where %USERPROFILE% represents your user
location.

E3010 Access to file/directory denied. Please ensure that the file/directory has read/write permissions.

E3011 Mask Hits Measurements will not be selected as this feature is not available for Mask Hits measurement.

E3012 Folder does not exist.

E4000 Not enough data points. Unable to render plot(s).

E4001 Internal measurement error. Please remove a measurement and try again.

E4002 Not enough data points for spectrum computation.

E4003 Due to high memory usage, only a portion of the waveform could be processed. Please reduce your
record length or the number of measurements.

E4004 An error occurred in the edge extraction process.

E4005 Qualifier: The record length and sample interval must match across the waveforms.

E4006 A maximum of 4096 qualifier zones is supported. The entire waveform will not be processed and hence
partial measurement results are available.

E4007 Logic Qualifier enabled and no qualifier zones found.

W4008 The configured Ref voltage for Overshoot must be greater than or equal to the mid autoset ref levels.

W4009 The configured Ref voltage for Undershoot must be lesser than or equal to the mid autoset ref levels.

Table continued…
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Code Description

E4010 The preamble has got clipped

E4011 The postamble has got clipped

E4012 The local ref levels could not be calculated due to insufficient edges in burst

E4013 The configured Ref voltage must be greater than or equal to the mid autoset ref levels.

E4014 The configured Ref voltage must be lesser than or equal to the mid autoset ref levels.

E4015 45 One or more qualifier zones had too few edges for measurement calculation.

E4016 Not enough edges in the waveform for measurement calculation.

E4017 Qualifier not enabled and hence no qualifier zones found. Please enable the qualifier.

E4018 The preamble is incomplete in all the qualifier zones.

E401945 The preamble is incomplete in one or more qualifier zones.

E4020 The postamble is incomplete in all the qualifier zones.

E402145 The postamble is incomplete in one or more qualifier zones.

E402245 Not enough samples present in the qualifier zones. Please increase the sampling rate and reacquire the
waveform.

E4023 The configured ref levels are not correct. The high ref level should be >= Mid and Mid should be >= Low
for both Rise and Fall slopes. Reconfigure the ref levels and run the measurement.

E4024 Could not compute proper High and Low values.

W4025 The signal does not cross the configured Ref Voltage and hence the result shows zero population.
Please adjust the Ref voltage value.

W4026 Command Patterns were not found in the required order.

E4027 From Symbol not found in the acquisition.

E4028 To Symbol not found in the acquisition.

E4029 The configured High Ref voltage must be ≥ to the mid autoset ref levels.

E4030 The configured Low Ref voltage must be ≤ to the mid autoset ref levels.

Table continued…

45 Displays the zone number for which the preamble/postamble fails.
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Code Description

E4031 The configured High Ref voltage must be ≥ to the mid autoset ref levels and the configured Low Ref
voltage must be ≤ to the mid autoset ref levels.

E4032 Set up the DDR Search and turn on the Qualifier to run this measurement.

E4033 Required command was not found after the burst.

E4034 Self Refresh Entry command is not registered in the current acquisition.

E4035 Self Refresh Exit command is not registered in the current acquisition.

E4036 Vsw1 voltage point on DQ is not found in one or more zones.

E4037 Vsw2 voltage point on DQ is not found in one or more zones.

E4038 Insufficient Edges in CK source in one or more zones.

E4039 Insufficient Edges in DQ source in one or more zones.

E4040 Invalid configuration, extrapolation voltage should be >= Vsw2 and Vsw2 > Vsw1

E4041 CK rising edge corresponding to the DQ edge is not found in one or more zones

E4042 DQ edge at Vsw1 was not found in one or more zones

E5000 This report cannot be appended because the Append feature is incompatible with this report version.
Do you want to overwrite or save as a new report? Press Yes to overwrite. Press No to save as a new
report.

E5001 The report contains data. Do you wish to overwrite?

E5002 Cannot save file:There may not be enough free disk space. Delete one or more files to free disk space,
and then try again.

E5003 Cannot save some of the waveform file(s) as the application encountered internal error.

E5004 Do you wish to append the current results to

E5005 46 Occurs while running setup. Please make sure you have finished any previous setup and closed other
applications.

E5006 This PDF Report cannot be appended because the report file is currently open. Close the file and
append.

W5005 The path or file name exceeds the system limit of 260 characters.

Table continued…

46 This error occurs during DPOJET installation on a DPO/MSO oscilloscope. Delete the Installshield folder under C:\Program files\Common Files and delete all files
and folders under C:\Windows\Temp folder. Restart the installation again.
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Code Description

E6001 The measurement cannot show the failed event as failures are not found in the current acquisition.

E6002 The measurement cannot show the failed event as there is a mis-match in waveform and measurement
data.

E7001 Error in reading measurement data.

E7002 Error in reading plot data.

E8000 The sequence has been aborted. Please note Zoom min/max may not work as expected

W9005 Derating value calculated using single Slew Rate measurement value.

W9006 Derating value cannot be computed since the calculated Slew Rate is not present in the derating
table 47.

E9007 Derating Error 48.

10001 The BT Filter file is not present in the specified path

10002 BT Filter file is not in the appropriate filter file format

10003 BT Filter file does not contain any filter coefficients for current waveform Sample Rate

10004 The BT Filter file contains illegal characters in the filter coefficients. Choose the appropriate filter file
format

10005 Either waveform or BT Filter Sample Rate is less than 100 GS/s. Choose waveform and BT filter with a
higher Sample Rate

10006 Very high noise power for computing Noise Enhancement Factor

10007 Illegal values in either BT Filter file or in the FFE taps ";

10011 The FFE Taps file is not present in the specified path

10012 The FFE Taps file contains some DFE tap coefficients. Choose the FFE Taps file having only the FFE
coefficients

10013 The FFE Taps file does not contain any tap coefficients for the FFE

10014 The selected FFE Taps file is not in the appropriate file format

Table continued…

47 Signal Slew Rate value is outside the derating table (Example: If DDR2-800 MT/s tDS derating with a differential probe has a DQS differential slew rate of 0.65 V/ns,
this warning message is displayed as the derating table definition starts from 0.8 V/ns). Derating value is not supported (TBD) in the specification (Example: If the
DQS differential slew rate is 2.0 V/ns and the DQ slew rate is 0.7 V/ns, then the value is -(TBD). Derating will not be applied for the above cases and the base limit
will be displayed in the results table.

48 Slew Rate measurements used to calculate the derated value failed to Run as there are no sufficient edges on the Rise and Fall slopes of the waveform. Base
measurement limits are not defined as per the specification.
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Code Description

10020 TDEC value is less than zero. Solution cannot be computed due to eye-closure

10021 An internal error occurred. Re-Install DPOJET. The Butterworth filter file is not present in the specified
path

10022 An internal error occurred. Re-Install DPOJET. The Butterworth filter file is not in the appropriate filter file
format

10023 An internal error occurred. Re-Install DPOJET. The Butterworth filter file does not contain coefficients for
current waveform Sample Rate

10024 An internal error occurred. Re-Install DPOJET. The Butterworth filter file contains illegal characters or file
corrupted

100101 Channel not supported for noise compensation.

100102 Unable to read the Scope Noise Characterization database.

100103 Invalid values for scope settings for noise compensation.

100201 The required utility for PDF report generation is not installed or corrupted. Reinstall the application and
try generating the PDF report.

Measurement range limit values
The following table lists the maximum and minimum values of all measurement range limits:

Note: Measurement Range Limits are provided for each measurement under the General configure tab of the DPOJET
application. The range limits are turned off by default. For two-source measurements such as Skew, Setup, Hold and a few others,
these range limits are always ON (OFF is disabled). In these cases, the range limits are used by the algorithms to associate the
valid edge of first source to the valid edge of the second source.

Table 179: Measurement range limit values

Name

Measurement range limits (Max) Measurement range limits (Min)

Default Max Min Default Max Min

Period/Freq measurements

Period 1 ms 1 ks 0 s 0 s 1 ks 0 s

CC–Period 1 ns 1 s 1 fs –1 ns –1 fs –1 s

Freq 10 GHz 50 GHz 1 MHz 1 MHz 50 GHz 1 MHz

N–Period 1 ms 1 ks 0 s 0 s 1 ks 0 s

Table continued…
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Name

Measurement range limits (Max) Measurement range limits (Min)

Default Max Min Default Max Min

Pos Width/ Neg
Width

10 ns 1 Ms 1 ps 1 ns 1 Ms 1 ps

+Duty Cycle/–
Duty Cycle

90 % 100 % 0 % 10 % 100 % 0 %

+CC–Duty/ –CC–
Duty

90 % 100 % 100 % 10 % 100 % 0 %

Data Rate 10 Gb/s 50 Gb/s 1 Mb/s 1 Mb/s 50 Gb/s 1 Mb/s

Jitter Measurements

TIE 1 ns 1 µs –1 µs –1 ns 1 µs –1 µs

RJ 1 ns 1 µs 0 s 1 ns 1 µs 0 s

RJ–δδ 1 ns 1 µs 0 s 0 s 1 µs 0 s

TJ@BER 1 ns 1 µs 0 s 0 s 1 µs 0 s

DJ 1 ns 1 µs 0 s 0 s 1 µs 0 s

DJ–δδ 1 ns 1 µs 0 s 0 s 1 µs 0 s

Phase Noise 1 ms 1 ms 0 s 0 s 1 ms 0 s

DCD 1 ns 1 µs 0 s 0 s 1 µs 0 s

DDJ 1 ns 1 µs 0 ns 0 s 1 µs 0 s

PJ 1 ns 1 µs 0 s 0 s 1 µs 0 s

J2 1 ns 1 µs 0 s 0 s 1 µs 0 s

J9 1 ns 1 µs 0 s 0 s 1 µs 0 s

F/N 1 ns 1 µs 0 s 0 s 1 µs 0 s

SRJ 1 ns 1 µs 0 s 0 s 1 µs 0 s

RJ (h) 1 ns 1 µs 0 s 0 s 1 µs 0 s

RJ (v) 1 ns 1 µs 0 s 0 s 1 µs 0 s

PJ (h) 1 ns 1 µs 0 s 0 s 1 µs 0 s

Table continued…
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Name

Measurement range limits (Max) Measurement range limits (Min)

Default Max Min Default Max Min

PJ (v) 1 ns 1 µs 0 s 0 s 1 µs 0 s

PJrms 1 ns 1 µs 0 s 0 s 1 µs 0 s

SJ@Freq 1 ns 1 µs 0 s 0 s 1 µs 0 s

PkPkClkTJ 1 ms 1 ks 0 s 0 ms 1 ks 0 s

PkPkClkRJ 1 ms 1 ks 0 s 0 ms 1 ks 0 s

PkPkClkDJ 1 ms 1 ks 0 s 0 ms 1 ks 0 s

Noise Measurements

RN 500 mV 10 V -10 V -500 mV 10 V -10 V

RN (v) 500 mV 10 V -10 V -500 mV 10 V -10 V

RN (h) 500 mV 10 V -10 V -500 mV 10 V -10 V

DN 500 mV 10 V -10 V -500 mV 10 V -10 V

DDN 500 mV 10 V -10 V -500 mV 10 V -10 V

DDN0 500 mV 10 V -10 V -500 mV 10 V -10 V

DDN1 500 mV 10 V -10 V -500 mV 10 V -10 V

PN 500 mV 10 V -10 V -500 mV 10 V -10 V

PN (v) 500 mV 10 V -10 V -500 mV 10 V -10 V

PN (h) 500 mV 10 V -10 V -500 mV 10 V -10 V

NPN 500 mV 10 V -10 V -500 mV 10 V -10 V

TN@BER 500 mV 10 V -10 V -500 mV 10 V -10 V

Unit Amplitude 500 mV 10 V -10 V -500 mV 10 V -10 V

Time Measurements

Rise Time 200 ns 1 ks 0 s 0 s 1 ks 0 s

Setup 10 ns 1 s –1 s 0 s 1 s –1 s

Table continued…
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Name

Measurement range limits (Max) Measurement range limits (Min)

Default Max Min Default Max Min

High Time 10 ns 1 Ms 1 ps 0 s 1 Ms 1 ps

Fall Time 200 ns 1 ks 0 s 0 s 1 ks 0 s

Rise Slew Rate 1 V/ns 100 V/ns 1 uV/ns 0 V/ns 100 V/ns 0 V/ns

Fall Slew Rate 0 V/ns 0 V/ns –100 V/ns –1 V/ns –1 uV/ns –100 V/ns

Hold 10 ns 1 s –1 s 0 s 1 s –1 s

Low Time 10 ns 1 Ms 1 ps 1 ps 1 Ms 1 ps

Skew 10 ns 1 s –1 s –10 ns 1 s –1 s

Gated Skew 10 µs 1 s –1 s –10 µs 1 s –1 s

SSC Profile 1 ms 1 ks 0 s 0 s 1 ks 0 s

SSC Mod Rate 10 kHz 50 GHz 100 Hz 1 kHz 50 GHz 100 Hz

SSC Freq Dev 1 kppm 1 Gppm -1 Gppm -1 kppm 1 Gppm -1 Gppm

SSC Freq Dev
Min

1 kppm 1 Gppm -1 Gppm -1 kppm 1 Gppm -1 Gppm

SSC Freq Dev
Max

1 kppm 1 Gppm -1 Gppm -1 kppm 1 Gppm -1 Gppm

Time Outside
Level

1 ms 1 ks 0 s 0 s 1 ks 0 s

tCMD-CMD 1 ms 1 ks 0 s 0 s 1 ks 0 s

Eye Measurements

Height 500 mV 1 kV 0 V 50 mV 1 kV 0 V

Height@BER 500 mV 1 kV 0 V 50 mV 1 kV 0 V

Width 1 ns 1 s 0 s 50 ps 1 s 0 s

Width@BER 0.9 UI 1.0 UI 0 UI 0.1 UI 1.0 UI 0 UI

Eye High 500 mV 10 V -10 V -500 mV 10 V -10 V

Eye Low 500 mV 10 V -10 V -500 mV 10 V -10 V

Table continued…
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Name

Measurement range limits (Max) Measurement range limits (Min)

Default Max Min Default Max Min

Q-Factor 1 k 1 G 0 0 1 G 0

V-Widest Open
Eye

3V -10V 10V -3V -10V 10V

Amplitude Measurements

AC RMS 1 mV 10 V 0 V 0 V 10 V 0 V

DC Common
Mode

500 mV 10 V –10 V –500 mV 10 V –10 V

AC Common
Mode

500 mV 10 V –10 V –500 mV 10 V –10 V

High 500 mV 10 V –10 V –500 mV 10 V –10 V

T/nt-Ratio 8 dB 12 dB –12 dB 0 dB 12 dB –12 dB

High–Low 500 mV 10 V –10 V –500 mV 10 V –10 V

Low 500 mV 10 V –10 V –500 mV 10 V –10 V

V–Diff–Xovr 500 mV 10 V –10 V –500 mV 10 V –10 V

Overshoot 500 mV 10 V 0 V 0 mV 10 V 0 V

Undershoot 500 mV 10 V 0 V 0 V 10 V 0 V

Cycle Pk-Pk 500 mV 10 V -10 V –500 mV 10 V –10 V

Cycle Min 500 mV 10 V -10 V –500 mV 10 V –10 V

Cycle Max 500 mV 10 V -10 V –500 mV 10 V –10 V

Standard-Specific Measurements

PCIe Med-Mx-
Jitter

1 ms 1 ks 0 s 0 s 1 ks 0 s

PCIe AC
Common Mode

500 mV 10 V –10 V –500 mV 10 V –10 V

PCIe T-RF-
Mismch

1 ns 1 ks 0 s 0 s 1 ks 0 s

Table continued…
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Name

Measurement range limits (Max) Measurement range limits (Min)

Default Max Min Default Max Min

PCIe MAX-MIN
Ratio 49

1 V 10 V –10 V –1 V 10 V –10 V

PCIe SSC FREQ
DEV

200 ns 1 ks 0 s 0 s 1 ks 0 s

PCIe SSC
PROFILE

1 ms 1 ks 0 s 0 s 1 ks 0 s

PCIe-T-Tx-Diff-PP 1 V 10 V –10 V –1 V 10 V –10 V

PCIe T-TX 1 ns 1 s 0 s 50 ps 1 s 0 s

PCIe T-Tx-Fall 200 ns 1 ks 0 s 0 s 1 ks 0 s

PCIe Tmin-Pulse 1 ms 1 ks 0 s 0 s 1 ks 0 s

PCIe DeEmph 8 dB 12 dB –12 dB 0 dB 12 dB –12 dB

PCIe T-Tx-Rise 200 ns 1 ks 0 s 0 s 1 ks 0 s

PCIe UI 1 ms 1 ks 0 s 0 s 1 ks 0 s

T-TX-DDJ 1 ns 1 μs 0 s 0 s 1 μs 0 s

T-TX-UTJ 1 ns 1 μs 0 s 0 s 1 μs 0 s

T-TX-UDJDD 1 ns 1 μs 0 s 0 s 1 μs 0 s

T-TX-UPW-TJ 1 ns 1 μs 0 s 0 s 1 μs 0 s

T-TX-UPW-DJDD 1 ns 1 μs 0 s 0 s 1 μs 0 s

V-TX NO-EQ 1.2 V 2 V 0 V 0 V 2 V 0 V

V-TX EIEOS 1.2 V 2 V 0 V 0 V 2 V 0 V

ps21TX 8 dB 12 dB –12 dB 0 dB 12 dB –12 dB

V-TX-BOOST 8 dB 12 dB –12 dB 0 dB 12 dB –12 dB

USB AC Common
Mode

500 mV 10 V –10 V –500 mV 10 V –10 V

USB VTx-Diff-PP 1 V 10 V –10 V –1 V 10 V –10 V

Table continued…

49 Custom name for PCIe MAX-MIN Ratio is PCIe VRX-MAX-MIN Ratio.
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Name

Measurement range limits (Max) Measurement range limits (Min)

Default Max Min Default Max Min

USB TCdr-Slew-
Max

200 ns 1 ks 0 s 0 s 1 ks 0 s

USB Tmin-Pulse-
Tj

1 ms 1 ks 0 s 0 s 1 ks 0 s

USB Tmin-Pulse-
Dj

200 ns 1 ks 0 s 0 s 1 ks 0 s

USB SSC MOD
RATE

200 ns 1 ks 0 s 0 s 1 ks 0 s

USB SSC FREQ
DEV MAX

200 ns 1 ks 0 s 0 s 1 ks 0 s

USB SSC FREQ
DEV MIN

200 ns 1 ks 0 s 0 s 1 ks 0 s

USB SSC
PROFILE

1 ms 1 ks 0 s 0 s 1 ks 0 s

USB UI 1 ms 1 ks 0 s 0 s 1 ks 0 s

AOP 500 mW 10 W -10 W -500 mW 10 W -10 W

ER 500 mW 10 W -10 W -500 mW 10 W -10 W

OMA 500 mW 10 W -10 W -500 mW 10 W -10 W

Optical High 500 mW 10 W -10 W -500 mW 10 W -10 W

Optical Low 500 mW 10 W -10 W -500 mW 10 W -10 W

Eye Crossing
Level

500 mW 10 W -10 W -500 mW 10 W -10 W

Eye Crossing
Time

-1fs -500as -1fs -1ns 1ns -1ns

Eye Crossing
Percent

100% 100% 0% 0% 100% 0%

RIN 100 dB/Hz 1000 dB/Hz -1000 dB/Hz -100 dB/Hz 1000 dB/Hz -1000 dB/Hz
RINxOMA 100 dB/Hz 1000 dB/Hz -1000 dB/Hz -100 dB/Hz 1000 dB/Hz -1000 dB/Hz
TDEC 10 dB 10 dB 0 dB 0 dB 10 dB 0 dB
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Measurement units
The following table lists the engineering multipliers that the DPOJET application uses.

Table 180: Measurement units

Abbreviation Unit Multiplier

y yocto or septillionths 1E-24)

z zepto or sextillionths 1E-21)

a atto or quintillionths 1E-18)

f femto or quadrillionths 1E-15)

p pico or trillionths 1E-12)

n nano or billionths 1E-09)

u micro or millionths 1E-06)

m milli or thousandths 1E-03)

one 1E+00)

k kilo or thousands 1E+03)

M mega or millions 1E+06)

G giga or billions 1E+09)

T tera or trillions 1E+12)

P peta or quadrillions 1E+15)

E exa or quintillions 1E+18)

Z zetta or sextillions 1E+21)

Y yotta or septillions 1E+24)

Custom mask file requirements
DPOJET uses mask definition files that are compatible with TekScope firmware user masks, and consist of ASCII text but are identified
with a .msk file extension. Any firmware mask can be saved as a user mask and imported into DPOJET. Alternatively, DPOJET mask files
can be manually created using an ASCII text editor such as Notepad, or copied from an existing mask and then edited. DPOJET doesn't
require most of the fields found in a TekScope mask file, so the minimum DPOJET mask file is substantially simpler.

The following fields are required:
:MASK:USER:SEG1:POINTS x1,y1,x2,y2,x3,y3,x4,y4;
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:MASK:USER:SEG2:POINTS x1,y1,x2,y2,x3,y3,x4,y4;
:MASK:USER:SEG3:POINTS x1,y1,x2,y2,x3,y3,x4,y4;
Seg1 represents the top mask segment, typically used to detect overshoot. Similarly, Seg3 is the base mask segment that detects
undershoot. Seg2 is the center-of-eye mask, which typically has four or six vertices. The mask vertices are represented by xy pairs where
x is in seconds and y is in volts. All mask segments must be convex. The center of the eye is the time reference point t = 0.

For reasons beyond the scope of this document, it is not valid to have ALL time values for ALL segments greater than zero.

The top and base segments can affect the eye diagram scale. The eye diagram will always be scaled such that these segments are fully
displayed.

If it is desired to disable a mask segment, use four identical vertices (conceptually describing a rectangle with zero width and zero height).
Such a segment will cause no mask hits, although it can still affect eye diagram scaling. For example, :MASK:USER:SEG1:POINTS
0,4,0,4,0,4,0,4; would disable the upper segment, but it would force the top edge of the eye diagram to at least +4 V.

All other fields are optional, at the time of this writing, and are ignored by DPOJET. It is possible that future versions of DPOJET software
will use additional fields as new features are added to TekScope firmware or DPOJET.

An example mask file is as follows. Only the last three lines are mandatory:
:MASK:USER:WID 400.0000E-12;
:MASK:USER:LAB "User Mask";
:MASK:USER:VSCA 200.0000E-3;
:MASK:USER:BITR 2.5000E+9;
:MASK:USER:SEG1:POINTS
-200.0000E-12,600.0000E-3,200.0000E-12,600.0000E-3,200.0000E-
12,800.0000E-3,-200.0000E-12,800.0000E-3;
:MASK:USER:SEG2:POINTS -140.0000E-12,0.0000,25.8494E-27,-400.0000E-3,140.0000E-
12,0.0000,25.8494E-27,400.0000E-3;
:MASK:USER:SEG3:POINTS
-200.0000E-12,-800.0000E-3,200.0000E-12,-800.0000E-3,200.0000E-12,-
600.0000E-3,-200.0000E-12,-600.0000E-3;

Correlation of measurement to configuration
The following tables list the configure tabs displayed for each measurement.

Table 181: Period/Freq measurements

UI Name Measurements Edges Bit Config
Clock
Recovery RJDJ Filters General Global Optical

Period Clock Period

Data Period

Freq Clock Frequency

Data Frequency

Table continued…
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UI Name Measurements Edges Bit Config
Clock
Recovery RJDJ Filters General Global Optical

Pos Width Pos Width

Neg Width Neg Width

N–Period N–Period

+Duty Cycle +Duty Cycle

-Duty Cycle -Duty Cycle

CC-Period CC-Period

+CC-Duty +CC-Duty

-CC-Duty -CC-Duty

Datarate

Table 182: Jitter measurements

UI Name Measurements Bit Config Edges
Clock
Recovery BER RjDj Filters General Global Optical

TIE Clock TIE

Data TIE

TJ@BER Clock TJ

Data TJ

DCD Clock DCD

Data DCD

RJ Clock RJ

Data RJ

RJ (h)

RJ(v)

PJ(h)

PJ(v)

Table continued…
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UI Name Measurements Bit Config Edges
Clock
Recovery BER RjDj Filters General Global Optical

PJrms

SJ@Freq

DJ Clock DJ

Data DJ

DDJ DDJ

RJ–δδ Clock RJ–δδ

Data RJ–δδ

DJ–δδ Clock DJ–δδ

Data DJ–δδ

PJ Clock PJ

Data PJ

SRj SRj

F/N F/N

Jitter
Summary 5
0

Phase
Noise

J2 Clock TJ

Data TJ

J9 Clock TJ

Data TJ

PkPkClkRJ

PkPkClkDJ

PkPkClkTJ

50 Jitter Summary is not an individual measurement but a convenience function. Pressing this button automatically adds a set of eleven jitter-related
measurements with a single action. The measurements are: TIE, RJ, RJ–δδ, DJ, DJ–δδ, PJ, DDJ, DCD, TJ@BER, and Width@BER.
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Table 183: Noise measurements

UI Name Measurement
s

Bit config RnDn Clock
recovery

Filters General Global Optical

RN

RN (v)

RN (n)

DN

DDN

DDN1

DDN0

PN

PN(v)

PN(h)

NPN

TN@BER

Unit
Amplitude

Noise
summary 51

Table 184: Timing measurements

Measurements SSC Bus State Edges
Clock
Recovery RJDJ Filters General Global Optical

Rise Time

Fall Time

Skew

Gated Skew

Table continued…

51 Noise Summary is not an individual measurement but a convenience function. Pressing this button automatically adds a set of eleven noise-related
measurements with a single action. The measurements are: RN, DN, PN, DDN, DDN1, DDN0, TN@BER.
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Measurements SSC Bus State Edges
Clock
Recovery RJDJ Filters General Global Optical

High Time

Low Time

Setup

Rise Slew Rate

Fall Slew Rate

Hold

SSC Profile

SSC Mod Rate

SSC Freq Dev

SSC Freq Dev
Min

SSC Freq Dev
Max

Time Outside
Level

tCMD-CMD

Table 185: Eye measurements

Measurements Bit Config Edges
Clock
Recovery RNDN RJDJ Filters General Global Optical

Width

Width@BER

Height

Height@BER

Mask Hits

Eye High

Eye Low

Table continued…
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Measurements Bit Config Edges
Clock
Recovery RNDN RJDJ Filters General Global Optical

Q-Factor

AutoFit Mask Hits

Table 186: Amplitude measurements

Measurements Bit Config Edges
Clock
Recovery RJDJ Filters General Global Optical

AC RMS

High

DC Common Mode

AC Common Mode

Low

T/nT Ratio

High–Low

V–Diff–Xovr

Overshoot

Undershoot

Cycle Pk-Pk

Cycle Min

Cycle Max

Table 187: Standard-specific measurements

Measurements Bus State Bit Config Edges
Clock
Recovery BER Filters General Global Optical

PCI Express

PCIe Med-Mx-
Jitter

Table continued…
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Measurements Bus State Bit Config Edges
Clock
Recovery BER Filters General Global Optical

PCIe T-RF-
Mismch

PCIe MAX-MIN
Ratio 52

PCIe SSC FREQ
DEV

PCIe SSC
PROFILE

PCIe T-Tx-Diff-PP

PCIe T-TX

PCIe T-Tx-Fall

PCIe Tmin-Pulse

PCIe DeEmph

PCIe T-Tx-Rise

PCIe UI

PCIe AC
Common Mode

T-TX-DJ

T-TX-UTJ

T-TX-UDJDD

T-TX-UPW-TJ

T-TX-UPWDJDD

V-TX-NO-EQ

V-TX- EIEOS

ps21TX

USB 3.0 Essentials

Table continued…

52 Custom name for PCIe MAX-MIN Ratio is PCIe VRX-MAX-MIN Ratio.
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Measurements Bus State Bit Config Edges
Clock
Recovery BER Filters General Global Optical

USB VTx-Diff-PP

USB TCdr-Slew-
Max

USB Tmin-Pulse-
Tj

USB Tmin-Pulse-
Dj

USB SSC MOD
RATE

USB SSC FREQ-
DEV MAX

USB SSC FREQ
DEV-MIN

USB SSC
PROFILE

USB UI

USB AC
Common Mode

Optical

AOP

ER

OMA

Optical High

Optical Low

Eye Crossing
Level
Eye Crossing
Time
Eye Crossing
Percent
Mask Hit Ratio
Table continued…
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Measurements Bus State Bit Config Edges
Clock
Recovery BER Filters General Global Optical

Mask Margin
RIN
RINxOMA
TDEC

Reference
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Algorithms
About algorithms
The DPOJET application can take measurements from one or two waveforms. The number of waveforms used by the application depends
on the type of measurement being taken.

Oscilloscope setup guidelines
For all measurements, use the following guidelines to set up the oscilloscope:

1. The signal is any channel, reference, or math waveform.
2. The vertical scale for the waveform must be set so that the waveform does not exceed the vertical range of the oscilloscope.
3. The sample rate must be set to capture sufficient waveform detail and avoid aliasing.
4. Longer record lengths increase measurement accuracy but the oscilloscope takes longer to measure each waveform.

Period/Freq measurements

Period

If the Signal Type is Clock
The Period measurement calculates the duration of a cycle as defined by a start and a stop edge. Edges are defined by polarity, threshold,
and hysteresis. The application calculates clock period measurement using the following equation:

Where:

P Clock is the clock period.

T is the VRefMid crossing time for the selected polarity.

If the Signal Type is Data
The Period measurement calculates the duration of a Unit Interval. The application calculates this measurement using the following
equation:

Where:

P Data is the data period.

T Data is the VRefMid crossing time in either direction.

K n = Cn –C n-1 is the estimated number of unit intervals between two successive edges. Cn is the calculated data bit index of T n Data.

Each measurement result P n Data is repeated K n times in the measurement result vector, so that the measurement population is equal to
the number of unit intervals in the qualified waveform, rather than the number of edge pairs.

Algorithms
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Positive and negative width
Amount of time the waveform remains above/below the mid reference voltage level.

The application calculates these measurements using the following equations:

Where:

W + is the positive pulse width.

W — is the negative pulse width.

T — is the VRefMid crossing on the falling edge.

T + is the VRefMid crossing on the rising edge.

Frequency
Frequency measurement calculates the inverse of the data period for each cycle.

If the Signal Type is Clock
The application calculates clock frequency measurement using the following equation:

Where:

F Clock is the clock frequency.

P Clock is the clock period measurement.

If the Signal Type is Data
The application calculates data frequency measurement using the following equation:

Where:

F Data is the data frequency.

P Data is the data period measurement.

Algorithms
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N-Period

If the Signal Type is Clock
The N–Period measurement calculates the elapsed time for N consecutive crossings of the mid reference voltage level in the direction
specified.

The application calculates this measurement using the following equation:

Where:

NP Clock is the accumulated period for N clock cycles.

T Clock is the VRefMid crossing time for the selected edge polarity.

If the Signal Type is Data
The N–Period measurement calculates the elapsed time for N consecutive unit intervals.

The application calculates this measurement using the following equation:

Where:

NP Data is the duration for N unit intervals.

T Data is the VRefMid crossing time in either direction.

If T n+N Data does not exist for a given n, no measurement is recorded for that position.

Positive and negative duty cycle
The +Duty Cycle and –Duty Cycle measurements calculate the ratio of the positive (or negative) portion of the cycle relative to the period.

The application calculates these measurements using the following equations:

Where:

D + is the positive duty cycle.

D — is the negative duty cycle.

W + is the positive pulse width.

W — is the negative pulse width.

P Clock is the period.

Related topics
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Period

Positive and negative width

CC-Period
The CC–Period measurement calculates the difference in period measurements from one cycle to the next.

The application calculates CC–Period measurement using the following equation:

Where:

ΔP is the difference between adjacent periods.

P Clock is the clock period measurement.

Positive and negative CC duty
The + CC–Duty and – CC–Duty measurements calculate the difference in positive (or negative) pulse widths from one cycle to the next.

The application calculates these measurements using the following equations:

Where:

ΔW + is the difference between positive pulse widths of adjacent clock cycles.

ΔW — is the difference between negative pulse widths of adjacent clock cycles.

W + is the positive pulse width measurement.

W — is the negative pulse width measurement.

Data rate

If the Signal Type is Clock
The Data Rate measurement calculates the inverse of the mean duration of all cycles defined by the consecutive starting and stopping
edges. Edges are defined by polarity, threshold and hysteresis. The application calculates the Data Rate using the following equation:

If the Signal Type is Data
The Data Rate measurement calculates the inverse of the mean duration of the Unit Intervals in the signal. The application calculates the
Data Rate using the following equation:
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Where:

Tn is the VRefMid crossing time in both direction

Kn is the estimated number of unit intervals in successive edges

Jitter measurements

TIE
TIE (Time Interval Error) is the difference in time between an edge in the source waveform and the corresponding edge in a reference
clock. The reference clock is usually determined by a clock recovery process performed on the source waveform. For Explicit-Clock clock
recovery, the process is performed on an explicitly identified source.

If the Signal Type is Clock
The application calculates Clock TIE measurement using the following equation:

Where:

TIE Clock is the clock time interval error.

T 'Clock is the corresponding edge time for the specified reference clock.

If the Signal Type is Data
The application calculates Data TIE measurement using the following equation:

Where:

TIE Data is the data time interval error.

T 'Data is the corresponding edge time for the specified reference clock.

The subscript k is used to indicate that there is one measurement per actual edge.

RJ
Random Jitter (RJ) is the rms magnitude of all timing errors not exhibiting deterministic behavior. A single RJ value is determined for each
acquisition, by means of RJ-DJ separation analysis.

Algorithms

284



RJ(h)
RJ(h) is the portion of RJ attributable to random horizontal displacement of the localized waveform. Compare this to RJ(v). Since RJ(h) and
RJ(v) are uncorrelated, RJ = sqrt(RJ(h)2 + RJ(v)2).

Related topics
Joint Jitter/Noise analysis on page 323

Noise model component interrelationships on page 325

RJ(v)
RJ(v) is the portion of RJ attributable to random vertical noise. If the waveform slew rate is infinite at each transition, noise would have no
effect on the edge timing. Since the waveform slew rate is finite on each transition, some amount of noise is manifested as jitter. Since
RJ(h) and RJ(v) are uncorrelated, RJ = sqrt(RJ(h)2 + RJ(v)2).

Related topics
Joint Jitter/Noise analysis on page 323

Noise model component interrelationships on page 325

Dual dirac random jitter
Dual Dirac Random Jitter (RJ–δδ) is the rms magnitude of all timing errors not exhibiting deterministic behavior, calculated based on a
simplifying assumption that the histogram of all deterministic jitter can modeled as a pair of equal-magnitude dirac functions (impulses). A
single RJ–δδ value is determined for each acquisition, by means of RJ-DJ separation analysis.

Related topics

Jitter analysis through RJ-DJ separation

Jitter estimation using Dual-Dirac models

Jitter summary
The Jitter Summary is not a single measurement. The Jitter Summary button on the graphical user interface simply creates one each of all
the other jitter measurements, as a convenience. This convenience function is not supported via the programmable interface.

TJ@BER
Total Jitter at a specified Bit Error Rate (BER). This extrapolated value predicts a peak-to-peak jitter that will only be exceeded with a
probability equal to the BER. It is generally not equal to the total jitter actually observed in any given acquisition. A single TJ@BER value is
determined for each acquisition, by means of RJ-DJ separation analysis.

DJ
Deterministic Jitter (DJ) is the peak-to-peak amplitude for all timing errors that follow deterministic behavior. A single DJ value is
determined for each acquisition, by means of RJ-DJ separation analysis.
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Dual Dirac deterministic jitter
Dual Dirac Deterministic Jitter (DJ–δδ) the peak-to-peak magnitude for all timing errors exhibiting deterministic behavior, calculated based
on a simplifying assumption that the histogram of all deterministic jitter can be modeled as a pair of equal magnitude dirac functions
(impulses). A single DJ–δδ value is determined for each acquisition, by means of RJ-DJ separation analysis.

Phase noise
The Phase Noise measurement performs a jitter measurement, converts the result into the frequency domain, and reports the rms jitter
integrated between two specific frequencies selected by the user.

The phase noise measurement is defined only for clock signals. If the source waveform appears to be a data signal, a warning message
will be produced but the measurement will proceed.

PJ
Periodic Jitter (PJ) is the peak-to-peak amplitude for that portion of the deterministic jitter which is periodic, but for which the period is
not correlated with any data pattern in the waveform. A single PJ value is determined for each acquisition, by means of RJ-DJ separation
analysis.

PJ(h)
PJ(h) is the portion of PJ attributable to periodic horizontal displacement of the waveform. Compare this to PJ(v). For any given frequency,
PJ(h) and PJ(v) are correlated and added algebraically. If PJ(h) and PJ(v) are at the same frequency but of opposite phase, one or both
can be larger than PJ.

Related topics
Joint Jitter/Noise analysis on page 323

Noise model component interrelationships on page 325

PJ(v)
PJ(v) is the portion of PJ attributable to periodic vertical noise. If the waveform slew rate is infinite at each transition, noise would have
no effect on the edge timing. Since the waveform slew rate is finite on each transition, some amount of noise is manifested as jitter. For
any given frequency, PJ(h) and PJ(v) are correlated and added algebraically. If PJ(h) and PJ(v) are at the same frequency but of opposite
phase, one or both can be larger than PJ.

Related topics
Joint Jitter/Noise analysis on page 323

Noise model component interrelationships on page 325

NPJ
Non-Periodic Jitter (NPJ) is the dual-dirac magnitude of that portion of Bounded Uncorrelated Jitter (BUJ) that is not periodic. Since it is not
periodic and is not correlated with the data pattern, NPJ is frequently difficult to distinguish from (Gaussian) RJ.
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This component of jitter is not analyzed by default, but you can enable it by switching the jitter analysis mode to Spectral + BUJ. Since
it typically requires high populations to distinguish, you may need to acquire multiple waveforms before jitter results are available when
Spectral + BUJ mode is enabled.

DDJ
Data-Dependent Jitter (DDJ) is the peak-to-peak amplitude for that portion of the deterministic jitter directly correlated with the data pattern
in the waveform. A single DDJ value is determined for each acquisition, by means of RJ-DJ separation analysis.

DCD
Duty Cycle Distortion (DCD) is the peak-to-peak amplitude for that portion of the deterministic jitter directly correlated with signal polarity,
that is the difference between the mean positive edge displacement versus that on negative edges. A single DCD value is determined for
each acquisition, by means of RJ-DJ separation analysis.

J2
J2 is Total Jitter at a Bit Error Rate (BER) value of 2.5E-3. This statistical value predicts a peak-to-peak jitter that will only be exceeded with
a probability equal to the BER.

J9
J9 is Total Jitter at a Bit Error Rate (BER) value of 2.5E-10. This statistical value predicts a peak-to-peak jitter that will only be exceeded
with a probability equal to the BER.

SRJ
Sub-Rate Jitter is periodic jitter at a rate that integrally divides the data rate. For example, if the data rate is F bits/second, sub-rate jitter
components could occur at F/2 or F/4. It typically occurs when a serial data stream is formed by multiplexing (interleaving) an integral
number of lower-rate bit streams together, although there can be other causes. Sub-rate jitter is a sub-component of PJ.

The SRJ measurement is the peak-to-peak amplitude for the sum of all F/N jitter components that are tracked by DPOJET. Since different
F/N components are correlated with each other, the peak-to-peak SRJ depends on relative phases and is not simply the sum of the
individual F/N components.

The SRJ measurement always tracks and accounts for N = 2, 4 and 8 regardless of whether the corresponding F/N measurements have
been selected.

F/N
Conceptually, F/N jitter is the peak-to-peak amplitude of periodic jitter occurring at a rate that divides the data rate (F) by the integer N.
However, it excludes jitter occurring at harmonics of F/N. For example, F/4 jitter occurs at one fourth the data rate (but the measurement
excludes jitter attributable to F/2 before determining the peak-to-peak amplitude).

For a repeating data pattern, some deterministic jitter can be interpreted either as DDJ or as F/N jitter. This condition occurs when the
pattern length, P, is an integer multiple of N. By convention, such jitter is reported as DDJ, and the corresponding F/N is reported as zero.
For example, a signal with a pattern length of 10 would report F/2 = 0 since jitter at half the bit rate can be interpreted as DDJ. But F/4 and
F/8 may be non-zero since they cannot be DDJ for this pattern length.

The measurement uses a divisor (N) of 2 by default but a divisor of 2, 4 or 8 can be selected.

For a given N, the value of F/N is computed as follows:
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For a data stream of I bits, the mean jitter for each of the phases n ∈{1, 2, … N} is calculated as:

The jitter-per-phase is collected into a jitter trend or array:

From this trend, the trends attributable to higher harmonics are removed (for example, the T2 and T4 trends are subtracted from the T8
trend):

The peak-to-peak jitter is then:

From this trend, the trends attributable to higher harmonics are removed (for example, the T2 and T4 trends are subtracted from the T8
trend):

For a repeating data pattern with repeat length N, some deterministic jitter falls in an ambiguous category where it could be interpreted
either as DDJ or as F/N jitter. By convention, such jitter is reported as DDJ, and the corresponding F/N is reported as zero.

Related topics

SRJ

Jitter analysis through RJ-DJ separation

PJrms
Periodic Jitter RMS (PJrms) is the root mean square amplitude for that portion of the deterministic jitter which is periodic but for which the
period is not correlated with any data pattern in the waveform. A single PJrms value is determined for each acquisition, by means of RJ-DJ
separation analysis.

SJ@Freq
SJ@Freq is a Sinusoidal Jitter measurement which reports the peak to peak amplitude of energy within the narrow spectral band specified
by the user. A single SJ@Freq value is determined for each acquisition, by means of TIE spectral analysis.

Clock Pk-Pk
This measurement calculates the peak-to-peak jitter for larger sample sizes of clock signal, similar to jitter tail-fitting procedure. This
measurement is specific to only Clock signal as input and is related to the Period measurement only. It also does not support any plots.
The measurement computation steps are defined below:
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1. Capture the Period of the clock signal and accumulate. Find the Pk-Pk value and Standard deviation value.
2. Capture the Histogram result of the periods.
3. From the histogram data, separate out Random (PkPkClkRJ) and Deterministic (PkPkClkDJ) components by tail-fitting procedure.
4. The Pk-Pk jitter (PkPkClkTJ) of the BER 53 is equal to RJ*2*Q@BER+DJ.

Noise measurements

TN@BER
Total Noise at a specified Bit Error Rate (BER). This extrapolated value predicts a peak-to-peak vertical eye closure (relative to the
estimated bit amplitude) that will only be exceeded with a probability equal to the BER. It is generally not equal to the total vertical closure
actually observed in any given acquisition. A single TN@BER value is determined for each acquisition, by means of RN-DN separation
analysis.

Related topics
Joint Jitter/Noise analysis

Noise model component interrelationships

RN
Random Noise (RN) is the rms magnitude of all vertical deviations from nominal bit amplitude not exhibiting deterministic behavior. A single
RN value is determined for each acquisition, by means of RN-DN separation analysis.

Related topics
Joint Jitter/Noise analysis on page 323

Noise model component interrelationships on page 325

RN(v)
RN(v) is the portion of RN attributable to random vertical displacement of the waveform. Compare this to RN(h). Since RN(v) and RN(h)
are uncorrelated, RN = sqrt(RN(v)2 + RN(h)2).

Related topics
Joint Jitter/Noise analysis on page 323

Noise model component interrelationships on page 325

RN(h)
RN(h) is the portion of RN attributable to random jitter. If the waveform slew rate is zero across the center of each bit, jitter will have no
effect on vertical measurements at this point. But if the waveform slew rate is not zero at the center of each bit, some amount of jitter is
manifested as vertical displacement. Since RN(v) and RN(h) are uncorrelated, RN = sqrt(RN(v)2 + RN(h)2).

53 You can configure the BER values. Example, 10^-18, 10^-12.
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Related topics
Joint Jitter/Noise analysis on page 323

Noise model component interrelationships on page 325

DN
Deterministic Noise (DN) is the peak-to-peak amplitude for all vertical deviations from nominal bit amplitude that follow deterministic
behavior. A single DN value is determined for each acquisition, by means of RN-DN separation analysis.

Related topics
Joint Jitter/Noise analysis on page 323

Noise model component interrelationships on page 325

PN
Periodic Noise (PN) is the peak-to-peak amplitude for that portion of the deterministic noise which is periodic, but for which the period is
not correlated with any data pattern in the waveform. A single PN value is determined for each acquisition, by means of RN-DN separation
analysis.

Related topics
Joint Jitter/Noise analysis on page 323

Noise model component interrelationships on page 325

PN(v)
PN(v) is the portion of PN attributable to periodic vertical displacement of the waveform. Compare this to PN(h). For any given frequency,
PN(v) and PN(h) are correlated and added algebraically. If PN(v) and PN(h) are at the same frequency but of opposite phase, one or both
can be larger than PN.

Related topics
Joint Jitter/Noise analysis on page 323

Noise model component interrelationships on page 325

PN(h)
PN(h) is the portion of PN attributable to periodic jitter. If the waveform slew rate is zero across the center of each bit, jitter will have no
effect on vertical measurements at this point. But if the waveform slew rate is not zero at the center of each bit, some amount of jitter is
manifested as vertical displacement. For any given frequency, PN(v) and PN(h) are correlated and added algebraically. If PN(v) and PN(h)
are at the same frequency but of opposite phase, one or both can be larger than PN.

Related topics
Joint Jitter/Noise analysis on page 323

Noise model component interrelationships on page 325
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DDN(0)
Data-Dependent Noise for 0 bits (DDN(0)) is the peak-to-peak amplitude for all bit pattern-correlated vertical variations of low bits from the
nominal low level, at the center of the eye. A single DDN(0) value is determined for each acquisition.

Related topics
Joint Jitter/Noise analysis on page 323

Noise model component interrelationships on page 325

DDN(1)
Data-Dependent Noise for 1 bits (DDN(1)) is the peak-to-peak amplitude for all bit pattern-correlated vertical variations of high bits from the
nominal high level, at the center of the eye. A single DDN(1) value is determined for each acquisition.

Related topics
Joint Jitter/Noise analysis on page 323

Noise model component interrelationships on page 325

DDN
Data-Dependent Noise (DDN) is the total vertical eye closure due to bit pattern-correlated vertical variations, at the center of the eye. It is
the sum of the positive peak DDN(0) relative to the nominal low level, and the negative peak DDN(1) relative to the nominal high level. A
single DDN value is determined for each acquisition.

Related topics
Joint Jitter/Noise analysis

Noise model component interrelationships

NPN
Non-Periodic Noise (NPN) is the dual-dirac magnitude of that portion of Bounded Uncorrelated Noise (BUN) that is not periodic. Since it
is not periodic and is not correlated with the data pattern, NPN is frequently difficult to distinguish from (Gaussian) RN. This component of
noise is not analyzed by default, but you can enable it by switching the analysis mode to Spectral + BUJ. Since it typically requires high
populations to distinguish, you may need to acquire multiple waveforms before noise results are available when Spectral + BUJ mode is
enabled.

Related topics
Separation of Non-Periodic jitter (NPJ)

Preferences-Jitter decomp

Unit Amplitude
The Unit Amplitude is the automatically determined nominal eye amplitude at the horizontal center of the eye. The nominal High level is
the mean value of the distribution that represents DDN(1), and the nominal Low level is the mean value of the distribution that represents
DDN(0). Unit Amplitude is the difference between these nominal High and Low values, and it is used to normalize all the other noise
measurements if the units are switched from absolute to normalized. The actual High and Low levels are not individually reported, but they
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are depicted on plots such as the BER Eye Contour, PDF Eye, Correlated Eye, using pink dots positioned along a vertical line at the eye
center.

Related topics
Joint Jitter/Noise analysis

Noise model component interrelationships

Noise summary
The Noise Summary is not a measurement. The Noise Summary button on the graphical user interface simply creates one each of all the
primary noise measurements, as a convenience. The function is also accessible via the programmable interface.

Timing measurements

Rise time
The Rise Time measurement is the time difference between when the VRefHi reference level is crossed and the VRefLo reference level is
crossed on the rising edge of the waveform. The Rise Time algorithm uses the VRef values as the reference voltage level. Each edge is
defined by the slope, voltage reference level (threshold), and hysteresis.

The application calculates this measurement using the following equation:

Where:

T Rise is the Rise Time.

T Hi+ is the VRefHi crossing on the rising edge.

T Lo+ is the VRefLo crossing on the rising edge.

Fall time
The Fall Time measurement is the time difference between when the VRefLo reference level is crossed and the VRefHi reference level is
crossed on the falling edge of the waveform. The Fall Time algorithm uses the VRef values as the reference voltage level. Each edge is
defined by the slope, voltage reference level (threshold), and hysteresis.

The application calculates this measurement using the following equation:

Where:

T Fall is the Fall Time.

T Lo- is the VRefLo crossing on the falling edge.

T Hi- is the VRefHi crossing on the falling edge.
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Gated Skew
Gated Skew is the time between the mid reference level crossings on the region specified by Gates on Source1 to the mid reference level
crossings on the region specified by Gates on Source2. The direction of the edge crossings are configurable.

The application calculates this measurement using the following equation:

Where:

T Gated Skew is the timing skew.

T Gate1 is the Main input Mid reference crossing time in the configured direction in Gate associated with Source1.

T Gate2 is the 2nd input Mid2 reference crossing time in the configured direction in Gate associated with Source 2.

Skew
Skew is the time between the mid reference level crossing on Source1 to the mid reference level crossing on Source2. The direction of the
edge crossing is configurable.

The application calculates this measurement using the following equation:

Where:

T Skew is the timing skew.

T Main is the Main input Mid reference crossing time in the configured direction.

T 2nd is the 2nd input Mid2 reference crossing time in the configured direction.

High time
The High Time Measurement is the amount of time that a waveform cycle is above the High reference voltage level.

The application calculates the measurement using the following equation:

Where:

T High is the high time.

T Hi- is the High reference crossing on the falling edge.

T Hi+ is the High reference crossing on the rising edge.

Low time
The Low Time measurement is the amount of time that a waveform cycle is below the Low reference voltage level.

The application calculates this measurement using the following equation:
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Where:

T Low is the low time.

T Lo+ is the Low reference crossing on the rising edge.

T Lo- is the Low reference crossing on the falling edge.

Setup
Setup Time is the time between the mid reference level crossing of the clock source (Source1) and the closest previous mid reference level
crossing of the data source (Source2). The crossings (edges) may be configured to be rising, falling or either.

The application calculates this measurement using the following equation:

Where:

T Setup is the setup time.

T Main is the Main input (clock) Mid reference crossing time in the specified direction.

T 2nd is the 2nd input (data) Mid2 reference crossing time in the specified direction.

Rising Slew Rate measurement algorithm
The Rise Slew Rate is defined as the rate of change of the voltage between the crossings of the specified VREFHI and VREFLO reference
voltage levels. The voltage difference is measured between the VREFHI reference level crossing and the VREFLO reference level crossing on
the rising edge of the waveform. The time difference is measured as the difference between the low time, and the low time at which VREFLO
and VREFHI are crossed. The Rise Slew Rate algorithm uses the high and low rise reference voltage levels to configure the values. Each
edge is defined by the slope, voltage reference level (threshold), and the hysteresis.

Figure 207: Rising Slew Rate measurement algorithm

The application calculates this measurement using the following equation:
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Fall slew rate
The Fall Slew Rate is defined as the rate of change of the voltage at the specified VREFLO and VREFHI reference voltage levels. The voltage
difference is measured between the VREFLO reference level crossing and the VREFHI reference level crossing on the falling edge of the
waveform. The time difference is measured as the difference between the high time and low time at which VREFHI and VREFLO are crossed.
The Fall Slew Rate algorithm uses the low time and high fall reference voltage levels to configure the values. Each edge is defined by the
slope, voltage reference level (threshold), and the hysteresis.

Figure 208: Fall slew rate

The application calculates this measurement using the following equation:

Hold
The Hold Time measurement is the elapsed time between when the clock waveform crosses its own voltage reference level and the
designated edge of a data waveform. The closest data edge to the clock edge that falls within the range limits is used.

The application calculates this measurement using the following equation:

Where:

T Hold is the hold time.

T Main is the Main input (clock) Mid reference crossing time in the specified direction.

T 2nd is the 2nd input (data) Mid2 reference crossing time in the specified direction.
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Note: The order of the input sources for Setup and Hold measurements (Source1 = Clock, Source2 = Data) differs from the order
of input sources on the Setup/Hold Trigger menu in the oscilloscope.

SSC profile
SSC Profile shows the modulation profile of the Spread Spectrum Clocking (SSC). It is the time trend plot of the SSC profile. All SSC
measurements use the Period measurement with a second order low pass filter. Using the profile you can analyze the SSC modulation
rate by using the horizontal cursors. You can also analyze the peak-to-peak frequency deviation by using the vertical cursors.

The following are the default configurations that are required:

• Constant Clock Recovery (CCR) Mean set as the Clock Recovery method.
• Low pass filter with 1.98 MHz cut off frequency set by default. This is the standard FiberChannel cut off frequency.
• Available plots are Time Trend, Data Array, Histogram and Spectrum plots.

SSC MOD rate
SSC Modulating Rate is the modulating frequency of a spread spectrum clock. It is the rate that the clock frequency changes.

Clock recovery is used on the measurement. The method is constant clock mean.

SSC FREQ DEV MIN
The SSC FREQ DEV MIN is defined as the minimum frequency shift as a function of time. It represents the frequency deviation in terms of
ppm (parts per million).

• Find the 50% edges on the SSC profile.
• Calculate the LOW value between the n and n+1 edge.
• Find the Minimum frequency deviation as LOW.

The application calculates the measurement using the equation:

Freq Dev Min(ppm)= ((Minimum Freq–Nominal Data Rate)/Nominal Data Rate)* 1e6

Available plots are Time Trend, Data Array, Histogram and Spectrum plots.

SSC FREQ DEV MAX
SSC FREQ DEV MAX is defined as the maximum frequency shift as a function of time. It represents the frequency deviation in terms of
ppm (parts-per-million).

• Find the 50% edges on the SSC profile
• Calculate the HIGH value between the n and n+1 edge
• Find the Maximum frequency deviation as HIGH

The application calculates the measurement using the equation:

Freq Dev Max(ppm)= ((Maximum Freq – Nominal Data Rate)/Nominal Data Rate)* 1e6

The difference between the SSC FREQ DEV MAX and SSC FREQ DEV MIN measurements are that they compute the maximum
frequency deviation and minimum frequency deviation separately. By doing this the limits can be applied separately.

Available plots are Time Trend, Data Array, Histogram and Spectrum plots.
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SSC FREQ DEV
SSC Freq Dev is the spread spectrum clock frequency deviation from the nominal frequency in ppm (parts per million).

Clock recovery is used on the measurement. The method is constant clock mean.

tCMD-CMD
tCMD-CMD measures the elapsed time between two bus states, for example CMD_1 and CMD_2. For each state, the relevant timing point
can be specified as the start of the state, the end of the state, or a rising or falling edge on a separately-specified clock source. The timing
resolution of this measurement is dependent on the sample clock used. For example, if the bus is composed of digital channels sampled
as 12.5 Gsps, the resolution is 80 ps.

Figure 209: tCMD-CMD

Time Outside Level measurement algorithm
Time Outside Level is the time the signal remains above the high reference level and/or below the low reference level.

Figure 210: Time Outside Level measurement algorithm
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Eye diagram measurements

Eye width
The Eye Width measurement is the measured minimum horizontal eye opening at the zero reference level.

The application calculates this measurement using the following equation:

Where:

UI AVG is the average UI.

TIE pk-pk is the Peak-Peak TIE.

Width@BER
Width@BER is the Eye Width at a specified Bit Error Rate (BER). This extrapolated value predicts a horizontal eye opening that will be
violated with a probability equal to the BER. It is generally not equal to the eye width actually observed in any given acquisition. A single
Width@BER value is determined for each acquisition, by means of RJ-DJ separation analysis.

Eye height
The Eye Height measurement is the measured minimum vertical eye opening at the UI center as shown in the plot of the eye diagram.
There are three types of Eye Height values.

The application calculates this measurement using the following equation:

Where:

V EYE-HI-MIN is the minimum of the High voltage at mid UI.

TIE EYE-LO-MAX is the maximum of the Low voltage at mid UI.

Eye Height-Transition
The application calculates this measurement using the following equation:

Where:

V EYE-HI-TRAN-MIN is the minimum of the High transition bit eye voltage at mid UI.

TIE EYE-LO-TRAN-MAX is the maximum of the Low transition bit eye voltage at mid UI.

Eye Height-Non-Transition
The application calculates this measurement using the following equation:
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Where:

V EYE-HI-NTRAN-MIN is the minimum of the High non- transition bit eye voltage at mid UI.

TIE EYE-LO-NTRAN-MAX is the maximum of the Low non-transition bit eye voltage at mid UI.

Height@BER
Height@BER is the Eye Height at a specified Bit Error Rate (BER). This extrapolated value predicts a vertical eye opening that will be
violated with a probability equal to the BER. It is generally not equal to the eye height actually observed in any given acquisition. A single
Height@BER value, in the given interval, is determined for each acquisition by means of Q-scale extrapolation.

Eye high
Eye High calculates the voltage at a selected horizontal position across the unit interval, for all High bits in the waveform. You specify
the offset at which the measurement takes place from 0% to 100% of the unit interval. Configure the measurement to include all bits,
only transition bits, or only non-transition bits. (Note that some of the waveform can be omitted from the measurement due to initialization
of clock recovery or filtering.) A histogram of the Eye High measurement corresponds to a vertical slice through the upper half of a
three-dimensional eye diagram.

Figure 211: Eye high

Note: This illustration shows how the measurement is made, and does not represent how the oscilloscope actually displays an
eye diagram or histograms on an eye diagram plot.

Eye low
Eye Low calculates the voltage at the selected horizontal position across the unit interval, for all Low bits in the waveform. A histogram of
the Eye Low measurement corresponds to a vertical slice through the lower half of a three-dimensional eye diagram.
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Figure 212: Eye low

Note: This illustration shows how the measurement is made, and does not represent how the oscilloscope actually displays an
eye diagram or histograms on an eye diagram plot.

Q-factor
Quality Factor is the ratio of eye size to noise.

The final measurement value would be computed according to the equation below:
Q-factor = [mean(EyeHigh) - mean(EyeLow)] / [stddev(EyeHigh) + stddev(EyeLow)]
Where:

Eye High: the sample values of positive UI at x%.

Eye Low: the sample values of negative UI at x%.

For more details refer Eye Height

Mask hits
The Mask hits measurement reports the number of unit intervals in the acquisition for which mask hits occurred, for a user-specified mask.
In the Results Summary view, the Mask hits measurement reports the total number of unit intervals for which a mask hit occurred in at
least one mask zone. In the Results Details view, the number of hits in each of three segments is reported.

The Mask hits measurement has several unique properties:

• Unlike other measurements, it requires a Mask hits plot. Adding a Mask hits measurement will cause the corresponding plot to be
created automatically. If you delete a Mask hits plot, the application will remove the corresponding Mask hits measurement after
verifying the action with you.

• The Mask hits measurement does not support the Worst-Case Waveforms logging feature.
• The Mask hits measurement does not support Measurement Range Limits.
• The Mask hits measurement does not support Population Limit.
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Autofit mask hits
Autofit Mask hits measurement reports the number of pixels in the acquisition for which mask hits occurred, for a user specified mask.
In the results summary view, Autofit Mask Hits measurement reports the total number of Pixel Hits for which a mask hit occurred. In the
Results Details View, the number of hits in each of three segments is reported. The population field shows the total number of unit intervals
measured.

The AUTOFIT Mask Hits measurement has several unique properties:

• Unlike other measurements, it requires a Mask hits plot. Adding an Autofit Mask Hits measurement will cause the corresponding plot to
be created automatically. If you delete a Mask Hits plot, the application will remove the corresponding Autofit Mask Hits measurement
after verifying the action with you.

• The Autofit Mask Hits measurement does not support Worst-Case Waveforms logging.
• The Autofit Mask Hits measurement does not support Measurement Range Limits.

V-Widest Open Eye
V-Widest Open Eye measurement measures the voltage at the widest eye opening in the search range from 40% to 60% of the eye
amplitude.

The detailed procedure for the V-Widest open Eye requires the following:

• The Voltage level search range is from 40% to 60% of the eye amplitude (eye height measured at the center of the eye diagram).
• Scan for the widest eye opening at the mentioned search range. Use the voltage level at the widest eye opening as the result of

V-Widest Open eye.

DFE eye height
This measurement calculates the eye height non-parametrically based on the rendered eye diagram. The eye height measurement could
be controlled by configuring the following parameters.

• X% of UI defines the exact time point (expressed as % of time range) in the horizontal scale to measure the eye height.
• Resolution defines the window around the V% to search for the maximum height.

Note: Select Absolute Voltage Level to enter the value in absolute instead of relative percentage.

DFE eye width
This measurement calculates the eye width non-parametrically based on the rendered eye diagram. The eye width measurement could be
controlled by configuring the following parameters.

• V% of Pk-Pk defines the exact voltage point (expressed as % of max voltage) in the vertical scale to measure the eye width.
• Resolution defines the window around the V% to search for the maximum width.

Note: Select Absolute Voltage Level to enter the value in absolute instead of relative percentage.

DFE eye diagram
This measurement calculates the rendered eye diagram with a specified mask. If a valid mask is present, then it returns the mask hit status
after rendering.
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Amplitude measurements

AC RMS
AC RMS is the true Root Mean Square of the data points about the Mean (µ).

The application calculates this measurement using the following equation:

Where,

N = Total number of samples

Xn = Voltage of nth sample

μ = Mean voltage of the waveform

High
The High Amplitude measurement calculates the nominal amplitude of a “1” bit, in one of two ways depending on the selected Method.
Note that the Mean method results in one measurement value for each “1” bit of the selected type, whereas the Mode method results in a
single measurement value for the entire waveform record.

When the Method = Mean, the measurement is calculated using the following equation:

Vn Hi = Mean[vn percent]

Where:

VHi is the high amplitude measurement result.

vn percent is the set of all waveform samples for event n falling within the selected portion (percent) of the unit interval, ranging from 1% to
100%. If no waveform samples fall within the window for a given unit interval, the single sample nearest in time to the window is taken.

n is the index of a high bit, a high transition bit, or a high non-transition bit.

When the Method = Mode, the measurement is calculated using the following equation:

VHi = Mean[vn percent]

Where vpresent represents a single histogram containing all the waveform samples selected according to the same windowing and transition
type criteria as in the Mean method.

Low
The Low Amplitude measurement calculates the nominal amplitude of a “0” bit, in one of two ways depending on the selected Method.
Note that the Mean method results in one measurement value for each “0” bit of the selected type, whereas the Mode method results in a
single measurement value for the entire waveform record.

When the Method = Mean, the measurement is calculated using the following equation:

Vn Lo = Mean[vn percent]

Where:
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VLo is the low amplitude measurement result.

vn percent is the set of all waveform samples for event n falling within the selected portion (percent) of the unit interval, ranging from 1% to
100%. If no waveform samples fall within the window for a given unit interval, the single sample nearest in time to the window is taken.

n is the index of a low bit, a low transition bit, or a low non-transition bit.

When the Method = Mode, the measurement is calculated using the following equation:

VLo = Mean[vn percent]

Where vpresent represents a single histogram containing all the waveform samples selected according to the same windowing and transition
type criteria as in the Mean method.

DC common mode
The Common Mode Voltage measurement (also called DC Common Mode) calculates the mean of the Common Mode voltage waveform.

The application calculates this measurement using the following equation:

Where:

V CM is the common mode voltage measurement.

 is the common mode voltage waveform.

i is the sample index of common mode waveform values.

AC common mode
The AC Common Mode Voltage measurement is the common mode voltage between two single-ended signals. AC is defined as all the
frequency components above the cutoff frequency (30 kHz).

The application calculates this measurement using the following equations (based on two single-ended sources from the DUT):
CM_Voltage = (Source1 + Source2) ÷ 2
AC_CMM p-p = Peak-to-Peak(High Pass filter (CM_Voltage))
Where:

AV_CMV p-p is the peak-to-peak common mode voltage.

T/nT ratio
The T/nT Ratio measurement reports the amplitude ratio between transition and non-transition bits.

The measurement calculates the ratios of all non-transition eye voltages (2nd and subsequent eye voltages after one edge but before the
next) to their nearest preceding transition eye voltage (1st eye voltage succeeding an edge). In the accompanying diagram, it is the ratio of
the Black voltages to the Blue voltages. The results are given in dB.
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Figure 213: T/nT ratio

The application calculates the T/nT Ratio using the following equations:

following a rising edge.

following a falling edge.

Where:

v EYE–HI–TRAN is the High voltage at the interpolated midpoint of the first unit interval following a positive transition.

v EYE–LO–TRAN is the Low voltage at the interpolated midpoint of the first unit interval following a negative transition.

v EYE–HI–NTRAN is the High voltage at the interpolated midpoint of all unit intervals except the first following a positive transition.

v EYE–LO–NTRAN is the Low voltage at the interpolated midpoint of all unit intervals except the first following a negative transition.

m is the index for all non-transition UIs.

n is the index for the nearest transition UI preceding the UI specified by m.

In a time trend plot of the measurement results, there is one measurement for each non-transition bit in the waveform (that is the black
arrows in the diagram).

High-Low
High – Low is the difference between High and Low amplitude measurements that bound each selected transition. The value is always
expressed as a positive number regardless of whether the transition is rising or falling. Note that the Mean method results in one
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measurement value for each selected transition , whereas the Mode method results in a single measurement value for the entire waveform
record.

A Transition Bit is defined as a bit that is preceded by one of the opposite polarity. A Non-Transition Bit is defined as a bit that is preceded
by one of the same polarity. For the High – Low measurement, the Bit Type (All, Transition or Non-Transition) refers to the first of the two
bits being measured. The second of the two bits must always be a transition bit. The diagram below should help make this clear.

Figure 214: High-Low

When the Method = Mean, the measurement is calculated using the following equation:

For rising transitions, Vn High-Low = VHi n+1 - Vn Lo

For falling transitions, Vn High-Low = |VLo n+1 - Vn Hi|

Where:

VHigh-Low is the high-low amplitude measurement result.

VHi is a High amplitude measurement result using the Mean method.

VLo is a Low amplitude measurement result using the Mean method.

n is the index of a bit of the selected type (all, transition or non-transition)

When the Method = Mode, the measurement is calculated using the following equation:

For rising transitions, Vdiff(n) = VHi n+1 - Vn Lo

For falling transitions, Vdiff(n) = |VLo n+1 - Vn Hi|

VHigh-Low = Mode[Vdiff]

Where [Vdiff] represents a single histogram containing all the individual rising and falling differences.

Note: If there are no waveform samples that fall within the identified percentage of the unit interval, the single nearest waveform
sample preceding the center point of the unit interval will be used.

V-Diff-Xovr
The Differential Crossover Voltage measurement (V–Diff–Xovr) calculates the voltage level at the crossover voltage of a differential signal
pair. If there is timing jitter on one of the pair of signal lines relative to the other, the crossover point will be modulated by the jitter. The
measurement is calculated using the following equation:

Where:

V Crossover is the crossing voltage.
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V Source1 is the voltage of the first source waveform.

T Crossover is the crossover time, when the Source1 and Source2 waveforms are equal in voltage.

Overshoot
Overshoot is the maximum peak amplitude above the Reference voltage level (VREF). Non-differential signals (Single Ended) are required
for this measurement such as DQS (SE) and CK(SE). For DQS signals, Search and Mark should be enabled.

Figure 215: Overshoot

Related topics

High mid and low reference voltage levels

Undershoot
Undershoot is the maximum peak amplitude below the Reference voltage level (VREF). Non-differential signals (Single Ended) are required
for this measurement such as DQS(SE) and CK(SE). For DQS signals, Search and Mark should be enabled.

Figure 216: Undershoot

Related topics

High mid and low reference voltage levels

Cycle max
Cycle Max is a voltage measurement which measures positive peak voltage for all cycles. It is the maximum voltage for each cycle from
the mid level of rise to the fall slope.

The application calculates this measurement using the following equation:

V CycleMax = Max(f(RiseIndex(i) to FallIndex(i+1))

Where:
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I =1 to the valid edge of the last cycle.

f is the function, which finds the maximum sample point in the defined region.

Cycle min
Cycle Min is a voltage measurement which measures negative peak voltage for all cycles. It is the minimum voltage for each cycle from the
mid level of Fall to the Rise slope.

The application calculates this measurement using the following equation:

V CycleMin = Min(f(FallIndex(i) to RiseIndex(i+1))

Where:

I =1 to the valid edge of the last cycle.

f is the function, which finds the minimum sample point in the defined region.

Cycle Pk-Pk
Cycle Pk-Pk is a voltage measurement which measures the absolute difference between the maximum and minimum amplitude for every
cycle of the waveform. It calculates the peak-to-peak value for all cycles of the waveform. The peak value is measured from Fall slope to
the next rise if the valid slope is a Fall. The next peak would be from Rise to next fall slope. The peak-to-peak value is calculated on all the
pairs of minimum and maximum values available.

The application calculates the Cycle Pk-Pk using the following equation:

for consecutive cycles

Where:

VMax(n) is the maximum peak amplitude.

VMin(n) is the minimum peak amplitude.

n is the number of cycles from 1 to the last valid edge.

Standard-Specific measurements

PCIe T-Tx-Diff-PP
PCIe T-Tx-Diff-PP voltage swing calculates the change in voltage level across a transition in the waveform. It is the peak-to-peak
differential voltage swing.
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The application calculates this measurement using the following equation:

Where:

VDiff-p-p is the differential peak-to-peak voltage.

VHigh is the maximum voltage calculated between i and i+1 points.

VLow is the minimum voltage calculated between i and i+1 points.

i is the index of the UI (bit) location preceding the transition.

i+1 is the index of the UI (bit) location after the transition.

PCIe T-TX
PCIe T-TX is based on the DPOJET measurement, Eye width. For more details, refer to the Eye width.

PCIe T-Tx-Fall
PCIe T-Tx-Fall is the time difference between the VRefLo(20%) reference level crossing and the VRefHi(80%) reference level crossing on
the falling edge of the waveform. The VRefLo and VRefHi are calculated based on the voltage level of the previous UI. There are two
distinct thresholds corresponding to de-emphasized transitions from high to low, and full swing transitions for VRefLo and VRefHi.
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Figure 217: PCIe T-Tx-Fall

The application calculates this measurement using the following equation:

Where:

TFall is the fall time

TLo– is the VRefLo crossing on the falling edge

THi– is the VRefHi crossing on the falling edge

PCIe Tmin-Pulse
PCIe Tmin-Pulse (minimum single pulse width TMin-Pulse) is measured from one transition center to the next.

The application calculates this measurement using the following equation:

Where:

TMin-Pulse is the minimum pulse width

T is the transition center

PCIe DeEmph
PCIe DeEmph is based on the DPOJET measurement, T/nT Ratio. For more details, refer to the T/nT ratio on page 303.

Note: PCIe DeEmph measurement uses Brick Wall filter.
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PCIe T-Tx-Rise
PCIe T-Tx-Rise is the time difference between the VRefHi(80%) reference level crossing and the VRefLo(20%) reference level crossing
on the rising edge of the waveform. The VRefHi and VRefLo are calculated based on the voltage level of the previous UI. There are two
distinct thresholds corresponding to de-emphasized transitions from low to high, and full swing transitions for VRefHi and VRefLo.

Figure 218: PCIe T-Tx-Rise

The application calculates this measurement using the following equation:

Where:

TRise is the Rise time

THi+ is the VRefHi crossing on the rising edge

TLo+ is the VRefLo crossing on the rising edge

PCIe UI
PCIe UI is based on the DPOJET measurement, Period. For more details, refer to the Period.

Note: PCIe UI uses a 3rd order LPF with the cut-off frequency of 198 kHz.

PCIe Med-Mx-Jitter
PCIe Med-Mx-Jitter is the maximum time between the jitter median and the maximum deviation from the median.

The application calculates this measurement using the following equation:

Where:

TMed-Max-Jitter is the median to max jitter
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TJitter-Median is the jitter median

TIE is the Time interval error

PCIe T-RF-Mismch
PCIe T-RF-Mismch (Rise and Fall Time mismatch measurement) is the mismatch between Rise time (TRise) and Fall time(TFall). Rise time
and Fall time are calculated using the “PCIe T-Tx-Rise” and “PCIe T-Tx-Fall” measurements.

The application calculates this measurement using the following equation:

Where:

TMismatch is the rise and fall time mismatch

TRise is the rise time

TFall is the fall time

PCIe MAX-MIN ratio
PCIe MAX-MIN Ratio (custom name is PCIe VRX-MAX-MIN Ratio) is defined as the voltage range ratio over which a particular receiver
must operate for the consecutive UI. Locate the mid edges crossover points. On the rising edge of the waveform, find the VSWINGMIN. At the
VSWINGMIN point, trace back two unit intervals to find the VSWINGMAX.

Figure 219: PCIe MAX-MIN ratio

The application calculates this measurement using the following equation:
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Where:

VSWINGMAX is the maximum voltage swing on the rising edge of the waveform.

VSWINGMIN is the minimum voltage swing on the rising edge of the waveform.

PCIe SSC PROFILE
PCIe SSC Profile measurement uses the Period measurement with a second order low pass filter of 1.98 MHz. The PCIe SSC Profile
shows the modulation profile of the Spread Spectrum Clocking. Using the SSC profile, you can find the SSC modulation rate by using
vertical bar cursors and peak-to-peak frequency deviation by using horizontal bar cursors. The configurations required to be set are:

• Constant Clock Mean as the Clock Recovery method
• Low pass filter to get the SSC components
• Time Trend Plot for the Period measurement

PCIe SSC FREQ DEV
PCIe SSC FREQ DEV is defined as the SSC frequency deviation in ppm (parts per million).

• Use the PCIe SSC Profile measurement to locate the mid edge cross points.
• Calculate the HIGH value between the n and n+1 edge and the LOW value between n+1 and n+2 edges.

The application calculates the measurement using the equation:

FREQ DEVIATION = HIGH–LOW

PCIe AC common mode
The AC Common Mode Voltage measurement is the common mode voltage between two single-ended signals. AC is defined as all the
frequency components above the cutoff frequency (30 kHz).

The application calculates this measurement using the following equations (based on two single-ended sources from the DUT):
CM_Voltage = (Source1 + Source2) ÷ 2
AC_CMM p-p = Peak-to-Peak(High Pass filter (CM_Voltage))
Where:

AV_CMV p-p is the peak-to-peak common mode voltage.

USB VTx-Diff-PP
VTx-Diff-PP voltage swing calculates the change in voltage level across a transition in the waveform. It is the peak-to-peak differential
voltage swing.

Algorithms

312



Figure 220: USB VTx-Diff-PP

The application calculates this measurement using the following equation:

Where:

VDiff-p-p is the differential peak-to-peak voltage.

VHigh is the maximum voltage calculated between i and i+1 points.

VLow is the minimum voltage calculated between i and i+1 points.

i is the index of the UI (bit) location preceding the transition.

i+1 is the index of the UI (bit) location after the transition.

USB TCdr-Slew-Max
Slew rate measurement finds the peak-to-peak period jitter. Period jitter can be obtained by taking the first difference of the filtered phase
jitter. The application uses the Period measurement with an LPF of 1.98 MHz to find the period jitter. It calculates the phase jitter by taking
the cumulative sum of the period jitter. Filters the phase jitter with the CR transfer function using the following equation:

The filtered period jitter is obtained from the phase jitter to calculate peak-to-peak period jitter.

USB Tmin-Pulse-Tj
Tmin-Pulse-Tj (minimum single pulse width TMin-Pulse) is measured from one transition center to the next including all jitter sources.

The application calculates this measurement using the following equation:
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Where:

TMin-Pulse is the minimum pulse width

T is the transition center

USB Tmin-Pulse-Dj
USB Tmin-Pulse-Dj is defined as the minimum pulse width with only deterministic jitter components.

• Plot the time trend for the TIE measurement.
• Take the FFT of the TIE time trend to get the TIE spectrum. Then separate the RJ and DJ values from the spectrum.
• Take the IFFT of the TIE spectrum without the RJ components and reconstruct the clock based on the TIE trend without the RJ

components.
• Find the minimum pulse width within the reconstructed clock.

USB SSC MOD RATE
USB SSC MOD RATE is defined as the SSC modulation rate in terms of Hz. Use the SSC Profile measurement to locate the mid edge
crossover points. Determine the time difference between the consecutive mid reference voltage levels as shown:

Δt= T n+1 –T n

Where:

T n is the VREFmid crossing time

T n+1 is the n+1 VREFmid crossing time

The application calculates this measurement using the following equation:

Modulation Rate= 1/Δt

USB SSC FREQ-DEV-MAX
USB SSC FREQ DEV MAX is defined as the maximum frequency shift as a function of time. It represents the frequency deviation in terms
of ppm (parts per million).

• Find the 50% edges on the SSC profile.
• Calculate the HIGH value between the n and n+1 edge.
• Find the Maximum frequency deviation as HIGH.

The application calculates the measurement using the equation:

Freq Dev Max (ppm) = ((Maximum Freq–Nominal Data Rate)/Nominal Data Rate)* 1e 6

USB SSC FREQ-DEV-MIN
USB SSC FREQ DEV MIN is defined as the minimum frequency shift as a function of time. Represents the frequency deviation in terms of
ppm (parts per million).
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• Find the 50% edges on the SSC profile.
• Calculate the LOW value between the n and n+1 edge.
• Find the Maximum frequency deviation as LOW.

The application calculates the measurement using the equation:

Freq Dev Min (ppm) = ((Minimum Freq–Nominal Data Rate)/Nominal Data Rate)* 1e 6

USB SSC PROFILE
USB SSC Profile measurement uses the Period measurement with a second order low pass filter of 1.98 MHz. The USB SSC Profile
shows the modulation profile of the Spread Spectrum Clocking. Using the SSC profile, you can find the SSC modulation rate by using
horizontal cursors and peak-to-peak frequency deviation by using vertical cursors. The configurations required to be set are:

• Constant Clock Mean as the Clock Recovery method
• Low pass filter to get the SSC components
• Time Trend Plot for the Period measurement

USB UI
USB UI is based on the DPOJET measurement, Period. For more details, refer to the Period.

Note: USB UI uses a 3rd order LPF with the cut-off frequency of 198 kHz.

USB AC common mode
The USB AC Common Mode Voltage measurement is the common mode voltage between two single-ended signals. AC is defined as all
the frequency components above the cutoff frequency (30 kHz).

The application calculates this measurement using the following equations (based on two single-ended sources from the DUT):
CM_Voltage = (Source1 + Source2) ÷ 2
AC_CMM p-p = Peak-to-Peak(High Pass filter (CM_Voltage))
Where:

AV_CMV p-p is the peak-to-peak common mode voltage.

Average optical power
Average optical power (AOP) is the true average component of an optical signal in Watts.

Extinction ratio
Extinction ratio is the ratio of average power levels of the logic 1 level (High) to the logic 0 level (Low) of an optical signal. All level
determinations are made within the Eye Aperture.

The Eye Aperture is adjustable and defaults to 20% of the signal bit time.
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Optical modulation amplitude
Measures the longest run-length for '1's and '0's and determines the mean of the center part called as P1 and P0 respectively.

The center area over which the mean is measured ≤15 UI past the last edge.

Optical Modulation Amplitude (OMA) = P1 - P0

Optical high
The Optical high measurement calculates the nominal amplitude of a “1” bit, in one of two ways depending on the selected Method. Note
that the Mean method results in one measurement value for each “1” bit of the selected type, whereas the Mode method results in a single
measurement value for the entire waveform record.

When the Method = Mean, the measurement is calculated using the following equation:

Wn Hi = Mean[wn percent]

Where:

WHi is the optical high measurement result.

wn percent is the set of all waveform samples for event n falling within the selected portion (percent) of the unit interval, ranging from 1% to
100%. If no waveform samples fall within the window for a given unit interval, the single sample nearest in time to the window is taken.

n is the index of a high bit, a high transition bit, or a high non-transition bit.

When the Method = Mode, the measurement is calculated using the following equation:

WHi = Mean[wn percent]

Where wpresent represents a single histogram containing all the waveform samples selected according to the same windowing and
transition type criteria as in the Mean method.

Optical low
The Optical low measurement calculates the nominal amplitude of a “0” bit, in one of two ways depending on the selected Method. Note
that the Mean method results in one measurement value for each “0” bit of the selected type, whereas the Mode method results in a single
measurement value for the entire waveform record.

When the Method = Mean, the measurement is calculated using the following equation:

Wn Lo = Mean[wn percent]

Where:

WLo is the Optical low measurement result.

wn percent is the set of all waveform samples for event n falling within the selected portion (percent) of the unit interval, ranging from 1% to
100%. If no waveform samples fall within the window for a given unit interval, the single sample nearest in time to the window is taken.

n is the index of a low bit, a low transition bit, or a low non-transition bit.

When the Method = Mode, the measurement is calculated using the following equation:

WLo = Mean[wn percent]

Where wpresent represents a single histogram containing all the waveform samples selected according to the same windowing and
transition type criteria as in the Mean method.
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Eye Crossing Level
Eye Crossing Level is a histogram measurement which operates on two-dimensional histogram data that is collected from multiple
acquisitions. By taking one dimensional slices along certain column or row indices of the 2D histogram, one dimensional histograms can
be produced. The eye aperture is adjustable and defaults to 20% of the NRZ bit time.

The Eye Crossing Level measurement lists the voltage/watts level where the rising and falling edges of the eye waveform intersect
(PCross1 and PCross2). The measurement algorithm searches for the eye waveform with narrowest crossing width.

Figure 221: Eye Crossing Level

TCross1 and TCross2 = Eye Crossing Time in seconds

PCross1 and PCross2 : Eye Crossing Level in volts/watts

Eye Crossing Time
Eye Crossing Time is a histogram measurement which operates on two-dimensional histogram data that is collected from multiple
acquisitions. By taking 1-dimensional slices along certain column or row indices of the 2D histogram, one dimensional histograms can be
produced. The eye aperture is adjustable and defaults to 20% of the NRZ bit time.

The Eye Crossing Time measurement is the time of a single eye crossing waveform in seconds (TCross 1).

Eye Crossing Percent
Eye Crossing Percent is a histogram measurement which operates on two-dimensional histogram data that is collected from multiple
acquisitions. By taking one dimensional slices along certain column or row indices of the 2D histogram, one dimensional histograms can
be produced. The eye aperture is adjustable and defaults to 20% of the NRZ bit time.

Eye Crossing Percent measurement is an eye crossing point expressed as a percentage of the eye waveform height.

Eye Crossing Percent = 100* (Eye Crossing Level - Zero Level) / (One Level - Zero Level)
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Eye Crossing Percent gives an indication of duty cycle distortion or pulse symmetry problems in high speed signals. It is valuable for
measuring amplitude distortions caused by differences in One Level and Zero Level durations.

Mask Hit Ratio
A Mask Hit Ratio is the ratio of number of UI that have a mask hit and total number of UI observed.
Mask Hit Ratio = (# of UI that have a mask hit) / (total # of UI observed)

Mask Margin
The concept of margin allows for more information to be shared than merely Pass/Fail decision. We assume the position of level values
and unit interval boundary as 100% and original mask location as 0%. Hence a 20% mask margin implies that the mask violations does not
occur even after scaling the original mask by this amount.

TDEC

Transmitter Dispersion and Eye Closure (TDEC) is a parameter used to characterize the quality of an optical transmitter. It is measured
by the vertical eye closure based on histogram data from eye diagrams captured for a waveform using an optical to electrical converter.
Within the oscilloscope, filtering is implemented to limit the bandwidth which is defined by a reference receiver. The equalization of the
filtered and captured waveform is performed using SDLA and this TDEC measurement is to be applied post equalization. The captured
waveform post-equalization should be the input to the TDEC measurement along with the FFE files of SDLA where the optimized filter taps
are saved.

The bandwidth limit filter "the 4th order of Bessel Thomson filter" supplied along with the DPOJET to be used while optimization of taps in
SDLA and input to the DPOJET. Scope noise and Target BER are provided as user configuration option and entered prior to the TDEC
measurement in DPOJET. Refer to the eye diagram and the computation of TDEC is involved by finding σG such that below equation gets
satisfied.

Figure 222: Eye Diagram for TDEC measurement construction
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The TDEC is computed as below,

with,

where,

The m is set for 1.5 by default in DPOJET. The Noise Enhancement Factor of equalizer Ceq is computed as,

The notation N(f) above is the normalized noise spectrum obtained by filtering white noise with the reference filter. The BT Filter is used
as the reference filter and all these normalizations is done in the DPOJET-TDEC measurement. The Heq() is the frequency response of the
reference equalizer. The h(n) is obtained from SDLA and to be used as “FFE taps” file which is an input to DPOJET on the configuration
of measurement. All normalization, frequency domain conversion and integration for the optimum σG performed inside the DPOJET so that
the TDEC in dB is computed as,

Where,
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S is the standard deviation of the scope noise with no input signal.

This scope noise S need to be measured manually for the scope by the user before running the DPOJET-TDEC measurement without any
signal and terminating the channel with 50 Ohm termination.

The, σestimated_ideal is obtained by performing a sequential search so that below equation gets satisfied.

RIN

RIN (Relative Intensity Noise) is the ratio of the laser intensity's noise to the laser's power. RIN can be measured on continuous or
modulated waveforms.

RIN is calculated as follows:

1. RIN for continuous signal:

2. RIN for modulated signal:

Where,

• Scope Noise = Vertical noise of the oscilloscope
• Noise RMS High = RMS value of “1” bit
• Noise RMS Low = RMS value of “0” bit
• BW = Optical bandwidth or bandwidth of optical fiber

RINxOMA

RINxOMA is the Relative Intensity Noise on Optical Modulation Amplitude. Optical modulation amplitude is the difference between the high
level and the low level, each level measured in a particular part of the waveform.

RINxOMA measurement verifies the relative intensity of noise optical modulation amplitude of the DUT signal. RINxOMA is measured as
follows:
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Where,

• Scope Noise = Vertical noise of the oscilloscope
• Noise RMS High = RMS value of “1” bit
• Noise RMS Low = RMS value of “0” bit
• BW = Optical bandwidth or bandwidth of optical fiber

Jitter separation

Jitter analysis through RJ-DJ separation
Many of the jitter measurements are based on the concept of RJ-DJ separation. The application begins with the measured jitter-versus-
time (as represented by the TIE measurement array) and analytically determines the random and deterministic components of the jitter.
The deterministic part is further separated into independent subcomponents with specific characteristics.

The random jitter (RJ) is assumed to be zero-mean Gaussian, and is assumed to have a flat spectrum when viewed in the frequency
domain. The measured RJ is fitted to a Gaussian mathematical model, which is parameterized by its standard deviation. Using the
mathematical model for RJ, statistically probable jitter extremes may be predicted for much greater populations than actually measured.

The deterministic jitter (DJ) is predictable and can be generated consistently given known circumstances. The various DJ measurements
each report the peak-to-peak value of the corresponding DJ subcomponent.

Once all the jitter components have been identified and the random jitter has been converted to a mathematical model, the components
can be reassembled such that performance may be extrapolated to extremely low bit error rates. The probabilistic Total Jitter (TJ@BER)
and probabilistic Eye Width (Width@BER) are examples of such measurements. The reported values are predictions that correspond to a
user-specified Bit Error Rate, rather than observed values.

Two approaches are supported for performing jitter separation. The first method is based on spectrum analysis. It is only possible when
the data pattern is repetitive. A clock waveform is always repetitive. Other repetitive testing data patterns are used, such as the K28.5 data
pattern. Patterns may have rather long repetition lengths; for example, the CJTPAT pattern is 2640 bits. When using this method, you must
specify the pattern length, and you will receive a warning if the pattern length appears to differ from that specified.

The second RJ-DJ separation method, known as arbitrary pattern analysis, may be used when the data pattern is not necessarily
repetitive. This method works by correlating deterministic jitter observed over many repetitions with the bit pattern within a time-domain
window surrounding each observation.

RJ-DJ separation via spectrum analysis
When the source waveform represents a repeating data pattern, Deterministic Jitter (DJ) has a frequency spectrum of impulses. The
impulses due to the data pattern are equally spaced and occur at predictable frequencies related to the pattern length and bit rate.
Specifically, the pattern-related jitter impulse must occur at multiples of fo/N, where fo is the data bit rate and N is the data pattern length.
Other spectral impulses may occur due to periodic jitter not correlated with the data pattern.

To obtain measurements of DJ and RJ, all the components of the jitter spectrum that exceed the noise floor by a chosen margin are
attributed to deterministic jitter. Those components that fall at the frequency increment corresponding to the pattern length are identified
as data-dependent jitter, and those occurring at other frequencies are attributed to uncorrelated periodic jitter. The remaining spectral
noise floor (appropriately normalized to account for the removed deterministic jitter) is integrated to predict the standard deviation of the
underlying Gaussian random noise process.
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Once the spectral components corresponding to each deterministic jitter type have been identified, each component is inverse-transformed
back to the time domain. From these waveforms, the peak-to-peak jitter for each component is determined. For the random jitter, the RMS
deviation is directly computable from the standard deviation of the Gaussian model.

RJ-DJ separation for arbitrary patterns
When the data pattern borne by the source waveform is not cyclically repeating, any periodic jitter still has a frequency spectrum consisting
of impulses but this is not true of the data-dependent jitter.

In this case, analysis of the data-dependent jitter may proceed based on the assumption that any given bit is affected by a finite (and
relatively small) number of preceding bits. By averaging all events for which a given bit is preceded by a particular bit sequence, the
data-dependent jitter attributable to that bit sequence is obtained. This is because PJ and RJ are not correlated to a particular data
sequence and thus are averaged out.

If each bit is assumed to be affected by N preceding bits, there are a total of 2N possible data sequences. The sequence length N is a
configurable parameter. To get statistically sound average values for the data-dependent jitter, a minimum population of observations is
required for each individual pattern that occurs at least once. This population limit is also configurable by the user.

By the above means, the data-dependent jitter is characterized. Once characterized, the data-dependent jitter, on a bit-by-bit basis, may be
removed from the original jitter versus time record. The remaining jitter is composed of periodic and random jitter. This jitter is transformed
into the frequency domain, and the spectral analysis approach is used to separate the impulsive periodic jitter from the broad noise floor of
random jitter.

Separation of Non-Periodic jitter (NPJ)
Bounded Uncorrelated Jitter (BUJ) refers to all bounded jitter that is not correlated to the data pattern on the waveform. Thus, it excludes
DDJ, DCD and RJ. It can be further subdivided into PJ (which is deterministic, and easily recognized using a spectral approach) and
Non-Period Jitter (NPJ).

Depending on its precise nature, NPJ is often difficult to distinguish from RJ. It typically cannnot be isolated using frequency domain
techniques, so a different domain is used. The important difference between RJ and NPJ is that RJ has a Gaussian distribution (with
unbounded tails) whereas NPJ is bounded by definition. This fact is used as a basis for separation.

In DPOJET, the jitter separation algorithms are modified as follows when the Spectral + BUJ method is selected:

1. Data-Dependent Jitter (DDJ) and Duty-Cycle jitter (DCD) are first removed using either a spectral approach for repeating patterns or a
correlation approach for arbitrary data patterns.

2. PJ is identified and removed using a spectral approach.
3. The remaining jitter is assumed to contain (Gaussian) RJ and possibly NPJ. (In the Spectral Only method of jitter analysis, no further

processing is done and this jitter is reported as RJ.)
4. When Spectral + BUJ processing is selected, the RJ + NPJ jitter is collected into a histogram that is typically accumulated over multiple

waveform acquisitions. When the (user-configurable) minimum histogram population has been acquired, the histogram is converted to
an estimate of the Cumulative Density Function (CDF) and plotted using the Q-scale for the vertical axis. The Q-scale plot has the
property that a true Gaussian distribution appears as a straight line, with a slope equal to 1/σ (where σ is the standard deviation of
the Gaussian distribution). If the distribution is a mixture of a true Gaussian plus some bounded distribution, the plotted curve has left
and right extremes that asymptotically approach straight lines with a slope of 1/σ. The horizontal offset between the two asymptotes
represents the dual-dirac magnitude of the NPJ.

Estimation of TJ@BER and eye Width@BER
One of the outcomes of the RJ-DJ separation was a mathematical model for random jitter’s probability density function (PDF) and
measured values for the PDFs of the deterministic jitter components. Since all of these components are assumed to be statistically
independent, the PDF of the total jitter can be calculated by convolution.
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Integration of the PDF yields the cumulative distribution function (CDF), which can then be used to create the bit error rate curve (bathtub
curve). Based on the bathtub curve, the eye opening (Width@BER) and eye closure (TJ@BER) can be estimated for a given bit error rate.

The application calculates the eye opening at the specified BER using the following equation:

Eye opening = 1–TJ@BER when TJ@BER is less than one Unit Interval

Jitter estimation using Dual-Dirac models
Jitter estimation based on RJ-DJ separation depends in part on the specific jitter components modeled. For the purposes of analyzing
jitter and identifying root cause, it is very useful to identify components as specifically as possible. But for the purposes of determining
compliance, it has been found that a simplified jitter model yields results that are more consistent across different measurement
instruments and different vendors.

A simplified model that has found acceptance in several industry standards is known as the Dual-Dirac model. This is because the
probability density function (PDF) of all the deterministic jitter is replaced with a PDF consisting of two Dirac functions such that the total
jitter and eye opening at very low bit error rates is unchanged. The Random Jitter and Deterministic Jitter values derived from this model
are identified as RJ–δδ and DJ–δδ, respectively.

Two slightly different Dual-Dirac models have been defined. Both models begin with a jitter versus BER (bathtub) curve, either created from
a full jitter analysis based on RJ-DJ separation, or from direct measurement of error rate versus sample point offset. The two models differ
in how the RJ–δδ and DJ–δδ values are extracted from the curve.

For the Fibre-Channel standard, values for RJ–δδ and DJ–δδ are chosen such that the Dual-Dirac bathtub curve exactly matches the
measured curve at the BER = 10-5 and BER=10-9 points.

For the PCI Express and FB-DIMM standards, the bathtub curve is re-plotted using a different y-axis. Instead of directly plotting against the
log of the BER, the y-axis is converted to the Q-scale. The BER to Q-scale transformation was designed such that Gaussian distributions
are converted to straight lines, with a slope that is directly related to the standard deviation of the Gaussian.

When using the Dual-Dirac jitter measurements, it is critical that you select the model that matches the applicable standard. This may
be configured in the DPOJET preferences, which are found under Analyze > Jitter and Eye Analysis (DPOJET) > Preferences, on the
Measurement tab.

Joint Jitter/Noise analysis

Differences between Jitter-Only and Jitter+Noise analysis
Traditionally, jitter has been analyzed by detecting edge crossings at a voltage, current or optical power reference level and then analyzing
the distribution of these edge times relative to a reference clock. Based on various properties of the jitter distribution (observed in the time,
frequency and statistical domains), the jitter has been separated into categories or components that exhibit well-known behaviors. This
allows a mathematical model of the jitter to be constructed, which can then be used to extrapolate jitter behavior for higher populations of
bits than were actually measured. In this process, the shape of the analog waveform between edge crossings is entirely ignored.

In Joint Jitter/Noise Analysis, the entire analog waveform is analyzed. The process is analogous in many ways to Jitter-Only analysis,
but the mathematical model for jitter and noise behavior is more thorough and better fits the physical world. For example, in addition to
the familiar jitter components (RJ, PJ, DDJ) there are corresponding noise components (RN, PN, DDN). Jitter is still analyzed at points
where the waveform crosses a horizontal reference line, and Noise is analyzed where the waveform crosses a vertical reference line once
each unit interval. These two reference planes are where the model parameters (RJ – DDJ and RN – DDN) are determined, although the
process of determining the parameter values involves compensating for effects of jitter on noise and vice versa.

Because both techniques use parameterized mathematical models to extrapolate behavior, they will not yield identical results (but should
be very close). Consider an analogy: You could measure the area of a circle by splitting the circle into a number of narrow wedge-shaped
triangles with their points all at the center of the circle, and adding the areas of the triangles. Or you could estimate the circle’s area by
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placing a fine rectangular grid on the circle and counting the number of squares that were mostly inside the circle. Both methods will yield a
good estimate but the two models won’t give the same answer.

Because the Jitter-Only model does not consider vertical effects, there are some aspects of eye closure to which the jitter-Only method is
entirely blind but the Jitter+Noise method models well. The Jitter-Only method does not provide any noise measurement values at all, for
obvious reasons. And the Jitter+Noise method exposes how noise is manifested as jitter, and jitter as noise, which is helpful in identifying
root cause.

Use of Jitter+Noise analysis when DJAN is not enabled
The DJAN option enables noise measurements such as TN@BER, RN and DN in DPOJET. When you have enabled only DJA (DPOJET
Advanced) option, then you may still select “Jitter+Noise” as the analysis method on the DPOJET Preferences > Jitter Decomp menu.
Then the DPOJET uses the more complex Jitter + Noise parameter model and processing, but does not allow noise measurements to
select and run. Noise measurements can be selected and run when you enable DJAN.

It may seem pointless to select the Jitter+Noise analysis method if the noise measurements are not accessible. The Jitter+Noise uses
more complete model, and the jitter values may change slightly, or even markedly in rare cases.

One example is an eye that is closed at the target BER due to voltage ring-back in the middle of the eye. In that case, the traditional
Jitter-Only method can entirely miss the noise induced eye closure but the Jitter+Noise approach will recognize it. Also, selection of the
Jitter+Noise model with DJA can be useful if you are trying to compare jitter measurement results with a peer who is using a scope with the
DJAN option enabled.

Basic steps in joint Jitter+Noise analysis
The process of performing Jitter+Noise analysis includes these major steps:

1. Perform clock recovery to identify a reference clock representing the ideal transition times. This process also yields the received
Boolean bit stream.

2. Measure the exact instant in time where each data transition (edge) occurs.
3. Measure the slew rate at each of these edges.
4. Measure the exact amplitude at the center (50% point) of each bit.
5. Measure the slew rate at each of these bit centers.
6. Perform a joint analysis on the prior four data sets to decouple the effects of jitter on noise and vice versa.
7. Considering the entire analog waveform (not just the edges and bit centers), derive the “correlated waveform”. This is the waveform

the reflects channel effects (low-pass filtering, reflections) while filtering out variations uncorrelated to the data pattern.
8. Compare the edge times from step 2 with the clock times from step 1 to derive TIE (Time Interval Error). Use spectral analysis, time

analysis and Q-scale analysis to derive model parameters such as RJ and PJ. Please see the various topics under Jitter analysis
through RJ-DJ separation on page 321 for a more thorough description of this process.

9. Compare the bit amplitudes from step 3 with the ideal bit stream (derived from the received Boolean bit stream and the nominal high
and low bit amplitudes). Use spectral analysis, time analysis and Q-scale analysis to derive model parameters such as RN and PN.
See Noise model component interrelationships on page 325.

10. Use two-dimensional convolution to combine the effects of all jitter an noise model parameters into a statistical model of uncorrelated
noise. This includes RJ, PJ, NPJ, RN, PN and NPN.

11. Convolve the model of uncorrelated jitter+noise with the correlated waveform to create a model of the overall eye diagram’s true
PDF.

12. Integrate the PDF of step 11 from top to bottom (for ‘0’ bits only) to derive the ‘0’ bit CDF. Perform a complimentary operation to
derive the ‘1’ bit CDF.

13. Superimpose the CDFs of steps 11 and 12 to get the BER eye: analogous to the bathtub curve, except two-dimensional. (In fact, the
jitter bathtub or the noise bathtub can be derived directly from the BER Eye by slicing it either horizontally or vertically, respectively.)
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Noise model component interrelationships
The figure below depicts graphically how the various noise model parameters relate to each other. It is only the upward-reaching portions
of the lower models and the downward-reaching portions of the upper models that contribute to eye opening (or closure), and this is
reflected in how the DDN, DN and TN@BER values are calculated.

Figure 223: Noise model component interrelationships

Results
The application calculates statistics for all selected measurements. The application displays the following statistics in the Results menu:

• Mean
• Std Dev (Standard Deviation)
• Max (Maximum Value)
• Min (Minimum Value)
• p-p (Peak-to-Peak)
• Population
• Max-cc (Maximum positive cycle-to-cycle variation)
• Min-cc (Maximum negative cycle-to-cycle variation)

Mean
The application calculates the mean value using the following equation:

Standard Deviation
The application calculates the standard deviation using the following equation:
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It may seem odd that the equation for the estimate of the Standard Deviation contains a 1/(N-1) scaling factor. If you knew the true mean
of X and used it in place of the estimated mean X then you would, in fact, scale by 1/N. But, X is an estimate and is likely to be in error
(or bias), causing the estimate of the Standard Deviation to be too small if scaled by 1/N. This is the reason for the scaling shown in the
equation. (Refer to Chapter 9.2 in A. Papoulis, Probability, Random Variables, and Stochastic Processes, McGraw Hill, 1991.)

Note: RMS value can be calculated using the relation (rms)= (mean value)+ (stddev).

Maximum Value
The application calculates maximum value using the following equation:

Max(X) = Most Positive Value of X

Minimum Value
The application calculates minimum value using the following equation:

Min(X) = Most Negative Value of X

p-p
The application calculates peak-to-peak using the following equation:

p-p(X) = Max(X )– Min(X)

Population
Population is the total number of events or observations over which the other statistics were calculated.

Population (X) = N

Max-cc
The application calculates Max-cc using the following equation:

Max-cc(X) = Max(X CC )

Where:

X CC is the first difference of X.

Min-cc
The application calculates Min-cc using the following equation:

Min-cc(X) = Min(X CC )
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Where:

X CC is the first difference of X.
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GPIB commands
About the GPIB program
You can use remote GPIB commands to communicate with the DPOJET application. An example
of a GPIB program that can execute the DPOJET application is included with the application in
C:\Users\Public\Tektronix\TekApplications\DPOJET\Examples.

The example shows how a GPIB program executes the application to do the following tasks:

1. Start the application.
2. Recall a setup.
3. Take a measurement.
4. View measurement results and plots.
5. Exit the application.

Note: Commands are not case and space sensitive. Your program will operate correctly even if you do not follow the capitalization
and spacing precisely.

GPIB reference materials
To use GPIB commands with your oscilloscope, you can refer to the following materials:

• The GPIB Program Example in C:\Users\Public\Tektronix\TekApplications\DPOJET\Examples for
guidelines to use while designing a GPIB program.

• The Parameters topics for range of values, minimum units and default values of parameters.
• The programmer information in the online help of your oscilloscope.

Argument types
The syntax shows the format that the instrument returns in response to a query. This is also the preferred format when sending the
command to the instrument though any of the formats will be accepted. This documentation represents these arguments as follows:

Table 188: Argument types

Symbol Meaning

<NR1> Signed integer value.

<NR2> Floating point value without an exponent.

<NR3> Floating point value with an exponent.

double Double precision floating point with exponent.

DPOJET:ACTIVATE
This command launches the DPOJET to active state.
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Syntax
DPOJET:ACTIVATE

Outputs
DPOJET:ACTIVATE launches the DPOJET.

DPOJET:ADDMeas
This set-only command adds the specified measurement to the bottom of the current DPOJET list of measurements and will appear in the
results summary page.

Syntax
DPOJET:ADDmeas {PERIod | CCPeriod | FREQuency | NPERiod | PWIdth | NWIdth |
PDUTy | NDUTy | PCCDuty | NCCDuty | DATARATE | TIE | RJ | RJDirac | TJber
| DJ | DJDirac | PHASENoise | DCD | DDJ | PJ | J2 | J9 | SRJ | PJrms |
SJFREQ | PKPKCLKTJ | PKPKCLKRJ | PKPKCLKDJ | PJRMS | FN | RJH | RJV | PJH
| PJV | RN | RNV| RNH | DN | DDN | DDN_1 | DDN_0 | PN | PNV | PNH |
NPN | TNBER | NOISESUMMARY | UNITAMPLITUDE | RISEtime | SETup | HIGHTime |
FALLtime | HOLD | LOWTime | SKEW | GATEDSKEW | HEIght | WIDth | MASKHits |
WIDTHBer | HEIGHTBer |CYCLEMIN | CYCLEMAX | ACRMS | ACCOMmonmode | COMmonmode
| HIGH | TNTratio | HIGHLOW | LOW | VDIFFxovr | RISESLEWrate | FALLSLEWrate |
OVERShoot | UNDERShoot | CYCLEPktopk | JITTERSummary | PCIETTXDiffpp | PCIEDEemph
| PCIETTx | PCIETTXRise | PCIETTXFall | PCIEUI | PCIETMinpulse | PCIEMEdmxjitter
| PCIETRfmismch | PCIESSCFReqdev | PCIEMAXMINratio | PCIESSCPROFile | PCIEVEye
| PCIETTXUTJ | PCIETTXUDJDD | PCIETTXUPWTJ | PCIETTXUPWDJDD | PCIETTXDDJ |
PCIEVTXBOOST | PCIEVTXNOEQ | PCIEVTXEIEOS | PCIEPS21TX | PCIEACCommonmode |
VTXDiffpp | TMINPULSETJ | TCDRslewmax | USBUI | USBACCommonmode | TMINPULSEDJ
| QFACTOR | EYELOW | EYEHIGH | TCMDTOCMD | TIMEOUTSIDELEVEL | SSCFREQDEVMAX
| SSCFREQDEVMIN | SSCFREQDEV |SSCMODrate | SSCPROfile | USBSSCFREQDEVMAX |
USBSSCFREQDEVMIN | USBSSCMODrate | USBSSCPROFile | AUTOFITMaskhits | AOP | EXRATIO
| OMA | OPTHIGH | OPTLOW| EYECROSSLEVEL | EYECROSSTIME | EYECROSSPERCENT | DFEEW |
DFEEH | DFEEYEDIAGRAM | VWOE | MASKMARGIN | MASKHITRATIO | RIN | RINXOMA | TDEC }

Inputs
Same as syntax for measurement options.

Outputs
None

DPOJET:APPLYAll
This command applies configuration of specified type of the specified DPOJET measurement to all other DPOJET measurements.

Syntax
DPOJET: APPLYAll {FILTers | CLOCKRecovery| RJDJ}, MEAS<x>
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Inputs
{FILTers | CLOCKRecovery| RJDJ}, MEAS<x>
For example: DPOJET:APPLYAll FILTers, MEAS2

DPOJET:BITRatestate
This command sets or queries the user bitrate state, either on or off.

Syntax
DPOJET:BITRatestate {0|1}
DPOJET:BITRatestate?

Inputs
{0|1}

Outputs
{0|1}

DPOJET:CLEARALLMeas
This set-only command clears the entire current list of defined measurements in DPOJET.

Syntax
DPOJET:CLEARALLMeas

Outputs
None

DPOJET:DATAratelimits
This command sets or queries the reference bitrate for measurement limits.

Syntax
DPOJET:DATAratelimits <NR3>
DPOJET:DATAratelimits?

Inputs
<NR3>

Outputs
<NR3>
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DPOJET:DESKEW
This command performs a DPOJET deskew operation with the settings specified in DPOJET:DESKEW.

Syntax
DPOJET:DESKEW {EXEcute}

Inputs
{EXEcute}

DPOJET:DESKEW:DESKEWchannel
This command sets or queries the channel to be deskewed.

Syntax
DPOJET:DESKEW:DESKEWchannel {CH1-CH4}
DPOJET:DESKEW:DESKEWchannel?

Inputs
{CH1 - CH4}

Outputs
{CH1 - CH4}

DPOJET:DESKEW:DESKEWHysteresis
This command sets or queries the deskew channel hysteresis value.

Syntax
DPOJET:DESKEW:DESKEWHysteresis <NR3>
DPOJET:DESKEW:DESKEWHysteresis?

Inputs
<NR3>

Outputs
<NR3>

DPOJET:DESKEW:DESKEWMidlevel
This command sets or queries the deskew channel midlevel value.
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Syntax
DPOJET:DESKEW:DESKEWMidlevel <NR3>
DPOJET:DESKEW:DESKEWMidlevel?

Inputs
<NR3>

Outputs
<NR3>

DPOJET:DESKEW:EDGE
This command sets or queries the edge types used when calculating deskew.

Syntax
DPOJET:DESKEW:EDGE {RISE | FALL | BOTH}
DPOJET:DESKEW:EDGE?

Inputs
{RISE | FALL | BOTH}

Outputs
{RISE | FALL | BOTH}

DPOJET:DESKEW:MAXimum
This command sets or queries the maximum deskew value possible.

Syntax
DPOJET:DESKEW:MAXimum <NR3>
DPOJET:DESKEW:MAXimum?

Inputs
<NR3>

Outputs
<NR3>

DPOJET:DESKEW:MINimum
This command sets or queries the minimum deskew value possible.
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Syntax
DPOJET:DESKEW:MINimum <NR3>
DPOJET:DESKEW:MINimum?

Inputs
<NR3>

Outputs
<NR3>

DPOJET:DESKEW:REFChannel
This command sets or queries the reference channel used for deskew operation.

Syntax
DPOJET:DESKEW:REFChannel {CH1 - CH4}
DPOJET:DESKEW:REFChannel?

Inputs
{CH1 - CH4}

Outputs
{CH1 - CH4}

DPOJET:DESKEW:REFHysteresis
This command sets or queries the reference channel hysteresis value.

Syntax
DPOJET:DESKEW:REFHysteresis <NR3>
DPOJET:DESKEW:REFHysteresis?

Inputs
<NR3>

Outputs
<NR3>

DPOJET:DESKEW:REFMidlevel
This command sets or queries the reference channel midlevel value.

GPIB commands

DPOJET Jitter, Noise and Eye Diagram Analysis Solution Application Help 333



Syntax
DPOJET:DESKEW:REFMidlevel <NR3>
DPOJET:DESKEW:REFMidlevel?

Inputs
<NR3>

Outputs
<NR3>

DPOJET:DIRacmodel
This command sets or queries the current dirac model.

Syntax
DPOJET:DIRacmodel {FIBREchannel | PCIExpress}
DPOJET:DIRacmodel?

Inputs
{FIBREchannel | PCIExpress}

Outputs
{FIBREchannel | PCIExpress}

DPOJET:EXPORT
This set-only command saves the specified DPOJET plot to the specified file path. The Format is determined through the filename
extension, with a default of png if no extension is specified.

Supported extensions include jpeg, jpg, tif, tiff, bmp, emf, .mat, .csv and png. 

Syntax
DPOJET:EXPORT {PLOT1-PLOT4, <file string>}

Inputs
{PLOT1-PLOT4, <file string>}

DPOJET:EXPORTRaw
This set-only command saves the raw Eye diagram 2d histogram data to the specified file path. The format is determined through the
filename extension. Supported extension include .csv

Note: Ensure that the Plot window is open while sending this PI command; else a file will be not generated.
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Syntax
DPOJET:EXPORTRaw {PLOT1-PLOT4, <file string>}

Inputs
{PLOT1-PLOT4, <file string>}

Example
DPOJET:EXPORTRAW PLOT1, "savedimage.csv".

DPOJET:GATING
This command sets or queries the gating state.

Syntax
DPOJET:GATING {OFF | ZOOM | CURSOR | MARKS}
DPOJET:GATING?

Inputs
{OFF | ZOOM | CURSOR | MARKS}

Outputs
{OFF | ZOOM | CURSOR | MARKS}

DPOJET:HALTFreerunonlimfail
This command sets or queries the halt free-run on limit failure (On or Off).

Syntax
DPOJET:HALTFreerunonlimfail {1 | 0}
DPOJET:HALTFreerunonlimfail?

Inputs
{1 | 0}

Outputs
{1 | 0}

DPOJET:HIGHPerfrendering
This command sets or queries the current high-performance eye rendering setting.
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Syntax
DPOJET:HIGHPerfrendering <NR1>
DPOJET:HIGHPerfrendering?

Inputs
<NR1>

Outputs
<NR1>

DPOJET:INTERp
This command sets or queries the current interpolation model.

Syntax
DPOJET:INTERp {LINear | SINX}
DPOJET:INTERp?

Inputs
{LINear | SINX}

Outputs
{LINear | SINX}

DPOJET:JITtermode?
This command queries the current jitter mode.

Syntax
DPOJET:JITtermode?

Outputs
<string>

DPOJET:JITtermodel
This command sets the current jitter model.

Syntax
DPOJET:JITtermodel {BUJ | Legacy}
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Inputs
{BUJ | Legacy}

DPOJET:ANALYSISMETHOD
This command sets or queries the current analysis method value.

Syntax
DPOJET:ANALYSISMETHOD { JITTEROnly | JITTERNoise }
DPOJET:ANALYSISMETHOD?

Inputs
JITTEROnly | JITTERNoise

DPOJET:LASTError?
This query-only command returns the contents of the last pop-up warning dialog box. If no errors have occurred since startup, or since the
last call to DPOJET:LASTError?, this command returns an empty string.

Syntax
DPOJET:LASTError?

Outputs
<string>

DPOJET:LIMITRise
This command turns on or off the ability to limit Rise/Fall measurements to transition bits only.

Syntax
DPOJET:LIMITRise {1 | 0}

Inputs
{1 | 0}

Outputs
{1 | 0}

DPOJET:MINBUJUI
This command sets or queries the minimum number of UI for BUJ analysis.
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Syntax
DPOJET:MINBUJUI <NR3>
DPOJET:MINBUJUI?

Inputs
<NR3>

Outputs
<NR3>

DPOJET:LIMits:FILEName
This command sets or queries the current limits filename.

Syntax
DPOJET:LIMits:FILEName <string>
DPOJET:LIMits:FILEName?

Inputs
<string>

Outputs
<string>

DPOJET:LIMits:STATE
This command turns on or off the pass-fail limit system. Pass-fail status can be queried using the DPOJET:MEAS <x>:RESULTS node.

Syntax
DPOJET:LIMits:STATE {1 | 0}

Inputs
{1 | 0}

Outputs
{1 | 0}

DPOJET:LOGging:MEASurements:FOLDer
This command sets or queries the current folder used for measurement logging.
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Syntax
DPOJET:LOGging:MEASurements:FOLDer <string>
DPOJET:LOGging:MEASurements:FOLDer?

Inputs
<string>

Outputs
<string>

DPOJET:LOGging:MEASurements:STATE
This command turns on or off the future logging of measurements. Individual measurements included in the logging are selected using the
DPOJET:MEAS<x>:LOGging node. This parameter turns on or off the entire set of included measurements.

Syntax
DPOJET:LOGging:MEASurements: {1 | 0}

Inputs
{1 | 0}

Outputs
{1 | 0}

DPOJET:LOGging:SNAPshot
This command performs a DPOJET export of the specified type, either for statistics or measurements.

Syntax
DPOJET:LOGging:SNAPshot {STATistics | MEASurements}

Inputs
{STATistics | MEASurements}

Outputs
{STATistics | MEASurements}

DPOJET:LOGging:STATistics:FILEName
This command sets or queries the current file used for statistics logging.

Syntax
DPOJET:LOGging:STATistics:FILEName <string>
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DPOJET:LOGging:STATistics:FILEName?

Inputs
<string>

Outputs
<string>

DPOJET:LOGging:STATistics:STATE
This command turns on or off the future logging of statistics. Individual measurements included in the logging are selected using the
DPOJET:MEAS<x>:LOGging node. This parameter turns on or off the entire set of included measurements.

Syntax
DPOJET:LOGging:STATistics:STATE {1 | 0}

Inputs
{1 | 0}

Outputs
{1 | 0}

DPOJET:LOGging:WORSTcase:FOLDer
This command sets or queries the current folder used for worst case logging.

Note: Waveform filenames generated while worst case logging is on will follow the syntax of “Measurement
Name”-“Source”_Min1.wfm and “Measurement Name”-“Source”_Max1.wfm, For example: Period1-Ch1_Max1.wfm, Period1-
Ch1_Min1.wfm, Rise Time1-Ch1_Max1.wfm, Rise Time1-Ch1_Min1.wfm.

Syntax
DPOJET:LOGging:WORSTcase:FOLDer <string>
DPOJET:LOGging:WORSTcase:FOLDer?

Inputs
<string>

Outputs
<string>

DPOJET:LOGging:WORSTcase:STATE
This command turns on or off the future logging of worst case waveforms. Individual measurements included in the logging are selected
using the DPOJET:MEAS<x>:LOGging node. This parameter turns on or off the entire set of included measurements.
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Syntax
DPOJET:LOGging:WORSTcase:STATE {1 | 0}

Inputs
{1 | 0}

Outputs
{1 | 0}

DPOJET:MEAS<x>
This command returns the branch query for the application measurement slot with index <x>. This will always match the measurement
defined at the associated index <x> displayed on the DPOJET screen, where index 1 is the first, or top, of the measurement list.

Branch queries will only contain the measurement branches for those branches that have measurements defined. This means queries to
branches that do not exist will time out. This is required because the number of measurements that can be defined in DPOJET, is 99. 

Syntax
DPOJET:MEAS<x>?

DPOJET:MEAS<x>:BER:TARGETBER
This command sets or queries the BER value.

Syntax
DPOJET:MEAS<x>:BER:TARGETBER <NR3>
DPOJET:MEAS<x>:BER:TARGETBER?

Inputs
<NR3>

Outputs
<NR3>

Note: This command is different from DPOJET:MEAS:RJDJ:BER whose configuration parameter exist in RJDJ tab.

Note: This command is different from DPOJET:MEAS:RNDN:BER whose configuration parameter exist in RNDN tab.

DPOJET:MEAS<x>:BITCfgmethod
This command sets or queries the measurement bit configure method.
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Syntax
DPOJET:MEAS<x>:BITCfgmethod {MEAN | MODE}
DPOJET:MEAS<x>:BITCfgmethod?

Inputs
{MEAN | MODE}

Outputs
{MEAN | MODE}

DPOJET:MEAS<x>:BITPcnt
This command sets or queries the percentage value to be measured for the Bit type selected.

Syntax
DPOJET:MEAS<x>:BITPcnt <NR3>
DPOJET:MEAS<x>:BITPcnt?

Inputs
<NR3>

Outputs
<NR3>

DPOJET:MEAS<x>:BITConfig:STARTPercent
This command sets or queries the starting percentage of the bit to measure.

Syntax
DPOJET:MEAS<x>:BITConfig:STARTPercent <NR3>
DPOJET:MEAS<x>:BITConfig:STARTPercent?

Inputs
<NR3>

Outputs
<NR3>

DPOJET:MEAS<x>:BITConfig:ENDPercent
This command sets or queries the ending percentage of the bit to measure.
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Syntax
DPOJET:MEAS<x>:BITConfig:ENDPercent <NR3>
DPOJET:MEAS<x>:BITConfig:ENDPercent?

Inputs
<NR3>

Outputs
<NR3>

DPOJET:MEAS<x>:BITConfig:NUMBins
This command sets or queries the number of bins per window.

Syntax
DPOJET:MEAS<x>:BITConfig:NUMBins <NR3>
DPOJET:MEAS<x>:BITConfig:NUMBins?

Inputs
<NR3>

Outputs
<NR3>

DPOJET:MEAS<x>:BITConfig:ABSRELstate
This command sets or queries the user absolute/relative state, either on or off.

0-> sets the Absolute

1-> sets the Relative

Syntax
DPOJET:MEAS<x>:BITConfig:ABSRELstate {0|1}
DPOJET:MEAS<x>:BITConfig:ABSRELstate?

Inputs
{0|1}

Outputs
{0|1}
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DPOJET:MEAS<x>:BITType
This command sets or queries the measurement bit type setting.

Syntax
DPOJET:MEAS<x>:BITType {ALLBits | NONTRANsition | TRANsition}
DPOJET:MEAS<x>:BITType?

Inputs
{ALLBits | NONTRANsition | TRANsition}

Outputs
{ALLBits | NONTRANsition | TRANsition}

DPOJET:MEAS<x>:BUSState:CLOCKPolarity
This command sets or queries the clock polarity for the clock edge.

Syntax
DPOJET:MEAS<x>:BUSState:CLOCKPolarity {RISING | FALLING}
DPOJET:MEAS<x>:BUSState:CLOCKPolarity?

Inputs
{RISING | FALLING}

Outputs
{RISing | FALLing}

DPOJET:MEAS<x>:BUSState:FROMPattern
This command sets or queries the Pattern from which the Bus state is configured.

Syntax
DPOJET:MEAS<x>:BUSState:FROMPattern <string>
DPOJET:MEAS<x>:BUSState:FROMPattern?

Inputs
<string>

Outputs
<string>
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DPOJET:MEAS<x>:BUSState:FROMSymbol
This command sets or queries the symbol from which the Bus state is configured.

Syntax
DPOJET:MEAS<x>:BUSState:FROMSymbol <string>
DPOJET:MEAS<x>:BUSState:FROMSymbol?

Inputs
<string>

Outputs
<string>

DPOJET:MEAS<x>:BUSState:MEASUREType
This command sets or queries the type for which the bus state is configured.

Syntax
DPOJET:MEAS<x>:BUSState:MEASBUSType {SYMbol | PATTern}
DPOJET:MEAS<x>:BUSState:MEASBUSType?

Inputs
{SYMbol | PATTern}

Outputs
{SYMbol | PATTern}

DPOJET:MEAS<x>:BUSState:MEASUREFrom
This command sets or queries where the bus is measured from.

Syntax
DPOJET:MEAS<x>:BUSState:MEASUREFROM {CLOCKEdge | START | STOP}
DPOJET:MEAS<x>:BUSState:MEASUREFROM?

Inputs
{CLOCKEdge | START | STOP}

Outputs
{CLOCKEdge | START | STOP}
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DPOJET:MEAS<x>:BUSState:MEASURETO
This command sets or queries from where the bus is measured to.

Syntax
DPOJET:MEAS<x>:BUSState:MEASURETO {START | STOP | CLOCKEdge}
DPOJET:MEAS<x>:BUSState:MEASURETO?

Inputs
{CLOCKEdge | START | STOP}

Outputs
{CLOCKEdge | START | STOP}

DPOJET:MEAS<x>:BUSState:TOPattern
This command sets or queries the Pattern to which the Bus state is configured.

Syntax
DPOJET:MEAS<x>:BUSState: TOPattern <string>
DPOJET:MEAS<x>:BUSState: TOPattern?

Inputs
<string>

Outputs
<string>

DPOJET:MEAS<x>:BUSState:TOSymbol
This command sets or queries the symbol to which the Bus state is configured.

Syntax
DPOJET:MEAS<x>:BUSState: TOSymbol <string>
DPOJET:MEAS<x>:BUSState: TOSymbol?

Inputs
<string>

Outputs
<string>
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DPOJET:MEAS<x>:CLOCKRecovery:BHVRSTANdard
This command sets or queries the current behavioral standard, as specified in the user interface.

Syntax
DPOJET:MEAS<x>:CLOCKRecovery:BHVRSTANdard <string>
DPOJET:MEAS<x>:CLOCKRecovery:BHVRSTANdard?

Inputs
<string>

Outputs
<string>

DPOJET:MEAS<x>:CLOCKRecovery:CLOCKBitrate
This command sets or queries the clock bit rate. Used if DATARate is 1.

Syntax
DPOJET:MEAS<x>:CLOCKRecovery:CLOCKBitrate <NR3>
DPOJET:MEAS<x>:CLOCKRecovery:CLOCKBitrate?

Inputs
<NR3>

Outputs
<NR3>

DPOJET:MEAS<x>:CLOCKRecovery:CLOCKFrequency
This command sets or queries the clock frequency. Used with Constant Clock - Fixed clock recovery method.

Syntax
DPOJET:MEAS<x>:CLOCKRecovery:CLOCKFrequency <NR3>
DPOJET:MEAS<x>:CLOCKRecovery:CLOCKFrequency?

Inputs
<NR3>

Outputs
<NR3>
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DPOJET:MEAS<x>:CLOCKRecovery:CLOCKMultiplier
This command sets or queries the clock multiplier.

Syntax
DPOJET:MEAS<x>:CLOCKRecovery:CLOCKMultiplier <NR3>
DPOJET:MEAS<x>:CLOCKRecovery:CLOCKMultiplier?

Inputs
<NR3>

Outputs
<NR3>

DPOJET:MEAS<x>:CLOCKRecovery:CLOCKPath
This command sets or queries the current known clock pattern path.

Syntax
DPOJET:MEAS<x>:CLOCKRecovery:CLOCKPath <string>
DPOJET:MEAS<x>:CLOCKRecovery:CLOCKPath?

Inputs
<string>

Outputs
<string>

DPOJET:MEAS<x>:CLOCKRecovery:DAMPing
This command sets or queries the clock recovery damping value.

Syntax
DPOJET:MEAS<x>:CLOCKRecovery:DAMPing <NR3>
DPOJET:MEAS<x>:CLOCKRecovery:DAMPing?

Inputs
<NR3>

Outputs
<NR3>
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DPOJET:MEAS<x>:CLOCKRecovery:DATARate
This command turns on or off DATArate usage.

Syntax
DPOJET:MEAS<x>:CLOCKRecovery:DATARate {1 | 0}

Inputs
{1 | 0}

Outputs
{1 | 0}

DPOJET:MEAS<x>:CLOCKRecovery:BWType
This command sets or queries the clock recovery bandwidth type.

Syntax
DPOJET:MEAS<x>:CLOCKRecovery:BWType {LOOPBW | JTFBW}
DPOJET:MEAS<x>:CLOCKRecovery:BWType?

Inputs
{LOOPBW | JTFBW}

Outputs
{LOOPBW | JTFBW}

DPOJET:MEAS<x>:CLOCKRecovery:LOOPBandwidth
This command sets or queries the clock recovery loop bandwidth.

Syntax
DPOJET:MEAS<x>:CLOCKRecovery:LOOPBandwidth <NR3>
DPOJET:MEAS<x>:CLOCKRecovery:LOOPBandwidth?

Inputs
<NR3>

Outputs
<NR3>
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DPOJET:MEAS<x>:CLOCKRecovery:MEANAUTOCalculate
This command sets or queries how often the clock is calculated, either FIRST, or on EVERY acquisition.

Syntax
DPOJET:MEAS<x>:CLOCKRecovery:MEANAUTOCalculate {FIRST | EVERY}
DPOJET:MEAS<x>:CLOCKRecovery:MEANAUTOCalculate?

Inputs
{FIRST | EVERY}

Outputs
{FIRST | EVERY}

DPOJET:MEAS<x>:CLOCKRecovery:METHod
This command sets or queries the current Clock recovery method.

Syntax
DPOJET:MEAS<x>:CLOCKRecovery:METHod {STANDARD | CUSTOM | CONSTMEAN | CONSTFIXED |
EXPEDGE | EXPPLL | CONSTMEDIAN | BEHAVIORAL}
DPOJET:MEAS<x>:CLOCKRecovery:METHod?

Inputs
{STANDARD | CUSTOM | CONSTMEAN | CONSTFIXED | EXPEDGE | EXPPLL | CONSTMEDIAN |
BEHAVIORAL}

Outputs
{STANDARD | CUSTOM | CONSTMEAN | CONSTFIXED | EXPEDGE | EXPPLL | CONSTMEDIAN |
BEHAVIORAL}

DPOJET:MEAS<x>:CLOCKRecovery:MODel
This command sets or queries the current clock recovery model.

Syntax
DPOJET:MEAS<x>:CLOCKRecovery:MODel {ONE | TWO}
DPOJET:MEAS<x>:CLOCKRecovery:MODel?

Inputs
{ONE | TWO}
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Outputs
{ONE | TWO}

DPOJET:MEAS<x>:CLOCKRecovery:NOMINALOFFset
This command sets or queries the clock offset.

Syntax
DPOJET:MEAS<x>:CLOCKRecovery:NOMINALOFFset <NR3>
DPOJET:MEAS<x>:CLOCKRecovery:NOMINALOFFset?

Inputs
<NR3>

Outputs
<NR3>

DPOJET:MEAS<x>:CLOCKRecovery:NOMINALOFFset:AUTO?
This query-only command returns the value in the Auto text box for the Nominal Clock Offset controls. If the nominal clock offset method
selection type is set to Auto and an acquisition cycle has been completed, this field shows the clock-to-data offset that was automatically
determined. A positive value means that the clock leads the data (precedes it in time). If the offset has not been determined, the returned
string is TBD.

Syntax
DPOJET:MEAS<x>:CLOCKRecovery:NOMINALOFFset:AUTO?

Outputs
<string>

DPOJET:MEAS<x>:CLOCKRecovery:NOMINALOFFset:MANual
This command sets or queries the value for Manual text box.

Syntax
DPOJET:MEAS<x>:CLOCKRecovery:NOMINALOFFset:MANual <NR3>
DPOJET:MEAS<x>:CLOCKRecovery:NOMINALOFFset:MANual?

Inputs
<NR3>
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Outputs
<NR3>

DPOJET:MEAS<x>:CLOCKRecovery:NOMINALOFFset:Recalctype
This command sets or queries the recalculation list box.

Syntax
DPOJET:MEAS<x>:CLOCKRecovery:NOMINALOFFset:Recalctype {FIRST | EVERY}
DPOJET:MEAS<x>:CLOCKRecovery:NOMINALOFFset:Recalctype?

Inputs
{FIRST | EVERY}

Outputs
{FIRST | EVERY}

DPOJET:MEAS<x>:CLOCKRecovery:NOMINALOFFset:SELECTIONtype
This command sets or queries the selection type.

Syntax
DPOJET:MEAS<x>:CLOCKRecovery:NOMINALOFFset:SELECTIONtype {AUTO | MANUAL}
DPOJET:MEAS<x>:CLOCKRecovery:NOMINALOFFset:SELECTIONtype?

Inputs
{AUTO | MANUAL}

Outputs
{AUTO | MANUAL}

DPOJET:MEAS<x>:CLOCKRecovery:PATTern
This command turns on or off the usage of CLOCKPath to a specific known data pattern.

Syntax
DPOJET:MEAS<x>:CLOCKRecovery:PATTern {1 | 0}

Inputs
{1 | 0}
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Outputs
{1 | 0}

DPOJET:MEAS<x>:CLOCKRecovery:STAndard
This command sets or queries the current clock recovery standard, as specified in the user interface.

Syntax
DPOJET:MEAS<x>:CLOCKRecovery:STAndard <string>
DPOJET:MEAS<x>:CLOCKRecovery:STAndard?

Inputs
<string>

Outputs
<string>

DPOJET:MEAS<x>:COMMONMode:FILTers:STATE
This command sets or queries the state of the common mode filter frequency.

Syntax
DPOJET:MEAS<x>:COMMONMode:FILTers:STATE {ON | OFF}
DPOJET:MEAS<x>:COMMONMode:FILTers:STATE?

Inputs
{ON | OFF}

Outputs
{1 | 0}

DPOJET:MEAS<x>:CUSTomname
This command sets or queries the custom measurement name for the measurement in slot x.

Syntax
DPOJET:MEAS<x>:CUSTomname <string>
DPOJET:MEAS<x>:CUSTomname?

Inputs
<string>
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Outputs
<string>

DPOJET:MEAS<x>:CUSTOMGATING:SOURCE1GATE
This commands sets or queries the gate associated with source1.

Syntax
DPOJET:MEAS<x>:CUSTOMGATING:SOURCE1GATE {GATE1 | GATE2 | GATE3 GATE4 | GATE5 |
GATE6 | GATE7 | GATE8 | GATE9 | GATE10 | GATE11 | GATE12 | GATE13 | GATE14 | GATE15
| GATE16 | NONE}
DPOJET:MEAS<x>:CUSTOMGATING:SOURCE1GATE?

Inputs
{GATE1 | GATE2 | GATE3 GATE4 | GATE5 | GATE6 | GATE7 | GATE8 | GATE9 | GATE10 |
GATE11 | GATE12 | GATE13 | GATE14 | GATE15 | GATE16 | NONE}

Outputs
{GATE1 | GATE2 | GATE3 GATE4 | GATE5 | GATE6 | GATE7 | GATE8 | GATE9 | GATE10 |
GATE11 | GATE12 | GATE13 | GATE14 | GATE15 | GATE16 | NONE}

DPOJET:MEAS<x>:CUSTOMGATING:SOURCE2GATE
This commands sets or queries the gate associated with source2.

Syntax
DPOJET:MEAS<x>:CUSTOMGATING:SOURCE2GATE {GATE1 | GATE2 | GATE3 GATE4 | GATE5 |
GATE6 | GATE7 | GATE8 | GATE9 | GATE10 | GATE11 | GATE12 | GATE13 | GATE14 | GATE15
| GATE16 | NONE }
DPOJET:MEAS<x>:CUSTOMGATING:SOURCE2GATE?

Inputs
{GATE1 | GATE2 | GATE3 GATE4 | GATE5 | GATE6 | GATE7 | GATE8 | GATE9 | GATE10 |
GATE11 | GATE12 | GATE13 | GATE14 | GATE15 | GATE16 | NONE}

Outputs
{GATE1 | GATE2 | GATE3 GATE4 | GATE5 | GATE6 | GATE7 | GATE8 | GATE9 | GATE10 |
GATE11 | GATE12 | GATE13 | GATE14 | GATE15 | GATE16 | NONE}

DPOJET:MEAS<x>:CUSTOMGATING:FROMedge
This commands sets or queries the edge type for source1.
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Syntax
DPOJET:MEAS<x>:CUSTOMGATING:FROMedge {RISe | FALL | BOTH}
DPOJET:MEAS<x>:CUSTOMGATING:FROMedge?

Inputs
{RISe | FALL | BOTH}

Outputs
{RISe | FALL | BOTH}

DPOJET:MEAS<x>:CUSTOMGATING:TOedge
This commands sets or queries the edge type for source2.

Syntax
DPOJET:MEAS<x>:CUSTOMGATING:TOedge {RISe | FALL | BOTH}
DPOJET:MEAS<x>:CUSTOMGATING:TOedge?

Inputs
{RISe | FALL | BOTH}

Outputs
{RISe | FALL | BOTH}

DPOJET:MEAS<x>:CUSTOMGATING:MEASUREMENTEdge
This command sets or queries the current measurement edge.

Syntax
DPOJET:MEAS<x>:CUSTOMGATING:MEASUREMENTEdge {FIRST | ALL}
DPOJET:MEAS<x>:CUSTOMGATING:MEASUREMENTEdge?

Inputs
{FIRST | ALL}

Outputs
{FIRST | ALL}

DPOJET:MEAS<x>:DATA?
This query-only command returns the measurement data. This is similar to the curve query, where the output is in the format
#<x><yyy><data><newline>, where <x> is the number of <y> bytes.
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For Example: If <yyy>=500, <x>=3

Note: <x> is hexadecimal format. The letters A-F denote the number of y bytes between 10 and 15 digits.

<yyy> is the number of bytes to transfer.

<data> is curve data.

<newline> is a single-byte new line character at the end of the data.

Syntax
DPOJET:MEAS<x>:DATA?

Outputs
The measurement values as a stream of doubles.

DPOJET:MEAS<x>:DFE:RESOlution
This command sets or queries the resolution.

Syntax
DPOJET:MEAS<x>:DFE:RESOlution <NR3>
DPOJET:MEAS<x>:DFE:RESOlution?

Inputs
<NR3>

Outputs
<NR3>

DPOJET:MEAS<x>:DFE:TAPState
This command sets or queries the tap value state, either on or off.

Syntax
DPOJET:MEAS<x>:DFE:TAPState {0|1}
DPOJET:MEAS<x>:DFE:TAPState?

Inputs
{1 | 0}

Outputs
{1 | 0}

GPIB commands

356



DPOJET:MEAS<x>:DFE:ABSOLUTEVOLTAGEState
This command sets or queries DFE absolute voltage state for DFE_EyeWidth measurement.

Syntax
DPOJET:MEAS<x>:DFE:ABSOLUTEVOLTAGEState {0 | 1 | ON | OFF}
DPOJET:MEAS<x>:DFE:ABSOLUTEVOLTAGEState?

Inputs
{0 | 1 | ON | OFF}

Outputs
{1 | 0}

DPOJET:MEAS<x>:DFE:ABSOLUTEVOLTAGEValue
This command sets or queries DFE absolute voltage value for DFE_EyeWidth measurement.

Syntax
DPOJET:MEAS<x>:DFE:ABSOLUTEVOLTAGEValue <NR3>
DPOJET:MEAS<x>:DFE:ABSOLUTEVOLTAGEValue?

Inputs
<NR3>

Outputs
<NR3>

DPOJET:MEAS<x>:DFE:ABSOLUTETIMEState
This command sets or queries DFE absolute time state for DFE_EyeHeight measurement.

Syntax
DPOJET:MEAS<x>:DFE:ABSOLUTETIMEState {0 | 1 | ON | OFF}
DPOJET:MEAS<x>:DFE:ABSOLUTETIMEState?

Inputs
{0 | 1 | ON | OFF}

Outputs
{0 | 1}
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DPOJET:MEAS<x>:DFE:ABSOLUTETIMEValue
This command sets or queries DFE absolute time value for DFE_EyeHeight measurement.

Syntax
DPOJET:MEAS<x>:DFE:ABSOLUTETIMEValue <NR3>
DPOJET:MEAS<x>:DFE:ABSOLUTETIMEValue?

Inputs
<NR3>

Outputs
<NR3>

DPOJET:MEAS<x>:DFE:MEASatpercent
This command sets or queries the measure at X% value.

Syntax
DPOJET:MEAS<x>:DFE:MEASatpercent <NR3>
DPOJET:MEAS<x>:DFE:MEASatpercent?

Inputs
<NR3>

Outputs
<NR3>

DPOJET:MEAS<x>:DFE:DELAYCOMPENSATION
This command sets or queries the DFE delay compensation.

Syntax
DPOJET:MEAS<x>:DFE:DELAYCOMPENSATION {MANUAL,AUTO}
DPOJET:MEAS<x>:DFE:DELAYCOMPENSATION?

Inputs
{MANUAL | AUTO}

Outputs
{MANUAL | AUTO}
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DPOJET:MEAS<x>:DFE:MANUALDELAY
This command sets or queries the manual delay value.

Syntax
DPOJET:MEAS<x>:DFE:MANUALDELAY <NR3>
DPOJET:MEAS<x>:DFE:MANUALDELAY?

Inputs
<NR3>

Outputs
<NR3>

DPOJET:MEAS<x>:DISPLAYNAME?
This command queries the UI name of the measurement x in the measurement table.

Syntax
DPOJET:MEAS<x>:DISPLAYNAME?

Outputs
<string>

Note: If the measurement UI name has special character δ, then it is displayed as d.

DPOJET:MEAS<x>:DFE:TAPValue
This command sets or queries the tap value.

Syntax
DPOJET:MEAS<x>:DFE:TAPValue <NR3>
DPOJET:MEAS<x>:DFE:TAPValue?

Inputs
<NR3>

Outputs
<NR3>

DPOJET:MEAS<x>:EDGE1
This command sets or queries the Source1 edge type.
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Syntax
DPOJET:MEAS<x>:EDGE1 {RISe | FALL | BOTH}
DPOJET:MEAS<x>:EDGE1?

Inputs
{RISe | FALL | BOTH}

Outputs
{RISe | FALL | BOTH}

DPOJET:MEAS<x>:EDGE2
This command sets or queries the Source2 edge type.

Syntax
DPOJET:MEAS<x>:EDGE2 {RISe | FALL | BOTH}
DPOJET:MEAS<x>:EDGE2?

Inputs
{RISe | FALL | BOTH}

Outputs
{RISe | FALL | BOTH}

DPOJET:MEAS<x>:EDGEIncre
This command sets or queries the measurement edge increment value.

Syntax
DPOJET:MEAS<x>:EDGEIncre <NR3>
DPOJET:MEAS<x>:EDGEIncre?

Inputs
<NR3>

Outputs
<NR1>

DPOJET:MEAS<x>:EDGES:FROMLevel
This command sets or queries the FromLevel edge for the measurement.
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Syntax
DPOJET:MEAS<x>:EDGES:FROMLevel {HIGH | MID | LOW}
DPOJET:MEAS<x>:EDGES:FROMLevel?

Inputs
{HIGH | MID | LOW}

Outputs
{HIGH | MID | LOW}

DPOJET:MEAS<x>:EDGES:LEVel
This command sets or queries the level used for the edges configuration.

Syntax
DPOJET:MEAS<x>:EDGES:LEVel
DPOJET:MEAS<x>:EDGES:LEVel?

Inputs
{HIGH | MID | LOW}

Outputs
{HIGH | MID | LOW}

DPOJET:MEAS<x>:EDGES:SLEWRATETechnique
This command sets or queries the slew rate technique for the measurement.

Syntax
DPOJET:MEAS<x>:EDGES:SLEWRATETechnique {NOMinalmethod | DDRmethod}
DPOJET:MEAS<x>:EDGES:SLEWRATETechnique?

Inputs
{NOMinalmethod | DDRmethod}

Outputs
{NOMinalmethod | DDRmethod}

DPOJET:MEAS<x>:EDGES:SUBRATEDivisor
This command sets or queries the subrate divisor value for the application measurement slot with index <x>. 
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Syntax
DPOJET:MEAS<x>:EDGES:SUBRATEDivisor {TWO | FOUR | EIGHT}
DPOJET:MEAS<x>:EDGES:SUBRATEDivisor?

Inputs
{TWO | FOUR | EIGHT}

Outputs
{TWO | FOUR | EIGHT}

DPOJET:MEAS<x>:EDGES:EYEHeightstate
This command sets or queries the automated eye height state, either on or off.

Syntax
DPOJET:MEAS<x>:EDGES:EYEHeightstate {1 | 0}
DPOJET:MEAS<x>:EDGES:EYEHeightstate?

Inputs
{1 | 0}

Outputs
{1 | 0}

DPOJET:MEAS<x>:EDGES:VOLTAGEState
This command sets or queries the user defined voltage state, either on or off.

Syntax
DPOJET:MEAS<x>:EDGES:VOLTAGEState {1 | 0}
DPOJET:MEAS<x>:EDGES:VOLTAGEState {1 | 0}

Inputs
{1 | 0}

Outputs
{1 | 0}

DPOJET:MEAS<x>:EDGES:USERDefinedvoltage
This command sets or queries the user defined voltage.
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Syntax
DPOJET:MEAS<x>:EDGES:USERDefinedvoltage <NR3>
DPOJET:MEAS<x>:EDGES:USERDefinedvoltage?

Inputs
<NR3>

Outputs
<NR3>

DPOJET:MEAS<x>:EDGES:TOLevel
This command sets or queries the ToLevel edge for the measurement.

Syntax
DPOJET:MEAS<x>:EDGES:TOLevel {HIGH | MID | LOW}
DPOJET:MEAS<x>:EDGES:TOLevel?

Inputs
{HIGH | MID | LOW}

Outputs
{HIGH | MID | LOW}

DPOJET:MEAS<x>:FILTers:BLANKingtime
This command sets or queries the current filter blanking time.

Syntax
DPOJET:MEAS<x>:FILTers:BLANKingtime <NR3>
DPOJET:MEAS<x>:FILTers:BLANKingtime?

Inputs
<NR3>

Outputs
<NR3>

DPOJET:MEAS<x>:FILTers:HIGHPass:FREQ
This command sets or queries the current high pass filter frequency.
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Syntax
DPOJET:MEAS<x>:FILTers:HIGHPass:FREQ <NR3>
DPOJET:MEAS<x>:FILTers:HIGHPass:FREQ?

Inputs
<NR3>

Outputs
<NR3>

DPOJET:MEAS<x>:FILTers:HIGHPass:SPEC
This command sets or queries the current high pass filter specification.

Syntax
DPOJET:MEAS<x>:FILTers:HIGHPass:SPEC {NONE | FIRST | SECOND | THIRD}
DPOJET:MEAS<x>:FILTers:HIGHPass:SPEC?

Inputs
{NONE | FIRST | SECOND | THIRD}

Outputs
{NONE | FIRST | SECOND | THIRD}

DPOJET:MEAS<x>:FILTers:LOWPass:FREQ
This command sets or queries the current low pass filter frequency.

Syntax
DPOJET:MEAS<x>:FILTers:LOWPass:FREQ <NR3>
DPOJET:MEAS<x>:FILTers:LOWPass:FREQ?

Inputs
<NR3>

Outputs
<NR3>

DPOJET:MEAS<x>:FILTers:LOWPass:SPEC
This command sets or queries the current low pass filter specification.
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Syntax
DPOJET:MEAS<x>:FILTers:LOWPass:SPEC {NONE | FIRST | SECOND | THIRD}
DPOJET:MEAS<x>:FILTers:LOWPass:SPEC?

Inputs
{NONE | FIRST | SECOND | THIRD}

Outputs
{NONE | FIRST | SECOND | THIRD}

DPOJET:MEAS<x>:FILTers:SJBAndwidth
This command sets or queries the SJ Bandwidth of SJ@FREQ measurement for the application measurement slot with index <x>.

Syntax
DPOJET:MEAS<x>:FILTers:SJBAndwidth <NR3>
DPOJET:MEAS<x>:FILTers:SJBAndwidth?

Inputs
<NR3>

Outputs
<NR3>

DPOJET:MEAS<x>:FILTers:SJFRequency
This command sets or queries the SJ Frequency of SJ@FREQ measurement for the application measurement slot with index <x>.

Syntax
DPOJET:MEAS<x>:FILTers:SJFRequency <NR3>
DPOJET:MEAS<x>:FILTers:SJFRequency?

Inputs
<NR3>

Outputs
<NR3>

DPOJET:MEAS<x>:REFVoltage
This command sets or queries the reference voltage for the measurement.
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Syntax
DPOJET:MEAS<x>:REFVoltage {100 | -100}
DPOJET:MEAS<x>:REFVoltage?

Inputs
{100 | -100}

Outputs
{100 | -100}

DPOJET:MEAS<x>:FILTers:RAMPtime
This command sets or queries the current filter ramp time.

Syntax
DPOJET:MEAS<x>:FILTers:RAMPtime <NR3>
DPOJET:MEAS<x>:FILTers:RAMPtime?

Inputs
<NR3>

Outputs
<NR3>

DPOJET:MEAS<x>:FROMedge
This command sets the FROMedge value for the measurement.

Syntax
DPOJET:MEAS<x>:FROMedge {RISe | FALL | BOTH}

Inputs
{RISe | FALL | BOTH}

Outputs
{RISe | FALL | BOTH}

DPOJET:MEAS<x>:HIGHREFVoltage
This command sets or queries the high reference voltage value for the selected configuration.
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Syntax
DPOJET:MEAS<x>:HIGHREFVoltage <NR3>
DPOJET:MEAS<x>:HIGHREFVoltage?

Inputs
<NR3>

Outputs
<NR3>

DPOJET:MEAS<x>:LOWREFVoltage
This command sets or queries the low reference voltage value for the selected configuration.

Syntax
DPOJET:MEAS<x>:LOWREFVoltage <NR3>
DPOJET:MEAS<x>:LOWREFVoltage?

Inputs
<NR3>

Outputs
<NR3>

DPOJET:MEAS<x>:LOGging:MEASurements:FILEname?
This command queries the current file name that will be used for the measurement when measurement logging is turned on.

Syntax
DPOJET:MEAS<x>:LOGging:MEASurements:FILEname?

Outputs
<string>

DPOJET:MEAS<x>:LOGging:MEASurements:SELect
This command sets or queries the given measurement to be included in any measurement logging. Statistic logging is turned on or off as a
whole, using the DPOJET:LOGging branch.

Syntax
DPOJET:MEAS<x>:LOGging:MEASurements:SELect {1 | 0}
DPOJET:MEAS<x>:LOGging:MEASurements:SELect?
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Inputs
{1 | 0}

Outputs
{1 | 0}

DPOJET:MEAS<x>:LOGging:STATistics:SELect
This command sets or queries the given measurement for inclusion in any statistic logging. Statistic logging is turned on or off as a whole,
using the DPOJET:LOGging branch.

Syntax
DPOJET:MEAS<x>:LOGging:STATistics:SELect {1 | 0}
DPOJET:MEAS<x>:LOGging:STATistics:SELect?

Inputs
{1 | 0}

Outputs
{1 | 0}

DPOJET:MEAS<x>:LOGging:WORSTcase:SELect
This command sets or queries the given measurement for inclusion in any worst-case logging. Statistic logging is turned on or off as a
whole, using the DPOJET:LOGging branch.

Syntax
DPOJET:MEAS<x>:LOGging:WORSTcase:SELect {1 | 0}

Inputs
DPOJET:MEAS<x>:LOGging:WORSTcase:SELect?
{1 | 0}

Outputs
{1 | 0}

DPOJET:MEAS<x>:MARGIN:HITCOUNTValue
This command sets or queries the HitCount value.

Syntax
DPOJET:MEAS<x>:MARGIN:HITCOUNTValue <NR3>
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DPOJET:MEAS<x>:MARGIN:HITCOUNTValue?

Inputs
<NR3>

Outputs
<NR3>

DPOJET:MEAS<x>:MARGIN:HITRATIOState
This command sets or queries the HitRatio state.

Syntax
DPOJET:MEAS<x>:MARGIN:HITRATIOState {1 | 0}
DPOJET:MEAS<x>:MARGIN:HITRATIOState?

Inputs
{1 | 0}

Outputs
{1 | 0}

DPOJET:MEAS<x>:MARGIN:HITRATIOValue
This command sets or queries the HitRatio value.

Syntax
DPOJET:MEAS<x>:MARGIN:HITRATIOValue <NR3>
DPOJET:MEAS<x>:MARGIN:HITRATIOValue?

Inputs
<NR3>

Outputs
<NR3>

DPOJET:MEAS<x>:MARGIN:RESOlution
This command sets or queries the resolution value.

Syntax
DPOJET:MEAS<x>:MARGIN:RESOlution <NR3>
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DPOJET:MEAS<x>:MARGIN:RESOlution?

Inputs
<NR3>

Outputs
<NR3>

DPOJET:MEAS<x>:MASKfile
This command sets or queries the current mask file name.

Syntax
DPOJET:MEAS<x>:MASKfile <string>
DPOJET:MEAS<x>:MASKfile?

Inputs
<string>

Outputs
<string>

DPOJET:MEAS<x>:MASKOffset:HORIzontal:SELECTIONtype
This command sets or queries the selection type. 

Syntax
DPOJET:MEAS<x>:MASKOffset:HORIzontal:SELECTIONtype { AUTOFIT | MANUAL}

DPOJET:MEAS<x>:MASKOffset:HORIzontal:SELECTIONtype?

Inputs
{AUTOFIT | MANUAL}

Outputs
{AUTOFIT | MANUAL}

DPOJET:MEAS<x>:MASKOffset:HORIzontal:AUTOfit?
This query-only command returns the value in the Autofit text box for the Mask Offset controls. If the mask offset method selection type
is set to Autofit and an acquisition cycle has been completed, this field shows the displacement of the mask offset that was automatically
determined. A positive value means that the mask has moved to the right. If the offset has not been determined, the returned string is TBD. 
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Syntax
DPOJET:MEAS<x>:MASKOffset:HORIzontal:AUTOfit?

Outputs
<string>

DPOJET:MEAS<x>:MASKOffset:HORIzontal:MANual
This command sets or queries the value for Manual text box. 

Syntax
DPOJET:MEAS<x>:MASKOffset:HORIzontal:MANual <NR3>

DPOJET:MEAS<x>:MASKOffset:HORIzontal:MANual?

Inputs
<NR3>

Outputs
<NR3>

DPOJET:MEAS<x>:MEASRange:MAX
This command sets or queries the maximum measurement range limit value.

Syntax
DPOJET:MEAS<x>:MEASRange:MAX <NR3>
DPOJET:MEAS<x>:MEASRange:MAX?

Inputs
<NR3>

Outputs
<NR3>

DPOJET:MEAS<x>:MEASRange:MIN
This command sets or queries the minimum measurement range limit value.

Syntax
DPOJET:MEAS<x>:MEASRange:MIN <NR3>
DPOJET:MEAS<x>:MEASRange:MIN?
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Inputs
<NR3>

Outputs
<NR3>

DPOJET:MEAS<x>:MEASRange:STATE
This command turns on or off the measurement range limits.

Syntax
DPOJET:MEAS<x>:MEASRange:STATE {1 | 0}

Inputs
{1 | 0}

Outputs
{1 | 0}

DPOJET:MEAS<x>:MEASStart
This command sets or queries the measurement start value.

Syntax
DPOJET:MEAS<x>:MEASStart <NR3>
DPOJET:MEAS<x>:MEASStart?

Inputs
<NR3>

Outputs
<NR1>

DPOJET:MEAS<x>:N
This command sets or queries the measurement N value.

Syntax
DPOJET:MEAS<x>:N <NR3>
DPOJET:MEAS<x>:N?
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Inputs
<NR3>

Outputs
<NR1>

DPOJET:MEAS<x>:NAME?
This query-only command returns the measurement name for the measurement in slot x. For measurements that include 16-bit characters
in their UI names, such as DJDirac, the string returned will contain question marks where the UI contains nontext characters.

Syntax
DPOJET:MEAS<x>:NAME?

Outputs
<string>

DPOJET:MEAS <x>: OPTIcal:BANDWIDth
This command sets or queries the optical to electrical converted bandwidth value.

Syntax
DPOJET:MEAS<x>:OPTIcal:BANDWIDth <NR3>
DPOJET:MEAS<x>:OPTIcal:BANDWIDth?

Inputs
<NR3>

Outputs
<NR3>

DPOJET:MEAS<x>:OPTIcal:BTFILTEr
This command sets or queries current BT Filter file with absolute path. 

Syntax
DPOJET:MEAS<x>:OPTIcal:BTFILTEr <string>
DPOJET:MEAS<x>:OPTIcal:BTFILTEr?

Inputs
<string>
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Outputs
<string>
Default path: "C:\Users\Public\Tektronix\TekApplications\DPOJET\Filters\BTFilter.flt"

DPOJET:MEAS<x>:OPTIcal:FFETAPS
This command sets or queries current FFE tap file with absolute path. 

Syntax
DPOJET:MEAS<x>:OPTIcal:FFETAPS <string>
DPOJET:MEAS<x>:OPTIcal:FFETAPS?

Inputs
<string>

Outputs
<string>
Default path: "C:\Users\Public\Tektronix\TekApplications\SDLA\taps\FFE.tap"

DPOJET:MEAS <x>: OPTIcal:SCOPERN
This command sets or queries the Scope RN(rms) value. 

Syntax
DPOJET:MEAS<x>:OPTIcal:SCOPERN <NR3>
DPOJET:MEAS<x>:OPTIcal:SCOPERN?

Inputs
<NR3>

Outputs
<NR3>

DPOJET:MEAS<x>:OPTIcal:TARGETBer
This command sets or queries the Target BER value display. The 1E-Value = 10-Value will be considered as Target BER for the TDEC
computation. 

Syntax
DPOJET:MEAS<x>:OPTIcal:TARGETBer <NR3>
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DPOJET:MEAS<x>:OPTIcal:TARGETBer?

Inputs
<NR3>

Outputs
<NR3>

DPOJET:MEAS <x>: OPTIcal:WFMTYpe
This command sets or queries the optical waveform type. 

Syntax
DPOJET:MEAS<x>:OPTIcal:WFMTYpe {CONTINUOUS | MODULATED}
DPOJET:MEAS<x>:OPTIcal:WFMTYpe?

Inputs
{CONTINUOUS | MODULATED}

Outputs
{CONTINUOUS | MODULATED}

DPOJET:MEAS<x>:PHASENoise:HIGHLimit
This command sets or queries the upper phase noise integration limit.

Syntax
DPOJET:MEAS<x>:PHASENoise:HIGHLimit <NR3>
DPOJET:MEAS<x>:PHASENoise:HIGHLimit?

Inputs
<NR3>

Outputs
<NR3>

DPOJET:MEAS<x>:PHASENoise:LOWLimit
This command sets or queries the lower phase noise integration limit.

Syntax
DPOJET:MEAS<x>:PHASENoise:LOWLimit <NR3>
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DPOJET:MEAS<x>:PHASENoise:LOWLimit?

Inputs
<NR3>

Outputs
<NR3>

DPOJET:MEAS<x>:PLOTFILES
The query-only command returns plot file paths of a given measurement. 

Syntax
DPOJET:MEAS<x>:PLOTFILES?

Outputs
DPOJET:MEAS<x>:PLOTFILES? Returns the plot files path of a given measurement to,
C:\Users\<LocalUser>\Tektronix\TekApplications\DPOJET\Reports\Resources.

DPOJET:MEAS<x>:REFVoltage
This command sets or queries the reference voltage for the measurement.

Syntax
DPOJET:MEAS<x>:REFVoltage {100 | —100}
DPOJET:MEAS<x>:REFVoltage?

Inputs
{100 | —100}

Outputs
{100 | —100}

DPOJET:MEAS<x>:RESULts?
This query-only command returns the measurement branch for the currently selected measurement for measurement slot <x>.

Syntax
DPOJET:MEAS<x>:RESULts?

Outputs
The measurement branch for the selected measurement for measurement slot x.

GPIB commands

376



DPOJET:MEAS<x>:RESULts:ALLAcqs?
This query-only command returns the measurement results from all acquisitions.

Syntax
DPOJET:MEAS<x>:RESULts:ALLAcqs?

Outputs
<NR3>

DPOJET:MEAS<x>:RESULts:ALLAcqs:HITPopulation?
This query-only command returns the mask hit population.

Syntax
DPOJET:MEAS<x>:RESULts:ALLAcqs:HITPopulation?

Outputs
<NR3>

DPOJET:MEAS<x>:RESULts:ALLAcqs:HITS?
This query-only command returns the mask hits measurement for all segments.

Syntax
DPOJET:MEAS<x>:RESULts:ALLAcqs:HITS?

Outputs
<NR3>

DPOJET:MEAS<x>:RESULts:ALLacqs:LIMits:STATus?
This query-only command returns the pass/fail status per measurement. If any of the statistics fails, the cumulative result is fail, otherwise
pass. 

Syntax
DPOJET:MEAS<x>:RESULts:ALLacqs:LIMits:STATus?

Outputs
{PASS | FAIL}
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DPOJET:MEAS<x>:RESULts:ALLacqs:LIMits:HIgh:STATus?
This query-only command returns the pass/fail status for high limit.

Syntax
DPOJET:MEAS<x>:RESULts:ALLacqs:LIMits:HIgh:STATus?

Outputs
{PASS | FAIL}

DPOJET:MEAS<x>:RESULts:ALLacqs:LIMits:LOw:STATus?
This query-only command returns the pass/fail status for low limit.

Syntax
DPOJET:MEAS<x>:RESULts:ALLacqs:LIMits:LOw:STATus?

Outputs
{PASS | FAIL}

DPOJET:MEAS<x>:RESULts:ALLAcqs:MAX?
This query-only command returns the maximum value for all accumulated measurement acquisitions for slot <x>.

Syntax
DPOJET:MEAS<x>:RESULts:ALLAcqs:MAX?

Outputs
<NR3>

DPOJET:MEAS<x>:RESULts:ALLAcqs:MAXCC?
This query-only command returns the maximum positive cycle-to-cycle delta of the selected measurement.

Syntax
DPOJET:MEAS<x>:RESULts:ALLAcqs:MAXCC?

Outputs
<NR3>
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DPOJET:MEAS<x>:RESULts:ALLAcqs:MAXCC:STATus?
This query-only command returns the pass/fail status for the maximum positive cycle-to-cycle delta of the selected measurement (set
via :DPOJET:LIMits:FILEName).

Syntax
DPOJET:MEAS<x>:RESULts:ALLacqs:MAXCC:STATus?

Outputs
{PASS | FAIL}

DPOJET:MEAS<x>:RESULts:ALLAcqs:MAXHits?
This query-only command returns the maximum mask hits measurement for all segments.

Syntax
DPOJET:MEAS<x>:RESULts:ALLAcqs:MAXHits?

Outputs
<NR3>

DPOJET:MEAS<x>:RESULts:ALLAcqs:MAX:STATus?
This query-only command returns the pass/fail status for the max measurement for the currently loaded limit file (set
via :DPOJET:LIMits:FILEName).

Syntax
DPOJET:MEAS<x>:RESULts:ALLacqs:MAX:STATus?

Outputs
{PASS | FAIL}

DPOJET:MEAS<x>:RESULts:ALLacqs:MAX:HIGHLimit?
This query-only command returns the high limit value of Max for measurement <x>.

Syntax
DPOJET:MEAS<x>:RESULts:ALLacqs:MAX:HIGHLimit?

Outputs
<NR3>
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DPOJET:MEAS<x>:RESULts:ALLacqs:MAX:HIGHMArgin?
This query-only command returns the high margin value of Max for measurement <x>.

Syntax
DPOJET:MEAS<x>:RESULts:ALLacqs:MAX:HIGHMArgin?

Outputs
<NR3>

DPOJET:MEAS<x>:RESULts:ALLacqs:MIN:LOWLimit?
This query-only command returns the low limit value of Min for measurement <x>.

Syntax
DPOJET:MEAS<x>:RESULts:ALLacqs:MIN:LOWLimit?

Outputs
<NR3>

DPOJET:MEAS<x>:RESULts:ALLacqs:MIN:LOWMArgin?
This query-only command returns the low margin value of Min for measurement <x>.

Syntax
DPOJET:MEAS<x>:RESULts:ALLacqs:MIN:LOWMArgin?

Outputs
<NR3>

DPOJET:MEAS<x>:RESULts:ALLAcqs:MEAN?
This query-only command returns the mean value for all accumulated measurement acquisitions for slot <x>.

Syntax
DPOJET:MEAS<x>:RESULts:ALLAcqs:MEAN?

Outputs
<NR3>

DPOJET:MEAS<x>:RESULts:ALLacqs:MEAN:HIGHLimit?
This query-only command returns the high limit value of Mean for measurement <x>.
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Syntax
DPOJET:MEAS<x>:RESULts:ALLacqs:MEAN:HIGHLimit?

Outputs
<NR3>

DPOJET:MEAS<x>:RESULts:ALLAcqs:MEAN:STATus?
This query-only command returns the pass/fail status for the mean measurement for the currently loaded limit file (set
via :DPOJET:LIMits:FILEName).

Syntax
DPOJET:MEAS<x>:RESULts:ALLAcqs:MEAN:STATus?

Outputs
{PASS | FAIL}

DPOJET:MEAS<x>:RESULts:ALLAcqs:MIN?
This query-only command returns the minimum value for all accumulated measurement acquisitions for slot <x>.

Syntax
DPOJET:MEAS<x>:RESULts:ALLAcqs:MIN?

Outputs
<NR3>

DPOJET:MEAS<x>:RESULts:ALLAcqs:MINCC?
This query-only command returns the maximum negative cycle-to-cycle delta of the selected measurement.

Syntax
DPOJET:MEAS<x>:RESULts:ALLAcqs:MINCC?

Outputs
<NR3>

DPOJET:MEAS<x>:RESULts:ALLAcqs:MINCC:STATus?
This query-only command returns the pass/fail status for the negative cycle-to-cycle delta of the selected measurement.

Syntax
DPOJET:MEAS<x>:RESULts:ALLAcqs:MINCC:STATus?
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Outputs
{PASS | FAIL}

DPOJET:MEAS<x>:RESULts:ALLAcqs:MINHits?
This query-only command returns the minimum mask hits measurement for all segments.

Syntax
DPOJET:MEAS<x>:RESULts:ALLAcqs:MINHits?

Outputs
<NR3>

DPOJET:MEAS<x>:RESULts:ALLAcqs:MIN:STATus?
This query-only command returns the pass/fail status for the minimum measurement for the currently loaded limit file (set
via :DPOJET:LIMits:FILEName).

Syntax
DPOJET:MEAS<x>:RESULts:ALLAcqs:MIN:STATus?

Outputs
{PASS | FAIL}

DPOJET:MEAS<x>:RESULts:ALLacqs:PK2PK?
This query-only command returns the peak-to-peak value for all accumulated measurement acquisitions for slot <x>.

Syntax
DPOJET:MEAS<x>:RESULts:ALLacqs:PK2PK?

Outputs
<NR3>

DPOJET:MEAS<x>:RESULts:ALLacqs:PK2PK:STATus?
This query-only command returns the pass/fail status for the peak-to-peak measurement for the currently loaded limit file (set
via :DPOJET:LIMits:FILEName).

Syntax
DPOJET:MEAS<x>:RESULts:ALLacqs:PK2PK:STATus?
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Outputs
{PASS | FAIL}

DPOJET:MEAS<x>:RESULts:ALLAcqs:POPUlation?
This query-only command returns the mean measurement value for the currently selected measurement for measurement slot <x>.

Syntax
DPOJET:MEAS<x>:RESULts:ALLAcqs:POPUlation?

Outputs
<NR1>

DPOJET:MEAS<x>:RESULts:ALLacqs:POPUlation:STATus?
This query-only command returns the pass/fail status for the population measurement for the currently loaded limit file (set
via :DPOJET:LIMits:FILEName).

Syntax
DPOJET:MEAS<x>:RESULts:ALLacqs:POPUlation:STATus?

Outputs
{PASS | FAIL}

DPOJET:MEAS<x>:RESULts:ALLAcqs:SEG(x):Hits?
This query-only command returns the mask hits measurement for the given segment, either SEG1, SEG2 or SEG3.

Syntax
DPOJET:MEAS<x>:RESULts:ALLAcqs:SEG<x>:Hits?

Outputs
<NR3>

DPOJET:MEAS<x>:RESULts:ALLAcqs:SEG(x):MAXHits?
This query-only command returnseturns the maximum mask hits measurement for the given segment, either SEG1, SEG2 or SEG3.

Syntax
DPOJET:MEAS<x>:RESULts:ALLAcqs:SEG<x>:MAXHits?
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Outputs
<NR3>

DPOJET:MEAS<x>:RESULts:ALLAcqs:SEG(x):MINHits?
This query-only command returns the minimum mask hits measurement for the given segment, either SEG1, SEG2 or SEG3.

Syntax
DPOJET:MEAS<x>:RESULts:ALLAcqs:SEG<x>:MINHits?

Outputs
<NR3>

DPOJET:MEAS<x>:RESULts:ALLAcqs:STDDev?
This query-only command returns the standard deviation for all accumulated measurement acquisitions for slot <x>.

Syntax
DPOJET:MEAS<x>:RESULts:ALLAcqs:STDDev?

Outputs
<NR3>

DPOJET:MEAS<x>:RESULts:ALLacqs:STDDEV:STATus?
This query-only command returns the pass/fail status for the standard deviation measurement for the currently loaded limit file (set
via :DPOJET:LIMits:FILEName).

Syntax
DPOJET:MEAS<x>:RESULts:ALLacqs:STDDEV:STATus?

Outputs
{PASS | FAIL}

DPOJET:MEAS<x>:RESULts:CURRentacq:MAX?
This query-only command returns the maximum value of the measurement value for the currently selected measurement for measurement
slot <x>.

Syntax
DPOJET:MEAS<x>:RESULts:CURRentacq:MAX?
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Outputs
<NR3>

DPOJET:MEAS<x>:RESULts:CURRentacq:MAXCC?
This query-only command returns the maximum positive cycle-to-cycle delta of the selected measurement.

Syntax
DPOJET:MEAS<x>:RESULts:CURRentacq:MAXCC?

Outputs
<NR3>

DPOJET:MEAS<x>:RESULts:CURRentacq:MAXCC:STATus?
This query-only command returns the pass/fail status for the Max cycle-to-cycle measurement for the currently loaded limit file. (Set using
DPOJET:LIMits:FILEName).

Syntax
DPOJET:MEAS<x>:RESULts:CURRentacq:MAXCC:STATus?

Outputs
{PASS | FAIL}

DPOJET:MEAS<x>:RESULts:CURRentacq:MAX:STATus?
This query-only command returns the pass/fail status for the max measurement for the currently loaded limit file. (Set using
DPOJET:LIMits:FILEName).

Syntax
DPOJET:MEAS<x>:RESULts:CURRentacq:MAX:STATus?

Outputs
{PASS | FAIL}

DPOJET:MEAS<x>:RESULts:CURRentacq:MEAN?
This query-only command returns the mean value of the measurement for the current acquisition or for the most recent processing cycle.

Syntax
DPOJET:MEAS<x>:RESULts:CURRentacq:MEAN?
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Outputs
<NR3>

DPOJET:MEAS<x>:RESULts:CURRentacq:MEAN:STATus?
This query-only command returns the pass/fail status for the mean measurement for the currently loaded limit file. (Set using
DPOJET:LIMits:FILEName).

Syntax
DPOJET:MEAS<x>:RESULts:CURRentacq:MEAN:STATus?

Outputs
{PASS | FAIL}

DPOJET:MEAS<x>:RESULts:CURRentacq:MIN?
This query-only command returns the minimum value for the currently selected measurement for measurement slot <x>.

Syntax
DPOJET:MEAS<x>:RESULts:CURRentacq:MIN?

Outputs
<NR3>

DPOJET:MEAS<x>:RESULts:CURRentacq:MINCC?
This query-only command returns the maximum negative cycle-to-cycle delta of the selected measurement.

Syntax
DPOJET:MEAS<x>:RESULts:CURRentacq:MINCC?

Outputs
<NR3>

DPOJET:MEAS<x>:RESULts:CURRentacq:MINCC:STATus?
This query-only command returns the pass/fail status for the min cycle-to-cycle measurement for the currently loaded limit file. (Set using
DPOJET:LIMits:FILEName).

Syntax
DPOJET:MEAS<x>:RESULts:CURRentacq:MINCC:STATus?
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Outputs
{PASS | FAIL}

DPOJET:MEAS<x>:RESULts:CURRentacq:MIN:STATus?
This query-only command returns the pass/fail status for the minimum measurement for the currently loaded limit file. (Set using
DPOJET:LIMits:FILEName).

Syntax
DPOJET:MEAS<x>:RESULts:CURRentacq:MIN:STATus?

Outputs
{PASS | FAIL}

DPOJET:MEAS<x>:RESULts:CURRentacq:PK2PK?
This query-only command returns the peak-to-peak value for the currently selected measurement for measurement slot <x>.

Syntax
DPOJET:MEAS<x>:RESULts:CURRentacq:PK2PK?

Outputs
<NR3>

DPOJET:MEAS<x>:RESULts:CURRentacq:PK2PK:STATus?
This query-only command returns the pass/fail status for the peak-to-peak measurement for the currently loaded limit file. (Set using
DPOJET:LIMits:FILEName).

Syntax
DPOJET:MEAS<x>:RESULts:CURRentacq:PK2PK:STATus?

Outputs
{PASS | FAIL}

DPOJET:MEAS<x>:RESULts:CURRentacq:POPUlation?
This query-only command returns the population measurement value for the currently selected measurement for measurement slot <x>.

Syntax
DPOJET:MEAS<x>:RESULts:CURRentacq:POPUlation?

GPIB commands

DPOJET Jitter, Noise and Eye Diagram Analysis Solution Application Help 387



Outputs
<NR1>

DPOJET:MEAS<x>:RESULts:CURRentacq:POPUlation:STATus?
This query-only command returns the pass/fail status for the population measurement for the currently loaded limit file. (Set using
DPOJET:LIMits:FILEName).

Syntax
DPOJET:MEAS<x>:RESULts:CURRentacq:POPUlation:STATus?

Outputs
{PASS | FAIL}

DPOJET:MEAS<x>:RESULts:CURRentacq:STDDev?
This query-only command returns the standard deviation of the measurement value for the currently selected measurement for
measurement slot <x>.

Syntax
DPOJET:MEAS<x>:RESULts:CURRentacq:StdDev?

Outputs
<NR3>

DPOJET:MEAS<x>:RESULts:CURRentacq:STDDev:STATus?
This query-only command returns the pass/fail status for the standard deviation measurement for the currently loaded limit file. (Set using
DPOJET:LIMits:FILEName).

Syntax
DPOJET:MEAS<x>:RESULts:CURRentacq:STDDev:STATus?

Outputs
{PASS | FAIL}

DPOJET:MEAS<x>:RESULts:GETAll
The query-only command returns results of given measurement in xml format with units.

Syntax
DPOJET:MEAS<x>:RESULts:GETAll?
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Outputs
DPOJET:MEAS<x>:RESULts:GETAll? Returns the results of given measurement in xml format with units.

DPOJET:MEAS<x>:RESULTS:STATus?
This query-only command returns the status of the given measurement values in slot MEAS<x>. Valid for currently valid measurements, or
the error status such as “Not enough edges”.

Syntax
DPOJET:MEAS<x>:RESULTS:STATus?

Outputs
<string>

DPOJET:MEAS<x>:RESULts:VIew?
This query-only command returns the results view type.

Syntax
DPOJET:MEAS<x>:RESULts:VIew?

Outputs
{SUMmary | DETails}

DPOJET:MEAS<x>:RJDJ:BER
This command sets or queries the RJDJ Target BER value.

Syntax
DPOJET:MEAS<x>:RJDJ:BER <NR3>
DPOJET:MEAS<x>:RJDJ:BER?

Inputs
<NR3>

Outputs
<NR3>

DPOJET:MEAS<x>:RJDJ:DETECTPLEN
This command sets or queries the current detect plan. 
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Syntax
DPOJET:MEAS<x>:RJDJ:DETECTPLEN {0 | 1 | ON | OFF}

Inputs
<NR3>
0 is Manual

1 is Auto

Outputs
<NR3>

DPOJET:MEAS<x>:RJDJ:NCMODe
This command sets or queries the noise compensation mode, Auto or Manual. 

Syntax
DPOJET:MEAS<x>:RJDJ:NCMODe {1 | 0}
DPOJET:MEAS<x>:RJDJ:NCMODe?

Input
{1 | 0}
0 is Manual
1 is Auto

Output
{1 | 0}
0 is Manual
1 is Auto

DPOJET:MEAS<x>:RJDJ:PATLen
This command sets or queries the current RJDJ pattern length.

Syntax
DPOJET:MEAS<x>:RJDJ:PATLen <NR3>
DPOJET:MEAS<x>:RJDJ:PATLen?

Inputs
<NR3>
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Outputs
<NR3>

DPOJET:MEAS<x>:RJDJ:SCOPERN
This command to sets or queries the scope noise value from the applicable measurements.

Syntax
DPOJET:MEAS<x>:RJDJ:SCOPERN <NR3>
DPOJET:MEAS<x>:RJDJ:SCOPERN?

Inputs
<NR3>

Outputs
<NR3>

DPOJET:MEAS<x>:RJDJ:SNCREFID
This command sets or queries the reference id which is used for fetching the noise value. 

Syntax
DPOJET:MEAS<x>:RJDJ:SNCREFID <string>
DPOJET:MEAS<x>:RJDJ:SNCREFID?

Input
<string>

Output
<string>

DPOJET:MEAS<x>:RJDJ:TYPe
This command sets or queries the current RJDJ measurement type.

Syntax
DPOJET:MEAS<x>:RJDJ:TYPe {ARBITrary | REPEating}
DPOJET:MEAS<x>:RJDJ:TYPe?

Inputs
{ARBitrary | REPEating}
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Outputs
{ARBitrary | REPEating}

DPOJET:MEAS<x>:RJDJ:WINDOwlength
This command sets or queries the current RJDJ window length.

Syntax
DPOJET:MEAS<x>:RJDJ:WINDOwlength <NR3>
DPOJET:MEAS<x>:RJDJ:WINDOwlength?

Inputs
<NR3>

Outputs
<NR3>

DPOJET:MEAS<x>:RNDN:BER
This command sets or queries the RNDN Target BER value.

Syntax
DPOJET:MEAS<x>:RNDN:BER <NR3>
DPOJET:MEAS<x>:RNDN:BER?

Inputs
<NR3>

Outputs
<NR3>

DPOJET:MEAS<x>:RNDN:AUTODETECTpattern
This command sets or queries the current detect plan. 

Syntax
DPOJET:MEAS(x):RNDN:AUTODETECTpattern {1 | 0 | ON | OFF}

Inputs
<NR3>
0 is Manual
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1 is Auto

DPOJET:MEAS<x>:RNDN:NCMODe
This command sets or queries the noise compensation mode. 

Syntax
DPOJET:MEAS<x>:RNDN:NCMODe {1 | 0}
DPOJET:MEAS<x>:RNDN:NCMODe?

Input
{1 | 0}
0 is Manual
1 is Auto

Output
{1 | 0}
0 is Manual
1 is Auto

DPOJET:MEAS<x>:RNDN:PATLen
This command sets or queries the current RNDN pattern length.

Syntax
DPOJET:MEAS<x>:RNDN:PATLen <NR3>
DPOJET:MEAS<x>:RNDN:PATLen?

Inputs
<NR3>

Outputs
<NR3>

DPOJET:MEAS<x>:RNDN:TYPe
This command sets or queries the current RNDN measurement type.

Syntax
DPOJET:MEAS<x>:RNDN:TYPe {ARBITrary | REPEating}
DPOJET:MEAS<x>:RNDN:TYPe?
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Inputs
{ARBitrary | REPEating}

Outputs
{ARBitrary | REPEating}

DPOJET:MEAS<x>:RNDN:SCOPERN
This command to sets or queries the scope noise value from the applicable measurements.

Syntax
DPOJET:MEAS<x>:RNDN:SCOPERN <NR3>
DPOJET:MEAS<x>:RNDN:SCOPERN?

Inputs
<NR3>

Outputs
<NR3>

DPOJET:MEAS<x>:RNDN:SNCREFID
This command sets or queries the reference id which is used for fetching the noise value. 

Syntax
DPOJET:MEAS<x>:RNDN:SNCREFID <string>
DPOJET:MEAS<x>:RNDN:SNCREFID?

Input
<string>

Output
<string>

DPOJET:MEAS<x>:RNDN:WINDOwlength
This command sets or queries the current RNDN window length.

Syntax
DPOJET:MEAS<x>:RNDN:WINDOwlength <NR3>
DPOJET:MEAS<x>:RNDN:WINDOwlength?
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Inputs
<NR3>

Outputs
<NR3>

DPOJET:MEAS<x>:SIGNALType
This command sets the signal type for various measurements.

Syntax
DPOJET:MEAS<x>:SIGNALType {CLOCK | DATA | AUTO}

Inputs
{CLOCK | DATA | AUTO}

Outputs
{CLOCK | DATA | AUTO}

DPOJET:MEAS<x>:SOUrce1
This command sets or queries the Source1 value. 

Syntax
DPOJET:MEAS<x>:SOUrce1 {CH1 - CH4 | MATH1 - MATH4 | REF1 - REF4 | D0 — D15}
DPOJET:MEAS<x>:SOUrce1?

Inputs
{CH1 - CH4 | MATH1 - MATH4 | REF1 - REF4 | D0 — D15}

Outputs
{CH1 - CH4 | MATH1 - MATH4 | REF1 - REF4 | D0 — D15}

DPOJET:MEAS<x>:SOUrce2
This command sets or queries the Source2 value. May return NONE for single-source measurement. Source2 may be the second source
used in dual-source measurements, or the clock source in others. In either case, it is always the same as the rightmost displayed source
on the UI.

Syntax
DPOJET:MEAS<x>:SOUrce2 {CH1 - CH4 | MATH1 - MATH4 | REF1 - REF4 | D0 — D15}
DPOJET:MEAS<x>:SOUrce2?
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Inputs
{CH1 - CH4 | MATH1 - MATH4 | REF1 - REF4 | D0 — D15}

Outputs
{CH1 - CH4 | MATH1 - MATH4 | REF1 - REF4 | D0 — D15}

DPOJET:MEAS<x>:SSC:NOMinalfreq:AUTO?
This query-only command returns the automatically-calculated nominal frequency value for SSC configurations.

Syntax
DPOJET:MEAS<x>:SSC:NOMinalfreq:AUTO?

Outputs
<string>

DPOJET:MEAS<x>:SSC:NOMinalfreq:MANual
This command sets or queries the user-defined nominal frequency value for SSC configurations.

Syntax
DPOJET:MEAS<x>:SSC:NOMinalfreq:MANual <NR3>
DPOJET:MEAS<x>:SSC:NOMinalfreq:MANual?

Inputs
<NR3>

Outputs
<NR3>

DPOJET:MEAS<x>:SSC:NOMinalfreq:SELECTIONtype
This command sets or queries the Nominal frequency selection type for the SSC configurations.

Syntax
DPOJET:MEAS<x>:SSC:NOMinalfreq:SELECTIONtype
DPOJET:MEAS<x>:SSC:NOMinalfreq:SELECTIONtype?

Inputs
{AUTO | MANUAL}
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Outputs
{AUTO | MANUAL}

DPOJET:MEAS<x>:TIMEDATa?
This query-only command returns the measurement time data. It is similar to the curve query, where the output is in the format
#<x><yyy><data><newline>, where <x> is the number of <y> bytes.

For Example: If <yyy>=500, <x>=3

<x> is hexadecimal format. The letters A-F denote the number of y bytes between 10 and 15 digits.

<yyy> is the number of bytes to transfer.

<data> is curve data.

<newline> is a single-byte new line character at the end of the data.

Syntax
DPOJET:MEAS<x>:TIMEDATa?

Outputs
After parsing the query results, the data is a stream of doubles.

Note: Time data is not available for all measurements. For Example: Scalar measurements.

DPOJET:MEAS<x>:TOEdge
This command sets the TOEdge value for the measurement.

Syntax
DPOJET:MEAS<x>:TOEdge {SAMEas | OPPositeas}

Inputs
{SAMEas | OPPositeas}

Outputs
{SAMEas | OPPositeas}

DPOJET:MEAS<x>:ZOOMEVENT
This command zooms into the waveform where a max/min value occurs in a measurement.

Syntax
DPOJET:MEAS<x>:ZOOMEVENT {"MAX" | "MIN"}
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Inputs
{"MAX" | "MIN"}

DPOJET:NOISEENABLED
This set-only command turns on or off the Noise measurements. 

Syntax
DPOJET:NOISEENABLED {1 | 0 | ON | OFF}
Inputs

1/ON to turn-on the noise measurements

0/OFF to turn-off the noise measurements

Outputs

NA

Note: Configure DPOJET option levels on page 37 to turn on/off the noise measurements.

DPOJET:NUMPlot?
This query-only command returns the current number of plots added. If no plots are added, then it returns 0, else returns the total number
of plots added between value 1 to 4.

Syntax
DPOJET:NUMPlot?

Outputs
<NR1>

DPOJET:NUMMeas?
This query-only command returns the current number of defined measurements.

Syntax
DPOJET:NUMMeas?

Outputs
<NR1>

DPOJET:OPTICALUNITType
This command sets or queries the current optical unit-type setting for DPOJET, either Watt, or dBm.
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Syntax
DPOJET:OPTICALUNITType {WATT | DBM}
DPOJET:OPTICALUNITType?

Inputs
{WATT | DBM}

Outputs
{WATT | DBM}

DPOJET:ADDPlot
This set-only command creates a plot of the specified type on the specified DPOJET measurement. Up to four plots can be created.

Syntax
DPOJET:ADDPlot {TIMEtrend | DATAarray | HISTOgram | SPECtrum | TRANSfer
| PHASEnoise | EYE | WAVEform | BATHtub | QBathtub | QPulsewidth |
COMPOSITEJitterhist | NOISEBAthtub | BERContour} | CORRELATEDEye |PDFEye | BEREye
| COMPOSITENoisehist | MEAS<x>}

Inputs
{TIMEtrend | DATAarray | HISTOgram | SPECtrum | TRANSfer | PHASEnoise | EYE |
WAVEform | BATHtub | QBathtub | QPulsewidth | COMPOSITEJitterhist | NOISEBAthtub |
BERContour} | CORRELATEDEye |PDFEye | BEREye | COMPOSITENoisehist | MEAS<x>}
For example: DPOJET:ADDPlot HISTOgram, MEAS2

DPOJET:CLEARALLPlots
This set-only command clears the entire current list of defined plots in DPOJET.

Syntax
DPOJET:CLEARALLPlots

DPOJET:PLOT<x>:COMPOSITEJitterhist:VERTical:SCALE
This command sets or queries the vertical scale setting for applicable plots, either Linear or Log. 

Note: Undefined for non-composite jitter histogram plots.

Syntax
DPOJET:PLOT<x>:COMPOSITEJitterhist:VERTical:SCALE {LINEAR | LOG}

DPOJET:PLOT<x>:COMPOSITEJitterhist:VERTical:SCALE?
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Inputs
{LINEAR | LOG}

Outputs
{LINEAR | LOG}

DPOJET:PLOT<x>:COMPOSITEJitterhist:NUMBins
This command sets or queries the current composite jitter histogram resolution. 

Note: Undefined for non-composite jitter histogram plots.

Syntax
DPOJET:PLOT<x>:COMPOSITEJitterhist:NUMBins {TWENtyfive | FIFTY | HUNdred | TWOFifty | FIVEHundred | TWOThousand |
MAXimum}

DPOJET:PLOT<x>:COMPOSITEJitterhist:NUMBins?

Inputs
{TWENtyfive | FIFTY | HUNdred | TWOFifty | FIVEHundred| TWOThousand | MAXimum}

Outputs
TWENtyfive | FIFTY | HUNdred | TWOFifty | FIVEHundred| TWOThousand | MAXimum}

DPOJET:PLOT<x>:COMPOSITEJitterhist:TJ
This command sets or queries the TJ Jitter component settings. 

Note: Undefined for non-composite jitter histogram plots.

Syntax
DPOJET:PLOT<x>:COMPOSITEJitterhist:TJ {1 | 0}

DPOJET:PLOT<x>:COMPOSITEJitterhist:TJ?

Inputs
{1 | 0}

Outputs
{1 | 0}

DPOJET:PLOT<x>:COMPOSITEJitterhist:RJNPJ
This command sets or queries the RJ+NPJ Jitter component settings. 
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Note: Undefined for non-composite jitter histogram plots.

Syntax
DPOJET:PLOT<x>:COMPOSITEJitterhist:RJNPJ {1 | 0}

DPOJET:PLOT<x>:COMPOSITEJitterhist:RJNPJ?

Inputs
{1 | 0}

Outputs
{1 | 0}

DPOJET:PLOT<x>:COMPOSITEJitterhist:PJ
This command sets or queries the PJ Jitter component settings. 

Note: Undefined for non-composite jitter histogram plots.

Syntax
DPOJET:PLOT<x>:COMPOSITEJitterhist:PJ {1 | 0}

DPOJET:PLOT<x>:COMPOSITEJitterhist:PJ?

Inputs
{1 | 0}

Outputs
{1 | 0}

DPOJET:PLOT<x>:COMPOSITEJitterhist:DDJDCD
This command sets or queries the DDJ+DCD Jitter component settings. 

Note: Undefined for non-composite jitter histogram plots.

Syntax
DPOJET:PLOT<x>:COMPOSITEJitterhist:DDJDCD {1 | 0}

DPOJET:PLOT<x>:COMPOSITEJitterhist:DDJDCD?

Inputs
{1 | 0}
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Outputs
{1 | 0}

DPOJET:PLOT<x>:CURRENTUISACquired
This command queries the current UIs acquired for eye diagram plot.

Syntax
DPOJET:PLOT<x>:CURRENTUISACquired?

Outputs
<NR3>

DPOJET:PLOT<x>:CURRENTUISANalyzed
This command queries the current UIs analyzed for Eye Diagram plot.

Syntax
DPOJET:PLOT<x>:CURRENTUISANalyzed?

Outputs
<NR3>

DPOJET:PLOT<x>:DATA:XDATa?
This command returns the plot X data values. This command is similar to the curve query, where the output is in the format
#<x><yyy><data><newline>, where <x> is the number of <y> bytes.

For example: If <yyy>=500, <x>=3

<x> is hexadecimal format. The letters A-F denote the number of y bytes between 10 and 15 digits.

<yyy> is the number of bytes to transfer.

<data> is curve data.

<newline> is a single-byte new line character at the end of the data.

Syntax
DPOJET:PLOT<x>:DATA:XDATa?

Outputs
After parsing the query results, the data is a stream of doubles.

Note: This command does not support plots such as the Eye Diagram Height plot, Waveform Plot and Eye diagram with mask
hits.
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DPOJET:PLOT<x>:DATA:XDATa:TJ?
This command returns the TJ plot X data values. This command is similar to the curve query, where the output is in the format
#<x><yyy><data><newline>, where <x> is the number of <y> bytes.

For example: If <yyy>=500, <x>=3

<x> is hexadecimal format. The letters A-F denote the number of y bytes between 10 and 15 digits.

<data> is curve data.

<newline> is a single-byte new line character at the end of the data.

Syntax
DPOJET:PLOT<x>:DATA:XDATa:TJ?

Outputs
After parsing the query results, the data is a stream of doubles.

DPOJET:PLOT<x>:DATA:XDATa:RJBUJ?
This command returns the RJ+BUJ plot X data values. This command is similar to the curve query, where the output is in the format
#<x><yyy><data><newline>, where <x> is the number of <y> bytes.

For example: If <yyy>=500, <x>=3

<x> is hexadecimal format. The letters A-F denote the number of <y> bytes between 10 and 15 digits.

<yyy> is the number of bytes to transfer.

<data> is curve data.

<newline> is a single-byte new line character at the end of the data.

Syntax
DPOJET:PLOT<x>:DATA:XDATa:RJBUJ?

Outputs
After parsing the query results, the data is a stream of doubles.

DPOJET:PLOT<x>:DATA:XDATa:PJ?
This command returns the PJ plot X data values. This command is similar to the curve query, where the output is in the format
#<x><yyy><data><newline>, where <x> is the number of <y> bytes.

For example: If <yyy>=500, <x>=3

<x> is hexadecimal format. The letters A-F denote the number of <y> bytes between 10 and 15 digits.

<yyy> is the number of bytes to transfer.

<data> is curve data.

<newline> is a single-byte new line character at the end of the data. 
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Syntax
DPOJET:PLOTx:DATA:XDATa:PJ?

Outputs
After parsing the query results, the data is a stream of doubles.

DPOJET:PLOT<x>:DATA:XDATa:DDJDCD?
This command returns the DDJ+DCD plot X data values. This command is similar to the curve query, where the output is in the format
#<x><yyy><data><newline>, where <x> is the number of <y> bytes.

For example: If <yyy>=500, <x>=3

<x> is hexadecimal format. The letters A-F denote the number of <y> bytes between 10 and 15 digits.

<yyy> is the number of bytes to transfer.

<data> is curve data.

<newline> is a single-byte new line character at the end of the data.

Syntax
DPOJET:PLOT<x>:DATA:XDATa:DDJDCD?

Outputs
After parsing the query results, the data is a stream of doubles.

DPOJET:PLOT<x>:DATA:XDATa:TN
This command returns the TN plot X data values. This command is similar to the curve query, where the output is in the format
#<x><yyy><data><newline>, where <x> is the number of <y> bytes.

For example: If <yyy>=500, <x>=3

<x> is hexadecimal format. The letters A-F denote the number of y bytes between 10 and 15 digits.

<data> is curve data.

<newline> is a single-byte new line character at the end of the data.

Syntax
DPOJET:PLOT<x>:DATA:XDATa:TN?

Outputs
After parsing the query results, the data is a stream of doubles.

DPOJET:PLOT<x>:DATA:XDATa:RNNPN
This command returns the RNNPN plot X data values. This command is similar to the curve query, where the output is in the format
#<x><yyy><data><newline>, where <x> is the number of <y> bytes.
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For example: If <yyy>=500, <x>=3

<x> is hexadecimal format. The letters A-F denote the number of y bytes between 10 and 15 digits.

<data> is curve data.

<newline> is a single-byte new line character at the end of the data.

Syntax
DPOJET:PLOT<x>:DATA:XDATa:RNNPN?

Outputs
After parsing the query results, the data is a stream of doubles.

DPOJET:PLOT<x>:DATA:XDATa:PN
This command returns the PN plot X data values. This command is similar to the curve query, where the output is in the format
#<x><yyy><data><newline>, where <x> is the number of <y> bytes.

For example: If <yyy>=500, <x>=3

<x> is hexadecimal format. The letters A-F denote the number of y bytes between 10 and 15 digits.

<data> is curve data.

<newline> is a single-byte new line character at the end of the data.

Syntax
DPOJET:PLOT<x>:DATA:XDATa:PN?

Outputs
After parsing the query results, the data is a stream of doubles.

DPOJET:PLOT<x>:DATA:XDATa:DDNZERO
This command returns the DDNZERO plot X data values. This command is similar to the curve query, where the output is in the format
#<x><yyy><data><newline>, where <x> is the number of <y> bytes.

For example: If <yyy>=500, <x>=3

<x> is hexadecimal format. The letters A-F denote the number of y bytes between 10 and 15 digits.

<data> is curve data.

<newline> is a single-byte new line character at the end of the data.

Syntax
DPOJET:PLOT<x>:DATA:XDATa:DDNZERO?

Outputs
After parsing the query results, the data is a stream of doubles.
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DPOJET:PLOT<x>:DATA:XDATa:DDNONE
This command returns the DDNONE plot X data values. This command is similar to the curve query, where the output is in the format
#<x><yyy><data><newline>, where <x> is the number of <y> bytes.

For example: If <yyy>=500, <x>=3

<x> is hexadecimal format. The letters A-F denote the number of y bytes between 10 and 15 digits.

<data> is curve data.

<newline> is a single-byte new line character at the end of the data.

Syntax
DPOJET:PLOT<x>:DATA:XDATa:DDNONE?

Outputs
After parsing the query results, the data is a stream of doubles.

DPOJET:PLOT<x>:DATA:YDATa?
This command returns the plot Y data values. This command is similar to the curve query, where the output is in the format
#<x><yyy><data><newline>, where <x> is the number of <y> bytes.

For example: If <yyy>=500, <x>=3

<x> is hexadecimal format. The letters A-F denote the number of y bytes between 10 and 15 digits.

<yyy> is the number of bytes to transfer.

<data> is curve data.

<newline> is a single-byte new line character at the end of the data.

Syntax
DPOJET:PLOT<x>:DATA:XDATa?

Outputs
After parsing the query results, the data is a stream of doubles.

Note: This command does not support plots such as the Eye Diagram Height plot, Waveform Plot and Eye diagram with mask
hits.

DPOJET:PLOT<x>:DATA:YDATa:TJ?
This command returns the TJ plot Y data values. This command is similar to the curve query, where the output is in the format
#<x><yyy><data><newline>, where <x> is the number of <y> bytes.

For example: If <yyy>=500, <x>=3

<x> is hexadecimal format. The letters A-F denote the number of y bytes between 10 and 15 digits.

<yyy> is the number of bytes to transfer.

<data> is curve data.
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<newline> is a single-byte new line character at the end of the data.

Syntax
DPOJET:PLOT<x>:DATA:YDATa:TJ?

Outputs
After parsing the query results, the data is a stream of doubles.

DPOJET:PLOT<x>:DATA:YDATa:RJBUJ?
This command returns the RJ+BUJ plot Y data values. This command is similar to the curve query, where the output is in the format
#<x><yyy><data><newline>, where <x> is the number of <y> bytes.

For example: If <yyy>=500, <x>=3

<x> is hexadecimal format. The letters A-F denote the number of <y> bytes between 10 and 15 digits.

<yyy> is the number of bytes to transfer.

<data> is curve data.

<newline> is a single-byte new line character at the end of the data.

Syntax
DPOJET:PLOT<x>:DATA:YDATa:RJBUJ?

Outputs
After parsing the query results, the data is a stream of doubles.

DPOJET:PLOT<x>:DATA:YDATa:PJ?
This command returns the PJ plot Y data values. This command is similar to the curve query, where the output is in the format
#<x><yyy><data><newline>, where <x> is the number of <y> bytes.

For example: If <yyy>=500, <x>=3

<x> is hexadecimal format. The letters A-F denote the number of <y> bytes between 10 and 15 digits.

<yyy> is the number of bytes to transfer.

<data> is curve data.

<newline> is a single-byte new line character at the end of the data.

Syntax
DPOJET:PLOT<x>:DATA:YDATa:PJ?

Outputs
After parsing the query results, the data is a stream of doubles.
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DPOJET:PLOT<x>:DATA:YDATa:DDJDCD?
This command returns the DDJ+DCD plot Y data values. This command is similar to the curve query, where the output is in the format
#<x><yyy><data><newline>, where <x> is the number of <y> bytes.

For example: If <yyy>=500, <x>=3

<x> is hexadecimal format. The letters A-F denote the number of <y> bytes between 10 and 15 digits.

<yyy> is the number of bytes to transfer.

<data> is curve data.

<newline> is a single-byte new line character at the end of the data.

Syntax
DPOJET:PLOT<x>:DATA:YDATa:DDJDCD?

Outputs
After parsing the query results, the data is a stream of doubles.

DPOJET:PLOT<x>:DATA:YDATa:TN
This command returns the TN plot Y data values. This command is similar to the curve query, where the output is in the format
#<x><yyy><data><newline>, where <x> is the number of <y> bytes.

For example: If <yyy>=500, <x>=3

<x> is hexadecimal format. The letters A-F denote the number of y bytes between 10 and 15 digits.

<yyy> is the number of bytes to transfer.

<data> is curve data.

<newline> is a single-byte new line character at the end of the data.

Syntax
DPOJET:PLOT<x>:DATA:YDATa:TN?

Outputs
After parsing the query results, the data is a stream of doubles.

DPOJET:PLOT<x>:DATA:YDATa:RNNPN
This command returns the RNNPN plot Y data values. This command is similar to the curve query, where the output is in the format
#<x><yyy><data><newline>, where <x> is the number of <y> bytes.

For example: If <yyy>=500, <x>=3

<x> is hexadecimal format. The letters A-F denote the number of y bytes between 10 and 15 digits.

<yyy> is the number of bytes to transfer.

<data> is curve data.

<newline> is a single-byte new line character at the end of the data.
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Syntax
DPOJET:PLOT<x>:DATA:YDATa:RNNPN?

Outputs
After parsing the query results, the data is a stream of doubles.

DPOJET:PLOT<x>:DATA:YDATa:PN
This command returns the PN plot Y data values. This command is similar to the curve query, where the output is in the format
#<x><yyy><data><newline>, where <x> is the number of <y> bytes.

For example: If <yyy>=500, <x>=3

<x> is hexadecimal format. The letters A-F denote the number of y bytes between 10 and 15 digits.

<yyy> is the number of bytes to transfer.

<data> is curve data.

<newline> is a single-byte new line character at the end of the data.

Syntax
DPOJET:PLOT<x>:DATA:YDATa:PN?

Outputs
After parsing the query results, the data is a stream of doubles.

DPOJET:PLOT<x>:DATA:YDATa:DDNONE
This command returns the DDNONE plot Y data values. This command is similar to the curve query, where the output is in the format
#<x><yyy><data><newline>, where <x> is the number of <y> bytes.

For example: If <yyy>=500, <x>=3

<x> is hexadecimal format. The letters A-F denote the number of y bytes between 10 and 15 digits.

<yyy> is the number of bytes to transfer.

<data> is curve data.

<newline> is a single-byte new line character at the end of the data.

Syntax
DPOJET:PLOT<x>:DATA:YDATa:DDNONE?

Outputs
After parsing the query results, the data is a stream of doubles.
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DPOJET:PLOT<x>:DATA:YDATa:DDNZERO
This command returns the DDNZERO plot Y data values. This command is similar to the curve query, where the output is in the format
#<x><yyy><data><newline>, where <x> is the number of <y> bytes.

For example: If <yyy>=500, <x>=3

<x> is hexadecimal format. The letters A-F denote the number of y bytes between 10 and 15 digits.

<yyy> is the number of bytes to transfer.

<data> is curve data.

<newline> is a single-byte new line character at the end of the data.

Syntax
DPOJET:PLOT<x>:DATA:YDATa:DDNZERO?

Outputs
After parsing the query results, the data is a stream of doubles.

DPOJET:PLOT<x>:XUnits?
This query-only command returns X units of the plot as a string.

Syntax
DPOJET:PLOT<x>:XUnits?

Outputs
<string>

Note: Plot units depends on the measurement type.Click here to see the possible

DPOJET:PLOT<x>:YUnits?
This query-only command returns Y units of the plot as a string.

Syntax
DPOJET:PLOT<x>:YUnits?

Outputs
<string>

Note: Plot units depends on the measurement type.Click here to see the possible
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DPOJET:PLOT<x>:SOUrce?
This query-only command returns the source measurement for the selected plot.

Syntax
DPOJET:PLOT<x>:SOUrce?

Outputs
{MEAS1 - MEAS99}

DPOJET:PLOT<x>:TREND:TYPe
This command sets or queries the trend type setting for Trend plots.

Syntax
DPOJET:PLOT<x>:TREND:TYPe {VECTOR | BAR}
DPOJET:PLOT<x>:TREND:TYPe?

Inputs
{VECTOR | BAR}

Outputs
{VECTOR | BAR}

DPOJET:PLOT<x>:TYPe?
This query-only command returns the current plot type for the selected plot.

Syntax
DPOJET:PLOT<x>:TYPe?

Outputs
{TIMEtrend | DATAarray | HISTOgram | SPECtrum | TRANSfer | PHASEnoise | EYE |
WAVEform | BATHtub | QBathtub | QPulsewidth | COMPOSITEJitterhist | NOISEBAthtub |
BERContour} | CORRELATEDEye |PDFEye | BEREye | COMPOSITENoisehist }

DPOJET:PLOT<x>:BATHtub:BER
This command sets or queries the bathtub BER value.

Syntax
DPOJET:PLOT<x>:BATHtub:BER <NR3>
DPOJET:PLOT<x>:BATHtub:BER?
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Inputs
<NR3>

Outputs
<NR1>

Note: Undefined for nonbathtub plots.

DPOJET:PLOT<x>:BATHtub:VERTical:SCALE
This command sets or queries the vertical scale setting for applicable plots, either Linear or Log. 

Syntax
DPOJET:PLOT<x>:BATHtub:VERTical:SCALE {LINEAR | LOG}
DPOJET:PLOT<x>:BATHtub:VERTical:SCALE?

Inputs
{LINEAR | LOG}

Outputs
{LINEAR | LOG}

Note: Undefined for nonbathtub plots.

DPOJET:PLOT<x>:EYE:ALIGNment
This command sets or queries eye alignment state for eye plots.

Syntax
DPOJET:PLOT<x>:EYE:ALIGNment {AUTO | LEFT | CENter}
DPOJET:PLOT<x>:EYE:ALIGNment?

Inputs
{AUTO | LEFT | CENter}

Outputs
{AUTO | LEFT | CENter}

Note: Undefined for noneye plots.
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DPOJET:PLOT<x>:EYE:HORizontal:AUTOscale
This command sets or queries the horizontal auto scale setting. 

Syntax
DPOJET:PLOT<x>:EYE:HORizontal:AUTOscale {1 | 0}
DPOJET:PLOT<x>:EYE:HORizontal:AUTOscale?

Inputs
{1 | 0}

Outputs
{1 | 0}

Note: Undefined for noneye plots.

DPOJET:PLOT<x>:EYE:HORizontal:RESolution
This command sets or queries the Horizontal Eye resolution. 

Syntax
DPOJET:PLOT<x>:EYE:HORizontal:RESolution <NR3>
DPOJET:PLOT<x>:EYE:HORizontal:RESolution?

Inputs
<NR3>

Outputs
<NR1>

Note: Undefined for noneye plots.

DPOJET:PLOT<x>:EYE:INTERPolationtype
This command sets or queries the interpolation type.

Syntax
DPOJET:PLOT<x>:EYE:INTERPolationtype { INTERPOLATION | NONINTERPOLATION }
DPOJET:PLOT<x>:EYE:INTERPolationtype?

Inputs
{ INTERPOLATION | NONINTERPOLATION }
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Outputs
INTERPOLATION | NONINTERPOLATION

DPOJET:PLOT<x>:EYE:MASKfile
This command sets or queries the mask file. 

Syntax
DPOJET:PLOT<x>:EYE:MASKfile <string>
DPOJET:PLOT<x>:EYE:MASKfile?

Inputs
<string>

Outputs
<string>

Note: Undefined for noneye plots.

DPOJET:PLOT<x>:EYE:STATE
This command sets or queries the eye state, either on or off. 

Syntax
DPOJET:PLOT<x>:EYE:STATE {1 | 0}
DPOJET:PLOT<x>:EYE:STATE?

Inputs
{1 | 0}

Outputs
{1 | 0}

Note: Undefined for noneye plots.

DPOJET:PLOT<x>:EYE:SUPERImpose
This command sets or queries whether superimposed eyes are generated in eye diagrams.

Syntax
DPOJET:PLOT<x>:EYE:SUPERImpose {1 | 0}
DPOJET:PLOT<x>:EYE:SUPERImpose?
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Inputs
{1 | 0}

Outputs
{1 | 0}

Note: Undefined for noneye plots.

DPOJET:PLOT<x>:EYE:VERTICALAlignment
This command sets or queries the vertical alignment state, either on or off.

Syntax
DPOJET:PLOT<x>:EYE:VERTICALAlignment {1 | 0}
DPOJET:PLOT<x>:EYE:VERTICALAlignment?

Inputs
{1 | 0}

Outputs
{1 | 0}

DPOJET:PLOT<x>:EYE:VERTScale
This command sets or queries the vertical scale state, either on or off.

Syntax
DPOJET:PLOT<x>:EYE:VERTScale {1 | 0}
DPOJET:PLOT<x>:EYE:VERTScale?

Inputs
{1 | 0}

Outputs
{1 | 0}

DPOJET:PLOT<x>:EYE:HORIZScale
This command sets or queries the horizontal scale state, either on or off.

Syntax
DPOJET:PLOT<x>:EYE:HORIZScale {1 | 0}
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DPOJET:PLOT<x>:EYE:HORIZScale?

Inputs
{1 | 0}

Outputs
{1 | 0}

DPOJET:PLOT<x>:EYE:VERTical:YAXISMAx
This command sets or queries the Y-Axis maximum value.

Syntax
DPOJET:PLOT<x>:EYE:VERTical:YAXISMAx <NR3>
DPOJET:PLOT<x>:EYE:VERTical:YAXISMAx?

Inputs
<NR3>

Outputs
<NR3>

DPOJET:PLOT<x>:EYE:VERTical:YAXISMIn
This command sets or queries the Y-Axis minimum value

Syntax
DPOJET:PLOT<x>:EYE:VERTical:YAXISMIn <NR3>
DPOJET:PLOT<x>:EYE:VERTical:YAXISMIn?

Inputs
<NR3>

Outputs
<NR3>

DPOJET:PLOT<x>:EYE:HORizontal:XAXISMAx
This command sets or queries the X-Axis maximum value.

Syntax
DPOJET:PLOT<x>:EYE:HORizontal:XAXISMAx <NR3>
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DPOJET:PLOT<x>:EYE:HORizontal:XAXISMAx?

Inputs
<NR3>

Outputs
<NR3>

DPOJET:PLOT<x>:EYE:HORizontal:XAXISMIn
This command sets or queries the X-Axis minimum value.

Syntax
DPOJET:PLOT<x>:EYE:HORizontal:XAXISMIn <NR3>
DPOJET:PLOT<x>:EYE:HORizontal:XAXISMIn?

Inputs
<NR3>

Outputs
<NR3>

DPOJET:PLOT<x>:TOTALUISAnalyzed?
This command queries the total UIs analysed for Eye Diagram plot.

Syntax
DPOJET:PLOT<x>:TOTALUISAnalyzed?

Output
<NR3>

DPOJET:PLOT<x>:TOTALUISAcquired?
This command queries the total UIs acquired for Eye Diagram plot

Syntax
DPOJET:PLOT<x>:TOTALUISAcquired?

Outputs
<NR3>
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DPOJET:PLOT<x>:HISTOgram:HORizontal:SPAN
This command sets or queries the histogram span.

Syntax
DPOJET:PLOT<x>:HISTOgram:HORizontal:SPAN <NR3>
DPOJET:PLOT<x>:HISTOgram:HORizontal:SPAN?

Inputs
<NR3>

Outputs
<NR3>

Note: Undefined for nonhistogram plots.

DPOJET:PLOT<x>:HISTOgram:AUTOset
This command runs a histogram autoset for the specified slot.

Syntax
DPOJET:PLOT<x>:HISTOgram:AUTOset {EXECute}

Inputs
{EXECute}

Note: Undefined for nonhistogram plots.

DPOJET:PLOT<x>:HISTOgram:HORizontal:AUTOscale
This command sets or queries the horizontal auto scale settings. 

Syntax
DPOJET:PLOT<x>:HISTOgram:HORizontal:AUTOscale {1 | 0}
DPOJET:PLOT<x>:HISTOgram:HORizontal:AUTOscale?

Inputs
{1 | 0}

Outputs
{1 | 0}
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Note: Undefined for nonhistogram plots.

DPOJET:PLOT<x>:HISTOgram:HORizontal:CENter
This command sets or queries the histogram center.

Syntax
DPOJET:PLOT<x>:HISTOgram:HORizontal:CENter <NR3>
DPOJET:PLOT<x>:HISTOgram:HORizontal:CENter?

Inputs
<NR3>

Outputs
<NR3>

Note: Undefined for nonhistogram plots.

DPOJET:PLOT<x>:HISTOgram:HORizontal:SPAN
This command sets or queries the histogram span.

Syntax
DPOJET:PLOT<x>:HISTOgram:HORizontal:SPAN <NR3>
DPOJET:PLOT<x>:HISTOgram:HORizontal:SPAN?

Inputs
<NR3>

Outputs
<NR3>

Note: Undefined for nonhistogram plots.

DPOJET:PLOT<x>:HISTOgram:NUMBins
This command sets or queries the current histogram resolution.

Syntax
DPOJET:PLOT<x>:HISTOgram:NUMBins {TWENtyfive | FIFTY | HUNdred | TWOFifty |
FIVEHundred | TWOThousand | MAXimum}
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DPOJET:PLOT<x>:HISTOgram:NUMBins?

Inputs
{TWENtyfive | FIFTY | HUNdred | TWOFifty | FIVEHundred | TWOThousand | MAXimum}

Outputs
{TWENtyfive | FIFTY | HUNdred | TWOFifty | FIVEHundred | TWOThousand | MAXimum}

Note: Undefined for nonhistogram plots.

DPOJET:PLOT<x>:HISTOgram:VERTical:SCALE
This command sets or queries the vertical scale setting for applicable plots, either Linear or Log.

Syntax
DPOJET:PLOT<x>:HISTOgram:VERTical:SCALE {LINEAR | LOG}
DPOJET:PLOT<x>:HISTOgram:VERTical:SCALE?

Inputs
{LINEAR | LOG}

Outputs
{LINEAR | LOG}

Note: Undefined for nonhistogram plots.

DPOJET:PLOT<x>:PHASEnoise:BASEline
This command sets or queries the phase noise baseline.

Syntax
DPOJET:PLOT<x>:PHASEnoise:BASEline <NR3>
DPOJET:PLOT<x>:PHASEnoise:BASEline?

Inputs
<NR3>

Outputs
<NR1>

Note: Undefined for nonphase-noise plots.
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DPOJET:PLOT<x>:PHASEnoise:SMOOTHENINGFilter
This command sets or queries the phase noise plot smoothing filter.

Syntax
DPOJET:PLOT<x>:PHASEnoise:SMOOTHENINGFilter {ONEBYHUNDREDTHdecade |
ONEBYTENTHDECADE | ONEDECADE}
DPOJET:PLOT<x>:PHASEnoise:SMOOTHENINGFilter?

Inputs
{ONEBYHUNDREDTHdecade | ONEBYTENTHDECADE | ONEDECADE}

Outputs
{ONEBYHUNDREDTHdecade | ONEBYTENTHDECADE | ONEDECADE}

DPOJET:PLOT<x>:SPECtrum:BASE
This command sets or queries the spectrum base. Undefined for non-spectrum plots.

Syntax
DPOJET:PLOT<x>:SPECtrum:BASE <NR3>
DPOJET:PLOT<x>:SPECtrum:BASE?

Inputs
<NR3>

Outputs
<NR1>

DPOJET:PLOT<x>:SPECtrum:HORizontal:SCALE
This command sets or queries the horizontal scale setting for applicable plots, either Linear or Log.

Syntax
DPOJET:PLOT<x>:SPECtrum:HORizontal:SCALE {LINEAR | LOG}
DPOJET:PLOT<x>:SPECtrum:HORizontal:SCALE?

Inputs
{LINEAR | LOG}

Outputs
{LINEAR | LOG}
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Note: Undefined for nonspectrum plots.

DPOJET:PLOT<x>:SPECtrum:MODE
This command sets or queries the spectrum mode.

Syntax
DPOJET:PLOT<x>:SPECtrum:MODE {NORMal | AVErage | PEAKhold}
DPOJET:PLOT<x>:SPECtrum:MODE?

Inputs
{NORMal | AVErage | PEAKhold}

Outputs
{NORMal | AVErage | PEAKhold}

DPOJET:PLOT<x>:SPECtrum:VERTical:SCALE
This command sets or queries the vertical scale setting for applicable plots, either Linear or Log. 

Syntax
DPOJET:PLOT<x>:SPECtrum:VERTical:SCALE {LINEAR | LOG}
DPOJET:PLOT<x>:SPECtrum:VERTical:SCALE?

Inputs
{LINEAR | LOG}

Outputs
{LINEAR | LOG}

Note: Undefined for nonspectrum plots.

DPOJET:PLOT<x>:TRANSfer:DENominator
This command sets or queries the transfer plot denominator.

Syntax
DPOJET:PLOT<x>:TRANSfer:DENominator {MEAS1 - MEAS99}
DPOJET:PLOT<x>:TRANSfer:DENominator?
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Inputs
{MEAS1 - MEAS99}

Outputs
{MEAS1 - MEAS99}

Note: Undefined for non-transfer plots.

DPOJET:PLOT<x>:TRANSfer:HORizontal:SCALE
This command sets or queries the horizontal scale setting for applicable plots, either Linear or Log. Undefined for nontransfer plots.

Syntax
DPOJET:PLOT<x>:TRANSfer:HORizontal:SCALE {LINEAR | LOG}
DPOJET:PLOT<x>:TRANSfer:HORizontal:SCALE?

Inputs
{LINEAR | LOG}

Outputs
{LINEAR | LOG}

DPOJET:PLOT<x>:TRANSfer:MODE
This command sets or queries the transfer plot mode.

Syntax
DPOJET:PLOT<x>:TRANSfer:MODE {NORMal | AVErage}
DPOJET:PLOT<x>:TRANSfer:MODE?

Inputs
{NORMal | AVErage}

Outputs
{NORMal | AVErage}

DPOJET:PLOT<x>:TRANSfer:NUMerator
This command sets or queries the transfer plot numerator. 

Syntax
DPOJET:PLOT<x>:TRANSfer:NUMerator {MEAS1 - MEAS99}
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DPOJET:PLOT<x>:TRANSfer:NUMerator?

Inputs
{MEAS1 - MEAS99}

Outputs
{MEAS1 - MEAS99}

Note: Undefined for nontransfer plots.

DPOJET:PLOT<x>:TRANSfer:VERTical:SCALE
This command sets or queries the vertical scale setting for applicable plots, either Linear or Log. Undefined for non-transfer plots.

Syntax
DPOJET:PLOT<x>:TRANSfer:VERTical:SCALE {LINEAR | LOG}
DPOJET:PLOT<x>:TRANSfer:VERTical:SCALE?

Inputs
{LINEAR | LOG}

Outputs
{LINEAR | LOG}

DPOJET:PLOT<x>:BERContour:ALIGNment
This command sets or queries the BER contour alighment. 

Syntax
DPOJET:PLOT<x>:BERContour:ALIGNment {AUTO | LEFT | CENter}
DPOJET:PLOT<x>:BERContour:ALIGNment?
Inputs
{AUTO | LEFT | CENter}
Outputs
{AUTO | LEFT | CENter}

DPOJET:PLOT<x>:BERContour:HORizontal:AUTOscale
This command sets or queries the horizontal auto scale setting. 

Syntax
DPOJET:PLOT<x>:BERContour:HORizontal:AUTOscale {1 | 0}
DPOJET:PLOT<x>:BERContour:HORizontal:AUTOscale?
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Inputs
{1 | 0}
Outputs
{1 | 0}

DPOJET:PLOT<x>:BERContour:HORizontal:RESolution
This command sets or queries the Horizontal Eye resolution. 

Syntax
DPOJET:PLOT<x>:BERContour:HORizontal:RESolution <NR3>
DPOJET:PLOT<x>:BERContour:HORizontal:RESolution?
Inputs
<NR3>

DPOJET:PLOT<x>:BERContour:MASK
This command sets or queries the eye state, either on or off. 

Syntax
DPOJET:PLOT<x>:BERContour:MASK {1 | 0}
DPOJET:PLOT<x>:BERContour:MASK?
Inputs
{1 | 0}
Outputs
{1 | 0}

DPOJET:PLOT<x>:BERContour:MASKFile
This command sets or queries the mask file. 

Syntax
DPOJET:PLOT<x>:BERContour:MASKFile <string>
DPOJET:PLOT<x>:BERContour:MASKFile?
Inputs
<string>
Outputs
<string>
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DPOJET:PLOT<x>:BERContour:SUPERImpose
This command sets or queries whether superimposed eyes are generated in eye diagrams. 

Syntax
DPOJET:PLOT<x>:BERContour:SUPERImpose {1 | 0}
DPOJET:PLOT<x>:BERContour:SUPERImpose?
Inputs
{1 | 0}
Outputs
{1 | 0}

DPOJET:PLOT<x>:BERContour:BER1E6V
This command sets or queries the BER1E6 Contour display.

Syntax
DPOJET:PLOT<x>:BERContour:BER1E6V {1 | 0}
DPOJET:PLOT<x>:BERContour:BER1E6V?

Inputs
{1 | 0}

Outputs
{1 | 0}

DPOJET:PLOT<x>:BERContour:BER1E9V
This command sets or queries the BER1E9 Contour display.

Syntax
DPOJET:PLOT<x>:BERContour:BER1E9V {1 | 0}
DPOJET:PLOT<x>:BERContour:BER1E9V?

Inputs
{1 | 0}

Outputs
{1 | 0}
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DPOJET:PLOT<x>:BERContour:BER1E12V
This command sets or queries the BER1E12 Contour display.

Syntax
DPOJET:PLOT<x>:BERContour:BER1E12V {1 | 0}
DPOJET:PLOT<x>:BERContour:BER1E12V?

Inputs
{1 | 0}

Outputs
{1 | 0}

DPOJET:PLOT<x>:BERContour:BER1E15V
This command sets or queries the BER1E15 Contour display.

Syntax
DPOJET:PLOT<x>:BERContour:BER1E15V {1 | 0}
DPOJET:PLOT<x>:BERContour:BER1E15V?

Inputs
{1 | 0}

Outputs
{1 | 0}

DPOJET:PLOT<x>:BERContour:BER1E18V
This command sets or queries the BER1E18 Contour display.

Syntax
DPOJET:PLOT<x>:BERContour:BER1E18V {1 | 0}
DPOJET:PLOT<x>:BERContour:BER1E18V?

Inputs
{1 | 0}

Outputs
{1 | 0}
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DPOJET:PLOT<x>:BERContour:TARGETBER
This command sets or queries the Target BER Contour display. 

Syntax
DPOJET:PLOT<x>:BERContour:TARGETBER{1 | 0}
DPOJET:PLOT<x>:BERContour:TARGETBER?

Inputs
{1 | 0}

Outputs
{1 | 0}

DPOJET:PLOT<x>:VERTBATHtub:BER
This command sets or queries the noise bathtub BER value. 

Syntax
DPOJET:PLOT<x>:VERTBATHtub:BER <NR3>
DPOJET:PLOT<x>:VERTBATHtub:BER?
Inputs
<NR3>
Outputs
<NR1>

DPOJET:PLOT<x>:VERTBATHtub:YAXISUnits
This command sets or queries the Y-axis unit for noise bathtube.

Syntax
DPOJET:PLOT<x>:VERTBATHtub:YAXISUnits {VOLTs | UNITAMPLITUDES}
DPOJET:PLOT<x>:VERTBATHtub:YAXISUnits?

Inputs
{VOLTs | UNITAMPLITUDES}

Outputs
{LINEAR | UNITAMPLITUDES}
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DPOJET:PLOT<x>:VERTBATHtub:HORIzontal:SCALE
This command sets or queries the horizontal scale setting for applicable plots, either Linear or Log.

Syntax
DPOJET:PLOT<x>:VERTBATHtub:HORIzontal:SCALE {LINEAR | LOG}
DPOJET:PLOT<x>:VERTBATHtub:HORIzontal:SCALE?
Inputs
{LINEAR | LOG}
Outputs
{LINEAR | LOG}

DPOJET:PLOT<x>:CORRELATEDEye:BER1E6V
This command sets or queries the BER1E6 Contour display. 

Syntax
DPOJET:PLOT<x>:CORRELATEDEye:BER1E6V {1 | 0}

DPOJET:PLOT<x>:CORRELATEDEye:BER1E6V?

Inputs
{1 | 0}

Outputs
{1 | 0}

DPOJET:PLOT<x>:EXPORTRaw
This query command returns the raw Eye diagram 2d histogram data in binary format. This command is similar to curve query

Syntax
DPOJET:PLOT<x>:EXPORTRaw?

Outputs
After parsing the query results, the data is a stream of doubles.

DPOJET:PLOT<x>:CORRELATEDEye:BER1E9V
This command sets or queries the BER1E9 Contour display. 

Syntax
DPOJET:PLOT<x>:CORRELATEDEye:BER1E9V {1 | 0}
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DPOJET:PLOT<x>:CORRELATEDEye:BER1E9V?

Inputs
{1 | 0}

Outputs
{1 | 0}

DPOJET:PLOT<x>:CORRELATEDEye:BER1E12V
This command sets or queries the BER1E12 Contour display. 

Syntax
DPOJET:PLOT<x>:CORRELATEDEye:BER1E12V {1 | 0}

DPOJET:PLOT<x>:CORRELATEDEye: BER1E12V?

Inputs
{1 | 0}

Outputs
{1 | 0}

DPOJET:PLOT<x>:CORRELATEDEye:BER1E15V
This command sets or queries the BER1E15 Contour display. 

Syntax
DPOJET:PLOT<x>:CORRELATEDEye:BER1E15V {1 | 0}

DPOJET:PLOT<x>:CORRELATEDEye:BER1E15V?

Inputs
{1 | 0}

Outputs
{1 | 0}

DPOJET:PLOT<x>:CORRELATEDEye:BER1E18V
This command sets or queries the BER1E18 Contour display. 

Syntax
DPOJET:PLOT<x>:CORRELATEDEye:BER1E18V {1 | 0}

GPIB commands

430



DPOJET:PLOT<x>:CORRELATEDEye:BER1E18V?

Inputs
{1 | 0}

Outputs
{1 | 0}

DPOJET:PLOT<x>:CORRELATEDEye:TARGETBER
This command sets or queries the TARGETBER Contour display. 

Syntax
DPOJET:PLOT<x>:CORRELATEDEye:TARGETBER {1 | 0}

DPOJET:PLOT<x>:CORRELATEDEye:TARGETBER?

Inputs
{1 | 0}

Outputs
{1 | 0}

DPOJET:PLOT<x>:CORRELATEDEye:EYEHEIGHT
This query-only command returns eye height of correlated eye diagram.

Syntax
DPOJET:PLOT<x>:CORRELATEDEye:EYEHEIGHT?

Inputs
<NR2>

Outputs
<NR2>

DPOJET:PLOT<x>:CORRELATEDEye:EYEWIDTH
This query-only command returns eye width of correlated eye diagram.

Syntax
DPOJET:PLOT<x>:CORRELATEDEye:EYEWIDTH?
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Inputs
<NR2>

Outputs
<NR2>

DPOJET:PLOT<x>:PDFEye:BER1E6V
This command sets or queries the BER1E6 Contour display.

Syntax
DPOJET:PLOT<x>:PDFEye:BER1E6V {1 | 0}

DPOJET:PLOT<x>:PDFEye:BER1E6V?

Inputs
{1 | 0}

Outputs
{1 | 0}

DPOJET:PLOT<x>:PDFEye:BER1E9V
This command sets or queries the BER1E9 Contour display.

Syntax
DPOJET:PLOT<x>:PDFEye: BER1E9V {1 | 0}

DPOJET:PLOT<x>:PDFEye: BER1E9V?

Inputs
{1 | 0}

Outputs
{1 | 0}

DPOJET:PLOT<x>:PDFEye:BER1E12V
This command sets or queries the BER1E12 Contour display.

Syntax
DPOJET:PLOT<x>:PDFEye:BER1E12V {1 | 0}

DPOJET:PLOT<x>:PDFEye:BER1E12V?
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Inputs
{1 | 0}

Outputs
{1 | 0}

DPOJET:PLOT<x>:PDFEye:BER1E15V
This command sets or queries the BER1E15 Contour display.

Syntax
DPOJET:PLOT<x>:PDFEye:BER1E15V {1 | 0}

DPOJET:PLOT<x>:PDFEye:BER1E15V?

Inputs
{1 | 0}

Outputs
{1 | 0}

DPOJET:PLOT<x>:PDFEye:BER1E18V
This command sets or queries the BER1E18 Contour display.

Syntax
DPOJET:PLOT<x>:PDFEye:BER1E18V {1 | 0}

DPOJET:PLOT<x>:PDFEye:BER1E18V?

Inputs
{1 | 0}

Outputs
{1 | 0}

DPOJET:PLOT<x>:PDFEye:TARGETBER
This command sets or queries the TARGETBER Contour display.

Syntax
DPOJET:PLOT<x>: PDFEye:TARGETBER {1 | 0}

DPOJET:PLOT<x>: PDFEye:TARGETBER?
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Inputs
{1 | 0}

Outputs
{1 | 0}

DPOJET:PLOT<x>:BEREye:BER1E6V
This command sets or queries the BER1E6 Contour display.

Syntax
DPOJET:PLOT<x>:BEREye:BER1E6V {1 | 0}

DPOJET:PLOT<x>:BEREye:BER1E6V?

Inputs
{1 | 0}

Outputs
{1 | 0}

DPOJET:PLOT<x>:BEREye:BER1E9V
This command sets or queries the BER1E9 Contour display.

Syntax
DPOJET:PLOT<x>:BEREye:BER1E9V {1 | 0}

DPOJET:PLOT<x>:BEREye:BER1E9V?

Inputs
{1 | 0}

Outputs
{1 | 0}

DPOJET:PLOT<x>:BEREye:BER1E12V
This command sets or queries the BER1E12 Contour display.

Syntax
DPOJET:PLOT<x>:BEREye:BER1E12V {1 | 0}

DPOJET:PLOT<x>:BEREye:BER1E12V?
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Inputs
{1 | 0}

Outputs
{1 | 0}

DPOJET:PLOT<x>:BEREye:BER1E15V
This command sets or queries the BER1E15 Contour display.

Syntax
DPOJET:PLOT<x>:BEREye:BER1E15V {1 | 0}

DPOJET:PLOT<x>:BEREye:BER1E15V?

Inputs
{1 | 0}

Outputs
{1 | 0}

DPOJET:PLOT<x>:BEREye:BER1E18V
This command sets or queries the BER1E18 Contour display.

Syntax
DPOJET:PLOT<x>:BEREye:BER1E18V {1 | 0}

DPOJET:PLOT<x>:BEREye:BER1E18V?

Inputs
{1 | 0}

Outputs
{1 | 0}

DPOJET:PLOT<x>:BEREye:TARGETBER
This command sets or queries the TARGETBER Contour display.

Syntax
DPOJET:PLOT<x>:BEREye:TARGETBER {1 | 0}

DPOJET:PLOT<x>:BEREye:TARGETBER?
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Inputs
{1 | 0}

Outputs
{1 | 0}

DPOJET:PLOT<x>:COMPOSITENoisehist:HORIzontal:SCALE
This command sets or queries the Horizontal scale setting for applicable plots, either Linear or Log. 

Syntax
DPOJET:PLOT<x>:COMPOSITENoisehist:HORIzontal:SCALE {LINEAR | LOG}

DPOJET:PLOT<x>:COMPOSITENoisehist:HORIzontal:SCALE?

Inputs
{LINEAR | LOG}

Outputs
{LINEAR | LOG}

DPOJET:PLOT<x>:COMPOSITENoisehist:NUMBins
This command sets or queries the current composite noise histogram resolution.

Syntax
DPOJET:PLOT<x>:COMPOSITENoisehist:NUMBins { TWENtyfive | FIFTY | HUNdred | TWOFifty | FIVEHundred | TWOThousand |
MAXimum}

DPOJET:PLOT<x>:COMPOSITENoisehist:NUMBins?

Inputs
{ TWENtyfive | FIFTY | HUNdred | TWOFifty | FIVEHundred | TWOThousand | MAXimum}

Outputs
{ TWENtyfive | FIFTY | HUNdred | TWOFifty | FIVEHundred | TWOThousand | MAXimum}

DPOJET:PLOT<x>:COMPOSITENoisehist:TN
This command sets or queries the TN Noise component settings. 

Syntax
DPOJET:PLOT<x>:COMPOSITENoisehist:TN {1 | 0}

DPOJET:PLOT<x>:COMPOSITENoisehist:TN?

GPIB commands

436



Inputs
{1 | 0}

Outputs
{1 | 0}

DPOJET:PLOT<x>:COMPOSITENoisehist:RNNPN
This command sets or queries the RN+NPN Noise component settings. 

Syntax
DPOJET:PLOT<x>:COMPOSITENoisehist:RNNPN {1 | 0}

DPOJET:PLOT<x>:COMPOSITENoisehist:RNNPN?

Inputs
{1 | 0}

Outputs
{1 | 0}

DPOJET:PLOT<x>:COMPOSITENoisehist:PN
This command sets or queries the PN Noise component settings.

Syntax
DPOJET:PLOT<x>:COMPOSITENoisehist:PN {1 | 0}

DPOJET:PLOT<x>:COMPOSITENoisehist:PN?

Inputs
{1 | 0}

Outputs
{1 | 0}

DPOJET:PLOT<x>:COMPOSITENoisehist:DDNZERO
This command sets or queries the DDN(0) Noise component settings. 

Syntax
DPOJET:PLOT<x>:COMPOSITENoisehist:DDNZERO {1 | 0}

DPOJET:PLOT<x>:COMPOSITENoisehist:DDNZERO?
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Inputs
{1 | 0}

Outputs
{1 | 0}

DPOJET:PLOT<x>:COMPOSITENoisehist:DDNONE
This command sets or queries the DDN(1) Noise component settings. 

Syntax
DPOJET:PLOT<x>:COMPOSITENoisehist:DDNONE {1 | 0}

DPOJET:PLOT<x>:COMPOSITENoisehist:DDNONE?

Inputs
{1 | 0}

Outputs
{1 | 0}

DPOJET:PLOT<X>:EYE:EYEVerticalscale
This command sets or queries eye diagram vertical scale when superimpose reference clock eye is checked.

Syntax
DPOJET:PLOT<X>:EYE:EYEVerticalscale {SCALETOData, SCALETORefclk}
DPOJET:PLOT<X>:EYE:EYEVerticalscale?

Inputs
{SCALETOData, SCALETORefclk}

Outputs
{SCALETOData | SCALETORefclk}

DPOJET:PLOT<X>:EYE:INTERPOLATIONFactor
This command sets or queries eye diagram interpolation factor.

Syntax
DPOJET:PLOT<X>:EYE:INTERPOLATIONFactor{AUTO, TWELVEPOINTEIGHT, SIXTEEN}
DPOJET:PLOT<X>:EYE:INTERPOLATIONFactor?
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Inputs
{AUTO, TWELVEPOINTEIGHT, SIXTEEN}

Outputs
{AUTO | TWELVEPOINTEIGHT | SIXTEEN}

DPOJET:POPULATION:CONDition
This command sets or queries the current population limit condition.

Syntax
DPOJET:POPULATION:CONDition {EACHmeas | LASTmeas}
DPOJET:POPULATION:CONDition?

Inputs
{EACHmeas | LASTmeas}

Outputs
{EACHmeas | LASTmeas}

DPOJET:POPULATION:LIMIT
This command sets or queries the current limit value.

Syntax
DPOJET:POPULATION:LIMIT <NR3>
DPOJET:POPULATION:LIMIT?

Inputs
<NR3>

Outputs
<NR1>

DPOJET:POPULATION:LIMITBY
This command sets or queries the mechanism by limits, either acquisition or population.

Syntax
DPOJET:POPULATION:LIMITBY {ACQuisitions | POPUlation}
DPOJET:POPULATION:LIMITBY?
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Inputs
{ACQuisitions | POPUlation}

Outputs
{ACQuisitions | POPUlation}

DPOJET:POPULATION:STATE
This command turns on or off population limits.

Syntax
DPOJET:POPULATION:STATE {1 | 0}

Inputs
{1 | 0}

Outputs
{1 | 0}

DPOJET:QUALify:ACTIVE
This command sets the active state for the qualifier source, either HIGH or LOW.

Syntax
DPOJET:QUALify:ACTIVE {HIGH | LOW}

Inputs
{HIGH | LOW}

Outputs
{HIGH | LOW}

DPOJET:QUALify:SOUrce
This command sets the qualifier source.

Syntax
DPOJET:QUALify:SOUrce {CH1 – CH4 | MATH1 - MATH4 | REF1 - REF4 | SEARCH0 – SEARCH8}

Inputs
{CH1 – CH4 | MATH1 - MATH4 | REF1 - REF4 | SEARCH0 – SEARCH8}
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Outputs
{CH1 – CH4 | MATH1 - MATH4 | REF1 - REF4 | SEARCH0 – SEARCH8}

DPOJET:QUALify:STATE
This command turns on or off measurement qualification.

Syntax
DPOJET:QUALify:STATE {1 | 0}

Inputs
{1 | 0}

Outputs
{1 | 0}

DPOJET:REFLevel:CH<x>:MIDZero
This command turns on or off the mid reference level voltage setting.

Syntax
DPOJET:REFLevel:CH<x>:MIDZero {1 | 0}

Inputs
{1 | 0}

Outputs
{1 | 0}

DPOJET:REFLevels:AUTOSet
This command performs a DPOJET ref level autoset on any sources selected using DPOJET:REFLevels:CH<x>:AUTOSet.

Syntax
DPOJET:REFLevels:AUTOSet {EXECute}

Inputs
{EXECute}

Note: All pieces of the reflevel branch have the ability to set ref levels for CH1-CH4, MATH1-MATH4, and REF1-Ref4. Only
the CH<x> portion is shown in this OLH, but it exists and matches exactly for MATH (DPOJET:REFLevels:MATH<x> and REF
(DPOJET:REFLevels:REF<x>).
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DPOJET:REFLevels:AUTOset:STATE?
This query-only command provides the Ref Level Autoset status.

Syntax
DPOJET:REFLevels:AUTOset:STATE?

Outputs
"RUNNING" | "STOPPED"

DPOJET:REFLevels:CH<x>:AUTOSet
This command sets or clears the reflevel autoset state of the given source. When set to 1, the given source will have a ref level autoset
acted on it during the next acquisition.

Syntax
DPOJET:REFLevels:CH<x>:AUTOSet {1 | 0}

Inputs
{1 | 0}

Outputs
{1 | 0}

Note: The Ref Level Autoset state is shown only for Ch1-Ch4 sources. It is the same for MATH and Ref waveforms. For example:
DPOJET:REFLevels: MATH<x>, DPOJET:REFLevels:REF<x>.

DPOJET:REFLevels:CH<x>:ABSolute
The ABSolute branch specifies the ref levels in cases where a user chooses not to run a ref level autoset on a given source. If a user does
run a ref level autoset, the percentage values of Rise, Fall and Hysteresis are used.

DPOJET:REFLevels:CH<x>:ABSolute:RISEHigh
This command sets the ref level voltage relative to base top for autoset. The default is 1.0.

Syntax
DPOJET:REFLevels:CH<x>:ABSolute:RISEHigh <NR3>

Inputs
<NR3>

Outputs
<NR3>
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DPOJET:REFLevels:CH<x>:ABSolute:RISELow
This command sets the ref level voltage relative to base top for autoset. The default is -1.0.

Syntax
DPOJET:REFLevels:CH<x>:ABSolute:RISELow <NR3>

Inputs
<NR3>

Outputs
<NR3>

DPOJET:REFLevels:CH<x>:ABSolute:RISEMid
This command sets the ref level voltage relative to base top for autoset. The default is 0.0.

Syntax
DPOJET:REFLevels:CH<x>:ABSolute:RISEMid <NR3>

Inputs
<NR3>

Outputs
<NR3>

DPOJET:REFLevels:CH<x>:ABSolute:FALLHigh
This command sets the ref level voltage relative to base top for autoset. The default is 1.0.

Syntax
DPOJET:REFLevels:CH<x>:ABSolute:FALLHigh <NR3>

Inputs
<NR3>

Outputs
<NR3>

DPOJET:REFLevels:CH<x>:ABSolute:FALLLow
This command sets the ref level voltage relative to base top for autoset. The default is -1.1.
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Syntax
DPOJET:REFLevels:CH<x>:ABSolute:FALLLow <NR3>

Inputs
<NR3>

Outputs
<NR3>

DPOJET:REFLevels:CH<x>:ABSolute:FALLMid
This command sets the ref level voltage relative to base top for autoset. The default is 0.0.

Syntax
DPOJET:REFLevels:CH<x>:ABSolute:FALLMid <NR3>

Inputs
<NR3>

Outputs
<NR3>

DPOJET:REFLevels:CH<x>:ABSolute:HYSTeresis
This command sets the hysteresis value used for autoset. The default is 0.03.

Syntax
DPOJET:REFLevels:CH<x>:ABSolute:HYSTeresis <NR3>

Inputs
<NR3>

Outputs
<NR3>

DPOJET:REFLevels:CH<x>:BASETop
This command sets the base-top method for autoset.

Syntax
DPOJET:REFLevels:CH<x>:BASETop {MINMax | FULLhistogram | EYEhistogram | AUTO}
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Inputs
{MINMax | FULLhistogram | EYEhistogram | AUTO}

Outputs
{MINMax | FULLhistogram | EYEhistogram | AUTO}

DPOJET:REFLevels:CH<x>:PERcent
The ref level commands that follow set percent ref level parameters in the same way that the absolute parameters do, except that these
commands set the various percentage levels used by the autoset.

DPOJET:REFLevels:CH<x>:PERcent:FALLHigh
This command sets the ref level voltage relative to base top for autoset.

Syntax
DPOJET:REFLevels:CH<x>:PERcent:FALLHigh <NR3>

Inputs
<NR3>

Outputs
<NR3>

DPOJET:REFLevels:CH<x>:PERcent:FALLLow
This command sets the ref level voltage relative to base top for autoset.

Syntax
DPOJET:REFLevels:CH<x>:PERcent:FALLLow <NR3>

Inputs
<NR3>

Outputs
<NR3>

DPOJET:REFLevels:CH<x>:PERcent:FALLMid
This command sets the ref level voltage relative to base top for autoset.

Syntax
DPOJET:REFLevels:CH<x>:PERcent:FALLMid <NR3>
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Inputs
<NR3>

Outputs
<NR3>

DPOJET:REFLevels:CH<x>:PERcent:PERCENTReflevel
This command sets or gets the Reference Levels to Percentage or Absolute.

Syntax
DPOJET:REFLevels:CH<x>:PERcent:PERCENTReflevel { 1 | 0 }
DPOJET:REFLevels:CH<x>:PERcent:PERCENTReflevel?

Inputs
1 - Percentage

0 - Absolute

Outputs
{ 1 | 0 }

Note: The reflevel commands can be used to set ref levels for CH1-CH4, MATH1-MATH4, and REF1-REF4. The
command syntax in OLH is shown only for CH<x>. Use MATH<x> and REF<x> for MATH1-MATH4, and REF1-REF4
(DPOJET:REFLevels:MATH<x> and REF (DPOJET:REFLevels:REF<x>).

DPOJET:REFLevels:CH<x>:PERcent:HYSTeresis
This command sets the hysteresis value used for autoset.

Syntax
DPOJET:REFLevels:CH<x>:PERcent:HYSTeresis <NR3>

Inputs
<NR3>

Outputs
<NR3>

DPOJET:REFLevels:CH<x>:PERcent:RISEHigh
This command sets the ref level voltage relative to base top for autoset.
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Syntax
DPOJET:REFLevels:CH<x>:PERcent:RISEHigh <NR3>

Inputs
<NR3>

Outputs
<NR3>

DPOJET:REFLevels:CH<x>:PERcent:RISELow
This command sets the ref level voltage relative to base top for autoset.

Syntax
DPOJET:REFLevels:CH<x>:PERcent:RISELow <NR3>

Inputs
<NR3>

Outputs
<NR3>

DPOJET:REFLevels:CH<x>:PERcent:RISEMid
This command sets the ref level voltage relative to base top for autoset.

Syntax
DPOJET:REFLevels:CH<x>:PERcent:RISEMid <NR3>

Inputs
<NR3>

Outputs
<NR3>

DPOJET:REPORT
These are set-only commands. EXECute executes a DPOJET report save operation for the currently defined report configuration. APPEnd
appends new data to the selected report.

Syntax
DPOJET:REPORT {EXECute | APPEnd}

GPIB commands

DPOJET Jitter, Noise and Eye Diagram Analysis Solution Application Help 447



Note: Ensure to close the PDF report before append.

Inputs
{EXECute | APPEnd}

DPOJET:REPORT:APPlicationconfig
This command turns on or off including complete application configuration in reports.

Syntax
DPOJET:REPORT:APPlicationconfig {1 | 0}

Inputs
{1 | 0}

Outputs
{1 | 0}

DPOJET:REPORT:AUTOincrement
This command turns on or off auto increment of report file names.

Syntax
DPOJET:REPORT:AUTOincrement {1 | 0}

Inputs
{1 | 0}

Outputs
{1 | 0}

DPOJET:REPORT:COMments
This command sets or queries the comments.

Syntax
DPOJET:REPORT:COMments <string>
DPOJET:REPORT:COMments?

Inputs
<string>
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Outputs
<string>

DPOJET:REPORT:DETailedresults
This command turns on or off including detailed results in reports.

Syntax
DPOJET:REPORT:DETailedresults {1 | 0}

Inputs
{1 | 0}

Outputs
{1 | 0}

DPOJET:REPORT:ENABlecomments
This command sets or queries the comments enable or disable settings.

Syntax
DPOJET:REPORT:ENABlecomments {1 | 0}
DPOJET:REPORT:ENABlecomments?

Inputs
{1 | 0}

Outputs
{1 | 0}

DPOJET:REPORT:GETIMAGE
This command returns the image which is set using DPOJET:REPORT:SETIMAGEPath command in binary format.

Syntax
DPOJET:REPORT:GETIMAGE?

Outputs
Returns the image in binary format
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DPOJET:REPORT:GETIMAGEName
This query only commands gets all the PNG format image names from this directory
C:\Users\<userName>\Tektronix\TekApplications\DPOJET\Reports\Resources.

Syntax
DPOJET:REPORT:GETIMAGEName?

Outputs
After parsing the query results, the data is a stream of string

DPOJET:REPORT:GETXMLReport
This query only command retrieve the report in binary format

Syntax
DPOJET:REPORT:GETXMLReport?

Outputs
After parsing the query results, the data is a stream of xmlstring

DPOJET:REPORT:PASSFailresults
This command turns on or off including pass/fail results in reports.

Syntax
DPOJET:REPORT:PASSFailresults {1 | 0}

Inputs
{1 | 0}

Outputs
{1 | 0}

DPOJET:REPORT:PLOTimages
This command turns on or off including detailed plot images in reports.

Syntax
DPOJET:REPORT:PLOTimages {1 | 0}

Inputs
{1 | 0}
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Outputs
{1 | 0}

DPOJET:REPORT:REPORTName
This command sets the current report file name.

Syntax
DPOJET:REPORT:REPORTName <string>

Inputs
<string>

Outputs
<string>

DPOJET:REPORT:SETupconfig
This command turns on or off including setup configuration in reports.

Syntax
DPOJET:REPORT:SETupconfig {1 | 0}

Inputs
{1 | 0}

Outputs
{1 | 0}

DPOJET:REPORT:SAVEWaveforms
This command turns on or off saving waveforms when a report save/append is invoked.

Syntax
DPOJET:REPORT:SAVEWaveforms {1 | 0}

Inputs
{1 | 0}

Outputs
{1 | 0}

GPIB commands

DPOJET Jitter, Noise and Eye Diagram Analysis Solution Application Help 451



DPOJET:REPORT:SETIMAGEPath
This command sets the path of the image which you want to retreive using DPOJET:REPORT:GETIMAGE command.

Syntax
DPOJET:REPORT:SETIMAGEPath <file string>

Inputs
<file string>

DPOJET:REPORT:STATE?
This query-only command provides the report status.

Syntax
DPOJET:REPORT:STATE?

Outputs
INPROGRESS | DONE

DPOJET:REPORT:VIEWreport
This command turns on or off viewing report after generation.

Syntax
DPOJET:REPORT:VIEWreport {1 | 0}

Inputs
{1 | 0}

Outputs
{1 | 0}

DPOJET:RESULts:STATus?
This query-only command returns the overall pass/fail status.

Syntax
DPOJET:RESULts:STATus?

Outputs
{PASS | FAIL}
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DPOJET:REPORT:TYPe
This command sets or queries the report type. 

Syntax
DPOJET:REPORT:TYPe {MHT|PDF}
DPOJET:REPORT:TYPe?

Inputs
{MHT | PDF}

Outputs
{MHT | PDF}

DPOJET:RESULts:VIew
This command sets or queries the results view type.

Syntax
DPOJET:RESULts:VIew {SUMmary | DETails}
DPOJET:RESULts:VIew?

Inputs
{SUMmary | DETails}

Outputs
{SUMmary | DETails}

DPOJET:RESULts:GETALLResults?
The query only command returns all the measurement results in binary format. This command is similar to curve query.

Syntax
DPOJET:RESULts:GETALLResults?

Outputs
DPOJET:RESULts:GETALLResults? After parsing the query results, the data is a stream of xml string.

DPOJET:SAVE
This set-only command saves the specified DPOJET measurement result to the specified ref. For Example: DPOJET:SAVE MEAS4, REF2.
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Syntax
DPOJET:SAVE {MEAS1-MEAS99 | REF1-REF4}

Inputs
{MEAS1-MEAS99 | REF1-REF4}

DPOJET:SAVEALLPLOTS
Saves all the plots to Reports/Resource folder.

Syntax
DPOJET:SAVEALLPLOTS

Outputs
DPOJET:SAVEALLPLOTS Saves plots at "C:\Users\<LocalUser>\Tektronix\TekApplications\DPOJET\Reports\Resources folder.

DPOJET:SETIMAGETPath
This command sets or queries the image path of the DPOJET application.

Syntax
DPOJET:SETIMAGETPath <file string>
DPOJET:SETIMAGETPath?

Inputs
<file string>

Outputs
<file string>

DPOJET:SETLOGGINGPath
This command sets or queries the Logging path of the DPOJET application.

Syntax
DPOJET:SETLOGGINGPath <file string>
DPOJET:SETLOGGINGPath?

Inputs
<file string>
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Outputs
<file string>

DPOJET:SETREPORTPath
This command sets or queries the Report path of the DPOJET application.

Syntax
DPOJET:SETREPORTPath <file string>
DPOJET:SETREPORTPath?

Inputs
<file string>

Outputs
<file string>

DPOJET:SHOWMEASWARNing
This sets or queries the visibility of Reference Level Autoset warnings, either on or off.

Syntax
DPOJET:SHOWMEASWARNing {1|0}
DPOJET:SHOWMEASWARNing?

Inputs
{1|0}

Outputs
{1|0}

DPOJET:SNC:ACTIvate
This set only command activates Scope Noise Characterization application.

Syntax
DPOJET:SNC:ACTIvate

Outputs
DPOJET:SNC:ACTIvate launches Scope Noise Characterization application
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DPOJET:SNC:CLOse
This set only command closes Scope Noise Characterization application.

Syntax
DPOJET:SNC:CLOse

Outputs
DPOJET:SNC:CLOse closes Scope Noise Characterization application

Note: When the Scope Noise Characterization application is launched using the DPOJET:SNC:ACTIvate command, it is
recommended to close the Scope Noise Characterization application using DPOJET:SNC:CLOse command only.

DPOJET:SOURCEAutoset
This command performs a DPOJET horizontal, vertical, or autoset on both horizontal and vertical for any sources used in current
measurements.

Syntax
DPOJET:SOURCEAutoset {HORIzontal | VERTical | BOTH}

Inputs
{HORIzontal | VERTical | BOTH}

DPOJET:SOURCEAutoset:HORizontal:UICount
This command sets or queries the UICount for horizontal autoset.

Syntax
DPOJET:SOURCEAutoset:HORizontal:UICount <NR3>
DPOJET:SOURCEAutoset:HORizontal:UICount?

Inputs
<NR3>. Default is 10000.

Outputs
<NR3>

DPOJET:SOURCEAutoset:HORizontal:UIValue
This command sets or queries the UI value for horizontal autoset.

Syntax
DPOJET:SOURCEAutoset:HORizontal:UIValue <NR3>
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DPOJET:SOURCEAutoset:HORizontal:UIValue?

Inputs
<NR3>

Outputs
<NR3>

DPOJET:SOURCEAutoset:STATE?
This query-only command provides the Source Autoset status.

Syntax
DPOJET:SOURCEAutoset:STATE?

Outputs
"RUNNING" | "STOPPED"

DPOJET:STATE
This command sets or queries the current measurement state of DPOJET.

Syntax
DPOJET:STATE {RUN | SINGLE | RECALC | CLEAR | STOP}
DPOJET:STATE?

Inputs
{RUN | SINGLE | RECALC | CLEAR | STOP}

Outputs
The current state of the DPOJET measurement sequencer, including any of the possible inputs.

DPOJET:TDCOMPensation
This command sets or queries the TD compensation state.

Syntax
DPOJET:TDCOMPensation {1 | 0 | ON | OFF}
DPOJET:TDCOMPensation?

Inputs
{1 | 0 | ON | OFF}
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Outputs
{1 | 0}

DPOJET:UNITType
This command sets or queries the current unit-type setting for DPOJET, either Unit Interval, or seconds.

Syntax
DPOJET:UNITType {UNITinterval | SEConds}
DPOJET:UNITType?

Inputs
{UNITinterval | SEConds}

Outputs
{UNITinterval | SEConds}

DPOJET:LOCKRJ
This command sets or queries the Lock RJ Value.

Syntax
DPOJET:LOCKRJ {1 | 0 }

DPOJET:LOCKRJ?

Inputs
{1 | 0}

Outputs
{1 | 0}

DPOJET:LOCKRJValue
This command sets or queries the LockRJValue.

Syntax
DPOJET:LOCKRJValue <NR3>

DPOJET:LOCKRJValue?

Inputs
{ Min = 1fs, Max = 1s}
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Outputs

DPOJET:PLOT<x>:BATHtub:XAXISUnits
This command sets or queries the X-Axis Units of Bathtub.

Syntax
DPOJET:PLOT<x>:BATHtub:XAXISUnits { UNITIntervals | SECOnds }

DPOJET:PLOT<x>:BATHtub:XAXISUnits?

Inputs
{ UNITIntervals | SECOnds }

Outputs
{ UNITIntervals | SECOnds }

DPOJET:PLOT<x>:NOISEBATHtub:YAXISUnits
This command sets or queries the Y-Axis Units of Noise Bathtub.

Syntax
DPOJET:PLOT<x>:NOISEBATHtub:YAXISUnits { UNITAmplitudes | VOLTs }

DPOJET:PLOT<x>:NOISEBATHtub:YAXISUnits?

Inputs
{ UNITAmplitudes | VOLTs }

Outputs
{ UNITAmplitudes | VOLTs }

DPOJET:VERTUNITType
This command sets or queries the vertical Unit.

Syntax
DPOJET:VERTUNITType {UNITamplitude | VOLts}

DPOJET:VERTUNITType?

Inputs
{UNITamplitude | VOLts}
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Outputs
{UNITamplitude | VOLts}

DPOJET:VERsion?
This query-only command returns the current DPOJET version string.

Syntax
DPOJET:VERsion?

Outputs
<string>
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DPOJET:MEAS<x>:RESULts:ALLAcqs:MAX:STATus? 379
DPOJET:MEAS<x>:RESULts:ALLAcqs:MAX? 378
DPOJET:MEAS<x>:RESULts:ALLAcqs:MAXCC:STATus? 379
DPOJET:MEAS<x>:RESULts:ALLAcqs:MAXCC? 378
DPOJET:MEAS<x>:RESULts:ALLAcqs:MAXHits? 379
DPOJET:MEAS<x>:RESULts:ALLacqs:MEAN:HIGHLimit? 380
DPOJET:MEAS<x>:RESULts:ALLAcqs:MEAN:STATus? 381
DPOJET:MEAS<x>:RESULts:ALLAcqs:MEAN? 380
DPOJET:MEAS<x>:RESULts:ALLacqs:MIN:LOWLimit? 380
DPOJET:MEAS<x>:RESULts:ALLacqs:MIN:LOWMArgin? 380
DPOJET:MEAS<x>:RESULts:ALLAcqs:MIN:STATus? 382
DPOJET:MEAS<x>:RESULts:ALLAcqs:MIN? 381
DPOJET:MEAS<x>:RESULts:ALLAcqs:MINCC:STATus? 381
DPOJET:MEAS<x>:RESULts:ALLAcqs:MINCC? 381

GPIB Commands (continued)
DPOJET:MEAS<x>:RESULts:ALLAcqs:MINHits? 382
DPOJET:MEAS<x>:RESULts:ALLAcqs:PK2PK? 382
DPOJET:MEAS<x>:RESULts:ALLAcqs:POPUlation:STATus? 383
DPOJET:MEAS<x>:RESULts:ALLAcqs:POPUlation? 383
DPOJET:MEAS<x>:RESULts:ALLAcqs:SEG<x>:Hits? 383
DPOJET:MEAS<x>:RESULts:ALLAcqs:SEG<x>:MAXHits? 383
DPOJET:MEAS<x>:RESULts:ALLAcqs:SEG<x>:MINHits? 384
DPOJET:MEAS<x>:RESULts:ALLAcqs:STDDEV:STATus? 384
DPOJET:MEAS<x>:RESULts:ALLAcqs:STDDev? 384
DPOJET:MEAS<x>:RESULts:ALLAcqs? 377
DPOJET:MEAS<x>:RESULts:CURRentacq:MAX:STATus? 385
DPOJET:MEAS<x>:RESULts:CURRentacq:MAX? 384
DPOJET:MEAS<x>:RESULts:CURRentacq:MAXCC:STATus? 385
DPOJET:MEAS<x>:RESULts:CURRentacq:MAXCC? 385
DPOJET:MEAS<x>:RESULts:CURRentacq:MEAN:STATus? 386
DPOJET:MEAS<x>:RESULts:CURRentacq:MEAN? 385
DPOJET:MEAS<x>:RESULts:CURRentacq:MIN:STATus? 387
DPOJET:MEAS<x>:RESULts:CURRentacq:MIN? 386
DPOJET:MEAS<x>:RESULts:CURRentacq:MINCC:STATus? 386
DPOJET:MEAS<x>:RESULts:CURRentacq:MINCC? 386
DPOJET:MEAS<x>:RESULts:CURRentacq:PK2PK:STATus? 387
DPOJET:MEAS<x>:RESULts:CURRentacq:PK2PK? 387
DPOJET:MEAS<x>:RESULts:CURRentacq:POPUlation:STATus?
388
DPOJET:MEAS<x>:RESULts:CURRentacq:POPUlation? 387
DPOJET:MEAS<x>:RESULts:CURRentacq:STDDev:STATus?
388
DPOJET:MEAS<x>:RESULts:CURRentacq:STDDev? 388
DPOJET:MEAS<x>:RESULts:GETAll 388
DPOJET:MEAS<x>:RESULTS:STATus? 389
DPOJET:MEAS<x>:RESULts:VIew? 389
DPOJET:MEAS<x>:RESULts? 376
DPOJET:MEAS<x>:RJDJ:BER 389
DPOJET:MEAS<x>:RJDJ:DETECTPLEN 389
DPOJET:MEAS<x>:RJDJ:NCMODe 390
DPOJET:MEAS<x>:RJDJ:PATLen 390
DPOJET:MEAS<x>:RJDJ:SCOPERN 391
DPOJET:MEAS<x>:RJDJ:SNCREFID 391
DPOJET:MEAS<x>:RJDJ:TYPe 391
DPOJET:MEAS<x>:RJDJ:WINDOwlength 392
DPOJET:MEAS<x>:RNDN:AUTODETECTpattern 392
DPOJET:MEAS<x>:RNDN:BER 392
DPOJET:MEAS<x>:RNDN:NCMODe 393
DPOJET:MEAS<x>:RNDN:PATLen 393
DPOJET:MEAS<x>:RNDN:SCOPERN 394
DPOJET:MEAS<x>:RNDN:SNCREFID 394
DPOJET:MEAS<x>:RNDN:TYPe 393
DPOJET:MEAS<x>:RNDN:WINDOwlength 394
DPOJET:MEAS<x>:SIGNALType 395
DPOJET:MEAS<x>:SOUrce1 395
DPOJET:MEAS<x>:SOUrce2 395
DPOJET:MEAS<x>:SSC: NOMinalfreq: MANual 396
DPOJET:MEAS<x>:SSC:: NOMinalfreq: SELECTIONtype 396
DPOJET:MEAS<x>:SSC:NOMinalfreq:AUTO? 396
DPOJET:MEAS<x>:TIMEDATa? 397
DPOJET:MEAS<x>:TOEdge 397
DPOJET:MEAS<x>:ZOOMEVENT 397
DPOJET:MINBUJUI 337
DPOJET:NOISEENABLED 398
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GPIB Commands (continued)
DPOJET:NUMMeas? 398
DPOJET:OPTICALUNITType 398
DPOJET:PLOT<x>:BATHtub:BER 411
DPOJET:PLOT<x>:BATHtub:VERTical:SCALE 412
DPOJET:PLOT<x>:BATHtub:XAXISUnits 459
DPOJET:PLOT<x>:BERContour:ALIGNment 424
DPOJET:PLOT<x>:BERContour:BER1E12 427
DPOJET:PLOT<x>:BERContour:BER1E15 427
DPOJET:PLOT<x>:BERContour:BER1E18 427
DPOJET:PLOT<x>:BERContour:BER1E6 426
DPOJET:PLOT<x>:BERContour:BER1E9 426
DPOJET:PLOT<x>:BERContour:HORizontal:AUTOscale 424
DPOJET:PLOT<x>:BERContour:HORizontal:RESolution 425
DPOJET:PLOT<x>:BERContour:MASK 425
DPOJET:PLOT<x>:BERContour:MASKFile 425
DPOJET:PLOT<x>:BERContour:SUPERImpose 426
DPOJET:PLOT<x>:BERContour:TARGETBER 428
DPOJET:PLOT<x>:BEREye:BER1E12V 434
DPOJET:PLOT<x>:BEREye:BER1E15V 435
DPOJET:PLOT<x>:BEREye:BER1E18V 435
DPOJET:PLOT<x>:BEREye:BER1E6V 434
DPOJET:PLOT<x>:BEREye:BER1E9V 434
DPOJET:PLOT<x>:BEREye:TARGETBER 435
DPOJET:PLOT<x>:COMPOSITEJitterhist:DDJDCD 401
DPOJET:PLOT<x>:COMPOSITEJitterhist:NUMBins 400
DPOJET:PLOT<x>:COMPOSITEJitterhist:PJ 401
DPOJET:PLOT<x>:COMPOSITEJitterhist:RJNPJ 400
DPOJET:PLOT<x>:COMPOSITEJitterhist:TJ 400
DPOJET:PLOT<x>:COMPOSITEJitterhist:VERTical:SCALE 399
DPOJET:PLOT<x>:COMPOSITENoisehist:DDNONE 438
DPOJET:PLOT<x>:COMPOSITENoisehist:DDNZERO 437
DPOJET:PLOT<x>:COMPOSITENoisehist:HORIzontal:SCALE
436
DPOJET:PLOT<x>:COMPOSITENoisehist:NUMBins 436
DPOJET:PLOT<x>:COMPOSITENoisehist:PN 437
DPOJET:PLOT<x>:COMPOSITENoisehist:RNNPN 437
DPOJET:PLOT<x>:COMPOSITENoisehist:TN 436
DPOJET:PLOT<x>:CORRELATEDEye:BER1E12V 430
DPOJET:PLOT<x>:CORRELATEDEye:BER1E15V 430
DPOJET:PLOT<x>:CORRELATEDEye:BER1E18V 430
DPOJET:PLOT<x>:CORRELATEDEye:BER1E6V 429
DPOJET:PLOT<x>:CORRELATEDEye:BER1E9V 429
DPOJET:PLOT<x>:CORRELATEDEye:EYEHEIGHT 431
DPOJET:PLOT<x>:CORRELATEDEye:EYEWIDTH 431
DPOJET:PLOT<x>:CORRELATEDEye:TARGETBER 431
DPOJET:PLOT<x>:CURRENTUISACquired 402
DPOJET:PLOT<x>:CURRENTUISANalyzed 402
DPOJET:PLOT<x>:DATA:XDATa:DDNONE? 406
DPOJET:PLOT<x>:DATA:XDATa:DDNZERO? 405
DPOJET:PLOT<x>:DATA:XDATa:PJ? 403
DPOJET:PLOT<x>:DATA:XDATa:PN? 405
DPOJET:PLOT<x>:DATA:XDATa:RNNPN? 405
DPOJET:PLOT<x>:DATA:XDATa:TJ? 403
DPOJET:PLOT<x>:DATA:XDATa:TN? 404
DPOJET:PLOT<x>:DATA:XDATa? 402
DPOJET:PLOT<x>:DATA:YDATa:DDJDCD? 408
DPOJET:PLOT<x>:DATA:YDATa:DDNONE? 409
DPOJET:PLOT<x>:DATA:YDATa:DDNZERO? 410
DPOJET:PLOT<x>:DATA:YDATa:PJ? 407

GPIB Commands (continued)
DPOJET:PLOT<x>:DATA:YDATa:PN? 409
DPOJET:PLOT<x>:DATA:YDATa:RNNPN? 408
DPOJET:PLOT<x>:DATA:YDATa:TJ? 407
DPOJET:PLOT<x>:DATA:YDATa:TN? 408
DPOJET:PLOT<x>:DATA:YDATa? 406
DPOJET:PLOT<x>:EXPORTRaw 429
DPOJET:PLOT<x>:EYE:ALIGNment 412
DPOJET:PLOT<X>:EYE:EYEVerticalscale 438
DPOJET:PLOT<x>:EYE:HORizontal:AUTOscale 413
DPOJET:PLOT<x>:EYE:HORizontal:RESolution 413
DPOJET:PLOT<X>:EYE:INTERPOLATIONFactor 438
DPOJET:PLOT<x>:EYE:MASKfile 414
DPOJET:PLOT<x>:EYE:STATE 414
DPOJET:PLOT<x>:EYE:SUPERImpose 414
DPOJET:PLOT<x>:HISTOgram:AUTOset 418
DPOJET:PLOT<x>:HISTOgram:HORizontal:AUTOscale 418
DPOJET:PLOT<x>:HISTOgram:HORizontal:CENter 419
DPOJET:PLOT<x>:HISTOgram:HORizontal:SPAN 418, 419
DPOJET:PLOT<x>:HISTOgram:NUMBins 419
DPOJET:PLOT<x>:HISTOgram:VERTical:SCALE 420
DPOJET:PLOT<x>:NOISEBATHtub:YAXISUnits 459
DPOJET:PLOT<x>:PDFEye:BER1E12V 432
DPOJET:PLOT<x>:PDFEye:BER1E15V 433
DPOJET:PLOT<x>:PDFEye:BER1E18V 433
DPOJET:PLOT<x>:PDFEye:BER1E6V 432
DPOJET:PLOT<x>:PDFEye:BER1E9V 432
DPOJET:PLOT<x>:PDFEye:TARGETBER 433
DPOJET:PLOT<x>:PHASEnoise:BASEline 420
DPOJET:PLOT<x>:PHASEnoise:SMOOTHENINGFilter 421
DPOJET:PLOT<x>:SOUrce? 411
DPOJET:PLOT<x>:SPECtrum:BASE 421
DPOJET:PLOT<x>:SPECtrum:HORizontal:SCALE 421
DPOJET:PLOT<x>:SPECtrum:MODE 422
DPOJET:PLOT<x>:SPECtrum:VERTical:SCALE 422
DPOJET:PLOT<x>:TRANSfer:DENominator 422
DPOJET:PLOT<x>:TRANSfer:HORizontal:SCALE 423
DPOJET:PLOT<x>:TRANSfer:MODE 423
DPOJET:PLOT<x>:TRANSfer:NUMerator 423
DPOJET:PLOT<x>:TRANSfer:VERTical:SCALE 424
DPOJET:PLOT<x>:TREND:TYPe 411
DPOJET:PLOT<x>:TYPe? 411
DPOJET:PLOT<x>:VERTBATHtub:BER 428
DPOJET:PLOT<x>:VERTBATHtub:HORIzontal:SCALE 429
DPOJET:PLOT<x>:XUnits? 410
DPOJET:PLOT<x>:YUnits? 410
DPOJET:PLOTx:DATA:XDATa:RJBUJ? 403
DPOJET:PLOTx:DATA:YDATa:RJBUJ? 407
DPOJET:POPULATION:CONDition 439
DPOJET:POPULATION:LIMIT 439
DPOJET:POPULATION:LIMITBY 439
DPOJET:POPULATION:STATE 440
DPOJET:QUALify:ACTIVE 440
DPOJET:QUALify:SOUrce 440
DPOJET:QUALify:STATE 441
DPOJET:REFLevel:CH<x>:MIDZero 441
DPOJET:REFLevels:AUTOSet 441
DPOJET:REFLevels:CH<x>:ABSolute 442
DPOJET:REFLevels:CH<x>:ABSolute:FALLHigh 443
DPOJET:REFLevels:CH<x>:ABSolute:FALLLow 443
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GPIB Commands (continued)
DPOJET:REFLevels:CH<x>:ABSolute:FALLMid 444
DPOJET:REFLevels:CH<x>:ABSolute:HYSTeresis 444
DPOJET:REFLevels:CH<x>:ABSolute:RISEHigh 442
DPOJET:REFLevels:CH<x>:ABSolute:RISELow 443
DPOJET:REFLevels:CH<x>:ABSolute:RISEMid 443
DPOJET:REFLevels:CH<x>:AUTOSet 442
DPOJET:REFLevels:CH<x>:BASETop 444
DPOJET:REFLevels:CH<x>:PERcent 445
DPOJET:REFLevels:CH<x>:PERcent:FALLHigh 445
DPOJET:REFLevels:CH<x>:PERcent:FALLLow 445
DPOJET:REFLevels:CH<x>:PERcent:FALLMid 445
DPOJET:REFLevels:CH<x>:PERcent:HYSTeresis 446
DPOJET:REFLevels:CH<x>:PERcent:PERCENTReflevel 446
DPOJET:REFLevels:CH<x>:PERcent:RISEHigh 446
DPOJET:REFLevels:CH<x>:PERcent:RISELow 447
DPOJET:REFLevels:CH<x>:PERcent:RISEMid 447
DPOJET:REPORT 447
DPOJET:REPORT:APPlicationconfig 448
DPOJET:REPORT:AUTOincrement 448
DPOJET:REPORT:COMments 448
DPOJET:REPORT:DETailedresults 449
DPOJET:REPORT:ENABlecomments 449
DPOJET:REPORT:PASSFailresults 450
DPOJET:REPORT:PLOTimages 450
DPOJET:REPORT:REPORTName 451
DPOJET:REPORT:SAVEWaveforms 451
DPOJET:REPORT:SETupconfig 451
DPOJET:REPORT:STATE? 452
DPOJET:REPORT:TYPe 453
DPOJET:REPORT:VIEWreport 452
DPOJET:RESULts:STATus? 452
DPOJET:RESULts:VIew 453
DPOJET:SAVE 453
DPOJET:SAVEALLPLOTS 454
DPOJET:SHOWMEASWARNing 455
DPOJET:SNC:ACTIvate 455
DPOJET:SNC:CLOse 456
DPOJET:SOURCEAutoset 456
DPOJET:SOURCEAutoset:HORizontal:UICount 456
DPOJET:SOURCEAutoset:HORizontal:UIValue 456
DPOJET:STATE 457
DPOJET:TDCOMPensation 457
DPOJET:UNITType 458
DPOJET:VERsion? 460
DPOJET:VERTUNITType 459

GPIB Program 328
GPIB Reference Materials 328

H
Halt free-run 226
Height 59
Height@BER 59, 299
High 61, 302, 316
High Pass filter 72
High time 293
High Time 58
High-Low 61, 305

Histogram 184
Histogram plot parameters 242
Hold 58, 59, 295
Horizontal cursors 209
Horizontal resolution 142
Hysteresis 177

I
Image export directory 159
Installing the Application 39

J
J2 55
J9 56
Jitter analysis 37
Jitter analysis through RJ-DJ separation 321
Jitter estimation using Dual-Dirac 323
Jitter measurements map 253
Jitter separation model 158
Jitter summary 285
Jitter Summary 55
JTF BW 84

L
Limit 72
Limits files 43
Lock RJ Value 157
Log notifiers 45
Logging export directory 159
Loop BW 84
Low 61, 302, 316
Low Pass filter 72
Low time 293
Low Time 58
Lower Frequency 113

M
Margin parameters 241
Mask files 43
Mask Hit Ratio 64
Mask hits 300
Mask Hits 60
Mask Margin 65
Max 179
Max or Min value 67
Max-cc 179
Mean 178
Measurement Range 67
Measurement Select Parameters 224
Measurements-Amplitude 60
Measurements-Eye 59
Measurements-Period/Freq 53
Measurements-Time 58
Menu Shortcuts
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Menu Shortcuts (continued)
Alt+A+J 44

Min 179
Min-cc 179
Moving and resizing plots 207

N
N-Period 54
Navigation panel 49
Neg Width 54
Noise analysis 37
Noise bathtub plot parameters 245
Noise measurements map 254
Nominal clock offset 89
Notifier duration 154
NPJ 55
NPJ measurement 287

O
One touch jitter 128
Opposite as From 111
Optical high 64
Optical low 64
Optical measurements

average optical power 64
extinction ratio 64
optical high 64
optical low 64
optical modulation amplitude 64

Optical parameters 242
Oscilloscope model number 35
Overshoot 61, 306

P
p-p 179
Path defaults 158
Pattern file name 82
Pattern Type 107
PCIe 75
PCIe AC common mode 312
PCIe AC Common Mode 62
PCIe MAX-MIN Ratio 62
PCIe Med-Mx-Jitter 62, 276
PCIe SSC FREQ DEV 62
PCIe SSC PROFILE 62
PCIe T-RF-Mismch 62, 277
PCIe T-TX 62, 277
PCIe T-Tx-Diff-PP 62, 277
PCIe T-Tx-Fall 62, 277
PCIe T-Tx-Rise 62, 277
PCIe T/nT Ratio 62, 277
PCIe Tmin-Pulse 62, 277
PCIe UI 62, 277
PDF eye plot parameters 247
Period 54
Phase Noise 55, 184

Phase noise plot parameters 244
PJ 55, 286
PJ(h) 56
PJ(v) 56
PJrms 56, 288
PkPkClkDJ 56
PkPkClkRJ 56
PkPkClkTJ 56
PLL clock recovery setup 82
PLL Custom BW 84
PLL model 83
PLL standard BW 83
Plot files 43
Plot summary views 207
Plot usage 185
Plots 49
Population 71, 108, 179
Pos Width 54
Positive and negative CC duty 283
Positive and negative duty cycle 282
Positive and negative width 281
Preferences Parameters 226
Preferences-General 154
Preferences-Jitter Decomp 156
Preferences-Measurement 154
Print figure 207
Printing plots 210
Probes 39
Product description 37
Progress indicator 172

Q
Q-Bathtub 185
Q-factor 300
Q-PulseWidth 185
Qualify

Horizontal Sample Rate 69

R
Ramp time 77
Recalc 48
recall 46
Recalling a Default Setup 47
Recalling a Saved Setup 46
Ref level menu parameters 225
Ref Levels Setup 151
reference levels 147
Related Documentation 34
Report export directory 159
Report files 43
Reports 49, 210, 247
Reports format 212
Requirements and Restrictions 39
Results 49, 325
Results as plots 184
Returning to the Application 45
RIN 65
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RINxOMA 65
Rise slew rate 294
Rise time 292
Rise Time 58
Rising versus falling thresholds 148
Rj 284
RJ 55
RJ-DJ

Auto 100
Manual 100

RJ-DJ analysis of arbitrary pattern 102
RJ-DJ analysis of repeating pattern 102
RJ-DJ analysis parameters 237
RJ-DJ separation for arbitrary patterns 322
RJ-DJ separation via spectrum analysis 322
RJ(h) 56
RJ(v) 56
RN-DN

Auto 103
Manual 103

RN-DN analysis of arbitrary pattern 105
RN-DN analysis of repeating pattern 105
RN-DN analysis parameters 238
Run 48

S
Same as From 111
Save Current Stats... 179
Saving a Setup 46
Select 49
Select measurement 130
Select sources 133
Selecting a measurement 52
Selecting plots 188
Separation on non-periodic jitter 322
Sequencing 172
Setup 58, 294
Show plots 48
Sine(x)/x 156
Single 48
SJ@Freq 56
Skew 58, 293
Source autoset 142
Spectrum 184
Spectrum plot parameters 243
Spread spectrum clocking

configuring 137
Spread spectrum clocking (SSC) 123
SRJ 56
SSC 72
SSC FREQ DEV 297
SSC FREQ DEV MAX 296
SSC FREQ DEV MIN 296
SSC modulation 137
SSC parameters 237
SSCpProfile 296
Standard: b/s 84
Starting the Application 41

Stat pop 177
Statistical results 178
Statistics log files 43
Std Dev 179
Steps to deskew probes and channels 51
Summary 180
Summary-Measurement 175
Summary-Misc 177
Summary-Ref levels 176
Sync cursor 207

T
T/nT ratio 303
T/nT-Ratio 61
Tab 41
Table of measurements-jitter 54
Table of measurements-Noise 57
TCdr-Slew-Max 63
tCMD-CMD 297
TDEC 65
Technical Support 35
Test point 65
Text editor 45
TIE 55, 284
Time outside level 297
Time Trend 184
Time trend plot parameters 244
Timing analysis 37
TJ 55
TJ@BER 285
Tmin-Pulse-Tj 63
Toolbar functions in plot 207
Transfer 184
Transfer function plot parameters 245
Tutorial 216
two source 141

U
Undershoot 61, 306
Upper Frequency 113
USB AC common mode 315
USB AC Common Mode 64
USB SSC MOD-RATE 63
USB SSC PROFILE 63
USB SSC-FREQ-DEV 63
USB Tmin-Pulse-Dj 63
USB UI 64
user comments 212

V
V-Diff-Xovr 61, 305
Vertical cursors 209
View log file 161
Viewing plots 206
virtual keypad 41
VTx-Diff-PP 63
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W
W1011 257
W1051 257
W1053 257
W1064 258
W4008 259
W4009 259
W4025 260
W4026 260
W410 256
W5005 261
Waveform 185
Waveform files 216
Waveform interpolation type 156
Width 59
Width@BER 60, 298
Window Length 107
Worst case logging 168

Z
Zoom and reset zoom 207
Zoom in a plot 208
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